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INTRODUCTION

Course Description

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

Course Objectives

As a result of this course, you will be able to use the InEight Estimate software to:

¢ Construct and modify cost estimates

¢ Calculate profit and finalize bid proposals

How to Use this Manual

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

Lessons

The following lessons are covered in this course:
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Course Lessons

Lesson Topic

Lesson1 Estimating Core Concepts
Lesson2 General Navigation
Lesson 3 Library Setup

Lesson4 Project Setup

Lesson 5 Estimate Direct Costs
Lesson 6 Estimate Indirect Costs

Lesson 7 Finalize the Estimate

Lesson Format

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

Objectives  Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.
Step by Walk you through the “mechanics” of how to perform specific functions in the
Steps software. For each step by step, you will use the Training Job that comes pre-

loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating
software.

Review Asks you questions to check what you have learned within each lesson.

Call-Outs

Throughout the document, you will also find important call-out banners.

TIP Tips are for important notes and information you want to remember.
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Jlelg= Notes are for critical information you need to know.

Ongoing Use

This manual is also designed to be a comprehensive reference guide you can use outside of the

classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.

1.1 0 FEATURED CONTENT

Spend Target Price Over Pay ltems
Library Address Book

1.2 O POPULAR TOPICS

Overview of the Estimating Process
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1.3 Quick Links

Cost Escalation Overview

Trench Calculator

Job Creation

Cost Breakdown Structure

View All Topics

1.3

Quick Guides
User Guides

Supplemental Documents

Integrated Solutions
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TopicsStartPage.htm
ResourcesStartPage.htm#Quick
ResourcesStartPage.htm#User
ResourcesStartPage.htm#Suppleme
http://learn.ineight.com/integrated_solutions

Estimate Essentials User Guide 1.4 Frequently asked questions

1.4 FREQUENTLY ASKED QUESTIONS

How do | know what version of Estimate | have?

The product version displays on the information bar at the bottom of the Estimate screen. You
can find more detailed version information by selecting System > About Estimate, then clicking
on the Version tab.

Why does my CBS look different than my coworker's?

Often your CBS register looks different due to the CBS Tree being open on your instance when it
is closed on someone else's or visa versa. If you prefer not to use the CBS Tree, you can close it by
selecting the X on the CBS Tree title bar. To open the CBS Tree, select Actions > CBS Tree Filter.
Your CBS may also look different due to using a different Saved View.

See Also:

Cost Breakdown Structures

Columns

How do | get the help bubbles to show back up?

To restore the system Help Bubbles, select File > Settings, then click on the Restore Defaults
button. Check the Never ask/show me again dialogs, then click OK.

See Also:

General Navigation

Where is the UNDO button?

We don’t have one, because in a multi-user environment, users may see unexpected behavior.
User A changes a quantity on a resource from 15 to 20. User B replaces the resource with
another resource on the cost item, and changes the quantity to 10. What is the expectation of
User A when performing an UNDO operation at this time? We can’t limit it to “just the changes
User A recently made” since that data may not even be in the estimate anymore. Instead, we
encourage users to become familiar with the PBS Changes Log, where any changes that affect the
Target Price will be captured.
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What does the Haul Calculator do?

In the CBS, Estimate’s Haul Calculator lets you enter the specifics, such as distance and speed of
up to three haul routes. Once entered, you can either:

¢ Calculate the number of trucks required to complete the haul in a set amount of time, or
¢ Calculate how long it will take to complete the haul with a set number of trucks.

Access the Haul Calculator from and employed equipment resource on a cost item record.

See Also:

Haul Calculator

What does the Trench Calculator do?

The Trench Calculator lets you quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width,
hinge elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor),
and up to four beddings.

See Also:

Trench Calculator

In the CBS, what'’s the difference between a locked and unlocked approach?

There are two basic approaches to structuring your cost items and pay items. You can choose to
work in a locked approach or an unlocked approach.

In a locked approach, level one cost items are automatically created and assigned to pay items.
This locked approach works well when pay items adequately represent the work plan.
Subordinate cost items inherit the pay item assignment of superior cost items.

The unlocked approach may work better when the pay items do not adequately represent the
work plan. You can then assign your cost items to your pay items in any arrangement.

See Also:

Cost Breakdown Structure

| cannot see any of the data blocks in a cost item record. How can | see them again?

In the cost item record, select Actions > Default Data Blocks.
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See Also:

Costs and Production

How can | sync my existing library address book entries with Platform’s vendors and contacts?

You can manage and retain all vendor information in the Estimate Address Book that are not
linked (disconnected) with Platform, including contacts and companies that are referenced in
multiple estimates, quotes and RFQs.

Disconnected Vendors and Contacts can be merged with existing Platform vendors and contacts,
or they can be uploaded to create new Platform vendors and contacts by navigating to the Library
> Setup > Address Book. You can also upload new Estimate vendors and contacts into Platform's
master data repository.

See Also:

Library Address Book

In Quote Management, what are scope items and how can | set this up?

Subcontractors and suppliers can sometimes provide a quote(s) for work during the tail end of
the bidding process. These last-minute offers make it extremely difficult for you to evaluate and
compare the various quotes and your ability to award them.

With scope items, you can create and evaluate checklists and quote group exclusions, and
account for them within the Quote Comparison and Award form.

See Also:

Scope Items
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InEight’
ESTIMATE

LESSON 1 - ESTIMATING CORE
CONCEPTS

Lesson Duration: 30 Minutes

Lesson Objectives
After completing this lesson, you will be able to:
e Explain the estimating process in InEight Estimate

e Explain key terms and concepts

Lesson Topics
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1.1 OVERVIEW OF THE ESTIMATING PROCESS

The estimating process typically progresses through the following five steps. If you are an Owner you
may not take part in all five of these steps, but may instead do a few in an iterative process as you
progress through stage gate approval phases.

1. Enter project details.

2. Enter proposal deliverables.

3. Calculate Direct & Indirect Project Cost.

4. Add Markup, Contingency, & Fees.

5. Distribute Cost + Markup to required structure.

The below table displays how these five steps correspond with specific forms in InEight Estimate:

Distribute Cost +
Markup to required

Add Markup, Structure Completed
Calculate Direct Contingency, Estimate
& Indirect Fees InEight File

Project Cost Estimate -
InEight (Pay ltem &)
Enter Proposal InEight Estimate - PROPOSAL
Deliverables Estimate — PPBS Form Form
Enter Project CBS Form (Brcrelgidown
Details ] (Cost
InEight Breakdown Structure)
Estimate - Structure)
InEight PAY ITEM
Estimate - (& Proposal )
Job Form
Properties
Form

Note the forms used in InEight Estimate to accomplish the steps above:

Job Properties

Pay Item & Proposal

CBS (Cost Breakdown Structure)

PBS (Price Breakdown Structure)
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The rest of this section walks you through an overview of each step in the process and its
corresponding form in InEight Estimate.

Step 1 - Enter Project Details

When you decide to estimate a new project, the first step is to create a new estimate and set it up with
the general project details. In InEight Estimate, you’ll enter basic information and project specific
settings in the Job Properties form from the Setup tab.

The Job Properties form is organized into tabs to help you keep track of all the basic information and
settings for the project. It begins with the Overview tab. You will move from left to right entering your
project specific information and adjusting any settings that differ from the default.

Estimate Quote Price Execution System Integrations

H ¥ BYais d a B b

£3 Equipment

JobProperies  Foundation  PayItem& BidWizard | Resource Resource | Costltem Standard | Reports
- SetupData ~  Proposal Rates - % Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports &
Cost Breakdown Structure (CBS) Register Job Properties @
| Overview | Security | CoverSheet | CostBasis | Minority Setup | Fuel Cost | JobTracking | JobFolder Tags | Competitors | Pridng | Schedule | CashFlow | Equipment »
Tdentification
Location: 1-10 MP 100 to MP 120 Type: Highway and General Engineering Contract Duration: 160
City: Phoenix Engineer: | Example Engineer — Fred Jones O] Time Measure: | Contract Days ~
County: Maricopa Ouiner: | Example Ovner - Jerry Slate Fl Forecast Start: | 6/11/2019
Country: | United States - Architect: | Example Architect - Robert Frost | ForecastFinish: | 11/20/2019
State: | Arizona Duration: 162
Latitude: 0.00000
Longitude: 0.00000
Proposal
Bid Date: | 12/23/2013 Opening Type: Public
Bid Time:  10:00:00 PM ProposalType:  Unit Price
Estimator: | Example Prime Contractor 1 —-Tom Cross ] Flan Holders: 5
Bid Location: Engineer's Office Liquidated Damages: 51,000.00
Oviners Estimate: $6,000,000.00  Liq. Damages Per: | Day
RFQ Contact: | Example Prime Contractor 1 - Tom Cross m

Accrued Costs OFF

As-Entered Currency ~ As-Entered Units  v19.1HD_19.1_QA2016  Training Job

Step 2 - Enter Proposal Deliverables

For Contractors who are submitting a proposal to a client, this step enables you to enter the client
provided deliverables clients are requesting pricing for. Most Owners will skip this step unless there is
a need to track various funding sources or prepare for internal or external company billing.

In InEight Estimate this list of items is recorded in the Pay Item & Proposal Register on the Setup tab.
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* Notice that your pay items have no pricing when first entered because you have yet to figure out
costs. You will come back to this form later in the process to distribute your costs and markup.

Pay Item & Proposal Register ©
Proposal Recap - Training Job. Item Recap - 200 SITEWORK & ROADWAY

Current Torget Forecast | Variance —

z Al
8411834 | $90411982 | $1,04136859 | $57,26852 | CUT - Tossw
1458 1458 153 | se603881 | cur « A Mok e i
Profit arkup recorcs) $313,781.00 ss52537.20
Pricing is now spread to
pay items saved e 1P
Pay  Forecast ) Lock ock tl Unit
Quantty Quantty  Gaaced)  Pree Dstrbuton  (arent
. . 59,3387
acubng 10.00 1000 Age Us. Doler 550000 $59,00000 7.2 7623 se7s s17L56
Undassifed Excavation 50,000.00 50000.00 CubicYard LS. Doler 550 527500000 suu 55569442 su6s ss2ene
‘Aogregate Sase ©,000.00 45,000.00 Ton Us. Dollr $65  $1060,000.00 802 $120,771.08 s sie57.2
AsphaltConcrete ot Mx Type A 38,0000 3500000 Ton U, Dollr $4245  $1613,100.00 761 smo3m.12 w87 smemn
WATER & SEWER US. Dolar $718,550.00 . sz [n $154.96.81
36 Inch RCP Cubert Class I 1,000.00 102400 UnearFeet U5, Doler w745 a0 s1430 $14297.53 s199 519908
10 Inch PYC Force Main (SDR21) 12000.00 12,0000 Linear Feet U, Dolar S50 s354,00000 62 ss5,908.82 625 495037

Step 3 - Calculate Direct & Indirect Project Cost

Once you've set up your estimate, you will perform take-offs and cost analysis to determine the total
estimated cost to complete the entire scope of work.

The Cost Breakdown Structure (CBS) Register is the main form where you will do your cost estimating.

e Itis the hierarchy of work activities that make up the estimate

e Each row in the CBS represents a work activity and is called a cost item
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Training Job - Estimate

Estimate Quote Price Execution System Integrations Actions More Actions
E Print e Mew % Copy Split & Cost Item + Assembly /’ ' ' E
'5'\!\ Preview Delete Paste ﬁ Toggle Suspended ] E Subordinate Cost Item | 5= Subordinate Assembly a . =
Expand/  Fiter  Clear
2 Export to Excel Cut Fill Down Indent E% Dependent Cost Item Collapse ~ = Filter
Print Edit Insert View -
Job Properties Cost Breakdown Structure (CBS) Register -
Drag columns here to group Find: | [Search For...] Saved views:
gg;ﬁnn Code — D= o gﬂp‘;ﬁ:nal ?E;?;Sanﬁty H!.:soljre Lt Coet EFontiansst; Alocated
! J0B 20,00 Mie $293,095.93  $5,861,918.63 m| s
Prime Bond PRIME BOND 1.00  Lump Sum $47,069.88 $47,069.88
Price % Add-On PRICE % ADD-OM 1.00  Lump Sum $294,928.95 $294,928.95
Job Financing FINAMCE EXPENSE 1.00  Lump Sum £0.00 £0.00
Indirect Cost Escalation IMDIRECT COST ESCAL... 1.00  Lump Sum $0.00 $0.00
Direct Cost Escalation DIRECT COST ESCALAT... 1.00  Lump Sum $18,837.35 §18,837.35
Indirect Cost Add-On IMDIRECT COST ADD-OM 1.00  Lump Sum $0.00 $0.00
Job Management & Equipment JOB MAMAGEMENT &E... 1.00 ' Lump Sum £157,096.28 £157,095.28
+ General Expense GEMERAL EXPENSE 1.00  Lump Sum $4,200.00 $4,200.00
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum $104,301.10 §104,301.10
+ 1 Mobilization 6410100 1.00 ' Lump Sum $11,909.51 $11,909.51
+ 2 Clearing & Grubbing 2010102 10.00  Acre £3,918.50 £39,184.97
= 3 Unclassified Excavation 2020183 50,000.00  Cubic Yard 468  $233,915.81
& 3L Excavation 3.1 50,000.00  Cubic Yard §3.00 $149,922.88
+ 3.2 Embankment 3.2 50,000.00  Cubic Yard $1.68 $83,992.94
= 4 Aggregate Base 303 5912 45,000.00  Ton §15.40  $592,928.99
+ 41 Furnish & Haul Base Material 4.1 45,000.00 Ton $11.54 $519,513.30
+ 4.2 Finegrade Subgrads 4.2 400,000.00  Square Yard 40,19 §75,848.36
- A __ b B s PrE T INE . &1 #na e a3

106

$5,861,918.63

Step 4 - Add Markup, Contingency, & Fees

Once you have estimated all project costs, you may need to add markup, contingency or other fees and
define the job’s profit in the Price Breakdown Structure form.
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% of
Target

Description Assigned Unassigned @ Total

w L Price Breakdown Structure

~ j Target Price $5,252,19... $545,755.99  $5,897,350.68 100.00
v % Markup $0.00  $315,692.95 £315,692,95 5,35
v g Target Profit 20,00 20,00 0.00
Indirect Cost Markup £0.00 £0.00 0.00

Direct Cost Markup S0.00 S0.00 0.00

w ™ Business Overhead 20.00 5315,692.95 £315,692.95 5.35
B0 Price % Add-On $0.00 $265,407.78 $265,407.78 4.50

OO Job Financing §0.00  £33,105.26 §33,105.25 0.56

8O0 Indirect Cost Escala... £0.00 §2,131.11 £2,131.11 0.04

B0 Direct Cost Escalation £0.00  $15,048.80 £15,048.80 0.26

.'.i Business Overhead ... &0.00 £0.00 £0.00 0,00

~ Jh Total Cost $5,252,19... $330,063.05  $5,582,257.73 94,65
+ & Indirect Cost €0.00 $329,063.05 £329,063.05 5,58
+ = Job Overhead $0.00 $329,063.05 $329,063.05 5,58

80 Prime Bond £0.00  $43,789.75 $43,789.75 0.74

00 Indirect Cost A... $0.00  $5,838.67 $5,888.67 0.10

OO Direct Cost Add... $0.00 $104,083.34 £104,088.34 1.76

A& Job OverheadI.. €0.00 $175,296.28 £175,295.28 2.97

~ g Direct Cost $5,252,19..  $1,000.00  $5,253,194.68 89.07
B Direct Cost Items $5,252,19..  $1,000.00  $5,253,194.68 89.07

Step 5 - Distribute Cost + Markup to required Structure

You now have a target price or total estimated value that you can spread to your required project

deliverables, back in the Pay Item & Proposal form. InEight Estimate has tools within this form to help

automatically distribute your cost, overhead and all markups to the listed items.
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Pay Item & Proposal Register @

Proposal Recap - Training Job

Current Target Forecast

Price: | $6,455450.00 | $6,553,876.75 | $6,462,850.00

Profit: §544,294.64 $642,821.40 $604,568.97

Margin%: 843 9.81

Drag columns here to group

ﬁlil:nlbh:rm Description
= |+ 6410100 Mobilization
+ 2010102 Clearing & Grubbing
+ 2020133 Undlassified Excavation
+ 3035912 Aggregate Base
+ 3034263 Asphalt Concrete Hot Mix Type A
+ 413(B)0464 36 Inch RCP Culvert Class IIT
+ 8000220 10 Inch PYC Force Main (SDR21)
+ 8000330 24 Inch PYC Gravity Sewer (SDR35)
+ 8000400 4 Foot Diameter Manhole

9.35

1.2 KEY CONCEPTS AND TERMS

Balanced Unit

Current Unit

X Item Recap - 641 0100 Mobilization
Wariance
$98,526.75 | ADD A Price: $18,300.00 | %386,800.00
£38,252.43 | ADD N Profit: $2,049.63 §370,501.39
§32,502.50 | ADD Total Cost: §16,298.61 $16,298.61
i Business Overhead: £840.31
- Job Overhead: §3,546.52
. Unassigned Direct Cost §2.26
| Assigned Direct Cost $11,909.51
Find: Saved views:
Pay Forecast (T/O) Unit of Currency Unit Price Total Price
Quantity Quantity Measure (current) (current)
1.00 1.00 | Lump Sum U.5. Dollar $386,800.00 $386,800.00
10.00 10.00  Acre U.5. Dollar $6,120.00 5$61,200.00
50,000.00 50,000.00  Cubic Yard U.5. Dollar £8.50 £425,000.00
40,00 £22.00  $380,000.00
sso0f Pricing is now spread to $35.00  $1,330,000.00
1,00¢ bid items $100.00  $100,000.00
12,000700 TZ000°00 | Cinear Feet | U.5. Dallar $28.00  $335,000.00
3,000.00 3,000.00  Linear Feet U.5, Dollar $64.00 £192,000.00
16.00 16.00 Each U.s. Dollar £A 500N £32 00000

£0,455,450.00

1.2 Key Concepts and Terms

Standard View

Unit Price
(balanced)

$18,300.00
$5,867.33
£6.31
$19.47
$52.28
$87.19
$29.82
$64.13
$4.579.64

To help you get started in InEight Estimate, you should know a few key terms:

Job Folder
Library
Form

Cost Item
Pay Item
Resource

Assembly

1.2.1 Job Folder

Total Price
{balanced)
$18,300 *
458,672
£315,500
£778,800
$1,986,64(
%87,190
$357,84C
$192,39C
s73.274 7
$6,553,98...

>

Job folders hold all the information for an individual project estimate. It is possible to import master

data into a job folder, but when you work in a job folder it is independent, meaning any activity
performed in that folder will not affect any other jobs and will not affect the library.

InEight Inc. | Release 24.7
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When moving back and forth between jobs, make sure to always double-check that you

TIP
are in the right job.

1.2.2 Library

The Library is a storehouse for master data, such as:
e Labor, equipment, and material unit cost rates

e Standard account codes

* Units of measure

When you create a new job from scratch, default data and settings copy from the Library into your new
job folder, except for the resource rates. Multiple list of resource rates can be maintained in the library
so you must select which rates to populate a new estimate with. Four tag fields are available to filter
the resource rates you bring into an estimate from the master library. For example, you may select a
subset of your labor rates based on the geographical location of the project.

1.2.3 Form

Any screen you open in InEight Estimate is considered a Form. There are three types of forms:
Standard, Register, and Record forms.

Standard Forms resemble typical data entry forms with fields available to fill in key project
information. They also may contain radio buttons or checkboxes to define settings for the job.

Job Properties @

Overview | Security | Cover Sheet

CostBasis | Minority Setup

Fuel Cost

JobTracking | Job Folder Tags | Competitors | Pridng | Schedue | CashFlow EqulmenlI

Standard shift Ankg&ments

Work Hours per Shift
Pay Hours per Shift:
shifts per Day:

Days per Week:

Entry Fields
Currencyl

U.5. Dollar

Default Currency:

TIP

Page 34 of 417

Standard Wage Rate Composite

Scale 1: 10000 %

Scale 2: 0.00 %

Scale 3: 0.00 %

Shify
Checkboxes

Rules

Tabs
[] Prézerve Ongmal Cost ltem

Data Source

ock Cost Ttems to Pay Trems
Pay Item Unit Price Precision: 2

[ factivate P8S Changes Log

[ factivate Quantity Checking

[]jMaintain CBS Structure at Level: 0

When man-count changes: @ Change UM/ Man-Hour
| () Change Days

Standard Rates

Radio buttons

Sales Tax Rate: 5.00 o

InEight Estimate uses tabs to group and organize entry fields and settings in a logical way,
so that the information is easy to access.
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Register Forms have a grid format of rows and columns, giving it a spreadsheet look and feel. Register
forms allow you to see information for multiple items at once. The Cost Breakdown Structure (CBS)
Register is an example of a register form.

Cost Breakdown Structure (CBS) Register ©

Drag columns here to group Find: | [5earch For...] | Saved views: | Standard View
gUB:ﬁDI'I Code e Description ggélsnd ?;C?;aqslfanﬁty ﬂ;‘;solfre Unit Cast ?gig::tg Allocated
+ 1 Mobilization 6410100 L.00  Lump Sum §11,909.51 §11,909.51 -
+ 2 Clearing & Grubbing 2010102 10.00  Acre $3,918.50 $39,184.97
E 3 Unclassified Excavation 2020183 50,000.00  Cubic Yard $4.54 §226,856.16
+ 3.1 Excavation 3.1 50,000.00  Cubic Yard £2.86 $142,863.22
+ 3.2 Embankment 3.2 .00 | Cubic Yard §1.68 £83,992.94
= 4 Aggregate Base 303 . - .00 Ton 515.40 $692,928.99
+ 41 Furnish & Haul Base Material 4.1 VVIBW |T1U|t|p|e .00 Ton §11.54 §519,513.30
+ 42 Finegrade Subgrade 4,2 items at once .00 Square Yard €0.19 §75,548.36
= 43 Install Aggregate Base 4.3 .00 Ton §2.17 5$97,567.33
+ 431 Place Aggregate Base 4.3.1 45,000.00  Ton §1.63 §73,460.92
+ 4.3.2 Blue Top Aggregate Base 4.3.2 400,000.00  Square Yard $0.06 £24,106.42
E 5 Asphalt Concrete Hot Mix Type A 303 4263 35,000.00  Ton $42.62 §1,491,580.59
+ 51 Furnish & Haul Hot Mix 51 35,000.00  Ton §39.27 51,374,562.54

2|+ 52 Install Hot Mix Type A 5.2 35,000.00  Ton §3.34 §117,018.05
E 6 36 Inch RCP Culvert Class IIT 413(B) 0464 1,024.00 Linear Feet $67.54 £69,159.49
+ 6.1 Furnish RCP Materials 6.1 1,024.00 Linear Feet $33.48 $34,286.70
+ 6.2 Excavate RCP Trench 6.2 1,858.56  Cubic Yard $4.51 $3,379.59
+ 6.3 Install RCP Pipe 6.3 1,024.00 Linear Feet 11,74 $12,017.60

In a register form, you can open a Record for individual items you want to drill into.

TIP The Tab key is the best way to move among fields in InEight Estimate (instead of the
Enter key).

The below figure displays a Cost Item Record accessed by double clicking on that item on the Cost
Breakdown Structure (CBS) Register.
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Cost Breakdown Structure (CBS) Register Cost Item Record @
CBS Code: Optional Code:  Description: Forecast (Tf0) Qty:  Unit of Measure:
B 303 5912 AggregateBase 45,000.00| | Ton
[m] 41 4.1 [ Furnish & Haul Base Material 45,000.00 | Ton |
PI Assignment: PILine Number: PI Description: Cost Segment:
303 5912 40 AgaregateBase Record focuses Direct Cost
- on 1 item
Cost Item Summary = Detail : $11.54 # Plug : §0.00 E
Drag columns here to group Find: | [Search For...] = | Saved views: | Previous View -
Row T Resource . Quantity Waste %
Mumber = Cods Azzembly Descplion (Less Waste) Add-on Qua
1 171 Teamster
- I - I
3 MER Aggregate Baze Rock 45,500.00 5.00 1

1.2.4 Cost Item

Cost items are the individual cost-related activities that make up the project. Cost items are organized
into a hierarchy in the Cost Breakdown Structure (CBS) Register. Each row in the CBS is considered a

cost item.

EOB;ﬁon Code = Rescriphion gggeonal 'Ele;ggaqsﬁanﬁty kl‘lgi.:so:re INAECaSE

+ 1 Mobilization 5410100 1.00  Lump Sum 511,909.51
+ 2 Clearing & Grubbing 2010102 10,00 Acre 53,918.50
B 3 Unclassified Excavation 2020183 50,000.00  Cubic Yard £4.68
+ 3.1 Excavation 31 50,000,00 Cubic Yard £3.00
+ 3.2 Embankment 3.2 50,000.00  Cubic Yard $1.68
= 4 Aggregate Base 303 5912 45,000.00 Ton £15.40
+ 4.1 Furnish & Haul Base Material 4.1 45,000.00 Ton £11.54
+ 4.2 Finegrade Subgrade 4,2 400,000.00  Square Yard 0,19
= 43 Install Aggregate Base 4.3 45,000.00 Ton £2.17
+ 4.3.1 Place Aggregate Base 4.3.1 45,000.00 Ton 51.63
+ 4.3.2 Blue Top Agagregate Base 4.3.2 400,000.00  Sqguare Yard £0.06

1.2.5 Pay Item

Pay items typically represent the owner required deliverables a contractor must submit pricing for. Pay
items are used to distribute the cost calculated in the Cost Breakdown Structure, with all markup,
including any fees or contingencies calculated in the Price Breakdown Structure. This allows the total
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estimate value to be distributed to a structure that is different than the CBS. Pay Items are
predominantly used by contractors to prepare a bid sheet. Owners may use pay items to identify
funding sources or for various reporting needs.

Position Pay Item Pay Forecast (T/0) Unit of Uit Price Total Price
ription L e " 5
il Quantity Quantity Measure Currency (current) (current)

Code = Number

200 SITEWORK & ROADWAY U.S. Dollar $3,402,700.00

6410100 Mobilization Loo 1.00  Lump Sum U.S. Dollar $395,600.00 $395,600.00

+ 12 2010102 Clearing & Grubbing 10,00 10.00 Ace U.S. Dollar $5,900.00 $59,000.00
+ 13 2020183 Undassified Excavation 50,000.00 50,000.00 Cubic Yard U.S. Dollar $5.50 $275,000.00
+ 1.4 303 5912 Aggregate Base 40,000.00 45,000.00 Ton U.S. Dollar $26.50 $1,060,000.00
+ 15 303 4263 Asphalt Concrete Hot Mix Type A 38,000.00 35,000.00 Ton U.S. Dollar $4245  $1,613,100.00
=2 400 WATER & SEWER U.S. Dollar $718,550.00
+ 21 413(8) 0464 36 Inch RCP Culvert Class I 1,000.00 1,024.00 Linear Feet U.S. Dollar $97.45 $97,450.00
+ 22 8§00 0220 10 Inch PVC Force Main (SDR21) 12,000.00 12,000.00 Linear Feet  U.S. Dollar $29.50 $354,000.00

1.2.6 Resource

Resources are the building blocks of a detailed cost estimate.

Resources are the people, equipment, material, and supplies needed to complete the project.
Resources are employed to cost items to develop an estimate, and are organized into seven categories
or types:

Labor

Construction Equipment
Rented Construction Equipment
Installed Equipment

Installed Materials

Supplies

N o g M e bdh =

Unique

1.2.7 Resource Assembly

A Resource Assembly is a group of resources that are often used together. For example, for civil work,
you may group together an operator foreman, operator, and laborer, along with a loader and
excavator. When estimating, you can employ this assembly which includes all of the pre-selected
resources.
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Resource Assembly Register @

Drag columns here to group

Code = Description :T:%“g;;lpmn Quantity H'_E”;ﬂre Unit Cost Total Cost Currency g;%:g'nﬂz;ﬁunal gre:lagraphic
— CCONC Concrete Crew Standard Assembly File 1.00 Hour §375.03 §375.03 .S, Dollar Concrete
Nmber = | Coge | Desepton Quantty (ST umecost amency R0 BRI = e
> 1 LCc2 Carpenter Journeyman 2.00 Each §28.92  U.S. Dallar CIDura... Standard Labor Rate File Carpenter Southwest ~ Wage Zon...

2 LF2 Finisher 1.00 Each §28.07 U.5. Dallar CIDura... Standard Labor Rate File Finisher - Conc... ~ Southwest = Wage Zon...
3 LIwi Iron Worker 1.00 Each §35.55  U.5. Dollar CIDura... Standard Labor Rate File Iron Worker Southwest = Wage Zon...
4| L2 Laborer 1.00 Each §26.37 U.S. Dallar CIDura... Standard Labor Rate File Laborer Southwest ~ Wage Zon...
5 ECRHC Hydraulic Crane 25 Ton 1.00 Each §117.60 U.5. Dollar CIDura... Standard EquipmentRate... Crane
& LC1 Carpenter Apprentice 1.00 Each §27.48  U.S. Dollar CIDura... Standard Labor Rate File Carpenter Southwest = Wage Zon...
7 LO2 Operator Class 2 1.00 Each §28.07 U.S. Dollar CIDura... Standard Labor Rate File Operator Southwest ~ Wage Zon...
8 ETFT Flatbed Truck 1.00 Each §22,60 U.5, Dallar CIDura... Standard EquipmentRate... Truck
9 LC3 Carpenter Foreman 1.00 Each §31.47  U.S. Dollar CIDura... Standard Labor Rate File Carpenter Southwest = Wage Zon...

+ CGRADE Grading Crew Standard Assembly File 1.00 Hour $234.73 §234.73 U.S. Dollar Earthwork

+ CMAINT Equipment Maintenance Standard Assembly File 1.00  Each §73.60 §73.60 U.S. Dollar Mechanic

+ CPAVE Paving Crew Standard Assembly File 1,00 Hour $476.24 §476.24 LS, Dollar Asphalt

1.2.8 Cost Item Assembly

A Cost Item Assembly is a predefined group of cost items that has cost based on estimator inputs to a
set of questions. Cost item assemblies provide parameter-driven estimating and can also refer to
reference tables. They allow companies to create intelligent construction systems to automatically
estimate various scopes of work, based upon a user providing specification and dimension variables.

Cost Ttem Assembly Register  ©

Drag columns here to group

Code - Description A_ssemhly'_ Default Default Default Default Default Organizational Geographic
File Description Quantity Unit of Measure Unit Cost Total Cost Currency Category Area

RWO1 Standard Retaining Wall Assembly Standard CostIt... 20.00 Cubic Yard $424.67 $8,493.38 .S, Dallar Concrete

TEST TEST 1.00  Each §0.00 $0.00 LS. Dollar

TEST -DRS Test Cost Item Assembly - Ductbank Standard CostIt... 1.00 Each £0.00 €0.00 U.S. Dollar Concrete MNortheast

TEST DS Test Cost Item Assembly - Ductbank Standard Cost It... 1.00 Each $0.00 $0.00 U.S. Dollar Excavator Southwest
’ i ;
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Lesson 1 Review

1. Which InEight Estimate form is used to enter basic information about the job as well as
define our cost basis?

a. Pay Iltem & Proposal
b. Job Properties

C. Library

d. Job Folder

2. All default data and settings copy from the Library into your new job folder except:
a. Labor rates
b. Equipment rates
C. Material rates
d

. All of the above

3. These are considered the “building blocks” of the job — you employ them to cost items to
develop your estimate.

a. Assemblies
b. Pay Items
C. Resources
d

Forms

Lesson 1 Summary

As a result of this lesson, you can:

e Explain the estimating process in InEight Estimate

e Explain key terms and concepts
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InEight’
ESTIMATE

LESSON 2 — GENERAL NAVIGATION

Lesson Duration: 45 Minutes

Lesson Objectives
After completing this lesson, you will be able to:

¢ Navigate the InEight Estimate system interface
¢ Navigate system settings

e Manage columns in InEight Estimate registers

Lesson Topics

InEight Inc. | Release 24.7
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2.1 GENERAL NAVIGATION

This section explores the layout of InEight Estimate.

As a new user to the InEight, the First-time sign in dialog box opens when you first sign in, and presents
guestions about your working environment in the Project Suite environment. Preferences are set for
language, date, and number formats and the User Agreement, which you must accept before you
begin. The First-time sign in dialog boxes only show for the initial sign-in to any of the InEight products.

Step by Step — Estimate preferences setup

1. Select your preferred language, and then click Next.

First time sign in

Language

Please choose your preferred language

(O Dutch (Mederlands)

(@ English

() Espafol (América Latina)
(O Frangais (Canada)

() Norsk (Bokmal)

O Portugués (Brasil)

Cancel m

2. Scroll to the bottom of the user agreement, and then select the check box for the terms and
conditions and privacy policy. Click Next.

TIP Make sure you have scrolled to the end of the user agreement

Page 42 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 2.1 General Navigation

3. Select a date format and number format, and then click Next.

2.1.1 Estimate first time access

Platform’s primary function lets you connect and share data between all Eight applications involved in
managing a project. This allows project management workflows to pass between jobsite, field office,
and front office seamlessly in a consistent and standardized user interface.

Step by Step — Launch Estimate

1. After selecting a project from the home page, you can access Estimate from the Main menu in
Platform by selecting Estimate, or by clicking Launch on the Estimate tile.

InEight®
SCHEDULE

nnnnnn

InEight®
ESTIMATE

InEight® InEight®
REPORT EXPLORE

2. When you select Estimate from the home page for the first time, you must click Download to
access the Estimate Launcher file.
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® © & ® W@

Launch InEight Estimate

¢ The EstimatelLauncher.msi file shows.
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PROJECT SETTINGS

Project home
Project details
Settings

Workflows

© 2022 InEight Inc Privacy Statement

T‘g‘! EstimatelLauncher.msi

¢ Opening the EstimateLauncher.msi file opens the InEight Estimate Launcher Setup
window.

3. Select Open, and then click Next to start the one-time Estimate Launcher download. Afterwards,
you will be able to open Estimate from the Main menu or the home page.

Welcome to the InEight Estimate Launcher
Installer Wizard

Project home
Let's get started on instaling InEight Estimate Launcher on
Project details your computer. Ciick Mext” to continue or "Cancel” to exit,

Settings

Workflows

18 EstimateLauncher.msi
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4. Click Finish to complete the Estimate Launcher Setup installation.

Completed the InEight Estimate Launcher
Setup Wizard

Click the Finish button to exit the Setup Wizard.

Back I Finish Cancel

5. Select Estimate again to start the Estimate Launcher, which extracts the required files to launch
the Estimate application.

InEight

ESTIMATE

After setting up your Estimate preferences and installing the Estimate launcher, you can begin using
Estimate.

Page 46 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 2.1 General Navigation

Step by Step — Estimate subsequent use

1. Launch Estimate by selecting Estimate from the Main menu.

Baractig.. InEight"
E— ESTIMATE

e Estimate in the cloud looks and functions much like the Estimate on-premise version. For
example, opening a job from the landing page brings you to the Cost Breakdown Structure
register, or the register designated as the start page in the application settings.

inbabe taremate

InEight'
ESTIMATE

Open a recent Job e ; Inislairq snbise

Rzazieg s

b 31 Dowstzatieq o sevvar
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2.1.2 Backstage View

InEight Estimate opens to the Backstage view. You can also get to the Backstage view from other tabs,
by selecting the File tab.

1 From the Start page you have the option to create, open or save a project, or close
all jobs that are open.

2 You access the Library or open the Jobs page to go to the Job Register, Compare
Jobs, delete a job, or do a Primavera Batch Sync.

3 » Templates allows you to create Job templates.
» You can create job snapshots or access previously created snapshots in the
Snapshot Register.
» You can also archive or back up and restore job folders.

4 Settings allows you to customize options such as General settings, Account Code
settings, Timesheet Warehouse settings, Licenses and Currency settings.

5 From the Open a recent Job section of the Start page, you can open the Training job
or click More to open your list of jobs.

6 You have the option of creating a new job from scratch, a template, from an existing
job, or using the Bid Wizard.
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2.1.3 Overview - Backstage View

InEight Estimate - o x

InEight®
ESTIMATE

Open a recent Job

More... e

Create a new Job from...

(0 & 3 e

Template Existing Job Bid Wizard

2.1.3.1 Archive / Restore

From the Backstage View, you can back up and restore your jobs using the Archive/Restore feature.

Step by Step — Archive and Restore a Job

1. Click File to open the Backstage View.

2. Select Archive / Restore.
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e Several options appear for archiving and restoring your jobs and library

nnnnnn

3. Select Archive Job.
e The Job Register appears
4. Select the Training Job, then click OK.
5. When prompted to include attachments, click Yes.
e The Save As window appears
6. Browse to where you want to save the job, then click Save.

7. To restore the job, select Restore Job Archive from the Archive / Restore page of the Backstage
View.

Browse to the archived job and select it.
9. Click Open.
¢ If the job already exists, a prompt will appear asking if you want to overwrite it
¢ To overwrite it, select Yes

¢ If you select No, you will be prompted to save it under a new Job Code

2.1.3.2 Settings

From the Settings in the Backstage view, you can adjust some system settings:

e General Settings
e Default Job Start page

¢ Decimal Precision
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e Language

[=]- Options

General

----- Decmal Precision

Restore Defaults...

2.1.3.3 Prompt to Save

General

DPrompttn Save Every |5 I | Minutes
Live Register Scrolling

Align and Match Columns

[] keep Employed Assemblies Collapsed
Summarize Values in Group Row

-

Show up to |15 (5 Detail Rows in Reqgisters without Scrolling

Title Bars
(® Show Job Code
(") Show Job Description

() ShowJob Code and Description

2.1 General Navigation

MNavigation Bar
‘When a record form is closed, return focus to:
(®) The last form accessed

() The form that opened it

Job Startup

Start Page: | Cost Breakdown Struc.. -

Language

Select a Language: | English (United States)

oK

An important setting to visit in the Tools menu is Prompt to Save. InEight Estimate does not
automatically save your work. Instead, it will prompt you to save as often as you specify in the general

settings.

2.1.3.4 Decimal Precision

The Decimal Precision setting is also helpful. This is where you can specify the way your numbers
display in the system. For example, you may want your costs to display to the hundredth decimal place
(2), and your quantities to display as whole numbers with nothing to the right of the decimal (0).

InEight Inc. | Release 24.7
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TIP Changing decimal precision does not affect the way your numbers are calculated.

2.1.4 Open a Job Folder

From the Backstage view, you can open a job folder by selecting Start. This opens the Start page,
where if you see your job, simply click on it to open it. If it’s not showing, click on More... and select the
job from the Job Register. The Job Register is the form that lists all of your existing job folders so you
can select the one you need.

InEight®
ESTIMATE

Open a recent Job

ﬁ More...

o Training Job
Library Training Job -
Maricopa County...

Close All Jobs

Jobs

Templates

Snapshots

Create a new Job from...

Archive [ Restore

Settings + = -‘| ﬁ ¥¥
Ealgies
Scratch Template Existing Job Bid Wizard

Step by Step — Open a Job Folder

1. From the Backstage view, under the Open a recent Job section, double click on your job.

2. The job folder opens by default to the Cost Breakdown Structure Register.
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2.1 General Navigation

@l [T} Training Job - Estimate
File Setup Estimate Quote Actions i
S Print [ open  S<cut Fill Down = B .= costltem = Assembly /i W W E
B, Preview @ new By copy [ spit J, | 'S Subordinate CostItem = % Subordinate Assembly s » =
Expand |  Filter  Clear
&} Export to Excel o Delete Paste n Toggle Suspended E% Dependent Cost Item Collapse ~ - Filter
Print Edit Insert View *

Cost Breakdown Structure (CBS) Register @

Drag columns here to group

CBS

Position Code Description
= JoB
Prime Bond

Price % Add-On

Job Financing

Unit of
Measure

Forecast
(T/0) Quantity

1.00  Lump Sum
Lump Sum
Lump Sum

Lump Sum

Previous View -

" Total Cost Optional
Unit Cost (Forecast) Currency Code
$5,361,800... %5,851,800.79 U5, Dollar -
$47,069.28 $47,069.28 1.5, Dollar PRIME BOND
$294,923.52 §294,923.52 .S, Dollar PRICE % ADD-OM
$0.00 $0.00 LS. Dollar FINANCE EXPENSE

You can change the default form that opens when you start up a job. From the Backstage view,
click on Settings to change the Job Startup > Start Page settings.

Settings

[=)- Options

- Dedmal Predsion
- Fax Mail
- Arrount Code Settings
[z~ Netwark.

- Deployment Mode

SQL Security

- Security Roles
- Attachment Settings
- Timesheet Warehouse Settings
- Licenses

Currency

Restore Defaults...

General

Prompt to Save Every |10 [ Minutes
Live Register Scrolling

[#] &lign and Match Columns

[ Keep Employed Assemblies Collapsed
summarize Values in Group Row

Show up to |15 5| Detail Rows in Registers without Scrolling

Title Bars
@ Show Job Code
() Show Job Description

() Show Job Code and Description

Language

Select a Language: | English (United States) -

2.1.5 Common Navigation

Navigation
@ Ribbon

@ Classic

Navigation Bar
When a record form is closed, return focus to:
@) The last form accessed

(©) The form that opened it

Job Startup

Cost Breakdown Stru...

Cost Breakdown Sh’uch.lrel%EBS) Register
Pay Item & Proposal Register

Quote Register

Quote Comparison & Award

Start Page:

Price Breakdown Structure

MNone

Access the common navigation slide-out panel by selecting the main menu located on the top left side

of the Estimate page. This feature provides a common navigation user experience that is shared

amongst all InEight products. The primary intent of this navigation menu is to provide a consistent

InEight Inc. | Release 24.7
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InEight product experience, with similar Project Suite graphical interfaces, while working within
multiple InEight products.

Estimate's on-premise software is authenticated by your Windows login credentials, which is shown
below the main menu.

Integrations

INEIGHTE

.. Labor i
Paul Triopi 230 Equipment “
I I aul Irpp Resources Resource

- B Materials  Assemblies

Resources

INEIGHT ONLINE

(i) Explore products

(® InEight learning and support

@ InEightcom

2.1.6 Help Bubbles

Help bubbles appear at various times in InEight Estimate, including the first time you open InEight
Estimate. These messages contain important information to clarify key functions in the system.

You can dismiss the message until the next time by closing it with the X in the corner or dismiss it
permanently by clicking the Never offer this help again link.
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, /L

Enter up to 10 factors (multipliers) here
to calculate a Factor Composite. The
Factor Composite is displayed on the
Production data block, and is multiplied
by the Duration Driven Man-Hours to
calculate the values shown in the
Factored Duration Driven Resources
column.

You can globally customize the titles of

these factors by choosing View from the
main menu, then choosing "Customize.”

Never offer this help again

2.1.7 Data Map

2.1 General Navigation

Found in the Price tab, the Data Map is a great way to view a high level summary of your estimate and
can be accessed at any time during the estimating process. You can see totals of direct costs, indirect

costs, profit, and overall bid price.

Data Map ©

$6,514,916 (99.89%) Current Price
$7,139 (0.11%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

InEight Inc. | Release 24.7

TARGET PRICE

$6,52

2,054

TOTAL COST
$5,869,847

Indirect Cost Markup

Direct Cost Markup

INDIRECT COST (9.94%)

Business Overhead
W 551%

Job Overhead
W 4.44%
DIRECT COST (80.06%)

Unassigned Direct Cost (Work Plan)
W 0.02%

Assigned Direct Cost (Work Plan)
W 80.04%

$34,118
$618,089
$648,514
$359,257

$289,257

$5,221,333
$1,000

$5,220,333
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2.1.8 InEight Estimate Layout

The layout of InEight Estimate is workflow based. You will move from left to right on the tabs as you
enter your data for the project and work on developing your estimate.

2.1.9 Overview - Setup Tab

Estimate Quote Price System Integrations

H ¥ B &L- W a B B

2 Equipment
Job Properties  Foundation  Pay Item & Bid Wizard | Resources | __ ) Resource CostItem  Standard Reports
- SetupData = Proposal - iRS Materials  Assemblies | Assemblies  Tables

o Initialize o Resources Assemblies Reports
Section Description

1 Initialize From the initialize section, you can access the following registers. Job
Properties is where you enter the basic project details. Foundation Setup
Data is where you populate all account codes and validated fields. The
Pay item & Proposal Register provides an alternate structure to distribute
estimated values. Bid Wizard helps automate the process of setting up
estimates by copying information that already exists in other jobs.

2 Resources In the Resources section, Resource Rates opens the Resource Rate
Register, where detail costs for labor, equipment and material is stored.
The Resource Assemblies opens the Resource Assembly Register,
where you create a combination of resources as an assembly and reuse
it as needed in multiple cost items.

3 Assemblies You can create a Cost Item Assembly to automatically estimate different
scopes of work based on input values. Standard tables - allow you to
create tables of reference data that can be accessed in any cost item
assembly.

4  Reports The Reports section is available from any tab. Depending on the tab you
access it from will bring you to reports specific to that tabs data. Here you
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will find reports on resources such as Resources Changes, Resource
Utilization, and Resource Cost Details.

2.1.10 Overview - Estimate Tab

File Setup Estimate Quote Price System Integrations
ﬂ !-.H Account Code Utilization e 'Ez Resource Utilization m _— D D Job Finance :
— b [ =
!ﬁ Work Breakdown Structures & E Resource Cost Details oo % Price % Add On
Cost Breakdown Resources Warkbook Schedule  Cash Flow Indirect ) Price Br
Structure (CES) o ~ £7] Resource Employments - - CostItems [®] Prime Bond Struch.
Breakdown Structures Resources Workbook Schedule Indirect Cost

1 Breakdown From the Breakdown Structures section in the Estimate tab you can
Structures access the Cost Breakdown Structure (CBS) Register, Account Code
Utilization Register, and Work Breakdown Structures (WBS) Register.

2 Resources Resource Rate Register is where you create or modify the rate charged
for labor, material and equipment resources. Different views of the
Resource Rate register such as Resource Utilization and Resource Cost
Details are available from the Resources section.

3 Excel InEight Estimate's integration with Microsoft Excel is a two-way
Workbook integration that allows you to update register fields in Estimate with data
contained in an Excel workbook, and update Excel cells with data
contained in a register field in Estimate. This is where you open the
embed excel workbook which is maintained as part of the estimate job
folder and where you preform the sync functions to send values back and
forth.

4  Schedule From the Schedule icon, you can access bi-directional integration with
Microsoft Project and Oracle Primavera. The Cash Flow graph displays
the projected cash flow of your project, along with the job financing
expense, individual cost category costs and resource utilization.
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5 Indirect Cost Indirect Cost Items filters the CBS register to display cost items that
ltems contain overhead costs that are not directly associated with any particular
deliverable items. Clicking on % Price Add on or Prime Bond opens up
these individual records.

6 Overhead Price Breakdown Structure (PBS) Register is a visual run-down of the
and Profit costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

7  Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios.

8 Reports From the Reports section, you can run reports on CBS Summary, CBS
Details, CBS Outline, CBS Estimate Summary, CBS Currency
Comparison.

2.1.11 Overview - Quote Tab

File Setup Estimate System Integrations

!@ = Quote Group Tags g @ iﬂ= ': @

{2} Minority Setup
Address = ReguestFor Quotes Resources Cost Items Reports
Book Attachments Quote (RFQ)
Setup Quote Management Quote Comparison & Award Reports

1 Setup Quotes are organized using Address book, Quote Group Tags,
Minority Setup and attachments in the Setup section. Address book
stores and maintains all information pertaining to subcontractors,
vendors, architects/engineers, etc. that you work with regularly. The
Minority Setup tab within Job Properties stores information about the
agency that authorizes the status of Minority Enterprises along with
their different types. You can use Quote Group Tags to group together
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multiple resources or cost items that will be sent in a single request for
quote package to solicited contractors or vendors..

2  Quote Quote Management allows you to access the Requests for Quote
Management (RFQs) register and Quotes. Request for Quotes (RFQs) are
invitations to sellers, requesting that they submit pricing to provide
services, equipment or material based on the line items and resources
included in your estimate. The Quote Register stores all of the quote
responses you receive for that job.

3 Quote The Quote Comparison & Award section allows you to perform
Comparison & comparative analysis across all the quotes you’ve received. You can
Award view a comparison of submitted pricing by resources or cost items.

4  Reports From the Reports section in Quotes you can run reports on Quote

Summary, Quote Record, Compare & Award, and Minority
Participation.

2.1.12 Overview - Price Tab

File Setup Estimate Quote System Integrations

@ | Lock Cost Items to Pay Items e IE Direct Markup A PBS Changes BASE -
3 [z
Hll
[D] Pricing [\3 Indirect Markup Log PES Changes 'h‘ Alternates
Pay Item & . ] Price Breakdown . Reports
Proposal @ & Competitors Structure (PBS) = Data Map
Pay Items Overhead and Profit Audit Log Alternates Reports

1 Payltems From the Pay Items section you can lock Cost items to Pay items and
access the Pay item & Proposal register. Under Pricing in Job Properties,
you can set up how the tool calculates profit and spreads pricing to your
pay items. In the Competitors section, you can keep track of companies
that have submitted bids as well as record and track competitor bid prices.

2 Overhead The Price Breakdown Structure (PBS) Register is a visual run-down of

InEight Inc. | Release 24.7 Page 59 of 417



2.1 General Navigation Estimate Essentials User Guide

and Profit the costs and profit that make up your Target Price. You can access the
Direct and Indirect Markup records or see totals of direct costs, indirect
costs, profit and overall bid price summarized in a Data Map.

3 AuditLog You can access the PBS Changes register (which logs any changes that
effect the Target Price) and turn on/off logging PBS changes..

4  Alternates Alternates are used to define alternate scenarios in order to assess the
impact of those scenarios on the total estimate value.

5 Reports From the Reports section in the Price tab, you can generate reports for
Standard Proposal, DOT Proposal, Pay Item Summary, Pay ltem
Currency Comparison, Pay Item Price Breakdown.

2.1.13 Overview - System Tab

File Setup Estimate Quote Integrations

) %] .
= Saved Views = (] Colors - ¥ External Reports = € About Estimate

— .
<) Titles - ﬁ Output Settings = E, External References = ﬁ' Release Notes
Customize Estimate InEight

o Help @) InEightcom  University
Customize o Help

1 Custom You can customize the titles and colors for different fields. You can export
and import saved Views, Titles, Colors and Output Settings. You can
customize reports generated by Estimate using External reports. External
References allows you to open external programs with Estimate.

2 Help You can access a comprehensive help system from the Help menu. You can
get information about the Estimate Version and all new updates about the
different versions.
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2.1.14 Overview - Integrations Tab

File Setup Estimate Quote System Integrations Actions More Actions

é‘a é‘j App Logs

Publish Estimate  Publish Cost Ttems o

to a Mew Project  to Active Project
InEight Platform

1 Publish Sends job data to InEight Platform Integration. You can continue using
Estimate to a Estimate during the publish and will be notified after the data has been
New Project sent successfully.

2  Publish Cost Sends cost items to the active project.
Items to Active
Project

3 AppLlogs Shows a list of InEight Project Suite application logs that you can
export to Excel.

2.1.15 Library

Click on the Library icon and the Library opens in its own window.

Users with sufficient security can access master information available in the Library.

TIP The Library is covered in greater detail in 3.1 Library Overview on page 86

2.1.16 Open Forms

The following steps assume you already opened the Training Job.

InEight Inc. | Release 24.7 Page 61 of 417



2.1 General Navigation Estimate Essentials User Guide

Step by Step — Open Forms

1. Click on the Setup tab.

2. In the Initialize section of the Setup tab, click on the drop-down menu for Job Properties.

3. Select Overview to open the Job Properties form.

Job Properties  Foundation  Pay !
= Setup Data - Pro

oD Owerview

I\U Security
E Cowver Sheet
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* Notice that each form opens in its own tab within the active job folder

Estimate Quote Price System Integ
" * ‘“‘ A F!.'_ Labn
9 T T e

L] | E Equ

Job Properties  Foundation  Pay Item & Bid Wizard | Resources __
~ SetupData =  Proposal - e Mat
Initialize Resol

Job Properties Cost Breakdown Structure (CBS) Register ©

¢ You can tab between these forms as you are working in InEight Estimate

e Once you are in a register, the Actions and More Actions tabs are available to you. The options
available are contextual to that register

Estimate Quote System Integrations Actions More Actions
Ell Print 0 MNew % Copy ﬁ Toggle Suspended Indent Split Link Field Cost Item .
'i Preview Delete Paste Outdent Split by Cost Type Unlink Field | 7= Subordinate Cost Item | [ S
@ Export to Excel Cut Fill Down Merge Cost Items H Dependent Cost Item
Print Edit Workbook

Estimate Quote System Integrations Artions Mare Actions
&= schedule Selection 4b Swap ~ "ﬁj Bid Wizard Z Unit / Total Confirmation Add Quote m Select in Model 'S
& Unschedule Selection e Remaove = Subtotal Calculator e Refresh Benchmarks Frame Selected |3|
E Calculate Flug Days (:," Update - Quantity Chedking Roll Up Quantities Upé?&:&;é -
Schedule Batch Operations Tools Data Source Model (
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2.2 SYSTEM SETTINGS OPTIONS

From the Backstage View, you can access system settings. System settings contain options and settings
that effect the entire InEight Estimate system. These settings include:

e General settings (options)
e Title Bars

¢ Navigation Bar

e Job Startup

e Language

All of the settings under the Options branch are user-level settings.

Integrations

Customize =- OPhnns General Navigation Bar
S General
i Dedimal Predision [] Prompt to Save Every |5 % | Minutes When a record form is closed, return focus to:
[] Live Register Scrolling (® The last form accessed
[ Align and Match Columns (O The form that opened it
[] Keep Employed Assemblies Collapsed
Summarize Values in Group Row Job Startup
Show up to |15 |5+ Detail Rows in Registers without Scrolling Start Page: | Cost Breakdown Struc... ~
Title Bars Language
@) show Job Code Select a Language: | English (United States) -
(O ShowJob Description
O ShowJob Code and Description

Restore Defaults... oK Cancel

The following step by step walks you through configuring general settings (options).

Step by Step — Decimal Precision

1. With InEight Estimate open, click on the File tab to go to the Backstage view.
2. Select Settings.
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Select General under Options in the node tree on the left.

Select how often you want to be prompted (in minutes).

Select Decimal Precision in the tree on the left.

S A

Review the default settings.

To activate Prompt to Save, select the Prompt to Save checkbox.

2.3 Columns

TIP Units of Measure will default to English, and Currency will default to U.S. Dollar.

@ Settings
Optns —
| General Decimal Precsion
i Cost Summary Precision P
IActomt Code Settings b Unit CostPrecision 2
Network _
i----DED'Wmeﬂt Maode Quantity Precision 2
i~ SQL Security
.- Security Roles Short Percent Precision 2
- Attachment Settings
- Timesheet Warehouse Settings Long Percent Precision 2
- Licenses
o CUFFRACY Currency Rate Precision 5
Restore Defaults...

QK J Cancel

2.3 COLUMNS

Within each register, you can move, sort, filter and group your columns to view the information the

way you need to see it.

InEight Inc. | Release 24.7
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2.3.1 Move Columns

You can move columns by selecting a column header and using drag-and-drop. If there are columns on

the register that you don’t use, you can hide and unhide them from view, as needed.

Step by Step — Move Columns

1. In the CBS, click on the Currency column header and drag the column to the left, dropping it to
the right of the Description column.

2. Hide the Optional Code column by dragging the Optional Code column header down until a black
X appears, then let go.

Optional
Code

Currency
1.5, Dollar
LS, Dollar PRIME BOMND

1.5, Dollar PRICE % ADD-OM
1.5, Dollar FIRIAMCE EXPENSE
LS. Dollar RECT COSTES...
LS, Dollar DIRECT COST ESC...
11.S. Dollar i}ptﬁE@Xz- :
1.5, Dollar Jgé-dﬁuﬁiunﬁEu-uEiuT...
LS. Dollar GEMERAL EXPEMSE
LS, Dollar DIRECT COST ADD...
1.5, Dollar 541 0100

1.5, Dollar 2010102

LS. Dollar 2020183

1.5, Dollar 3.1

¢ The Optional Code is now hidden from view

e To unhide a column, right click on any column header and select Column Chooser; a
Customization window appears, which contains all the hidden columns in that register
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3. Find the column you want to unhide and drag-and-drop it to the location where you want it to

go.
v

. Total Cost -

Optional

Unit Cost (Forecast) Currency c Edlgna

-

§5,861,300... §5,851,300.79 L.5. Dollar
$47,069.23 $47,069.28
§204,923.52  §294,923.52
$0.00

Customize

I Default Caption

Optional Optional
Code Code

Owned Equipment Owned Equipment
Biling... Biling...

COwned Equipment COwned Equipment
Total... Total...

COwned Equipment COwned Equipment
Total Cost Total Cost

Owned Equipment Owned Equipment

Unit Cost Unit Cost

Pay Hours Pay Hours

Rules Rules

Pay Item Pay Item

Assignment Assignment

Pay Item Pay Item

Description Description

Pay Item Pay Item

Line Number Line Number v

¢ You can also unhide a column using the Go To Column feature
4. Right click on a column header and select Go To Column.

5. Click on the drop-down menu and select the column you want to unhide.

InEight Inc. | Release 24.7 Page 67 of 417



2.3 Columns Estimate Essentials User Guide

Go To Column

Include columns that are not currently in the view

oK H Cancel |

6. Click OK.

2.3.2 Sort and Filter Columns

You can sort and filter your columns to drill down to specific information.

Step by Step — Sort Columns

You can sort on any column by clicking once on the column header.

1. In the CBS Register, click on the Total Cost (Forecast) column to sort the column in ascending
order (e.g., 1to 10, A to Z).

2. Click the Total Cost (Forecast) column a second time to sort in descending order (e.g.,10to 1, Z
to A).

TIP Use Ctrl-click to unsort a column and reset it to its original state.

Step by Step — Filter Columns

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

2. Click on the filter icon in the Unit of Measure column to select a filter value.
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e From the filter list, you can select any of the values defined for that column or you can use
one of the predefined values (Custom, Blanks, Non blanks).

Unit of . Total Cost
Measure i | Linit Cost (Forecast)
Values Text Filters
Enter text to search... e
| (Al Month
Acre Pound
Cubic Yard + | Sguare Feet
+ | Each Square Yard
Linear Feet Ton
+' | Lump Sum
Mile

I Clear Filter Filter Editor Close !
. tal=

3. Make your selection, then click Close.
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4. To clear the filter, click on the red X at the bottom of the form or click on the filter icon on the

header of the column you filtered and select (All), then click OK.

2.3.2.1 Filter Editor Overview

Column filters can be managed on individual columns or for the entire register using the Filter Editor.
The Filter Editor tool lets work with all the column filters for a register view in one place as well as
creating more complex filters through the use of grouping and applying And/Or statements.

When you add a new Group, a new Condition is automatically added to that Group.

With each additional Condition statement, you need to select an operator and a value in order for your

customized filter to take effect on your chosen column. Many new comparison operators have been
added to this version as shown below:

Filter Editor b4

And £

I - [WBS: CEAS (Civil Engineering Account Code System]] Begins with <enter a value> ) I

Load Save

45,000.00
400,000.00
35,000.00
35,000.00
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Ton
Square Yard
Tom

Ton

QK

Is less than

<

% Isless than or equal to
£ Iz between

£ Is not between

Aflc Contains

Afde Does not contain
[lec Begins with

asfd Ends with

Azt Is like

rzar Is not like

®» Is any of

&P Iz none of

Is blank
@ Is not blank =
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Creating complex filters using the Filter Editor

2.3 Columns

You can define filters across any of the columns available in the CBS register. You can also open the
Filter Editor using the button in the column filter drop-down, but regardless of how you access it, the

Filter Editor dialog permits defining a filter for the entire register and not just the selected column.

Forecast
(T/0) Quantity \ Measure

Unit Cost

Total Cost
(Forecast)

Subject Cost

Subject Cost Alocated Allocation

Rate

Currenc
Source ¥

1.00 Nump Sum $6,508,579.45

UM/ Equip-Hour

UM/ Hour

UM/ Man-+Hour

UM/ Shift

Undefined Biling Adjustment Amount
Undefined Billing Adjustment Percent
Undefined Biling Unit Rate
Undefined Cost Adjustment Amount
Undefined Cost Adjustment Percent
Undefined Total Billing Amount
Undefined Total Cost

Undefined Unit Cost

Unit Cost

35,0 Unit of Measure

$6,508,579.45

Apply

[ ] U.5. Dollar
U.S. Dollar

U.S. Dollar

U.5. Dollar

U.5. Dollar

U.S. Dollar

U.5. Dollar

U.5. Dollar

I T Y 5.0
U.S. Dollar

U.S. Dollar

U.5. Dollar

U.S. Dollar

U.5. Dollar

U.S. Dollar

U.5. Dollar

.5, Dollar

.S, Dolar

Because all the register fields are available, more complex filters can be created by using Grouping and
Or operators. In the following example, a filter has been defined to return all Terminal Cost Items that
either have a cost source of Plug, or exceed $100,000 of Total Cost (Forecast).
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Cost ure (CBS) o

Drag columns hare to group

CES =, - Opitianal Forecast Linit of Total Cost - Cost

Position Code = Deacrigtion Code (T Quantity Meanre Lo (Farecast) T |Temindd T | e T
s price sk add-on PRUICE % ADO-,, 100 Lump Sum SN28LE1  $312,33861 ]

¥ Direct Cost Add-0n DIRECT COST . LOO  Lump Sum $110,803.57 $110,803.57

%
E

* Job Management & Equipment JCB MANAGEM. .. L00  Lisnp Suf $157,096.28 §157,096.28

=

31 42,000.00  Cubic Yand 144 $144,552.52 ] Betal

15, 142.50 [+] Detal

#nd © 17005 || Oetad

[Rmfutaniio B.66073 [ oel

e D’T: Source] Equals Pl © 1_11.1.'6.37 Detai

st = - 3 L

[Total Cost Forecast]] Is greater than 100,000.00 & 103,388.50 [+] Detai

$42,000.00 [#] Flug

H

244,383.14 [v] Detal
mas6273 v oetal
518,778.57 Detal
147,665.50 [+] Detsi
$1,500.00 [~] Pug
5000 [v]  mx
220000 g
£2,100.00 [+] Fug
[ [ s | o |[e e ] B Th
O Tmem T imlumess | sawm) susem g
| 12510 100 Lump Sum §2,100.00 $2,100.00 [ P
15300 100 Lump Sum $3,300.00 $3,300.00 [#] Pug
16510 L.00  Lisip Suff §3,400.00 £3,400.00 Piug
| AT LAA Gk #0Amn A £1. A A (]| L
E .00 z 000
$HE30, 37806

# ([Cost Source] EQUAL Piug’ OR [Total Cost (Forecast)] GREATER THAM 100000) AND [Is Terminal] EQUAL Trus

When modifying a filter, the Filter Editor can be invoked by clicking the Edit Filter button located on
the bottom right of the CBS page.
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Cost Breakdown Structure (CBS) Register © -

00
S pan—— e v |unet v [oicwt / s Koo
= B JOB Mile £5,666,162.55 % &
Prime Bond 7000 Lump Sum $45861.93 &
Price % Add-On 7000 Lump Sum £284,057.38
Direct Cost Escalation 000 Lump Sum $13,933.28 £
Direct Cost Add-On 7000 Lump: Sum $99,952. 10 OVERHEAD
CIEY SITEWORK & ROADWAY Each $2,387,025.45 | ORK
+ 1.2 Clearing & Grubbing 1110 Age $39,184.97
= 13 Undassified Excavation 1122 Cubic Yard §158,985.21 ATION
+ 132 Embankment 1122.200 Cubic Yard $69,678.93
= 14 Agoregate Base 1120 Ton $692,928.59 £
+ L41 Furnish & Haul Base Material 1120. 100 Ton £519,513.30 .
= .5 Asphalt Concrete Hot Mix Type A 1240 Ton $1,486,222.28 ONCRETE PAVEMEN
+ L51 Furnish & Haul Hot Mix 1240. 100 Ton §1,374,562.54 MCRETE PAVEMEN
-] 2 WATER B SEWER Each §519,502.60 il
= 0 b $0.00
78 $5,615,073.91

4 -

Step by Step — Filter Editor

1. In the CBS, hover over the Unit of Measure column header for the filter icon to appear.

. f

% [Unit of Measure] EQUAL "Cubic Yard” OR [Total Cost (Forecast)] GREATER THAN 10000 OR [Account Code] EQUAL "112F

2. Click the Filter icon in the Unit of Measure column to select a filter value; select the desired
UoM.

3. Select the Filter Editor button, and the Filter Editor data box appears.

» By default, an And statement is created with a Begins with operator and a blank
value.

4. Select your preferred operator and enter in your preferred value.

5. To add additional And/Or statements, select the word And in the top left corner. A drop-down
appears.
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Filter Editor *

T And th <enter a value> g)
&y Or . e

5, Add Condition

= Add Group

#= Clear All

Load Save Ok Cancel Apphy

6. Choose which And/Or statement to add and then select the Preferred Operator.
7. Enterin your Preferred Value to complete your additional statement.
8. Click OK.
» Select the X to delete a single statement.
9. Select the And statement in the top left corner to begin clearing all And/Or statements.
10. From the drop-down, select the option Clear All.
11. Once done, select Apply and then click OK.

2.3.3 Group Columns

Sometimes you may want to organize your information into groups. Instead of filtering your
information down to one value (e.g., unit of measure = Ton), you can look at your information with a
separate group for each value (e.g., a group for Tons, a group for Cubic Feet, etc.).

Step by Step — Group Columns

1. From the CBS register, group the Unit of Measure column by dragging it into the grouping area
(where it says “Drag columns here to group”).
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Cost Breakdown Structure (CBS) Register @
v

Drag columns here to grol

T ——

*c8s % b ; L Unit of
Position Code Brs Bl (T/0) Quantity T Measure
= JoB 1,00  Lump Sum

Prime Bond 1.00  Lump Sum
Price % Add-On 1.00  Lump Sum
Job Financing 1.00  Lump Sum

¢ Notice that the cost items in the register are now grouped together by their units of
measure, and each group of cost items is subtotalled by costs, hours, quantities, etc.

Cost Breakdown Structure (CBS) Register ©

Unitof
Measure

Unitof . ces Deserption Optional Forecast T Total Cost

Measure Position Code Code (T/0) Quantity (Forecast)

Acre 1 10.00 $39,184.97
Cubic Yard 19 117,865.76 $498,571.36
Each 29 59.00 $1,684,854.23
LF 1 2,083.95 50.00
Linear Feet 1 30,248.00 $459,303.91
Lump Sum 23 22.00 $667,772.98
Mile 1 0.00 50.00
Month 2 2.00 $10,000.00
Pound 3 60,000.00 $44,408.30
Square Feet 9 136,300.00 $276,504.95
Square Yard 2 800,000.00 $99,954.78
= Ton 8 160,000.00 $2,034,391.05

2. To ungroup, right click in the grouping area and select Clear Grouping

e The column returns to its original location

TIP You can group by more than one column to have multiple grouping levels.

2.3.4 Saved Views

Once you have set up a view the way you like it, you can save the view so you won’t have to configure
it again later. InEight Estimate also comes with some pre-built views to help you organize the screen
the way you want to see it.

Views are accessed from the Saved Views menu in the top right portion of a register.

The following steps assume you have made changes to your register view and want to save it for future
use.
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Step by Step — Create a Saved View

1. In the CBS register, click on the Saved Views drop-down menu and the Save disc icon appears.

Alternates View

Benchmark View

Billing Rates View

Budget Comparison View

CBS Cost View

CBS Labels, Tags, Assignments View
CBS Production View

CBS Simple View

CBS Work Rules view v

2. Click on the Save disc icon.

e The Save Current View window appears

=
(53

%) Save Current View

Type a name for the current view. All filters, sorts,
aroups, and column settings will be saved underthis
name so that you can recall them later while in this
register.

View name: |
[7] save as Locked Corparate View

Include this view in the Saved Views section
of the report contral

o ][ cone |

3. Enter the View Name, then select OK.

e The new view displays in the drop-down menu

TIP Saved views are user-specific; you will only see your own saved views when you are
logged in.
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2.3.5 Subtotal Calculator

2.3 Columns

You can select multiple cost items and use the Subtotal Calculator to summarize and display Unit Cost,
Man-Hours/Unit and Units/Man-Hour. Highlight a cost item in the CBS and right click on a Total Cost
column (e.g., Total Cost (Forecast), Labor Total Cost, Owned Equipment Total Cost, etc.). Select

Subtotal Calculator from the right click menu, and enter the number of units to use in your calculation.

10D FTOPErues rounaaonon rFay Item &  oig WiZzara

v Setup Data ~ Proposal - HEE Materials
Initialize Resources
Cost Breakdown Structure (CBS) Register ©
Jrag columns here to group
+ L1 _.cdTiON $11,909
+ 1.2 Clearing & Grubbing §19,592
B 13 Undassified Excavation $85,360
+

HES0Urces

&7

QO

%

r.l'E

S

be

il il

[+]
o

Open
New

Delete
Cut
Copy

Da:‘tg_/_

nsen vost tem Assembly

nsert Cost ltem Assembly as Subordinate
Split

Split by Cost Type

Merge Cost ltems

Insert Resource

Insert Resource Assembly
Toggle Suspended
Go To Cost Allocation ltem

Schedule Selection
Unschedule Selection

Calculate Plug Days...

Subtotal Calculator

o| Total Cost (Forecast) $85,360.07 $37,567
{ Units: 1.00 §73,46(
{ Unit Cost: $85,360.07 §24 108
q 550,528
Man-Hours (Total) 1000.54
4 $54,308
Man-Hours / Unit: 1000.54 A -
Units [ Man-Hour: 0.00 B05,7
L]
As-Entered Currency As-Entered Units  Training Job

2.3.6 Register Running Totals

Roll Up Quantities

Add Quote...

You can select multiple rows in a register and see the sum total amount at the bottom of the register.

For example, you can hold down the CTRL key and multi-select cost items 2.1.1, 2.2.1, and 2.3.2 in the

CBS register, you can see the sum of the three selected cost items toward the bottom row of the

register.
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= 3 = 16,024.00 2 s299,779.84  s13.676.48 s14174.40 3 s0.00 = 5000 3 $258960.00 3 s0.00
$553,789.30  $129,366.37 511663521 s3.652.11 5000 5289,860.00 s0.00

Estimate calculates subtotals for quantities when the UOMs match. Superior cost items are not
included in the subtotals to avoid any double counting in the subtotal.

It is not necessary to export data to Microsoft Excel and run separate calculations to better understand
costs of multiple items. The sigma symbol shows in the subtotaled row to indicate it is the total of the
selected rows.

2.4 FIND FEATURE

The Find feature lets you search across all columns in the register with a single operation. The
matching results are then highlighted in yellow. A scroll bar annotation is provided to indicate the rows
in the grid containing matches. This lets you easily navigate to the search results in the register.

The Find feature also includes the flexibility to perform more precise searches using various syntax in
the search bar. The Find search bar shows the currently selected and total number of search results.

Mejg=n If you type in two words, such as total cost, the grid considers them as individual
conditions and selects records that contain either total or cost.

+ To find records that contain both search terms
like total cost, type + before the second word.
For example: total +cost.

- Type - to exclude records that contain a
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specific word, for example: total-cost. You
can combine different operators. Use + and -
to select records that contain both pay and
item, excluding records that contain
assignment. For example: pay +item -
assignment.

"quotes” To search for a string that contains a space
character, you need to enclose this string in
guotation marks. For example: "total cost".

. To search against a specific column, type the
first letters of the column's display name plus
a colon character. For example: optional:
unassigned. Now the grid displays records
containing unassigned in the optional code
column.

If you add another column-specific condition, the grid joins them using the + logical operator. Then the
record shows the result that matches both options. The same happens when you join a column-specific
condition with the one applied to all columns. An example of this search criteria looks like this:
optional: unassigned +"pay item".

Step by Step — Find Feature

1. From the Cost Breakdown Structure (CBS) Register, bring up the Find feature using CTRL+F.
2. In the search bar, type in Materials.

3. When all the searches are highlighted in yellow, use the up or down arrows to the right of the
search bar to navigate to the next search result in the register.
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Drag columns here to group *  material| 113 8@ W
EOB;ﬁon Code = Desambio gopéj:nal (T/0) Quantity k‘l‘lgi;;:re ERELGoSt I:ot?xlafaosst; Subjef
Indirect Cost Add-On INDIRECT COST ADD-ON 1.00  Lump Sum £0.00 £0.00 )
+ Job Management & Equipment JOB MAMAGEMENT & EQUIPMENT 1.00 | Lump Sum £157,096,28 §157,096.28
+ General Expense GEMERAL EXPENSE 1.00 | Lump Sum £4,200.00 £4,200.00
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum £98,633.23 £98,633.23
+ 1 Mobilization 5410100 1.00  Lump Sum 5$11,909.51 $11,909.51
+ 2 Clearing & Grubbing 2010102 10,00 Acre $3,918.50 $39,184.97
2 3 Unclassified Excavation 2020133 50,000.00 Cubic Yard £4.68 §233,915.81
+ 3.1 Excavation 3.1 50,000.00  Cubic Yard $3.00 §149,922.88
+ 3.2 Embankment 3.2 50,000,00  Cubic Yard 51.68 $83,992.94
= a Aggregate Base 303 5912 45,000.00 Ton §15.40 $692,928,99
> Furnish & Haul Base ‘41 $519,513.30
+ 4.2 Finegrade Subgrade 4,2 400,000.00 Square Yard 40,19 £75,848.36
= 43 Install Aggregate Base 4.3 45,000.00  Ton $2.17 $97,567.33
+ 431 Place Aggregate Base 4.3.1 45,000.00  Ton 5163 $73,460.92
+ 432 Blue Top Aggregate Base 4,3.2 400,000.00 Square Yard 20,06 £24,106.42
= 5 Asphalt Concrete Hot Mix Type A 303 4253 35,000.00  Ton $42.62  $1,491,580.59

4. To add the Find feature to the register functions header, select the Options icon to the far

right of the search bar. Then select Always Expanded.

5. To search in a specific column only, select the Options icon to the far right of the search
bar. Then select Search in Selected Column Only. Search a specific term in your
selected column.

6. To close the Find functionality, click the Close icon to the left of the search bar. You can
also hold down the Shift key and then select the F3 key to use this feature.

el g= A drop-down can be used to see a list of previous searches.

2.5 KEYBOARD SHORTCUTS

2.5.1 Navigating in a register

e

Arrow keys Move one cell up, down, left, or right

Tab Move to the next cell in the same row

SHIFT+Tab Move to the previous cell in the same row
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e

2.5 Keyboard Shortcuts

Page Down
ALT+Down Arrow

Numpad *

Numpad + key

Numpad - key

CTRL+Spacebar
CTRL+Tab
ALT
ALT+F4
CTRL+G

Move to the beginning of the cell

Move to the end of the cell

Move to the last row in the register

Shows the contents of drop-down list choices for applicable fields

Expands the subordinate leaves of a tree structure for the currently
highlighted branch

Expands the currently highlighted section to display subordinate
sections

Collapses the currently highlighted section to remove the display
of subordinate sections

Selects and Deselects a row
Toggles the display of open windows
Activates form menus

Closes active form

Opens the Go To Column navigator

2.5.2 Navigating in a record

I

Left and right arrow keys

TAB
SHIFT+TAB
Home
End
ALT+Down Arrow
F4

InEight Inc. | Release 24.7

Move one character left or right in an editable field

Move to the next editable field in the record

Move to the previous editable field in the record

Move to the beginning of the field

Move to the end of the field

Shows the contents of drop-down list choices for applicable fields

Shows the contents of drop-down list choices for applicable fields

Page 81 of 417



2.5 Keyboard Shortcuts Estimate Essentials User Guide

I

CTRL+Spacebar Selects and deselects a row
CTRL+TAB Toggles the display of open windows
ALT Activates form menus
ALT+F4 Closes active form
CTRL+G Opens the Go To Column navigator

2.5.3 Menu and keystroke commands

All forms have their own set of commands specific to the form. Commands for a form show in the
ribbon on contextual tabs (Actions and More Actions) when it is open and the form is active. Click a
command on the tab to order it. Some routine commands can be ordered using the standard Windows
keystroke combinations (e.g., Ctrl+C, Ctrl+V) or right-click with the mouse when the field is selected.

2.5.4 Function keys in Estimate

F1 Open to the Help
F2 (grid) Edit cell value: Enter edit mode for cells that are editable on the grid
F2 (tree list) Edit cell value: Enter edit mode for cells that are editable on the tree
list
F3 Find next: Finds the next value based on the search criteria
F4 (grid) Show selection register or options in the drop down
F5 Refresh, wherever available
F5 Collapse subordinate Items
F6 Expand subordinate Items

Meyg= In the Account Code Utilization Register, F5 can either refresh or collapse subordinates
based on whether an account code is selected.
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Lesson 2 Review

1. The is a great way to get a summary view of your bid. You can see totals of
direct costs, indirect costs, profit and the overall bid price.

a. Job Folder
b. Data Map
C. System tab

d. Resource Rate Register

2. You can group by more than one column to have multiple grouping levels.
1. True
2. False

3. Display settings for Units of Measure, Currency, and Colors can be adjusted from the
tab.

Setup
Estimate

System

a o T o

Help

Lesson 2 Summary

As a result of this lesson, you can:

¢ Navigate the InEight Estimate system interface
¢ Navigate system settings

e Manage columns in InEight Estimate registers
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LESSON 3 — LIBRARY SETUP

Lesson Duration: 60 minutes

Lesson Objectives

After completing this lesson, you will be able to use the following forms and explain their purpose:
e Library Job Properties
e Library Foundation Setup Data Register
e Library Resource Rate Register

e Library Assembly Register

Lesson Topics
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3.1 LIBRARY OVERVIEW

The Library is where you set up and maintain master information that imports into your projects,
including resource rates, tags, units of measure, cost item assemblies, and master breakdown
structures. It is also where security roles and permissions are configured.

You access the Library from the Backstage view in Estimate. Click on the Library link to open.

InEight®
ESTIMATE

Open a recent Job

- -

Library Training Job
LET Job 5C Job A Training Job -
Maricopa County...

Templates

Snapshots
Create a new Job from...

Archive [ Restore

A & o

You can also access the Library by clicking on the Library icon, when on the InEight Estimate landing
page.

Training Job - Estimate

System Actions More Actions
= g oa B
Equipment :

] Resource CostItemn  Standard Reports
Materials  Assemblies | Assemblies  Tables

BESOUFCES Assemblies Reports =
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When the Library opens, you see ribbons available under the main menu tabs. Each Menu tab has
unique sections which hold the necessary forms. In this lesson you will learn about each tab and their
components.

3.1.1 Library Tabs

The Library has four tabs which organizes the forms under sections. The tabs are:
e Setup
* Estimate
e System
¢ |ntegrations

The Actions and More Actions tabs appear when you open a register and contain functions for the
register you have active. .

Estimate System Integrations Actions More Actions

3.1.1.1 Setup Tab

Overview - Setup Tab

I T

1 Job The job properties maintained in the library will serve as the default
Properties settings for any new estimate that is created from scratch. When
creating a new job it will inherit all the job properties set in the master
library.
2 Foundation A master set of account codes, tags, and units of measure. When a

Setup Data new folder is created, the master set is automatically copied from the
Library to the new folder.

3 Address Book Used to store and maintain all information pertaining to the companies
with whom you work and contact regularly (subcontractors, vendors,
architects, etc.).

4 Trench Stores and maintains common trench configurations that are used from
Calculator project to project.
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5 Shift Rate
Calculator
6 Resources
7 Most Used
Resources
8 Resource
Assemblies
9 Cost Iltem
Assemblies
10 Standard
Tables
11 User Roles
12 Access
Control
13 Reports
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Overview - Setup Tab (continued)

I T

Allows you to set up shift rate configurations that you can access at the
project level.

Opens the Library Resource Rate Register where you can create and
edit all resources and resource cost details available for import into
your projects.

For quick access to the Labor, Equipment and Materials tabs of the
Master Resource Rate Register.

Takes you to the Library Resource Assembly Register where you can
set up resource assemblies to import into individual projects.

Cost Item Assemblies are predictive models to quickly and accurately
estimate elements of a job that can be repetitive in nature on the job or
from job to job.

The Standard Tables are used to create and/or list job-level table data
that is accessible by any of the Cost Item Assemblies that exist in a job.
The Standard Table Record allows the user to create and or modify a
Table record. The Standard Table Register lists all the job level tables
created / available in the project.

Opens the Register where you assign users to a role which can include
the forms, tabs and menu commands to which each role has access.
The user names that are used when setting up your User Profiles come
from Active Directory, and they are the user names that each user uses
when logging onto his/her personal computer.

Allows you to customize your system permissions by restricting
destinations or commands that only designated roles should have
access to.

Opens the Reports window, where you can access all system reports
and configure the default report settings.
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Library - Estimate

6

E ¥

Job Properties  Foundation

- Setup Data =

Master Initialization o o Master Resources o Master Assemblies Roles and Permissions Reports

Developer Tools 7 9 11

2l H W &L M a B @& B

22 Equipment
Address  Trench shift Rate | Resources ) Resource CostItem  Standard User Roles  Access Reports
Book Calculator  Caloulator - finR Materials Assemblies | Assemblies  Tables Caontrol

-grations

3.1.1.2 Estimate Tab

Overview - Estimate Tab

T T

1

Cost
Breakdown
Structure
(CBS)

Account
Code
Utilization

Work
Breakdown
Structures

Master
Workbook

Indirect Cost
ltems

Job Finance

Price % Add
On

Prime Bond

Opens the Library Cost Break Structure register, where you can define the
CBS that will automatically import when a new project is created.

Used to roll estimate line items into an account code hierarchy and
benchmark against historical projects in a way that is consistent across
projects.

Opens the Library Work Breakdown Structure register, where you can
define additional Work Breakdown Structures that will automatically import
when a new project is created.

Opens the master Microsoft Excel template which will be embed into each
new estimate job folder. The cells in the embed excel workbook can be
linked to send information to or from InEight Estimate Fields.

Takes you to the Library Cost Breakdown Structure Register where you
can edit and define indirect cost items.

Takes you to the Library Cost Breakdown Structure Register where you
can edit the Job Financing cost item.

Takes you to the Price % Add On record, where you can define the price %
add to be included in the Library CBS.

Opens to the Library Prime Bond record where you can define the bond
tables that will import automatically when a new project is created.
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Overview - Estimate Tab (continued)

I T S

9 Reports Opens the Reports window, where you can access all system reports and
configure their report settings.

Library - Estimate

System Integrations

fﬁ Account Code Utilization Z m |:| |:| Job Finance o
la [

h Work Breakdown Structures o % Price % Add On
Indirect Reports

Cost Breakdown Master )
Structure (CBS) Workbook =~ | CostItems [-®] Prime Bond
Master Breakdown Structures Workbook Master Indirect Cost Reports

3.1.1.3 System Tab

Overview - System Tab

I T S

1 Customize  Window to customize the field titles that are displayed throughout various
screens in the system, including all cost category titles, user-defined Tags,

and more.
2 Saved Allows you to save your views onto a disk or load from a disk.
Views
3  Titles Allows you to save titles onto a disk or load from a disk.
4 Colors Allows you to save your colors onto a disk or load from a disk.
5 Output Allows you to save your output settings onto a disk or load from a disk.
Settings
6 External Menu to not only generate reports created by Estimate, but also to open
Reports programs, folders, documents, reports, or Internet resources with the
associated program.
7 External Allows you to open programs, folders, documents, reports, or Internet

References resources with the associated program.
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Overview - System Tab (continued)

I T

8 Help Offers you links to Estimate’s general Help menu, information about
Section Estimate (i.e., version number, system information, tech support, etc.),
What’s New in the new version, and InEight’s external website.

= @

File Setup 2 stimate Integrations

- L .
= o Saved Views ~ (:_?i' Colors - 4 ¥ External Reparts ~ B About Estimate
—
<) Titles - ﬂ' Output Settings - |_’ External References - ﬁ' Release Motes
Customize Estimate ) InEight
o o Help @ InEight.com University
o Customize Help

External Reports

The External Reports menu lets you generate reports created by Estimate, and also lets you open
program files, folders, documents, or other internet resources.

System

External Reports ~

External References -

w

Each menu item can be added to the External Reports menu. Upon selecting one of the menu items,
the associated program, file, folder document or URL will open, as defined by the command entered in
the Open column.
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Developer Tools Integr,|
{4} External Reports ~ @ A
InEight Folder '
Estimate Open Support Tickets
Integrations
Customize
N\,
Customize Menu Items - ] b
. The External Reports menu allows you to not only generate reports created by Estimate, but it also
allows you to open programs, folders, documents, reports, or Internet resources with the associated
_ program. L
Each menu item that you add here will be added to the External Reports menu in Estimate. From there,
when you select one of these menu items, the associated Windows program will open the designated
program, folder, document, report, or Internet resource defined by the command. St}
it
For additional help using this feature, click on the Help button. e
r
Menu Order = Menu Text Open 9
..... -
2 Estimate Open S... htips:/fineight.com/help-support/ 109
3 Integrations https:/fineight.comfintegrations/ 49
39
i1
3,0
2,2
4,7
- 1,1
Add Edit Delete 0K Cancel Help
S s anrer R ——— S——— waud 8

To add a new menu text, first select the Add button and enter in a name in the Menu Text field, then
type in the location of the new Menu text under the Open field.
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The Bxternal Reports menu allows you to not only generate repaorts created by Estimate, but it also
| allows youto open programs, falders, documents, reperts, or Internet resources with the associated

| program.

Each m
when y

' Progra Menu Text:

New Menu Item

! Far adi Type the name of a program, folder, document, report, or Internet resource and
Windows will open it for you. If you do not know the command, dick the Browse buttan

- and select the file that you would like to open.
¥

Open:
3

Browse oK Cancel
| | ok |

Edit Delete 0K Cancel Help

TIP Customized Job Folder Tags match the view of the fields in the Job Properties form.

pric

@ soutestiate

s - £ Ouput settngs & whatsten

Esomate
T @ regrtan
Customize Help

R

serTog 2 4

serTag:
s

T
B T
B T

serTag 12: [Tag 12

e 22 Q [m% -] &[M « » M| P ¥ B

iiliiiiiiiii

Other expenses et
Subcontrat 0.0
Adto 000

Restore Job Folder Tag Tites. Fidd value Descrigion

Restore Al Customized Values,

InEight Inc. | Release 24.7 Page 93 of 417



3.1 Library Overview Estimate Essentials User Guide
3.1.1.4 Integrations

Overview - Integrations Tab

I T R

1 Publish Estimate to Lets you publish an estimate job to a new project. This
a New Project requires the installation of the data provider plug-in.

2 Publish Cost ltems Lets you publish cost items to an active project. This
to Active Project requires the installation of the data provider plug-in.

3 App Logs Lets you open the Estimate application logs in Project

Suite, view log details, and export to Excel.

Library - Estimate

System Integrations

@

Publish Estimate  Publish Cost Items
to a Mew Project  to Active Project

InEight Platform

App Logs

The InEight Project Suite App Log lets you drill down to the Detail level which helps you find, analyze
and solve application errors.
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[ Export to excel

Level Time Domain Area Message ExceptionMessage ExceptionType Route. Correlationld
Details  Error 2023/11/2811:2118 AM HDDesign Design E -> Publish N bscriptions exist that match top ng NoMessageTargetsException 0b1cT752-578f-4e12-b02b-cod8fadd14
Details  Error 2023/11/28 111053 AM HDDesign Design E -> Publish ng Exception 94fdc0a0-36h0-4696-a07c-08bFA5262
Details  Error HDDesign Design E -> Publish N ng Exception 12cac03b-T6ea-4808-9330-357b4b31
Detsils  Error HDDesign Design E -> Publish ng Exception 205hefab-fad1 -428h-bocd-9770e450be
Detsils  Error HDDesign Design ng Exception 2c9a0ea7-e898-4512-07h8-57a194732
Details  Error HDDesign Design ng NoMessageTargetsxception 244b84e1-87b-4c17-8944-d585 1031
Details  Error HDDesign Design ng Exception 30d6¢546-2581-421d-aa16-2341bbcfe
Details  Error HDDesign Design E -> Publish N ng NoMessageTargetsException 50913€27-13d8-417e-ah07-a4bf51 20636
Detsils  Error HDDesign Design ng Exception 430¢350a-4604-4040-b5df- 164702650110
Details . Error HDDesign Design E -> Publish N ng Exception of6f4150-Geec-4182-b2c7-14d2d91770c

InEight Project Suite App Logs - #42329000

Level

TImestamp: - 373-11-811:2118 -0700  [Received: 2023-11-28 112118 -0700]

Domain: HDDesign

Area Design

Correlationld: 411 7752-57f-4e12-b02b-ced8fadd 148 [Erowee o]

Expires 2023-12-1311:21:18 -0700

Machine: i1 swko0oINM

Message

EntityChange -> Publish NoMessageTargetsException
InEight.Platform.Messaging.NoMessageTargetsException

No ESB subscriptions exist that match topic=DesignCostitem, workType=EntityChange, sourceDomain=De,

at InEight.Platform.Messaging. ESBPublisher.<PublishiiorkilessageAsync>d_ 10 1. MoveNext (
-- End of stack trace from previous location where exception was thrown ---
at System.Runtime.CompilerServices.TaskAwaiter.ThrowForNonSuccess(Task task)
at System.Runtime.CompilerServices.TaskAwaiter.HandleNonSuccessAndDebuggerotific
at System.Runtime.CompilerServices.TaskAwaiter.ValidateEnd(Task task)
at InEight.Design.Common.Businesslogic.Services.EntityChangeService.<Publish>d_ 3. ice.cs:line 81

3.2 LIBRARY JOB PROPERTIES

The Library Job Properties form serves as a template for new jobs. Some of the tabs on the Library Job
Properties form hold basic settings that will require a default selection which will apply to all new jobs
created from scratch. Time can be saved when utilizing Library Job Properties, because the data and
settings you fill out will be automatically imported into a new job. Once imported, these settings can
be changed at the job level if necessary.

It may be helpful to complete the following tabs / fields at the Library level:

e Overview Tab Notes Field: Filling out the Notes section at the Library level would be helpful for
any instructions or reminders that you want to display on all projects’ Job Properties form. For
example, “Always double check currency exchange rates”

¢ Cost Basis Tab: Shift arrangements may or may not be standard across all projects, as well as
wage rates and scales. The cost basis default rules should be established within the library.

¢ Fuel Cost Tab: Entering a default fuel cost here will factor with the utilization of your equipment
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to be included in your equipment rates

Library - Estimate

Estimate System Integrations

& ¢ & B 8§ &L E aE @1 @

£2 Equipment

JobProperties ~ Foundation  Address Trench  ShiftRate | Resources __ Resource CostItem Standard UserRoles  Access Reports
- SetupData ~  Book  Caleulator Calculator - 7 Materials  Assemblies | Assemblies  Tables Control
Master Initialization Master Resources Master Roles and P i Reports -
Job Properties © -
Cover Sheet Minority Setup Job Folder Tags | Pridng | Schedue | CashFlow ing
Code: Library Status: Biddng 1~ | o

Desaiption:

Notes:

Last Saved: 11/28/2023 9:32:00 AM
Job created by: Sarita

Source Job:

Cancel

3.3 LIBRARY ADDRESS BOOK

Estimate's vendor and contact information in the address book register integrate with InEight
Platform's vendor and contact master data libraries.

Vendors and contacts are created and maintained in Platform's master data library as a single source
repository of vendor and contact data.
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0010118762

0010105600

m]

m]

0010069102

0010106779

(m]

0010097951

m]

0010114422

]

0010111084

m]

0010092209
O 0010006725
0010119746
0010102352

0010118867

The vendor and contact data structure shows a new hierarchy where multiple contacts can be assigned

to one vendor.

Address Book Register ©

Drag columes here to group

Vendar ID

Vendor ID
=) - 0DIDIDETR  Frank
—p  ODIDIETID  Tom

First Name Last Name

Name T

1 4 Al

11 1 Ontari
11 T Albert
114 T
1165292 BC Ltd
1169572 Albert

11754491 Canada Ltd
1189589 AB Ltd

2 rint

B Preview

& Export to Excel
Print

Alternate name

Sun Star Shuttle

Sparrow Excavation and Fencing
DBA AMJ Campbell Van Lines
Yvolution Metal Works

DBA Orleans Autopro

Young Contracting

Barcelo Flame Grilled Chicken

DBA Hydro Tech

DBA A-1 Portables

Synstone

Fire-Alert SE Edmonton

Vancouver Island Forest & Marine

LA

Address Book Register ©

Vendor Type

Comparny

Aberta
AbertaLtd
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Tax ID

Tax Jurisdiction

Address 1

Address 2

aty

>

Address 1/

7

Vendorsand  Vendors and
Contacts  Default Quotes
Layouts Edit
Wendor Name = Wendor Type
1 ABance Geomatics LLC 001
114 - Vendor2 1P Verder
1_vendorl 118 Verder
1_Vendory 1 Vendor
10X Engineered Materials LLC 2001
100 Engirsered Materials LLC mo1
11032119 Cariada Inc 001
1105500 Crtario Lid o8 Fire Alert 001
1107078 8.C. LTD 2001
11082005 Canada Inc 003
111008 Canadla inc. 002
1112004 Crtana [ne 001
11ZF0E.C. Ltd 001

VENDORS

Z00
Zo0
Zom
Zom
Z00m
Zo0m
Zom
Zom
Zo01
Z0m
2000

Z0m

Country |
R

VENDOR TYPES

Workbook

Tax ID

461564451
12345

824553213
824563213
731900852
BOBB21194
THNNN
726543085
105815492
896930377
08492095

Tax Jurisdiction

4503300400

1516913100
1516913100
001509700
001520100
000328480
70015905500
MIL5E5130
01563530
000301500

3.3 Library Address Book

mioops

.illooet

elta

Y

wrnaby
TosE
itford
dmonton

Juncan

B e &
g v,
Clear View Vendors  Wiew Contacts
Filter
View InEight Platform
Address 1 Address 2
12614 120th Ave NE
S0%h Street
1162 Mancheser Ave
1167 Marcheser Ave
300 Greenbank Road Sute 12
1-890 Taylor Creek Or
1570% Old Richber Pass Road
PRIMARY Address PRIMARYAD...
6856 Maeown Dr-1
5243 Riolteart Hoggan Lare
1016 Quaails Roast Crt

Country |
Region

Primary Email

Frankmatty Somail. com

Tomerose @gmal. com

y
ans
anoka
Jurnaby

Library - Estimate
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3.3.1 Pre-existing Estimate data

Upon upgrading to version 23.6, address book records show a combined list of both pre-existing
Estimate Address Book records and Platform vendors and contacts. Pre-existing Estimate Address Book
records are still editable, but Platform records are not. The pre-existing disconnected vendors and
contacts show a red glyph to the left of the Vendor ID column which shows that these records are
disconnected from Platform.

Address Book Register ©

Vendor ID = Vendor Name
 +
é‘ Alpha
—* Al.Ven1
Disconnected from
InEight Platform Ed-Sub2
g @ Example Vendor 4 DBE

The existing contact records also have a vendor record associated with it. New vendors and contacts
must be added via Platform, and changes to any Platform originated records must be modified in
Platform. This promotes the use of Platform as the single source of creation and maintenance for
vendor master data.

3.3.2 Estimate specific data

Certain vendor affiliated qualification information required for estimating purposes such as licensed,
bonded and insured data, or minority participation, is maintained directly in Estimate only rather than
in Platform.

There can be other Estimate vendor and contact data that only exist in Estimate and not in Platform,
such as License, Bond, Insurance and Minority Certifications, and Default Quotes.
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Address Book Register vVendor Record @
Vendor Details Contacts | Notes
Wendor ID: 1_NP-Vendor2 .
Vendor Name: = 1_NP-Vendor2 b Licensed
Vendor Type: 1_NPVendor Licensor:
Tax ID: 12345 Class:
Tax Jurisdiction: abc Identification:
Address 1: S0th Street
4] Bonded
Address 2:
Country [ Region: United States Of America Company:
City:  Scottsdale Agent:
State: Arizana Phone:

Postal / Zip Code: 85258

Phane Number: 99999999

B insured
963258741

L ]

Dafarancs kumhare I

Fax Mumber:

Web Site URL:

3.3.3 Address Book layouts

License [ Bond [ Insurance

Minority Certifications

Defadt Quates

[1eff Lewis

A

GDIMNDGE3Z

Owens Inc

Phil Jones

Cost per 1,000: |

Company:

Ewergreen Insurance|

Agent:

3.3 Library Address Book

You can choose between three address book page arrangements, vendors and contacts, vendors and

default quotes, and contacts.

Developer Tools

Estmate System Integrations

& print L@El 1L= :E [ open Fil Down Linik Field /‘ w v B @@
| ( by o)
B, Preview : U Delete UnLink Field 2 » o
Vendorsand  Vendorsand  Contacts Expand/  Fiter Cear  View\Vendors View Contacts
& Export toExcel || Contacts  Default Quotes & Copy Colspee = = Fter
Print Layouts Edit workbook View lllflgr\! Platform

Address Book Register ©

3.3.3.1 Vendors and Contacts

Vendors and Contacts are arranged where the vendor is the primary record in the register, and the

contacts associated with the vendor are shown as secondary detail records.
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Estmate Integrabtions
= Print LEIE] L% II=] | [4open
1
'ﬁ Preview ' I Delete
» Vendorsand  Vendors and  Contacts
@ BporttoExcel | Contacts  Default Quotes & Copy
Print Layouts

Address Book Register | O

[& - . ry
Drag columns here to group

_}
Vendor ID First Mame Last Mame
= 0010106779 Frank Matty
0010106779 Tom Cross

3.3.3.2 Vendors and Default Quotes

Vendors and default quotes are arranged where the vendor is the primary record in the register, and
the default quote group assignments for the vendor are shown as secondary detail records.
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File Setup Estmate System Integrations
. (2] >
'ﬂ Preview ! Delete
Vendors and Vendorsand  Contacts
@ Bxporttobxcel | Contacts  Defoult Quotes & Copy
Print Layouts
Address Book Register ©

Drag columns here to group

Vendor ID Vendor Name =

0010087554 1 Alkance Geomatics LLC

1_NP - Vendor2

Resource Resource
Code Description

= Asphalt Materials

3.3.3.3 Contacts

Contacts are arranged where the contacts are shown in a flat list and are not secondary detail records
under the Vendor. This layout can be used to search more easily for contacts regardless of their vendor
assignment.

e - = i aYs Integrabons

E" Print LEI:E L% EE Dl b

=8 Preview Copy
) Vendorsand Vendorsand — Contacts -

G BporttoExcel | Contacts  Default Quotes Fil Down
Print Layouts Edit

Address Book Register ©

vag columns here to group

First Name Last Mame Comparny
Madeesha Karunanayaks A
Joe Langmore You.Inc

TestUser 103@gmal.c...  TestUser 103@gm...  TestUser 103@&gmad. com
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3.3.4 View Vendors and Contacts in InEight Platform

Select View Vendors or View Contacts to open a new InEight Platform master data vendors and
contacts browser.

) Hame T Troe \ Fallnsene Prisary sl Costscttye Offce sumber o U

Vendor > Editvendor VENDOR DETAILS USERS CONTACTS

Cancel m

Vendor details

* o * Name

0010010622 Smith and Construction|

AMemate name Yondor typa

001

Vendor tax 10

120998877 TOO1910900

Sialug Drefaull curreney

Available

3.3.5 Vendor and contact creation

You can quickly create ad hoc vendors and contacts via the Quote Register and Record forms.

After you receive vendor quotes and you are ready to enter quote information, it can be an optimal
moment to create new vendors and contacts if they are not currently in the Address Book. Creating
vendors and contacts on the fly while the vendor quote information is readily available, and then
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entering the quote information is more expedient than leaving the quote to create the vendor and
contact in Platform. This is especially useful when you have multiple new vendor quotes.

You can create vendors and contacts on the fly in both the Quote Register > Address Book Register
Library and directly from the Quote record.

Quote Register

Quote Register ©  Quote Record

Drag columns here to group

" 2 Quote Quote Awarded
Desaiption &= St Vendar Vendor Name Contact Total Total
&o‘ Asphalt Materials Received Lewis Concrete - AAL Lewis Concrete <Ad-Hoc Contact> 51,115,975 s
[ cotratnens [N 5c1- 5 B e[
/¢, Guard Rai Items Tnvalid SUB4 iz suB4 SUB4 -- Harry Belefony $0.00 &
new J-11 Received 51-5 --51-5
3 Pipe Materials Received Ven10
[« Pipe Materials Received  Example Vendor 4DBi  Actions
Received Prime Contr, H B |
fo = i Example Prime Contra LL‘I@ ]L'[_‘(}} Q new /l, ? g ]'E{.]E) : _1@
/# Sign Ttems [fvald T example sub #3408 Ry | 7
Sign Items Incomplete  [Enter Vendor Name] Vendorsand  Vendors and Expand [  Filter  Clear View Vendors  View Cont
Contacts  Default Quotes Colapse - - Filter
Ja Site work Received | Civilworks Inc. —Ven
Layouts Edit View InEight Platform
test Received | [Enter Vendor Name] TIEVT TEST
* 999099 Robert Roberts z002
aa o
AAL Lewis Concrete

Quote Record

Quote Register Quote Record ©
Header
Description: | Asphalt Materials

Vendor: | <Ad-Hoc Vendor >

=l

e e
0

Contact: | <Ad-Hoc Contact>

Primary Email: |

External Ref.: [

For example, when you are in a quote record and need to quickly create a new vendor because the
vendor you received a quote from does not yet exist, you can select the Vendor Quick Add button, and
then enter in the vendor details in the Vendor Record — Library form.
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Quote Record O
Header

Vendor Detais

Description: | Site wark

Vendor: | chd-Hae Vendor >

o

Vendor ID: = (V187

Contact: | <Ad-Hoc Contact> 0 Vendor Type:
Primary Email: | | Tax ID:
Extarnal Ref.: | Tat Jurigdiction:

Address 1:

Resources | Cost ltems
1 Address 2:
Package = Couwntry / Region:
City:
Package & Code & RFQID Cuote Group Shate:

B P3 (Paving)

B P1 (Demo,Exay,Grading)
O P2 (Assisted Parking Lot)

Postal [ Zip Code:

Phone Number:

Fax Number:

Wb Site URL:

Reference Number:

Quote

Currency:

Do NotUse:

G(ﬂ Vendor Name: = |Lewis Concrate

—
—
—

Urited States OF America =
Phaenix
Arizana -

83256 ]

]
[ ]
]

.5, Dodlar l

Estimate Essentials User Guide

Vendor Record - Library

0K Mt >

You can also add additional qualification information in the License/Bond/Insurance and Minority

Certifications tabs.
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Wendor Detals
Vendar 10: = [V187
WVendor Name: = |Lewis Concreke
Vendor Type: 2004
Taox BD:
Tax Jurisdiction:

135 Magle Ave

Address 1:
Address 2:
Cowntry | Region: Urited Skates OF Amenics

City: [Phaenix

States Arizona
Fostal [2ip Code: 85284
Phane Mumber: 490 555 2656
Fax Mumbser:
Wb Site URL:
Reference Mumbser:
Quabe
Currencys L5, Dodllar

Do MotUse: [

Contacts | Motes
[ Licensed

Licensor:
Class:

Tdentification:

[ Bended

Company:

Agent:
Phone:

Cost per 1,000:

[ nsured

Company:

Agent:

Phane:

Vendor Record - Library

[0k Lewis

Ligense [ Bord | Inpurance

3.3 Library Address Book

General Enganeening
[Roc 333085

.HHI'JE‘F Bonding

3im Smith
[s00 555 6502

| 5300

.Enbm:lt
[Tam Janes

[450 568 £584

Contacts hotes Licerse [ Band [ Irsursnce Minority Cerificationrs Defaudt Quokes

Name Authority and Certification Member
EAosE  |awsrse

= Omes
O wee

Other Manority Certifications:
FAoBEL |cLozeres

[ osez

[l osez

] oBes

[ oBEs
[ oBEs
O ceer

Certification Comments:

Al = The additional qualification information is added and maintained in Estimate and cannot
be added to the vendor record when creating vendors directly in Platform.

After the vendor is created, it is included in the Library Address Book and can be chosen as a vendor to

be used on a quote.
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& - Address Book Register - Library
Actons
Drag columns here to group x| Enter text to search... | [1>] o4
VendorID = Vendor Name Vendor Type Address 1 Couriry / Tax ID LT
Region Jurisd..

tst =

Lewis Concrete 125 Maple Ave United States Of America

¥2 Bewd
+ Va1 MAINT. 2004 Add1 Albania T.303 co-
+ V203 J&d

Vendor1 vendor 1 VT1

v
LY SR V. P—" Mo e e R LT
a »

If you have a new contact to add, you can select the Contact Quick Add button, and then enter the
contact information.

Quote Record @ Contact Record - Library

Header 2

Contact Details

Descriptior: | Site work |
First Name: = |Robert Address 1: | 125 Maple Ave |

|

Last Name: = |Cantor |

Vendor: | Lewis Concrete = V157 i =
|

C my: * |L Concret
Contact: | <Ad+Hoc Contact> oﬁ/ L b

Primary Email: = [reanter@lenisconerate.com

Address 2: | |

Country/Region: | United States OF America

State: | Arizona

Primary Email: |
External ek 5 | Contact Type: | Estimate Contact City: |Fhoer|0: |
Department: | | Postalzipcode: (45256 |
Resources | Cost Ttems
— Pasition: |Contracter | Fax Number: | |+
Package = Title: [5r. Contractor] | Office Number: [440 555 2658 |
Language Preference: Mabile Number: |480 555 6887 |
P = Code & RFQID te
ackage & B Q Quote Group - Security
P1 (Demo,Exay,Grading) Vendor ID: V187 Last Changed By: |Paul Trippi
P2 (Assisted Parking Lot) Vendor: | Lewis Concrete -- V187 i Last Changed On: | 12/29/2023 11:50:42 AM
P3 (Paving) Do NotUsa:

Cancel New... < Prev Next =

After the contact is created, it becomes associated with the newly created vendor in the Library
Address Book.

Page 106 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide

3.3 Library Address Book

Address Book Register - Library

Vendor Name
j Lewis Concrete
vendor ID

First Name Last Name

187

Robert Cantor

x | Enter text to search... ﬁ
Vendor Type Address 1 E:I;nw / Tax ID ;Sr)i(sd

Z004 125 Maple Ave United States Of America

Company =  Address 1 Address 2 City

Lewis Conarete 125 Maple Ave Phoenix

=
4

The vendor and contact information are

stored in Platform where it can be easily accessed by selecting

one of the vendor ID links in the Library Address Book. The vendor can also be used by other Platform

applications.

Address Book Register - Library

VENDOR DETALS USERS

Vendor details

"o *Name
vigq Lewis Conerete
tesr fenor
2004
rendor tax 1D jendor tax jurisdiction
stans Defaul currency
Bvailasle
Default
ef
Default incoterms location
Addresses Vendor > Editvendor VENDOR DETAILS USERS IL] /
] @ Q
Country / Region
Full name Primary emad Contact type Office numbesr s User
/ u
] | Rabert Cantor Hame23@Examphe com Estimate Contact 480 555 2658 fisk
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3.3.6 Merge and Upload Contacts and Vendors into Platform

You can manage and retain all vendor information in the Estimate Address Book that are not linked
(disconnected) with Platform, including contacts and companies that are referenced in multiple
estimates, quotes and RFQs.

Disconnected Vendors and Contacts can be merged with existing Platform vendors and contacts, or
they can be uploaded to create new Platform vendors and contacts by navigating to the Library > Setup
> Address Book. You can also upload new Estimate vendors and contacts into Platform's master data
repository.

Estimate's process of uploading contacts and vendors into Platform's master data library (as a means
for all InEight products to access as a source system of contact and vendor data) not only lets you send
this information to Platform, but it provides you with a mechanism to clean up and simplify existing
Estimate Address Book data. For example, your current Estimate Address Book might contain many
duplicate contacts containing the same first and last name, but with different addresses, emails, or
mobile numbers. Merging these records helps administer customer data better so that you can
eventually only maintain a single contact or vendor that has the most up to date and most accurate
information.

Address Book Register ©

Vendor ID Company = Vendor Address 1
Z Phoenix Contractors Example Vendor 1838 100 Tenth Street
Z Phoenix Contractors Example Vendor 1666 100 Tenth Street
g Phoenix Contractors Example Vendor 5551 100 Tenth Street
Z Phoenix Contractors Example Vendor 222 100 Tenth Street

3.3.6.4 Disconnected Contacts and Vendors

Pre-existing Estimate vendors and contacts that are disconnected from Platform show a red glyph to
the left of the Vendor ID column, and only exist in Estimate at this time. To only show the disconnected
records, click the column filter in the Vendor ID column, and then select (Blanks). You can either delete
the disconnected records or choose to merge or upload them into Platform.

Showing only the disconnected vendors or contacts helps you see the vendors and contacts that are
not connected with Platform.
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Address Book Register ©

group

, First Last
Vendor ID T Name Name Com
| values  TextFiters Phoe
0
/J/ Phoe
o Enter text to search el
J Phoe
Iy LR —
4 (All) 7 Phoe
/I:J/ v | (Blanks) PCS
y Example Prime Contractor 13 PC3
J
Example Sub %14 DBE
new
Example Sub #24 DBE a
jose
Example Sub #8
InEic
Example Vendor 123 -
InEL
InEic
Clear Filter Filter Editor Close
InEic
Sasi Test3 18D

Melg= All new library address book records must be created in Platform.

Vendor and contact ID's that show a blank do not currently have an associated Platform vendor
association, as these vendors were originally created in Estimate. These vendors have not been merged
into Platform, and therefore have no association with the vendor master data that resides in Platform.

3 B B | 7 il Dow ink Fi
E‘ Print Lq'@ LL?} | r_l Open Fill Down Link Field /"{ Y w L%:
'i Preview ! ! a Delete J-L Merge Vendors UnLink Field :

Vendorsand  Vendorsand — Contacts Expand [ Filter  Clear View Venc

G ExporttoExcel | Contacts  Default Quotes & copy Collapse = = Filter

Print Layouts Edit Workbook View
Address Book Register ©
Drag columns here to group

Vendor ID Y7 | Vendor Mame = Vendor Type Tax ID Tax Jurisdiction Address 1 Address 2

nple Sub #34 DBE 900 First Street Suite 9000 -
Vendor ID el L Company =  Address 1 Address 2 City
MName MName -
Z Larry Jack Example Sub #34 DBE 900 First Str... Hometown

Inactive Contacts and Vendors

You can mark a vendor as Do Not Use in a contact record, which indicates the status of the contacts
associated vendor, and can only be set in Estimate when vendors are disconnected from Platform. The
record changes to red to signify it is inactive and cannot be used, but is not deleted from the system.
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Address Book Register Contact Record Vendor Record ©
Vendor Details Contacts | Notes
Vendor ID: 4909173019474807

Vendor Name:

Drag columns here to g

*  51st State

Estimate Essentials User Guide

First Name
Vendor Type: 2002
Tax ID: 13
Tax Jurisdiction: 5th Level
Cdregse®™ o Adge® L -
retein
Quote _
Address Book Register Contact Record ©
Currency: U.S, Dollar
/ Contact Details
Do NotUse: First Name: Tony Address 1: | 300 Third Street
Last Name: LM Address 2: 300 Third Street

ga—

,,M _/_ "‘Demg_n/_

Title: jr.tL Office Number: off-1
Language Preference: | English Mobile Number: mob-1
Vendor Security
Vendor ID: VID-003 Last Changed By: |InEight Service Account
Vendor: | Design&Consult - Last Changed On: |8/2/2023 1:56:09 PM
Do NotUse: {

To change the Do Not Use status, select the Vendor ID Platform link for the vendor record in Estimate.
In Platform, the Do Not Use flag can be maintained by selecting the Status field in Master Data Libraries
> Vendors, and automatically integrates with Estimate.

A Master data libraries / Vendors

Vendor >  Editvendor VENDOR DETAILS USERS CONTACTS

Status Default currency
Available v Select one v
Q,
| Default incoterms
Available Default incoterms b
Unavailable
Default incoterms location
Addresses PRIMARY REMIT TO ADDITIONAL
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Step by Step — Merge Estimate Vendors to Platform

1. Choose one connected and disconnected vendor, then select Merge Vendors with Platform.

B Print qu@ ]'DQ E] |'_I Open FilD: 8 Link Fieids /, Y w \:D<D 'E@ & Merge Vendors with Platform

R Preview ! jete [ Merge Vendors nLink Field ” e (@ Upload Vendors to Platform
Vendorsand  Vendorsand  Contacts Expand/  Filter  Clear View Vendors  View Contacts

&' EporttoExcel | Contacts  Default Quotes % Copy Collapse = =

Print Layouts Edit Workbook View InEight Platform

Address Book Register ©

Postal / Phone

Vendor ID Vendor Name = Address 1 City Sak Zp cnde Number

Address 2 Vendor Type Tax1l

» Note that the connected Estimate vendor previously exists in Platform, prior to the
merge of the two vendor records.

2. Select Merge.

Thedisplayed vendors will be mergedto the selected primary vendor.

Saved views:

Postal / Phone Fax

Primary Vendor ID =  Vendor Name =  Vendor Type Address 1 Address 2 City Zip Code Number Number

Web Site URL Currency Do Not Use

4 Ven34 Ven34 700 Seventh... 700 Seventh.. Hometown 889500 111-1314..  222-1342.. CND Dollar
Ven36 700 Seventh. Hometown 889500 111-1314... 2221342 CND Dollar

» Notice that the primary vendor is checked, as this record already exists in Platform.

» Other records where the Primary field is not checked are records to be merged into
the primary record.

» Fields in yellow for the non-primary records are deltas. These deltas will not be
merged, and differences will be lost once they are merged, as the data that exists in
Platform takes precedence. If you want any of the disconnected data to exist in
Platform, you need to manually change the data in Platform. The advantage for this
is to allow for the disconnected Estimate vendors to become associated with an
already existing Platform vendor, which lets the contact to still be keyed in areas it
was used in Estimate, such as in Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary
contact will exist.
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Attention

The attributes of the primary vendor will persist and the default

quotes for the other vendors will be removed. This operation will
save the Library.

Are you sure you want to continue?

Yes No

Step by Step — Upload Estimate Vendors to Platform

1. Choose a disconnected vendor with an associated contact, and then select Upload Vendors to

Platform.
E!! Print ]‘El LFI I L@ Hgl |_r'J- Merge Vendors with Platform
%_ Preview :@ Q Iﬁ @ @ ‘_['-]:" Upload Vendors to Platform

Vendorsand  Vendorsand  Contacts | View Vendors  View Contacts
@ ExporttoExcel | Contacts  Default Quotes

Print Layouts InEight Platform -
Address Book Register ©

Drag columns here to group

Saved views: | Previous View - | p
Vendor T  vendor Name = :ndor Type Country / City State Eostll] i
(s = i Region Zip Code Mumber
z Example Sub 298 Hometown AZ 889050 111-123-12; +
z Example Sub 77 United States Of America Hometown Arizona 839030 111-232-34
z Example Vendor 123 _. United States Of America Wi
Vendor ID First Name Last Mam State Postal / Errally) / Primary Email Contack
Zip Code Region Type
X Pat Roberts AZ 889060

2. Click the + symbol to the left of the Vendor ID to expand all the records. Select Upload to sync
the vendor shown with the contact in this window to Platform.

¢ The preview dialog box opens.

3. Select Yes in the Attention dialogue box to confirm that the vendor will be uploaded to Platform
and synchronized back to the Estimate Address Book library.
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State FLsLgl f§ woungy g LUrgeL L

City By

Attention

T 1

Wendors will be uploaded to Platform and synchronized back to
Estimate. This operation will sawe the Library.

Are you sure you want to continue?

fes Mo

Step by Step — Merge Contacts to Platform

1. Choose one connected and one disconnected contact, and then select Merge Contacts with

Platform.
i = = | 2 i 1 I F wi
E!! Print Ll?@ L|__§|3 IE L, O? _:-!, Link Fields '= B :gl@ | = Merge Contacts with Platform
%_ Preview ! ! DI UnLink Field {E" Upload Contacts to Platform
Vendorsand  Vendorsand — Contacts Expand /|  Clear View Vendors  View Contacts
& Export to Excel Contacts  Default Quotes % Copy Collapse Filter

Print Layouts Workbook View InEight Platform

Address Book Register © /

Drag columns here to group Saved views:

» I
I

343 Plum st

P00 Firs Str...
‘ 900 First 5tr... | 900 First Street Su..

e Prior to the merge, note that the connected Estimate contact previously exists in Platform,
prior to the merge of the two contact records.

= @  Master data libraries / Contacts

0A-T01-238 (D d‘ ® ®

CONTACTS CONTACT TYPES
® 4 5 5 o Q
Full name T Primary email / Mobile number City Created on Address 1 Is User AT
month/day/ All
(] Larry Jack te@yahoo.com / 111-565-8958 Hometown 09/15/2023 01:07:50 PM 900 First Street Suite 9000 false |

2. Select Merge.
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The displayed contacts will be merged to the selected primary contact

First Last
Name Name

Larry 3adk Example Sub #4 DBE tc@yahoo.com

Primary Company = Primary Emai

Larry Jack pt@sub.com

Contact = Address 1
Type

Estimate Cont... 900 First Stree
900 First Stree

Address 2

Country /
Region

900 First Str United State

343 Plum st

United State....

Estimate Essentials User Guide

State

Arizona

Saved views:

Postal / Mobile Office

o Zp Code Number Number

Hometown 889009 111-565-8 111-332-4
Hometown 889009 111-332-4

Merge Cancel

* Notice that the primary contact is checked, as this record already exists in Platform.

e Other records where the Primary field is not checked are records to merge into the

primary record.

¢ Fields in yellow for the non-primary records are deltas. These deltas will not be merged,
and differences will be lost after they are merged, as the data that exists in Platform takes
precedence. If you want any of the disconnected data to exist in Platform, you need to
manually change the data in Platform. The advantage for this is to allow for the
disconnected Estimate contact to become associated with an already existing Platform
contact, which lets the contact to still be keyed in areas it was used in Estimate, such as in

Quotes and RFQs.

3. Select Yes in the Attention dialogue box to acknowledge that the attributes of the primary

contact will exist.

Attention

save the Library.

Are you sure you want to continue?

fes

The attributes of the primary contact will persist. This operation will

Mo

¢ A message shows it was successful, and the entry is created in Platform.
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Attention

Successfully merged contacts with primary contact.

CONTACTS CONTACT TYPE..
(€] O B o Q
Full name T Company Primary email Address 1 Address 2 / Created on D
larry jack month/day/year
O LarryJack Example Sub #4 DBE te@yahoo.com 900 First Street Suite 9000 900 First Street Suite gn/ retown 09/15/2023 01:07:50 PM

Step by Step — Upload Contacts to Platform

1. Choose a disconnected contact, and then select Upload Contacts to Platform.

g g | r N @ .
= Print L[:I@ 1'[(13 'ﬁ \'@(D }__@ % Merge Contacts with Platform
& Preview . : 7 Upload Contacts to Piatform
Vendorsand Vendorsand  Contacts | View Vendors  View Contacts
G Export toExcel | Contacts  Default Quotes %
Print Layouts InEight Platform

Address Book Register ©

Vendor ID 'Y  First Name LastName = Address 1 Address 2

.

Saved views: | Previous Vie -]

Country /
Region

State Gity ;I‘;S?D' é’l

700 First Str United Arab Emirates Abu Dhabi

2. Select Upload to send the contact shown in this window to Platform.

e The purpose of the preview dialog is to let you see what will be created in Platform, and to
correct any issues before completing the operation.

The displayed contacts will be uploaded to Platform.

/

Drag columns here to group

Saved views: | Previous View -
) _ : / Postal / Contact Language Mobile Offis
First Name Last Name Company = Primary Email Zip Code Type Preference Nomber N
Keesha Blank SUBS 2@gmail.com / 889007 000 111

4

‘

3. Select Yes in the Attention dialogue box to upload the contact to Platform, synchronize back to
Estimate, and save to the library.
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Attention

Contacts will be uploaded to Platform and synchronized back to
Estimate. This operation will save the Library.

Are you sure you want to continue?

Yes No

e A message shows it was successful, and the entry is created in Platform.

Attention X

Successfully uploaded contacts to Platform.

0QA-TD1-238
CONTACTS CONTACT TYPES
® B ® & Fronewe P T B O Q
Fullname T Primary email Office number Mokile number Crested on i
/ month/day/year
Keesha Blank 2@9"73“,60!“ 111-222-3232 000 / 09/14/2023 01:26:22 PM b
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— Create Vendors and Contacts via Quote Record

1. Navigate to the Quote register and open an existing quote.

Quote Register ©
Drag columns here to group

Description = Quote Vendor Vendor Mame Contact

= Status

E———— L [—— T P |
iRk <Ad-Hoc Contact> |

/¢, Guard Ral Ttems - SUB4 Py SUB4 - Harry Belefony |
new J-11 Received vendor-Mada -- V206 e New <Ad-Hoc Contact>

ﬁ Pipe Materials Received Adams Concrete — Ven3 6 Delete <Ad-Hoc Contact>

& Fipe Materials Received Example Vendor 4 DBE - g{ Cut Example Vendor 4 DBE -- Leste...

A =3 Incomplete  Jose Luis Maldonado — % Copy Example Prime Contractor 211 ...

/¢ Sion Ttems - Example Sub %34 DEE Paste Example Sub %34 DEE — Larry .. |
Sign Ttems - 0703172 BC Ltd — 0010 Gl <Ad-Hoc Contact> |

A Site work Received Lewis Concrete — V187 | &0 Link this field to Excel Lewis Concrete - Robert Cantor
test Received [Enter Vendor Name] | c & UnLink from Excel <Ad-Hoc Contact>

» O Refrezh

2. Click the Vendor Quick Add icon in the Quote Record register.

Quote Register Quote Record ©

Header

Description: | eWEga =T Rte==

Vendor: LmEntrq:xis&:...E'@ !

Contact: | <Ad-Hoc Conta... @ [

Primary Email: | |

External Ref.: |

3. Inthe Vendor Record - Library window, enter a new Vendor ID and Vendor Name. Under the
Vendor Name field, enter in the other non-required information such as the Address and Phone
Number.
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Izl Vendor Record - Library - [m] x
Vendor Details Contacts Motes License [ Bond / Insurance Minarity Certifications Default Quotes
Vendor ID: * |Ven7869
Tag 1: - Last Changed By: Paul
Vendor Name: * |Adams Concrete
Tag 2: = | Last Changed On: |1/24/2024 2:11:43 PM
Vendar Type: Z002 -
Tag 3: -
Tax ID:

Tax Jurisdiction: Notes:

Address 1: 1029 King St |

Il

Address 2:

Country / Region: United States Of America - |

City: Scottsdale
State: Arizona -
Postal ( Zip Code: #5258
Phone Number: 430 555 6387 |
Fax Number:

Web Site URL:

lh

Reference Number: ABL-3847

Quote

Currency: U.5. Dollar -

O

Do NotUse:

Cancel New... < Prev Next >

4. On the right side of the window, enter any relevant information in the tabs, such as vendor
notes and license, bond and insurance information, and then click OK.

Contacts MNotes License f Bond { Insurance Minority Certifications Default Quotes

Tag 1: | Concrete - | Last Changed By: Paul
Tag 2: @ ~| LastChanged On: 1/24/2024 2:17:05 PM
Tag 3: o -

Motes:

- Jse this vendor for project work in the Phoenix metro area. |

- Reference number must be induded on the work inveice upon project completion.| |

Cancel New... < Prey Mext =

The new vendor is now added to the Estimate Address Book Register - Library.
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EEEEE d/  Fiter  Glear | View venders  View Conmtacts
coitpoe - = i
view 1ntight riatform ~
¢ [Enter tot to scarch. .. |
Vendeor Tvoe Address 1 Sl city State 1
ooz 1029 rang st United States Of America scomsasic Arzona = |
Guote kecora  © — -
[E— } P
— s246,720.00
S12.536.00
Vendor Name: [Adams Concret e
FretName: [ cmen
Lastrvame: [ |
) $259,056.00
M
Saved views [ Previeus vien -1~
o
Soit
-
-
-
/ = =

The following steps help to confirm that the vendor was created correctly, and that it can
be used to update or maintain the vendor after it has already been created, including steps
to create a new contact on the fly.
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5. Click the new Vendor ID in the Estimate Address Book Register - Library.

|, g (e

Rcopy | 7
Vendorsand  Vendors and Expar
Contacts Default Quotes Collaps=
Layouts Edit
Drag columns here to group
Vendor ID = Vendor Mame
Ven7369 Adams Concrete

The new vendor opens in Project Suite > Master data libraries > Vendors.
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Master data libraries / Vendors

Vendor >  Editvendor WVENDOR DETAILS USERS CONTACTS

Cancel

Vendor details

*ID * Name

Ven7869 Adams Concrete
Alternate name Vendor type

Z002 v

Vendor tax ID Vendor tax jurisdiction
Status Default currency

Available v Select one v
Default payment terms Default incoterms

Default payment terms v Default incoterms v

Default incoterms location

AddreSSeS PRIMARY REMIT TO ADDITIONAL

Country / Region Address 1 -

6. Click the Contact Quick Add icon in the Quote Record register.

Quote Register Quote Record ©

Header

Description: | Pipe Materials

Vendor: | Adams Concrete -- Ven7869 O iz
p—
Contact: | <Ad-Hoc Contact> O 2

Primary Email:

External Ref.:

7. In the Contact Record - Library window, enter the First Name, Last Name, Company, and
Primary Email. Under the Primary Email field, enter in the other non-required information such
as the Address and Phone Number, and then click OK.
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IZI Contact Record - Library — O x

Contact Details

First Name: * |Ton1 Address 1: |123 Maple Dr

Last Name: * |I'~‘1cHenr5-I Address 2: |

Company: * |\n'endor 1 Country/Region: | United States Of America

Primary Email: * |Name25@ExampIe.corn State: |Arizona

Ci

Contact Type: | Estimate Contact

Department: |Estimating Postal/Zip Code: |85259

Position: |Estimator Fax Mumber: |

Title: |Lead Estimator Office Number: |

|

|

|

|

ity: |Scottsdale |

|

|

|

Language Preference: |

Mobile Number: |480 555 3659|

Vendor Security
Vendor ID: Vend 1 Last Changed By: Paul Trippi

Vendor: | Vendor 1--Vend 1 ] Last Changed On: | 1/25/2024 9:11:43 AM

Do MNotUse:

| oK | | Cancel | New... < Prev Mext =

The new contact is now added to the Estimate Address Book Register - Library.
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Bo% -4 YR %

‘ B Copy
Vendorsand  Vendors and Expand Filter Clear View Vendors  View Contacts
Contacts Default Quotes Collapse ~ - Filter
Layouts Edit View InEight Platform A
Drag columns here to group Saved views: | Previous View - ‘ | Enter text to search...
Vendor ID Vendor Name Vendor Type Address 1 E:;izﬁy / City State
o] o mm | 0SKeSt | unied Siates OFAncrin Scotsi
Vendor ID First Name | st Mame. Comnany =  addresst Address 3 City 2
Quote Record @ \ -
- | Ven7863 Tom
Header
“
Description: | Pipe Materials $246,720.00
$12,336.00
Wendor: | Adams Concrete - Ven7859 © izl| VendorName: Adams Concrete (

Contact: | Adams Concrete -- Tom Henrys @ iz First Name: 50.00
Primary Email: Last Name:
)

External Ref.: ‘

Resources Cost Items

*
Drag columns here to group @

$259,056.00

Code & Quote Group & Description g‘;‘t Free Awarded D
e MPPI0 & Pipe Materials Pipe 10"PVC SDR21 O O

MPP24 Pipe Materials Pipe 24" PVC SDR35 ] ]
VALLES Pipe Materials Pipe RCP 36 In ] ]
* =] =] =]

< Prev Next >

8. Click the new contact Vendor ID in the Estimate Address Book Register - Library.
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El II= Copy W "
L@ | ‘./;" P B

Vendors and Contacts Expand f Filter  Clei
Contacts Collapse - - Filt
Layouts Edit View
Drag columns here to group Save
Vendor ID = Vendor Mame Vendor Type
5 i~ Ven7888 . Adams Concrete 2002
Vendar ID First Mame Last Mame
= | Ven7869 Tom Henirys
4

The vendor opens in Project Suite > Master data libraries > Vendors, and includes the new
contact.

@ | Master datalibraries / Vendors

Vendor > Edit vendor VENDOR DETAILS USERS CONTACTS
Vendor details
“Ip * Name
Ven7869 Adams Conerete

Addresses PRIMARY REMITTO ADDITIONAL
couniny/ Regien Vendor > Editvendor VENDOR DETAILS USERS CONTACTS
: Full name Primary email Comtact type Office number Mabile number city
[ | Tom Henrys Tomhenry@adamsconcrete.com Estimate Contact 4805552387 Scottsdale
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3.4 LIBRARY JOB PROPERTIES PRICING

3.4.1 Job Properties Overview

In Job Properties Overview > Pricing, there are balanced price and markup options in the bid pricing
area which lets you categorize costs, markup various costs in an estimate, and distribute that markup
throughout the bid which establishes balanced bid prices.

Job Properties ©
Overview Security | Cover Sheet CostBasis | Minority Setup Fuel Co: Pricing

Balanced Price Options
Calculate Balanced Pay Item Prices using:

(® Cost Amount
(O Billing Amount

Distribute Unassigned Cost/Billing Amount by:

(® Individual Categories
(O Top level Categories
(O Total Cost/Billing amount
Markup Options
Markup Pay Item by:
(® Using Weighted Distribution

(O Keeping Markup with Assigned Costs

Categorize Business Overhead as:

O Indirect Cost
(@ Markup

Calculate Proposal Recap Forecast Markup using:

(® Unit Markup (current) x Forecast (T/0) Quantity

() Forecast Price - Total Cost/Billing

3.4.2 Balanced Price Options

This option determines if a pay item will use the cost or billing amount values of the assigned cost
items as the basis for determining a balanced bid price. This also determines if the AutoPrice command
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will use the cost or billing amount values.

3.4.2.1 Calculate Balanced Pay Item Prices using Cost Amount:

Balanced Price Options
Calculate Balanced Pay Item Prices using:

(® Cost Amount
(O Billing Amount

Price Breakdown Structure  ©

oescroten dped  Uressgned  Totd TG liea By bieg ey Taget  bea
NG I S N F S N
v A Targeterce £5,040,796.20  $1,222,999.47 | $6,263,795.67] 100.00 §5,164,80 . $1,123,41  $5,268,21 100.00
v L Mardep £0.00  $896,150.52  4896,150.52 1431 $0.00 §755,088.85 £755,068.85 1201
« i TargetProfit $534,133.61  $504,13361 9.9 11.13 $0.00 $447,511.92 $447,511.92 7.12 8.00
', Indirect Cost Markup $14,730.68  $14730.68  0.24 5.00 $0.00  $37,33L7  §27,33L76 043 8.00
|, Direct Cost Markup §579,402.54  §579,40294  9.25 143 $0.00  $420,180.16 $420,180.15 6.68 8.00
« = Business Overhead $0.00  $302,025.90  $302,02590 482 $0.00  $307,556.93 $307,556.93 489
B8 Price % Add-0n $0.00  $281,870.81 $2BLETDEL 450 $0.00 $2BLE70.BL $281,870.81 448
BB lobFinandng £0.00 §5,762.53 $5,762.53  0.09 $0.00  $5,762.53  $5,762.53 0.09
88 Indirect Cost Escalation £0.00 $2,13L.11 213111 0.03 $0.00  $2,983.55  §2,983.55 0.0%
B8 Drect Cost Escalation £0.00 £12,261.46  $12,26146  0.20 $0.00  $15940.05  §16,940.05 0.27
A% Business Overhead Items £0.00 £0.00 000 0.00 0,00 £0.00 .00 0.00
v JA Total Cost $5,040,796.20 |  $325,839.95 $5,367,636.15 85.69 $5,164,80.. $368,342.37 $5,533,14. 87.99
v & Indrect Cost $0.00 | $325,839.95  $325839.95 5.0 $0.00 $367,392.37 $367,392.37 5.84
« & Job Overhead $0.00| $3258%9.95 $335839.95 510 $0.00  $367,342.37 $367,342.37 5.84
B8 Prime Bond $0.00| $45618.98  $45618.98 073 $0.00  $45,618.96  $45,618.98 0.73
BB Indrect Cost Add-On $0.00 §5,734.55 $5,73495  0.09 $0.00 564096  $5,640.46 0.11
55 Direct Cost Add-On .00 §99,189.74  $99,189.74  L5A $0.00  $103,316.14 $103,316.14 164
S Job Overhead Items s.00| $175,296.28  $175,296.28 280 $0.00 $211,766.79 $211,766.79 137
v 4 DirectCost £5,040,796.20 £1,000.00 £5,041,796.20  80.49 §5,154,80.  $1,000.00 £5,16580. 82.15
@ Drect Cost Items 5,040, 796.20 §1,000.00 $5,041,796.20 80.99 §5,164,80..  $1,000.00 $5,16580... 82.15

3.4.2.2 Calculate Balanced Pay Item Prices using Billing Amount:

Balanced Price Options

Calculate Balanced Pay Item Prices using:

() Cost Amount
(@) Billing Amount
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Price Breakdown Structure  ©

e e o SN T WD ML ML
v M TargetPrics $5,040,796.20  $1,222,999.47 $6,263,795.67 100.00 $5,164,80.. $1,123,41.| #6,288,21_ | 100.00
« A Markp $0.00  $A96,150.52  $896,150.52 1431 $0.00 $75S,088.85 $755,068.85 1201
w [\ TargetProfit $594,133.61  §594,133.61 5.9 113 $0.00 §H7,51152 §447,511.92 12 8.00
', Indinect Cost Marap £14,730.68 $14,730.68 0.24 5.00 £0.00 $27,331.7% $27,331.7% 0.43 8.00
\ Direct Cost Markup $579,402.94  $579,402.94  9.25 1145 $0.00 $420,180.16 $420,150.16 6.68 B.00
w = Businast Overhesd £0.00 $302,025.90 §302,025.90 482 $0.00 $307,556.93 §307,556.93 489
2 Price % Add-On $0.00  SBLEMEL  SHLENEL 490 $0.00 $281870.81 $281,870.81 448
BB Job Financing .00 $5,762.53 §5,762.53  0.09 $0.00  §5,72.53  $5,761.53 0.09
EE Indinect Cast Escalation £0.00 £2,131.11 §2,131.11 0.03 $0.00 §2,983.55 $2,963.55 .05
55 Direct Cost Escalation €000 $12,26146  $1226L46 020 $0.00  $15,940.05  $16,840.05 0.27
an Busness Overhead ltems $0.00 $0.00 $0.00  0.00 $0.00 $0.00 .00 0.00
« A Total Cost $5,040,796.20  $326,839.95 §5,367,636.15 9569 §5,164,80 . | §368,342.37  §5,533,14 a7.99
= & Indrect Cost $0.00  $325839.95 $325639.95 520 $0.00 | $367,342.37  $367,342.37 5.64
~ = Job Overhead £0.00 %325,839.95 §325,839.95 5.20 $0.00 | §367,342.37 $367.342.37 5.B4
89 Prime Bond .00 44561858 $45,61888 073 $0.00 | $45,61B.38  $45,618.98 0.73
BB Indrect Cost Add-On $0.00 §5,734.95 §5,73495  0.09 $0.00 | 66409 #6904 011
Eg Dwect Cost Add-On £0.00 £99,189.74 99, 159. 74 L53 $0.00 | §103,316.14 $103,316.14 L4
B4 Job Overhesd Items $0.00  $175,206.28  $175,296.28 260 $0.00 | $211,756.79  $211,766.79 3.37
« da Direct Cost $5,040,756.20 $1,000.00 $5,041,796.20 8049 $5,16480.. | $L000.00 §5,165,80. 8215
aa Diect Cost [tems $5,040,756.20 $1,000.00 §5,041,796.20 0.9 §5,164,80 $L,000.00  §5,165,80 8215

3.4.2.3 Distribution of Unassigned Costs/Billing Amount by Individual Categories

Distribute Unassigned Cost/Billing Amount by:

(® Individual Categories
() Top level Categories
(O Total Cost/Billing amount

Any costs in the estimate not assigned to a pay item needs to be proportionally spread back to all pay
items to determine a balanced bid price. This option lets the user choose the basis for calculating the
weighted distribution of any unassigned costs plus markup.

¢ Individual Categories - this option uses each individual cost categories as the basis for
establishing the weighted distribution amounts.
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Labor -
Gross Wi Taxes Fringes = d

Payltem _[Descripti Total Cost Cost|  Weight Cost| Weight| Distribution Cost| Weight| ] Price
6410100  Mobilization 513,106 51,763 0.9% $349 $588 0.9% $290 $294 0.9% $143 -
201 0102 Clearing & Grubbing 541,346 59,954 5.0% 55,379 53,331 5.0% 51,643 51,666 5.0% 5822 -
202 0183 Unclassified Excavation 590,455 520,923 10.4% 511,260 56,974 10.4% 53,441 53,487 10.4% $1,720 -
303 5512 Aggregate Base S646,510 568,717 34.2% 536,981 522,906 34.2% 511,300 511,453 34.2% 55,650
3034263  Asphalt Concrete Hot Mix Type & | 51,756,802 585,169 42.4% 545,835 528,390 424% 414,005 514,195  424% 47,003 -
[413(B) 0464 36 Inch RCP Culvert Class Il $73,220 514,114 7.0% 57,596 54,705 7.0% 52,321 52,352 7.0% 51,160

Total Direct Costs 52,621,839 $200,681 $108,000 566,894 533,000 533,447 516,500 .. 52,966,839

Unassigned Cost $300,000 550,000 530,000 $15,000

Markup 545,000 518,000 $3,000 $1,500

Total Distribution $345,000 5108,000 533,000 516,500

Target Price 52,966,839

* Top Level Cost Categories - This option uses the ten top level cost categories (labor, owned
equipment, rented equipment, supplies, materials, etc.) as the basis for establishing the

weighted distribution amounts.

| Labor Owned Equi
Item _|Descripti Total Cost Cost|  Weight] Distributi Cost| Weight] Distributi Cost| Weight] Distribution Price
6410100  Mobilization $13,106 $2,939 0.9% $1,582 $9,642 21% $2,332 S0 0.0% 50 $17,020
2010102  Clearing & Grubbing 541,346 516,657 5.0% 58,964 $23,587  5.2% 45,705 0 0.0% S0 456,015
2020183  Unclassified Excavation $90,455 534,872 10.4% 518,767 $55,583  12.2% 513,443 S0 0.0% 50 $122,665
3035912 Aggregate Base $646,910 |  $114,528 34.2% $61,635 $118,815  26.1% 528,736 $394,728  22.6% 512,431 §749,712
3034263  Asphalt Concrete Hot Mix Type A | 51,756,802 $141,949 42.4% 576,392 $235,310  51.7% 556,911 51,316,700 75.4% 541,465 | 51,931,570
413(B) 0464 36 Inch RCP Culvert Class Il $73,220 523,524 7.0% $12,660 S11,877  2.6% $2,873 $35078  2.0% $1,105 $89,857

Total Direct Costs $2,621,839 $334,469 $180,000 $454,814 $110,000 51,746,506 555,000 52,966,839

Unassigned Cost $300,000  5150,000 $100,000 450,000

Markup 545,000 $30,000 | $10,000 | $5,000 |

Total Distribution 345,000  $130,000 $110,000 455,000

Target Price 52,966,839

 Total Cost[/Billing Amount] - This option uses Total Cost as the basis for establishing the
weighted distribution amounts.
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Balanced
Pay Item  |Description Total Cost Weight| Distribution Price
641 0100 Mahilization 513,106 0.5% 51,725 S14,831
2010102  Clearing & Grubbing 41,345 1.5% 55,441 A6, TE7
2020183  Unclassified Excavation 590,455 3.5% 511,903 $102,358
035912  Aggregate Base $646,910 24, 7% 585,125 5732,035
303 4263 Asphalt Concrete Hot Mix Type A | 51,756,802 67.0% $231,172 | 51,987,974
413(B) 0464 36 Inch RCP Culvert Class Il 573,220 2.8% 59,635 SR2,855
Total Direct Costs 52,621,839 5345000 52,966,339
Unassigned Cost 300,000
Markup 545,000
Total Distribution 5345,000
Target Price 52,966,839
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3.4.2.4 Markup Options

Markup Options
Markup Pay Item by:

(® Using Weighted Distribution
() Keeping Markup with Assigned Costs

This option determines how markup is applied to pay items when establishing a balanced bid price.

e Using Weighted Distribution. Marking up Pay Items using weighted distribution takes the total
markup and proportionally spreads the amount using the chosen weighted distribution method.

Total Cost Balanced
Pay Item _ |Description Labor| Equipment| Material| Total| Weight| Distribution Price
2010102  Clearing & Grubbing 514,000 524,000 S0 538,000 4.0% 54,556 542,556
2020182  Unclassified Excavation 962,000  5172,000 S0 5234,000 | 24.8% 528,055 5262,055
3035912  Aggregate Base $112,000  $157,000 S404,000  S673,000 | 71.2% $80,689 5753,689
Total Direct Costs 5188,000  5353,000 3404,000 $945,000 5113,300 51,058,300
Markup
Markup Percent 205 10% 10%
Markup Amount 337,600 535,300 540,400  5113,300
Target Price 51,058,300

* Keeping Markup rates to Assigned Costs. This option uses the cost category amounts of all
assigned cost items and calculates the markup by applying markup percentages as defined in the
direct and indirect cost markup records. Excluding cost items from the dependency tab of the
markup record precludes the application of that markup percentage to the assigned costs on
that pay item.
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Labor Equipment Material Total

Pay Item |Description Cost] Markup|  Price cost]  Markup| Price Cost| Markup]  Price Cost| Markup] Price
2010102 Clearing & Grubbing 514,000 52,800 516,800 524,000 52,400 526,400 S0 S0 S0 | 538,000 55,200 543,200
2020183 Unclassified Excavation | $62,000 $12,400 574,400 | $172,000 517,200  $189,200 S0 S0 50 | $234,000 529,600  5263,600
3035912 Aggregate Base $112,000 $22.400 5134400 | $157,000 $15,700  $172,700 | 5404,000 540,400 5444400 | 5673000 S78500 5751,500

Total Direct Costs $183,000 537,600 $225,600  $353,000 $35,300 $388,300 S5404,000 540,400 5444400 5945,000 5113,300 $1,058,300

Markup Percentages

Labor 20%

Equipment 10%

Material 10%

3.4.2.5 Categorize Business Overhead as Indirect Cost

Categorize Business Overhead as:

(® Indirect Cost
() Markup

This option controls where cost Items with a cost segment of business overhead appear in the PBS.

¢ Indirect Cost - Business Overhead is included as a subcategory of indirect costs in the PBS.

Job Properties Pay Item & Proposal Register Price Breakdown Structure @  Cost Breakdown Structure (C
Description fssigned Unassgned  Total ?‘;‘;L ;’:;;ﬂ
~ M TargetPrice §5,263,291.67 §1,259,783.56 $5,523,075.24 100.00
v 1 Markup 50.00 $638,73242 038, 7IL 42 9.79
>\ TargetProfit $638,732.42  £638,732.42 9.7% 11.52
v jk Total Cost §5,263,291,67  $621,051.14 $5,884,342.51 50,21
~ & | Indirect Cost $0.00 §520,051.14  $520,051.14 9.51
» = Business Overhead £0.00 §340,453.76 §340,453.76 5.22
» = Job Overhead $0.00 §279,5597.38 §279,597.38 4.29
v g Direct Cost §5,263,291.67 $1,000.00 $5,264,291.67 80.70
ﬁ.i Direct Cost Items $5,263,291.67 $1,000.00 $5,264,291.67 80.70
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e Markup - Business Overhead is included as a subcategory of Markup in the PBS.

Job Properties Pay Item & Proposal Register Price Breakdown Structure ©  Cost Breakdown Structure (C
Description Assigned Unassigned Total :f‘;gﬂ ;,:i:?;ct
- ‘ Target Price $5,263,291,67 §1,259,783.56 $5,523,075.24 100.00
w % Markup £0.00 $979,186.18 $979,186.18 15.01
» |\ TargetProfit $638,732.42 $538,732.42 9.79 11.52
» = Business Overhead $0.00  4340,453.76  $34D,453.76 5.22
v g Total Cost $5,263,291.67 $230,597.38 $5,543,889.05 B4.99
w & | Indirect Cost £0.00 5273,597.38 5279,557.38 4.29
» = Job Overhead $0.00 $279,597.38 §279,597.38 4.29
v g Direct Cost $5,263,291.67 §1,000.00 $5,264,291.67 80.70
E.i Direct Cost [tems $5,263,201.67 $1,000.00 %5,264,291.67 80,70

3.4.2.6 Calculate Proposal Recap Forecast Markup

Calculate Proposal Recap Forecast Markup using:

(® Unit Markup (current) x Forecast (T/0) Quantity
(O Forecast Price - Total Cost/Billing

This option determines how the Markup is determined in the Forecast column of the Proposal Recap
data block on the Pay Item & Proposal form.

e Unit Markup (current) x Forecast (T/O) Quantity - The Forecast Markup amount is determined as
the sum of each Pay Items Unit Markup (current) multiplied by the Pay Items Forecast (T/O)
Quantity.

InEight Inc. | Release 24.7 Page 131 of 417



3.4 Library Job Properties Pricing Estimate Essentials User Guide

Proposal Recap - Training Job ® I
Current Target Forecast Variance |
Price: | $6455,450.00 | §6,523,075.24 | $6,462,850.00 | §67,625.24  ADD
Markup: $571,107.19 $638,732.42 | §631,560.32 1 §7,172.10 | ADD
Margin®e: 8.85 9.79 9.77 $1,413.30 ADD

Job Properties Fay Item & Proposal Register ©  Price

Drag columns here to group

Position . Fay ltem
= Desaipbon

10 Inch PVC Fares Main (SDR:21) Linear Fest $28.00 $336,000.00 5145 $17,550.62
24 Inch PVC Gravity Sewer (SDR3S) Linear Feet $64.00 $192,000.00 $7.96 $22,394.31
4 Foot Diameber Manhole 16.00 |Each §4,500.00 $72,000.00 448,18 §7,170.88
Struckural Excavation & Backfl B00.00 | Cubic Yard £30.00 §24,000.00 55.25 $4,200.04
Steel Renfarcement 30,000.00 [JPound 5160 $48,000.00 ($0.01) (6363.37)
Retaining Wall B50.00 ||Cubic Yard £535.00 $454, 750.00 $60.79 £51,669.32
Paint Extsting Stee Bridge Struchure. 100 JLuep Sum $100,000.00 $100,000.00 §10,913.94 §10,918.94
Process Equipment 100 |Each §1,920,500.00  §1,520,500.00 §170,356.68 §170,356.68
Removal of Underground Storage Tanks 200 [Each $12,500.00 £25,000.00 $1,571.45 £3,142.91
Disposal of Contaminated Sol 500,00 | Cubic Yard $25.00 $20,000.00 $2.25 $1,B02.45
Toll Booth 100 |Each $30,000.00 $320,000.00 §2,169.15 $2,169.15
Guardral Type 2 1,000.00 |Linear Fest §24.00 §24,000.00 (§2.06) {52,059.84)
Guardral Type 34 200.00 [Linear Fest $31.00 £5,200.00 ($2.68) (8532.14)
Type 4 Signs 1,000.00 |Square Feet $13.00 $13,000.00 $1.13) {$1,115.779
Realignment of Water Line 1.00 lEa-ch $7,000.00 $7,000.00 $7,000.00 $7,000.00
5
21 §6,455,450,00 §571,107.19

» Forecast Price Total Price - Total Cost/Billing. The markup amount is determined by subtracting
the sum of the total jobs cost based on forecast (T/O) quantities from the forecast bid price,
which is the sum of all pay item current unit prices multiplied by the pay items forecast (T/O

guantity).
‘ Proposal Recap - Training Job *
Current Targat Foracast Variance
| Price: | $6,455450.00 | $6523,07524  $6,462,850.00 = $67,625.24 ADD
Markup: £571,107.19 £638,732.42 ! ADD
Margin%: 8.85 9.79 §5,643.97 ADD
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Job Properties Pay Item & Proposal Regis @ Pric kd Structure Cost Breakdown Structure (CBS) Register
SS—— T
Position __ Pay Item T Forecast (T/0) Unitof Unit Price Tatal Price Unit Markup Total Markup un
Code = Quantity |Measure (ourrent) (ourrent) (current) (current) ﬂu
4385,300.00 4336,800.00  £370,596.05 $370,596.05
£6,120.00 $61,200.00 $1,007.30 $10,072.97
$8.50 $425,000.00 $3.04 $151,909.18
10/ Inch PVC Farce Main (SDR21) $28.00 $336,000.00 $1.46 $17,550.62
24 Inch PVC Gravity Sewer (SDR35) 3,000.00 |Linear Feet $64.00 $192,000.00 57,46 $22,394.31
4Foat Diameter Manhole 16,00 |Each $4,500.00 $72,000.00 $496.18 §7,170.88
Structural Excavaton & Backfil £00.00 | Cublc Yard $30.00 £24,000.00 5,25 £4,201.04
Steel Reinforcement 30,000.00 |Pound £L60 £43,000.00 (#0.00) (362.37)
Retaning Wal 85000 |Cublc Yard $535.00 $454,750.00 $60.79 £51,669.32
Paint Existing Steel Sridge Structure 1.00 fLump Sum £100,000.00 £100,000.00 £10,918.54 $10,918.94
Process Equipment 1.00 |Each $1,920,500.00 |  $1,920,500.00  $170,356.68 $170,356.68
Remaval of Underground Storage Tanks 2.00 |Esch $12,500.00 $25,000.00 $1,571.46 $3,142.91
Disposal of Contaminated Soi B00.00 |Cubic Yard $25.00 $20,000.00 $2.25 $1,802.45
Toll Baoth 1.00 |Each $30,000.00 $30,000.00 $2,169.15 $2,169.15
Guardrail Type 2 1,000.00 fLinear Feet $24.00 $24,000.00 (s2.08) ($2,055.88)
Guardrail Type 34 200.00 |Linear Feet $31.00 $5,200.00 (52.66) (5532.14)
Type 4 Signs 1,000.00 |Square Feet $13.00 $13,000.00 (s1.12) (51,115.77)
Reaignment of Water Line 100 |Each $7,000.00 $7,000.00 $7,000.00 $7,000.00
=+
2 $6| 462 . 850.00 $6,455,450.00 §571,107.19
Ll »
Job Properties. Pay Item & P | Price ke Cost (CBS) Register ©
Drag columns here to group
= Descripti i Forecast Unit of - Tottal Cast
Position Code = Code (T/0) Quantity Measure LiitCo:t (Forecast)

102

PRICE % ADD- 100 Lump Sum
FINANCE EXPE 100 Lump Sum
INDIRECT COS... 100 Lump Sum
DIRECT COST .. 100 Lump Sum
INDIRECT €05 .. 100 Lump Sum
JOB MAMAGEM... 1.00  Lump Sum
GENERAL EXPE ., 100 Lump Sum
DIRECT COST .. 100 Lump Sum
6410100 100 Lump Sum
2010102 1000 Ace
2020183 50,000.00 Cubic Yard
31 50,000.00 Cubic Yard
32 50,000.00 Cubic Yard
303 5012 45,000.00 Ton

41 45,000.00 Ten

4.2 400,000.00 Square Yard
43 45,000.00 Ton

4.3.1 45,000.00 Ton

43.2 400,000.00  Square Yard
303 4263 35,000.00 Ten

51 35,000.00 Ton

$46,915.38

$293,538.39 $293,538.39

$0.00 £0.00

$0.00 $0.00

$0.00 £0.00

$0.00 £0.00

$157,096.28 $157,096.28

$4,200,00 £4,200.00

$104,301.10 $104,301.10

$11,909.51 $11,909.51

$3,918.50 £39,184.97

$4.68 $233,915.81

£3.00 £149,922.88

$1.68 $A3,992.54

$15.40 $592,928.99

$1L.54 $519,513.30

£0.19 §75,848.36

£2.17 $97,567.33

$1.63 §73,460.52

$0.06 $24,106.42

$42.62  $1,491,580.59
$9.27

$5,835,106.09
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3.5 LIBRARY FOUNDATION SETUP DATA

Foundation Setup Data is where all drop-down options within Estimate fields are stored. These can
serve as category labels, alternate structures or validated tag fields. The different validated fields are
organized into tabs on this form.

Library - Estimate

Estimate Execution System Integrations Actions

B 2 2l B 8§ &L % a8 @w @

23 Equipment
Job Propertes  Foundation  Address  Trench shiftRate | Resource __ . Resource CostItem  Standard User Roles  Access Reports
- Setup Data = Book  Calculstor Calculator | Rates ~  BS Materials  Assemblies | Assemblies  Tables Control
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports -
Job Properties Foundation Setup Data Register & =
I Account Codes Tags Work Breakdown Structures Quote Group Tags Units of Measure Currencies Resource [ Assembly Files Geographic Areas Wage Zones Orgz Ly I

Drag columns here to group Find: | B2 Saved views: | Standard View - ‘

S . Grew RO gy AQmiy o
= 1001.345 Remove insulation Each U.5. Dollar 0.00 -
1010 Environmental Work Lump Sum U.5. Dollar 1.00
1019.234 Remove heater piping Each U.5, Dollar 1.00
1020 Mobilization Each U.S. Dollar 1.00

You should be aware of these category labels:

Category Labels

Name Definition

Account These codes will be set up on the back end and will help you compare your
Codes cost and production rates to similar cost items in past projects.

Tags Some tags are already set up for you. Additional tags can be created and used

to group and filter your items.

Work Use this format when you need to have multiple variations and summary

Breakdown reports of an estimate. WBS retains the same relationships between items as

Structures in the original estimate and only changes the view and how items are arranged
in hierarchy.

Units of These are standardized to relate to one another by a conversion factor. If you

Measure need to create a new unit of measure, you will need to reference it to a base

unit of measure and can include a conversion factor to allow you to convert
back and forth between English and Metric.

Currencies The default currency is set to U.S. Dollar, but you can also enter the exchange
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Category Labels

rate for other currencies (such as Canadian) so you can estimate with
whatever currency you need. Multiple currencies can be used in the same
project. The system base currency can be changed from USD in the
backstage view settings, but is a global change for the entire estimate
environment.

Currency - Exchange Currency Positive Currency Megative Currency Dedimal
Mame = Rate Symbaol Format Format Symbol
CMD Dallar 1.00000 g1.1 (51.1) Period (.}

When you create a new job folder, all category labels defined in the Library Foundation Setup Data
Register will be copied to the new job folder automatically.

3.6 RESOURCES

VIDEO | Create a Unique Resource

InEight Estimate refers to labor, equipment and material items as Resources. You will use these
resources as the basic building blocks used to detail the costs in your estimates.

InEight Estimate organizes resources into seven types:

Resources

Name Description

Labor The human resources that perform direct or indirect work. Direct labor is
typically classified by trade (e.g., pipefitters, electricians, iron workers) and
title (e.g., foreman, journeyman, laborer).

Construction Owned construction equipment.
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Resources

Equipment

Rented Construction equipment rented from a third party.

Construction

Equipment

Installed Materials that will remain installed on site after the project is completed, (e.g.,

Materials concrete, piping, aggregate).

Installed Equipment that will remain installed on site after the project is completed,

Equipment (e.g., boilers, heat exchangers, vessels, cooling towers).

Supplies Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Unique Resources that are of a “unique” nature and do not fit well into the other types

(e.g., dump fees, hauling charges and equipment rented by the month).

After creating a new job folder, you can import a filtered set of resources from the Library into the new
project. This is done on the Cost Basis tab of the Job Properties form.

In the following section, you will learn more about the resources stored in your Library in the Library
Resource Rate Register.

3.6.1 Library Resources Register

To open the Library Resources Register, select Labor from the Master Resources ribbon.

Estimate System Developer Tools Integrations Artions

m o B %W &dE g6~ % AE @1t @

22 Equipment

Job Properties  Foundation  Address  Trench shift Rate | Resources ) Resource CostItem Standard User Roles  Access Reports
- Setup Data ~ Book  Caloulator  Calculator - fRS Materials  Assemblies | Assemblies  Tables Contral
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports
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Overview - Library Resource Rate Register

T T

1 Tabs There are tabs along the top of the form for each of the seven resource
types, in addition to an Alltab that holds the resources of all types.

» Notice that you are on the Labor Tab

2 Resource Each record (or row in the register) represents a single resource.
Code

3 Description  The Description provides more detail about the resource.

4 Resource This is the resource cost per unit.

Rate per
Unit

5 Utilization Tells you how many units of that resource are being used in the job.
Count

6 Unit of Each resource is defined with a Unit of Measure.
Measure

7 Register This register includes columns for the resource attribute categories so you

can filter and group your resources.
Cost Breakdown Structure (CBS) Register Job Properties Resource Rate Register © =

Al Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies Unique I

to group e e e Find: Ee Saved views: eous View -

Resource _ Description Unit Cost Unit Cost Unit Cost Utilization Unit of Resource File Wage Organizational
Code (Scale 1) (Scale 2) (Scale 3) Count Measure Description Zone Category
= |+ LCt Carpenter Apprentice £37.48 £41.22 £54.96 534,37 fHour Standard Labor Rate... Wage Zone A Carpenter -
+ LC2 Carpenter Journey. .. $28.92 $43.38 $57.84 1,188.73 Hour Standard Labor Rate... Wage Zone A Carpenter
+ LC3 Carpenter Foreman £31.47 $47.20 £62.94 594.37 fHour Standard Labor Rate... Wage Zone A Carpenter
+ LF1 Finisher Apprentice £26.80 £40.20 £53.60 0.00 fHour Standard Labor Rate... Wage Zone A Finisher - Concrete
+ LF2 Finisher £28.07 £42.10 £56.13 534,37 fHour Standard Labor Rate... Wage Zone A Finisher - Concrete
+ LF3 Finisher Foreman £32.32 £48.48 564,64 0,00 §Hour Standard Labor Rate... Wage Zone A Finisher - Concrete |
25 27,257.30

Source Job and Source System name fields
The Source Job field provides visibility into the jobs from which the data may have originated from.

The Source System Name helps to see the source of the data when integrating with other systems.
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Resource Type Eszzurce Source Job gizgfn =
MName
+ Construction Equipment Rate EMTE Library System
+ Installed Material Rate MDIRTE Library System
+ Construction Equipment Rate ETOT Library System
+  Supply Rate SFM Library System
+ Supply Rate SFH Library System
+ Installed Material Rate MPD16 Library System

TIP Resource rate add and search tips:

e You cannot add new resources on the All tab.

» You can search for resources in the Resource Rate Register using the ‘Find’ field.

Next you will take a look at the different types of resources and how they differ when we drill into
resource rate records from each category.

3.6.2 Labor Resources

Looking at your Labor resources more closely, you will see all the Resource Codes for the Labor
resources begin with an L. This is a best practice for naming and organizing your resources, but you can
also use another organizational method of your choice.

3.6.3 Resource Rate Record

If you need to add cost to a resource, adjust a rate, or just view a more detailed breakdown, you can
open the resource’s rate record. From the Library Resource Rate Register, double click on the row
header for the resource you need to view in greater detail.
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Double click on the
row header to open

resource rate record Reszource File Unit of Productivity
Description Measure Factor
: Carpenter Apprentice | Standard Labor Rate... m
+ LC1 Carpenter Apprentice  Standard Labor Rate...  Hour 1.00
+ LC2 Carpenter Journey... Standard Labor Rate...  Hour 1.00
+ LC2 Carpenter Journey... Standard Labor Rate...  Hour 1.00
+ LC3 Carpenter Foreman Standard Labor Rate...  Hour 1.00

Overview - Resource Rate Record

I T

1 Record The record references the resource you are editing.

2 Charge Rate The Charge Rate tab is the tab the record defaults to and is where you
define the cost of the resource.

3 Scale Buttons The Scale buttons only show up on labor resources. They are used for
defining regular time, overtime and double time rates for the resource.

4 Cost The Cost Category Breakdown is where you enter the costs for the
Category resource. The categories will depend on what type of resource itis (e.g.,
Breakdown equipment resources will have equipment cost categories and materials

will have material cost categories).

5 Special The right side of the record will have additional options to help you define
Instructions/  the rate. These options change depending on what type of resource it is.
Base Wage
Factors
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Resource Rate Register Labor Rate Record © =

ICode: * Lt Description: |Carpenter Apprentice n

Setup | *Charge Rate BﬂgRate

I Scale 1 | Scale 2 | Scale 3 ‘ All Scales Ie Special Inst s
UsetheMaterials cost category to add additional laborcost
Cost Category Breakdown Amount €«> Percent | Is Taxed Is Insured formaterials andsupplies.
~  Total -_— Waorker's Comp values for this resource can be adjusted
«  Labor Varies automatically when this resource iz employed in ajob,
- based on the geographic location of the work, and the
Labor Base Varies Worker's Comp Override listed on the Cost Item on which
+ | Labor Burden Varies the resourceis employed.
> Labor Fringes Varies standard Worker's Comp Ovarrides can be defined in the
»  Labor Insurance Varies Library's Foundation Setup Data Register.
» | Labor Taxes Varies Base Wage Factors for Overtime
Undefined Labor B... .00 € 0.00
%0 [] Use Base Wage Factors for Scales 2 and 3
Undefined Labor £0.00 € 0.00
» | Materials 40,00 Scale 2 Factor: x Base Wage
Undefined .00 Scale 3 Factor: xBase Wage

This option multiplies the Scale 1 base wage by the factors
entered here to automatically calculate the base wage for
Scales 2 and 3.

I T S

6 Setup There is also a Setup tab where you can define the resource’s attributes, plus
other settings. These attributes are used for filtering which resource rates to
load into a new estimate.

7 Cost Labor resources default Cost Driver is Cl Duration which means their costs
Driver are driven by time.

8 Default ~ The Default Quantity is typically set to 1 for most cases if you are bringing in
Quantity  the resource you are using at least one.

ISen.u:l B:hargeRatE | Biling Rate ‘

Resource File: | Standard Labor Rate File - |
Geagraphic Area: | Southwest - |
Wage Zone: | Wage Zone A - |
Org. Category: | Carpenter - |
Account Code: | r./l

I Cost Driver: | CI Duration -
Cost Curve: | Employed Cost Item - |

Tag 1: | Mon Union - |

Tag 2: | Hourly - |

g3 | ]

Productivity Factor:

[DeFault Quantity: | 1.00'9

Currency: | U.5. Dollar -

Page 140 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 3.6 Resources

The following steps walk you through how to create a new labor resource.

Step by Step — Create a Labor Resource

1. From the Library landing page, on the Setup tab, click on Resource Rates from the Master
Resources section.

al B @ T4

Resource CostItem  Standard User Roles  Access Reports
Assemblies  Tables Control

Master Assemblies | Roles and Permissions | Reports

e The Library Resource Rate Register opens

2. Select the Labor tab.

w

Right click on any row header and select New.
¢ A new Labor Rate Record displays

In the Code field, type L + [your initials].

Press the Tab key.

Fill in the Description field.

N o g &

Click on the resource’s Setup tab and select Standard Labor Rate File from the Resource File
drop-down list.

8. Select a location for the Geographic Area.
9. Select Wage Zone A for Wage Zone.
10. Select a labor type for the Organizational Category.
11. For Tag 1, select a code.
12. For Tag 2, select a code.
13. On the Charge Rate tab, enter a dollar value for your Labor Base.

14. Expand Labor Burden and under Labor Fringes, type in a dollar value for Pension and
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Subsistence.

Resource Rate Register Labor Rate Record @

Code: * |LMECHINEIGHT | Description: |Mechanic - Heavy Duty

Setup ﬁ, Charge Rate Billing Rate

Scale 1| Scale 2 Scale 3 All Scales

Cost Category Breakdown Amount <> Percent

w Total £57.00
w  Labor £57.00
Labor Base £52.00
w  Labor Burden £5.00
w Labor Fringes £5,00

Travel &0.00 €« 0.00

Premium 50,00 < 0,00

Holiday £0.00 €« 0.00

Savings £0.00 €« 0.00

| Pension $3.00 | € 577

Vacation £0.00 < 0.00

| Subsistence £2.00 | = 3.85

Health & Welfare &0.00 €« 0.00

15. Define an overtime and double-time rate for the resource. Select the checkbox for Use Base
Wage Factors for Scales 2 and 3.

16. Set the Scale 2 Factor to 1.50 x Base Wage and Scale 3 Factor to 2.00 x Base Wage.

Base Wage Factors for Overtime

\¥| Use Base Wage Factors for Scales 2 and 3
Scale 2 Factor: 1.50 x Base \Wage
Scale 3 Factor: 200 x Base\Wage

This option multiplies the Scale 1 base wage by
the factors entered here to automatically calculate
the base wage for Scales 2 and 3.
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17. Click OK, to close the record.

3.6.4 Construction Equipment Resources

¢ Similar to Labor Resources, Construction Equipment Resources are also duration driven
resources by default

¢ They contain cost categories for ownership and operation costs

Resource Rate Register ©

Al | Labor | Construction Equipment | Rented Construction Equipment | Installed Material | Installed Equipment | Supplies | Unique

Drag columns here to group Find: «|  Saved views: | Previous View

G| Desarpton Do s e e i e e A - S =
= + EARAV Asphalt Paver Standard Equipment Rate...  Hour .00 .00 §53.40  U.5. Dollar 0.00 Asphalt e

+ EARL Asphalt Roller Standard Equipment Rate...  Hour .00 .00 $21.00 U.5. Dollar 0.00 Asphalt

+ ECOMP1 Compactor Smooth D... | Standard Equipment Rate...  Hour .00 .00 §7.00  U.5. Dollar 0.00 Compactor

+ ECOMP2 Compactor Sheeps F... | Standard Equipment Rate...  Hour .00 .00 $28.00 U.5. Dollar 0.00 Compactor

+ ECR110 Crane 110 Ton Standard Equipment Rate...  Hour 1.00 1.00 §196.00 L., Dollar 0.00 Crane

+ ECRET Boom Truck 15 Ton Standard Equipment Rate...  Hour 1.00 1.00 $28.00 U.S. Dollar 0.00 Crane

+ ECRHC Hydraulic Crane 25 Ton | Standard Equipment Rate...  Hour .00 1.00 §84.00 | U.5. Dollar 0.00 Crane

+ ED§ Dozer D& Standard Equipment Rate...  Hour .00 100 §84.00 | U.5. Dollar 0.00 Dozer

+ ED8 Dozer D& Standard Equipment Rate...  Hour .00 100 §140.00 ' U.S. Dollar 0.00 Dozer

+ EGI4G Grader 146 Standard Equipment Rate...  Hour .00 100 §35.00 | U.5. Dollar 0.00 Grader

+ EGI60H Grader 160H Standard Equipment Rate...  Hour .00 100 $§91.00 | U.5. Dollar 0.00 Grader

These resources are the fleet of construction equipment that you own.

3.6.5 Rented Equipment Resources

These resources represent the construction equipment that you rent.
¢ Rented Equipment Resources are also duration driven resources by default
¢ Contain cost categories for rental and operation cost as well as additional fees
¢ On the Rental Construction Equipment Record, you will notice a new tab named Quote
¢ Quotes will be discussed in detail in Lesson 8 — Quote Management

¢ You will also note the Tax section. You can check the box to Apply Standard Tax, which pulls the
Sales Tax percentage defined on the Cost Basis tab in Job Properties, or you can manually specify
a unique sales tax rate

Tax
Apply Standard Tax
Unique Sales TaxRate:  0.00 %
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Step by Step — Create a Rental Equipment Resource

1. Open the Library Resource Rates Register.
2. Select the Rented Construction Equipment tab.

3. Right click on any row header and choose New; a new Installed Rented Equipment Rate Record
displays.

4. In the Code field, type RECR + [your initials], then press Tab.
5. In the Description field, type Crane 110 Ton.

6. Click on the resource’s Setup tab and select Standard Rental Rate File from the Resource File
drop-down list.

7. Select a resource from the Organizational Category drop-down list.

Code: ®* |RECR110 Description: [Crane 110 Ton

Setup ﬁ, Charge Rate |:_| Quote Billing Rate

Resource File: | Standard Rental Rate File - User Defined 1: |
Geographic Area: - User Defined 2: B
Wage Zone: - User Defined 3: B
Org. Category: | Crane - User Defined 4: B
Account Code: o User Defined 5: |

T amt Diriarars T M=o - Ilmmar Tiafinad £ |:

8. Move back to the Charge Rate tab to follow the step by step on the next page.

3.6.6 Equipment Consumption Rates

The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define on the Library Job Properties > Fuel
Cost tab to give a fuel cost for your equipment rate.
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Job Properties Construction Eguipment Rate Record © -

Code: * |EAPAV Description: |Asphalt Paver

Setup ﬂ, Charge Rate Biling Rate

Fuel

Cost Category Breakdown Amount
v | Total £199.00 & Fuel Type Consumption Rate
v  Owned Eguipment £199.00 Gasoline - 12.00| GallonfHour
»  OE Ownership §0.00 -
~ OQEO) i 199.00 :
peration $ Consumption Rate factored
CE Repair Parts $0.00 with cost per liter gives you a
OE Repair Labaor 0,00 fuel cost
I O Fuel $144.00 I O Auto ate Maintenance Labar
CE Lube $0.00 Man-Hours for this resource

The below figure shows where consumption rates are defined on the Construction Equipment
Resource Rate Record.

3.6.7 Non-Hourly Rate Calculator

For owned and rented construction equipment, the rate entered must be hourly. If your rate is weekly
or monthly, you can use the Non-Hourly Rate Calculator on the Construction Equipment Resource
Record to come up with the hourly rate.

Step by Step — Non-Hourly Rate Calculator

1. Refer back to your last entry's rate amount. Under Non-Hourly Period Charge Rates on the right,
check the Calculate Non-Hourly Period Charge Rates checkbox.

On the resulting prompt, click OK.
In the Period field, select Weekly.

In the Amount Per Period field, type in a number value.

o & 0N

Type in a number of hours in the Hours Per Period field.
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Non-Hourly Period Charge Rates
V| Calculate Non-Hourly Period Charge Rates for
RE Rental
Period: | Weekly ||
Amount Per Period: $4.000.00
Hours Per Period: 20.00
Code: * |RECR110 Description: |Crane 110 Ton

Setup ﬁ, Charge Rate |1_,_| Quote Billing Rate

Cost Category Breakdown Amount
« Total £200.00
» Rented Equipment £200.00
» Fees £0.00
Undefined 20,00

6. Click OK to close the record.

3.6.8 Installed Materials, Installed Equipment & Supplies Resources

e Comparing the Installed Material & Equipment resources to those covered so far, you will note
that the unit of measure is not Hour for materials, but it is specific to the kind of material. It is a
guantity-driven resource, as opposed to duration-driven like your labor and equipment
resources

¢ You will also note the tax field can pull your standard tax settings from the Cost Basis tab in Job
Properties, or a unique sales tax rate can be manually entered in each record

e On record for these resource types, you will notice a new tab named Quote. This tab shows up
here because you may have to shop around and get quotes for these resources

e Quotes will be discussed in detail in Lesson 8 — Quote Management
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* In the Setup tab you will see a field named Waste % Add-on. Here you can account for
approximate waste percentages

¢ Cost categories will differ on each type of resource record

Job Properties Resource Rate Register ©

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies

Drag columns here to group

e Despto ihCost | Utkmten | kol | B
=i © Asphalt Mix (Finish) $32.50 0.00 Ton Standard Material Rate...
. + MAC . &sphalt Cement £195.00 0.00 Ton Standard Material Rate. ..
+ MACA1-1/2 Coarse Aggregate 1-1/2In £9.10 0.00 Ton Standard Material Rate. ..
+ MAFA Fine Aggregate £7.80 0.00  Ton Standard Material Rate. ..
+ MAHALL Aggregate Haul Quarry to P... £2.60 0.00 Ton Standard Material Rate...
+ MAIAZf4 Intermediate Aggregate 3/4... £10.40 0.00  Ton Standard Material Rate. ..
+ MASAND Sand £7.30 0,00 Ten Standard Material Rate. ..
+ MATK Tack £1.30 0.00 Gallon Standard Material Rate...
+ MER Aggregate Base Rock £3.45 0.00  Ton Standard Material Rate. ..
+ MC2000 Concrete 4000 PSI £110.50 0,00 Cubic Yard Standard Material Rate. ..
+ MC3500 Concrete 3500 PSI £104.00 0.00  Cubic Yard Standard Material Rate. ..
+ MDIRTA Dirt Class A §1.30 0.00  Cubic Yard Standard Material Rate...
+ MDIRTE Dirt Class B £5.50 0,00 Teon Standard Material Rate. ..

Above is an example of the Installed Material tab in the Library Resource Rate Register.

The following steps walk you through how to create a new material resource in InEight Estimate.

Step by Step — Create an Installed Material Resource

1. Select Resource Rates from the Library landing page.
¢ The Resource Rate Register displays

2. Select the Installed Material tab.

w

Right click on any row header and select New from the drop-down menu.
¢ A new Installed Material Rate Record displays

In the Code field, type MGBP + [your initials], then press Tab.

In the Description field, type Brick Pavers.

Select a unit of measure from the Unit of Measure drop-down list.

N o g k&

On the resource’s Setup tab, under Resource File select Standard Material Rate File.
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8. On the Charge Rate tab, expand Materials and enter a number value in the Installed Materials

Amount field.

Code: * |MGBPPB Description: |Brick Pavers

Setup ﬁ, Charge Rate l_,,__l Quote Biling Rate

Cost Category Breakdown Amount
~ Total £5.00
-
Installed Materials £5.00
Undefined Materials €0.00
» Fees £0.00
I A~ B~ I Tyl

9. Click OK to finish adding this resource.

3.6.9 Unique Resources

The Unique resource type is a catch-all and can be used for anything from dump fees and security to

creating subcontractors as a resource.

e The Unique resources are the only resources that have all cost categories available, as well as all
units of measure
¢ You will also note the tax field which can pull your standard tax settings from the Cost Basis tab

in Job Properties, or a unique sales tax rate can be manually entered in each record

¢ Quotes will be discussed in detail in Lesson 8 — Quote Management
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3.7 RESOURCE ASSEMBLIES

A Resource Assembly is a group of resources. You can create an assembly once and then reuse it as
needed in multiple cost items whenever the same combination of resources is needed.

Library - Estimate

Estimate Execution System Integrations Actions

ry
0 ¢ 2] B @W & 2> || al B @1
- ! = = - 23 Equipment
Job Properties  Foundation  Address  Trench shiftRate | Resource Resource CostItem  Standard User Roles  Access Reports

SetupData *  Book  Calculator Calculator | Rates ~  io Materials | Assemblies | Assemblies  Tables Contral

Master Initialization Master Resources Master Assembliﬁ; Roles and Permissions Reports

The most common use for an assembly is to group labor resources into crews (e.g., Pipe Crew,
Concrete Crew); however, any resource (equipment, materials, etc.) may be grouped into an assembly.
Utilizing assemblies allows you to estimate faster, since you can add and manage an entire group of
resources at once.

You can create assemblies in the Library and import them into job folders the same way you import
resources.

3.7.1 Library Resource Assembly Register

To open the Library Resource Assembly Register, select the Library icon, then select Resource
Assemblies from the Master Resources section of the Setup tab.

Overview - Library Resource Assembly Register

1 Each row in the register represents a single resource assembly and is defined with
an Assembly Code and Assembly Description.

2 Each assembly can be expanded by clicking the plus [*/icon next to its Assembly
Code.
3 Expanding an assembly reveals the list of resources that make up that assembly.

» Best practice for creating Assembly codes is to use C for Crew Assemblies, M
for Material Assemblies, etc., however you can have labor, equipment, and
materials in the same assembly
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Resource Assembly Register @ -
Drag columns here to group Find: Saved views:
de = | Descripton - Quentty ST umbcost  TotlCost  Cumency | Oroemzatenal  Congophic Mg Ven
> CCONC Standard Assembly... 1.00 | Hour - -
quntty (LS, wntcost cener DR RERre
= 1 Lc2 Carpenter Journeyman 2.00 Each $28.92 U.5.Dollar  CIDura.. Standard Labor Rate File Carpenter Southwest = Wage Zon...
2 LF2 Finisher 100 Each $28.07 U.S. Dollar CIDura... Standard Labor Rate File Finisher - Conc...  Southwest = Wage Zon...
3 w1 Tron Worker 1.00 Each $35.55 U.5. Dollar CIDura... Standard Labor Rate File Tron Worker Southwest ~ Wage Zon...
e 4 uz2 Laborer 100 Each $26.37 .S, Dollar CIDura... Standard Labor Rate File Laborer Southwest = Wage Zon...
5 ECRHC Hydraulic Crane 25 Ton 1.00 Each $84.00 L.5. Dollar CIDura... Standard Equipment Rate... = Crane
6 LC1 Carpenter Apprentice 100 Each $27.48 .S, Dallar CIDura... Standard Labor Rate File Carpenter Southwest = Wage Zon...
7 L02 Operator Class 2 1.00 Each $30.21 U.5. Dollar CIDura... Standard Labor Rate File Operator Southwest | Wage Zon...
8 ETFT Flatbed Truck 100 Each §7.00 .S, Dollar CIDura... Standard Equipment Rate... = Truck
0 9 LC3 Carpenter Foreman 1.00 Each $33.87 U.5. Dollar CIDura... Standard Labor Rate File Carpenter Southwest  Wage Zon...
CGRADE Grading Crew Standard Assembly... 1.00 Hour $175.06 $175.06 U.S. Dollar Earthwork
| + CMAINT Eguipment Maintenance Standard Assembly. .. 1.00 Each £58.00 §58.00  U.S. Dollar Mechanic | %
+ CPAVE Pavina Crew Standard Assemblv... 1.00  Hour $346.04 $346.04  U.S. Dollar Asphalt

3.7.2 Resource Assembly Record

To open an existing Resource Assembly Record, right click on the row header of an assembly (row) on
the Resource Assembly Register and select Open.

Overview - Resource Assembly Record

I T S

1 Assembly
Code and
Description

2 Quantity
and Unit of
Measure

3  Assembly

Details

4 Notes
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Each assembly is defined with an assembly Code and an assembly
Description.

Each assembly has a quantity and unit of measure. The defaultis 1 EA.
For crew assemblies with all hourly duration driven resources, it is a best
practice to change the Qty to Hour, so that when used on a cost item, it
will show you the assembly’s unit cost per hour.

The rows in the Assembly Details register represent the resources that
make up the resource assembly.

An area where the estimators make notes for records related to the
resource assemblies for work orders which is commonly performed by a
type of crew.

InEight Inc. | Release 24.7



Estimate Essentials User Guide 3.7 Resource Assemblies

Register bly Recos (2] -
~ 1 T |
| Code:  |CCONC Description: |Concrete Crew I | Qty:

Resource File: | Standard Assembly File Tag 1: - UM: | Hour -
Geographic Area: - Tag 2: - Unit Costz $330.38
‘Wage Zone: - Tag 3: - Currency: | U.S. Dollar -
Org. Category: | Concrete «|  MancCount: 8.00 Last Changed By:
Equip Count:  2.00 e Last Changed On:
Notes:

CostSummary | Assembly Detas

Drag columns here to group Q Find: | [SearchFor...] Saved views: | Previous View -

et B omoen  cwwy MU o cmee QR NS Qummird | coopotic |
> 1 Lc2 Carpenter Journey... 2.00 Each $28.92 U.S. Dollar CI Duration Standard Labor Rate File Carpenter Southwest Wage Z
2 LF2 Finisher 100  Each $28.07 U.5. Dollar CI Duration Standard Labar Rate File Finisher - Concrete Sou%est \Wage Z
3 w1 Tron Waorker 1.00 | Each §35.55  U.S5. Dollar CI Duration Standard Labor Rate File Iron Worker Southwest Wage Z
PRETE L2 100 Each $2537 11 Dol £1 Duirat tandard | ahor Date El Lah thuact ™

3.7.2.1 Productivity Rate Indicator in the CBS Register

The Productivity Indicator shows the field that contains the as-entered value and is driving the
estimate for that cost item. This appears as an arrow aligned to the left of the cell as shown below.

erwcripton ::‘-:'l:-\.:‘\:r".- ::l::r 1 Coit :lu:n‘-:'r Currancy ?:::wa-.-r—_- ;‘::uuw:‘ ]

i Wb e B, HHLYT 4 AT M UL, Doler LN IR ] (L% 1
Frime Bl L0 Lump Sum [ 3 LN o) 505700 (05, Doler

Frice % Add 0w L20  Lump Gum HI5 515 71 KI5 TE U5, Doler

e Fnanc g L0 Lump fum K00 000 5. Doler

Indirret £oal Escalation L0 Lump Sum 500 $0000 1.5, Dxlar

Drect Cosld | ecalainsn LA Lumsp Sum B A0 L. Doler

Inadirsert Coat Akl -Com LO0  Lump Sum [ =Xec] B0 105 Doler

Dok Mlanagranesd & | guigsment L20  Lump Sum BIST.00e 1 BIST056. 18 L5, Doler QD 9.0
Lenersl | apense L0 Luep Gum 4, 0000 #0000 LS, Dolar Qoo .00
Direct Coal Add-On LO0  Lume Sum 8, 7003 EAC. TN 3E 108, Dolar

skl i

| Unsclssadfurd | urawatuos 5000000  Cubs Yarsd | BN BLEE 58040 UL, Doler TFLET .09
Excaeaton S0.000.00  Cubse Yard B §13, 000080 1.5, Dolar 100 .00
Embarkment 50,000.00 Cubse Yard §L53 T ASLED 1.5, Dolar AT .00

Being able to see productivity drivers on the CBS register makes it easier to review and modify the
estimate as a whole while reducing the potential to accidentally overwrite a manually entered data.

Follow the step by step below to create a Resource Assembly.

Step by Step — Create a Resource Assembly

1. From the Library landing page, under the Master Resources section of the Setup tab, select
Resource Assemblies.
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¢ The Resource Assembly Register is shown.
2. Right click on any row header and select New from the drop-down menu.
¢ A new Resource Assembly Record is shown.
In the Code field, type CEXC + [your initials] as the unique code for the assembly.
4. Add a description in the Description field.

In the Assembly Details register at the bottom of the screen, click in the Resource Code column
in the first blank row, and then select the Resource icon that appears in the cell.

6. On the Labor tab of the resulting register, select the resource with the Description: LL2Laborer
and click OK to add this resource to the assembly.

7. Add two additional resources.

TIP You can use the Ctrl and Shift keys to select multiple resources at once.

8. Click OK to save and close the new assembly.

Resource Assembly Register &

Drag columns here to group

Code = Description EF; Eir;;ipﬁun Quantity I‘Elﬂgi;sn:re ]
+ CCONC Concrete Crew Standard Assembly... 1.00  Haour

Grading Crew Standard Assembly... 1.00  Haour
+ CMAINT Equipment Maintenance Standard Assembly... 1.00 Each
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Exercise 3.1 — Create Resources & Resource Assemblies

In this exercise, you will practice creating resources and assemblies in the InEight Estimate Library. In
the Library Resource Rate Register, create resources with the following variables:

Labor Resource

Resource Code LSFA Wage Zone Wage Zone A
Resource Field Organizational Supervision
Description Administrator Category

Geographic Area Southwest Scale 1 Labor Base $33.45

Scale 1 Premium 2 percent Scale 1 Subsistence $0.47
Resource File Standard Labor Rate File

Select the checkbox for Use Base Wage Factors for Scales 2 and 3.
Scale 2 Factor: 1.50 x Base Wage. Scale 3 Factor: 2.00 x Base Wage.

Rented Construction Equipment Resources

Rented Construction Equipment Resource

Resource Code  RPW3000 RE Rental Amount $3.40
Resource Pressure Washer 3000  Organizational Clean & Inspect
Description PSI Category

Resource File Standard Rental Rate File

Installed Material Resource

Resource Code MCCB Installed Materials Amount $300.00
Resource Pre-Cast Concrete Organizational Category Concrete
Description Catch Basin

Resource File Standard Material Rate File

Unit of Measure Each

Uncheck the box for Apply Standard Tax and enter a Unique Sales Tax Rate: 6%
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In the Library Resource Assembly Rate Register, create resource

assemblies with the following codes, descriptions, and resources.

Assembly #1
Assembly Code CBRIDGE
Assembly Description Bridge Crew
Resource File Standard Assembly File
Unit of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity
LC3 Carpenter Foreman 1
LL2 Laborer 2
LF2 Finisher 1
LC2 Carpenter Journeyman 2
Assembly #2
Assembly Code CRIPRAP
Assembly Description Rip Rap Replacement Crew
Resource File Standard Assembly File
Unite of Measure Hour

Select Wage Zone A Labor Resources for this Assembly.

Resources on Assembly Resource Description Resource Quantity
LT2 Teamster Foreman 5

LO3 Operator Class 3 1

LL2 Laborer 2

EX510 Backhoe JD 510 1
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ETPU
EL950

Exercise 3.1 — Create Resources & Resource Assemblies

Assembly #2 (continued)

Pickup

Loader 950

You should end up with similar results:

Resource Resource File Organizational Geographic Wage - Unit of
Code =Y Description Category Area Zone Descnohion Measure
— LSFA Standard Labor Rate File  Supervision Southwest Field Administrator Hour
Scale = Total Labar Labor Base  Labor Burden | Labor Fringes
Y 1 43392 §33,92 £33.45 £0.47 £0.47
2 £50.18 £50.18 £50.18 £0.00 £0.00
3 $56.90 $56.90 £56.90 £0.00 £0.00
Resource - Resource File Unit of Unit Cost Organizational
Code 7 ||| Desaription “! Description E Measure | (Scale 1) T Currency Category =
(=] RPW3000 Pressure Washer 3000 PSI Standard Rental Rate File |Hour $3.40|U.S. Dollar | Clean & Inspect
Total Rented Equipment RERental RERentExpense RE Overhead RE Finance Expense RE Insurance RE License RY
» $3.40 §3.40 $3.40 $0.00 $0.00 §0.00 $0.00 $0.00
Resource ’ Descrinti Resource File Unit of Unit Cost o Organizational
Code ESaD R Description Measure {Scale 1) =y Category
[=] Mcce Pre-Cast Concrete Catch Basin |standard Material Rate File | Each | £318.00 | .S, Dollar |Cor1crehe
Total Materials Installed Materials  Undefined Materials Fees  Sales Taxes  Undefined Fees  Undefined  Biling Rate E.:!I:E
b $318.00 $300.00] $0.00| $300.00| $18.00 $18.00| s0.00)  s0.00)  $318.00
Find: | [Search For...] [s+]| Saved views: Previous View E]
Resource - Unit of - Organizational Geographic wa
FleDesaipton =] Quantty [~] ol Unit Cost |~ | Total Cost [~ | Currency [~ | 20 v pres 25
Standard Assembly File 1.00 | Hour $170.11 $170.11|U.5. Dollar
Row Resource s . Unitof = Cost Resource Organizational Geographic Wage
Number Code Desaiption QuaNttY peagye UnitCost Curency Driver File Desaription Category Area Zone
» 1/LC2 Carpenter Journeyman 2.00 Each $28.92|U.5. Dollar CI Duration | Standard Labor Rate File Carp th Wage Zone A
2/LC3 Carpenter Foreman 1.00 Each $31.47 U.S. Dollar CI Duration | Standard Labor Rate File Carpenter Southwest  Wage Zone A
3|LF2 Finisher 1.00|Each $28.07/U.S. Dollar | CI Duration |Standard Labor Rate Fie Finisher - Concrete | Southwest | Wage Zone A
4/LL2 Laborer 2.00 Each $26.37|U.5. Dollar CI Duration | Standard Labor Rate File Laborer Southwest |Wage Zone A
Code = Y  Desciption ':if:‘;';;mﬁm Quantity bnitof Unit Cost Total Cast Currency S;ﬂ:;‘ﬁ""a‘ CTRE e
— CRIPRAP Rip Rap Replacement Crew Standard Assembly. . 1.00  Hour $152.89 $152.89 U.5. Dollar
M =B oo oy it o e == ==
= 1 U2 Laborer 2.00 Each $26.37 U.5. Dollar CI Duration Standard Labor Rate File Laborer Southwest ~ Wage Zon.
2 Lo3 Operator Ciass 3 100 Each $3062 US.Dolar | CIDuraton  StandardlaborRateFie  Operator Southwest | Wage Zon..
3|2 Teamster Foreman 0.50 Each 432,32 U.S. Dollar CI Duration Standard Labor Rate File Truck Driver - Teamster  Southwest = Wage Zon...
4 EL950 Loader 950 1.00 Each $14.18 U.S. Dollar CI Duration Standard Equipment Rate...  Loader
5 ETPU | Pidup 100 Each $420 U.S.Dolar | CIDurston  Standard EquipmentRate... Truck
& EX510 Backhoe 1D 510 100 Each $35.00 U.S. Dollar CI Duration Standard Equipment Rate... Excavator
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Congratulations, you have completed this exercise!

3.8 IMPORTING RESOURCES

The following procedures inform you how to setup resources in InEight Estimate from an excel sheet.

e =0 Use of this lesson will draw from other sections of InEight Estimating Manual. Basic
understanding of the Sort, Group, Filter, Excel integration functionality in InEight Estimate

is required.
3.8.1 Open Resource Rate Register

You can create resources within the Resource Rate Register. This is the location to build out the
structure of those resources.

Step by Step — Opening the Labor tab

1.
2.
3.
4,

Open the Job Folder or Library that you’re going to be working in.
From the Ribbon, select the Setup tab.
Under the Resources section, select Resource Rates. The Resource Rate Register opens.

Select the tab you want to add resources to.

Estimate Quote Price Execution System
S print @ tew Copy Link Field /’ W W P2 resowce Utiization ‘lﬁ
=1
B Preview Delete I Paste Unilnk Field ” . £ Resource Cost Detalls —
Expand /|  Filter  Clear Copy Job Re
& Bxport to Excel Cut Fill Down Collapse ~ = Filter to Librz
Print Edit Workbook View
Job Properties Resource Rate Register ©

Al Cpnslrucﬁun Equipment | Rented Construction Equipment | Instaled Material | Installed Equipment | Supples | Unigue
Drag columns here to group

Resource Desopon B Unit of Productivity Default ‘Waste % Uit Cost Unit Cost
Code Measure Factor Quantity Add-gn (5cale 1) (5cale 2)

The layout of this register and excel file is up to the organization and the decisions that are made
during the detail design phase. A basic excel file will be provided to your organization as a starting
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3.8 Importing Resources

point to work from. If that can’t be located, you can easily build one utilizing the views within InEight

Estimate.

3.8.1.1 Creating A Labor Saved View - Resource Rate Register

You can create a view to mirror both the register and excel sheets to easily bring information back and

forth from the two applications.

Example of columns:

NOTE

The view should appear as shown below with User Defined 1 in the first column. This field is used for

User Defined 1

Resource Code

Description

Resource File Description - Validated field
Geographic Area - Validated field

Wage Zone - Validated field
Organizational Category - Validated field
Tag 1 - Validated field

Tag 2 - Validated field

Currency - Validated field

Default Quantity

Use Base Wage Factors - Scale Factors
Scale Factor 2 - Scale Factors

Scale Factor 3 - Scale Factors

For more information on Validated Tags field, see Validated Tags topic. Scale Factors
aren’t required if you are manually applying rates to each cost category scale.

sorting and arranging data accurately moving between Estimate and Excel. You are not limited to UDF

1 and can choose to utilize a field of their choice for sorting.

B & B B

JobPropertes Foundaon Paylbem i SdWomd | R

Cont Breakdown Structure (CBS) Register

SehpDass s Propossl
nitialize

4[] cromctn Ensme. | nres ot | veteivel | skt x| save | o

Resource Fe Organizational Geogra
DesTpton Category area

EH
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Find; | [Search For...]

- If.a.el-eps

78 _Resousrce Labor Upioad 1 -'I
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3.8.2 Setting up the excel file

Go to the Excel sheet and make sure the information in the columns shown in the screenshot are filled
out. Basic concepts to keep in mind regarding the excel file:

Sort Code - This column needs to have a high sequential number such as 10000. This is very important
to assign as it will help us authenticate all the labor rates.

Resource Code - A unique Naming convention to be assigned to every labor resource. In this example
we have all labor resource starting with a L followed by the letters that represent the resource

description.

Labor Base - The base wage of the labor resource is entered here. Estimate does not allow $ sign to be
pasted, which is why the cells for the Base column are formatted to Number.

K3g - .

A B o o E F [ H ' Il K L " 1 ] 3

1 Requires
2 [valiciated Fieid
3 [Not Reauired

Rescurce Cost Details Regist
Curvency |~ | Default Ouantity - | Use Bave Wage Factoes - | “Scale Factor 2~ | “Scale Factor 3~ [Toesl | - |Labor Base - [T

TRUE 150
TRUE 150

St Lavo
SERREAE LA

1 10003 L5LE Fere
1 10004 LSUIBM Foreman Boilermaker  Stancans Labor Rate File  Carpenser
2 10005 LPFL Lead Pipe Fabricator  Standard Labor Rate File  Carpenser
Standard Labor Rate File  Carpenser
Standard Labo
Standard Labe

1
1
1
v ollar }
WageZocne A NemUnicn Howly LS. Dollar TRUE
WageZoneA  NomUnion Howly LS. Dollar ] TRUE 130
WageZoneA  NonUnion Wourly LS. Dollar 1 TALE 150
v 1
1l
]
}

TRuL 156

TEUE 150
TeUE 150
TRUE

v
WageZone A NeaUnicn Howly

3.8.2.2 Creating the resource

Follow this procedure once you have information filled out in excel.

Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.
3. Highlight the cells you want to bring into the estimate.
4

Copy the cells using right click and selecting Copy from the context menu.
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e i
EEEBENEREEE

Pipefitter & Standard Labor Rate File
10008 574 Fipefitier & Standsrd Labor Rate File  Carpenter Southwest Wage Zone A NonUnion Hourly 5. Dollas TRUE
10005 LBM1 Lead Boilermaker Standsrd Labor Rate File  Carpenter Southwest Wage Zone A NonUnion Hourly 5. Dollar TRUE
10010 LBM2 n Boilermake Standard Labor Rate File Southwest Zone A NonUnion US. Dotlar M

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Labor tab of the Resource Rate Register.

al B

Cost e Standard
Acaperrbie Takdea

& X B &zLr. 12

A3 Egupment
Foundation  Payltem & B Winard Fepor e
Zabup Dt = Proposal

Joby Propes Ses Reports
= BN Mtk
Assnpmibhes Heparts

Irnutia e Hesourses

Cost Breakdown Strecture ((BS) Register r Ressurce Rate Register n‘mmmm
.'l Corafruction Eguipment Reribed Cons nucson Egupemsnl | Drataded Material Instalied Equipment SuppEs Linngus

Lt Resousie e Retorie Fie O g boral Gesga
Defined 1 Code T Desoiption Categary &rea
% | - 1
1 G Hew
eleie
ut
. -I.J.
rE\_. Paste
[+ Bl

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking

Are you sure you want to insert the selected values?

8. Select Yes to confirm inserting the selected values.

9. The cells you copied from the excel sheet are now copied into the Resource Rate Register. The
Sort code data is pasted in the User defined 1 column. Resource Code & Resource description

data is pasted as well.
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Resource - Import Dema - Estimate - a

@I ._-‘f @ L] A, Labor ;.E

a a B @
B o cment
3bPropertes  Foundston  Poylemd BdWamwd | Resswce Fesowce | Costltem  Stndeed | Reports
- SewpDota - Proposal Fates - HE Matewish  Amorbles | Amenbles  Tobies
Intsskze Resources Assembles Reparts

Cast Breakdown Structure (CBS) Register Resource Rate Register ©  Resowrce Cost Details Register

o= . . . [ secs [ e

’ o Find: | [Bemeh Fer...] Saved viws: | BB fuesource Labor Upled Vi -

0 g - - Smmed G BT e oo o me |Eme mw

+ 0000 = Corpenter Jourey . | Standad Labor Rate Fle. Carpenter Soufwest  WageZoe A Monlrwn touly LS. Dodar 00 T¥] 000 e
+ 10001 LSUPF Foreman Ppe: Standard Labor Rate Fie: Carpenier SouTwest WageZoneA  honUmon  Moury U.S. Dolar 100 Ll 0.00 .
+ 10002 Lsurw Foreman fren Siandard Labor Rate Fle: Carpenier Soutwest Woge Zone & honUnion  Hourdy .5, Dollar 100 v 0.00 .00
+ ey LRC Foremen Crd Standard Labor Rate Fle Corpenier Aentvest Woge Toe A hon Union oy W5, Doller 100 v 0.00 R
i s e | Soddibore e Sotwet VomieeA e o s 0o w B mom
+ 10005 LPFL Lead Pipe Fabricater | Standard Labor Rate Fle Canpanter Soutwest Wage Zone A honUnion  Hourly U.E. Dolar 100 o 0.00 .00
+ 10006 L2 Joumeyman Ppefitter | Standard Labor Rate Fle Carpanter Soutwest Wage Zore A NonUnion  Hourly U.S5. Dollar 100 v 0.00 0.00
+ 10007 L3 Poefitter A Standand Lsbor Rate Fle Corpanter Soutwest Wage Jone A honUnion  Houly U.S. Dollar 160 v 0.00 000
+ 00 Ll Poufitter 8 Standard Labor Rate Fie Carpenter Soutwest Wage Tom A NonUmion  Hourly 1.5, Dollar .00 o+ 0.00 (X
* 10009 LBM1 Lead Bolermaker Standard Labor Rate Fle Carpenier Soutwest Wage Zore A hon Union  Hourly. LS. Dolar 100 Cd 0.00 .00
+ wow Lamz Joumeyman Boderm | Standard Labor Rate Fie Carpenter SouTwest Wage Zone A NonUnion  Hourly .5, Dodar 1w v 0.00 0

.

10. For Make sure the sorting is on User Defined 1 column. This allows us to see the
information being sorted similar to our data in excel file. Base Wage Factors need
to be flagged to turn on with the check box. Your first copy and paste should have
activated them. You need to copy and paste again in order to apply the factors.

Resource Cost [
tors - *Scale Factor2 - *Scale Factor 3 vpmll - |Labor

150 $28.92

1.50 2000 529.92

1.50 200§ 53052

1.50 2000 53152

1.50 2000 533,92

1.50 2004 533.92

1.50 2000 534.92

150 200§ 535.92

150 2000 53692

1.50 200 537.92

1.50 2008 538.92

— =

« Structure (C gister O st Details Register

Al | labor | Consirucion Equpment | Rented Consiruction Equipment | Installed Materisl | lestaled Equpment | Supples | Unigue

Find: | [Search Fer...)
User
Defined 1

+ |+ mwom - L50 2.0
+ 10001 LsuPr Foreman Ppe Standard Lsbor Rate Ple Carperiter Soufwest  WaepeZoned  NonUnion Moy Loy < L5 200
+ w00z LW Foreman fron Standard Labor Rste Fie Carpariier Soutwest Wage Jone A Nonlmion  Hourky U5, Dolar Lo3 + L5 200
* w000 LU Ferrran Crd Stanird] Laber Rate Fie Carpariter Soutmont WageZos A Menleisn  Heuwly  U.S. Dular Loy 4 150 240
+ 10004 LsueM Fereman Budermabir | Starviad Labar Rste Fie Carpenter Sofeest  WageZoeeA  Nenleisn Hawly  US. Dolwr Lo 4 150 200
+ H00s LPFL Lead Pipe Fabricalr  Standard Lsbor Fusie Fie Carpeniter Soufwest  WapeToneA  NonUnion Howdy U5, Dolar Loy < L5 2.0
+ 100s L2 Journeyman Ppeftter | Standard Labor Rete Fie Carperiter Soufwest  WegeZone A Monlnon Howly U5 Dolar Lo 4 L% 240
+ wooy PR3 Poefitier & Standard Labor Rete Fie Carpentier Soutest Wege fone & Nonlnon  Hourdy ., Dolar Lo ra L3 40
+ U003 LPF4 Poefitter B Standard Labor Rate Fie Carperiier Sotrwest Wage Zoe A Nonlrion  Hourly U5, Dolar oo 04 .50 00
+ 000 LBMY Liaet Bidesmsier Starviard Labor Rate Fie Carperiter Soufwest  WageZoe A NenUeon Houwdy LS. Dolar Lo < 150 2400
+ 10010 LBM2 Journeyman Bolerm . Stancard Labor Rate Fie Carpesiter Soufwest  WageZone A NonUnion Moy LS. Dol Loy 4 150 200

* -

3.8.2.3 Resource Cost Details

Labor resources are now in the system a user can apply rates to those resources.
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3.8 Importing Resources

From the Ribbon, select the Actions tab.

Under the View section, select the Resource Cost Details option. The Resource Cost Details
Register opens.

J[eg2 Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.
From the Saved views drop down, select the Labor view to filter down to only labor resources.
Right click a column header and select Column Chooser.

Drag and drop the columns into the view identified below.

Cost Breakdown Strocture (CB5) Register e

ind; | [SearchFar...] | Saved views: | Labor Vew

Resourcs & 1 g Fr Frnoe2 '
- Sle . T |Tow  Lsber T4 ot Ascanding poorentcesho UndefredFrcel  UndefredFrngs2  Undefine

I Sort Descending

Clear &l Sorting

- [ 1 owmm s 20
[ 1 £0.00
a0
w0
w0

e 1 w0 £0.00
=] ER ] 0.0
wFL ER ] s0.m

Drag 4 calems from balow to place it ista the
eister.

W Group By This Column

Adustment
[oreem—

wF2 1 am 0.0
0.0
.00
0.00

0.0
$0.00

193 1 om0 0.00
Mewarice
e ER ] s
e 1 oam 0.0

ahe Best Fit

.00 50.00
ey 1 w0 £0.00 Best Fit [all columng)
v FisedNone

Feced Left

Fined Right

Example of columns — The level of detail and utilization of specific cost categories is a decision for each

organization:

InEight Inc. | Release 24.7

User Defined 1 - Non editable fields from resource rates register

Resource Code - Non editable fields from resource rates register
Description - Non editable fields from resource rates register

Resource File Description - Non editable fields from resource rates register
Geographic Area - Non editable fields from resource rates register

Wage Zone - Non editable fields from resource rates register
Organizational Category - Non editable fields from resource rates register

Scale - Non editable fields from resource rates register
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e Labor Base

e Travel

e Premium

» Holiday

e Savings

» Pension

» Vacation

» Subsistence

» Health & Welfare

e Apprenticeship

» Undefined Fringe 1

e Undefined Fringe 2

» Undefined Labor Fringes
» Bodily Injury & Property Damage
* Workers Compensation
» Undefined Insurance1

» Undefined Insurance2
» Undefined Labor Insurance
* FICA

« FUTA

» SUTA

e Undefined Tax1

» Undefined Labor Taxes
» Undefined Labor Burden
» Undefined Labor

» Construction Supplies

» Undefined Materials

» Undefined

« Billing Rate

 Billing Rate Markup

« Billing Rate Markup %
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3.8.3 Filter/Sort/Paste - Resource Cost Details Register

The Labor upload view brings in the columns required to enter Labor base, burdens etc. Every Labor
resource has three rows created with Scales 1,2,3. The Scale Column is used to setup Straight time,
Over time, Double time.

=

Cost Breakdown Structure (CBS) Register Resource Rate Register Resource Cost Details Register i

Drag columns here to group

Ezzc;urce - Scale = | otal Labor Labor Base Labor Burden Labor Fringes Travel

LBM1 1 £0.00 €0.00 €0.00 $0.00 $0.00 s0
LBM1 £0.00 £0.00 £0.00 €0.00 €0.00 $0
LBM1 $0.00 $0.00 $0.00 $0.00 $0.00 $0
LBM2 £0.00 €0.00 €0.00 $0.00 $0.00 <0

Step by Step — Filter Resource Cost Detail Register

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 1.

Cost Breakdown Structure (CBS) Register Resource Rate Register r Resource Cost Details Register O ] Labor Rate Record

Drag columns here to group

= 10009 ,Lal;n_ _ Standard Labor Rate Fie Carpenter Southwest Wage Zane A T e $0.00
10010 LBM2 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A £0.00
10000 Lc2 Standard Labor Rate Fie Carpenter Southwest Wage Zone A | From | 1 [Te 1 ]I $0.00
10005 LPF1 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A .00
10006 LPF2 Standard Labor Rate Fie Carpenter Southwest Wage Zane A - $0.00
10007 LPF3 Standard Labor Rate Fie Carpenter Southwest \Wage Zone A £0.00
10008 LPF4 Standard Labor Rate Fie Carpenter Southwest Wage Zane A $0.00
10004 LSUBM Standard Labor Rate Fie Carpenter Southwest Wage Zone A 0.00
10003 Lsuc Standard Labor Rate Fie Carpenter Southwest Wage Zone A $0.00
10002 LSUTW Foreman Iron Standard Labor Rate Fie Carpenter Southwest Wage Zone A 0.00
10001 LSUPF Foreman Pipe Standard Labor Rate Fie Carpenter Southwest Wage Zane A $0.00

Clear Filter Custom Closs

3. Back on the excel spreadsheet, highlight the base rates to bring in.

4. Right click and select Copy in the context menu.
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vio 5 &

A B | o M_ | N | © | _» a | & s | T | uw juw w - S I | z

1 Required

2 validated Field

3 Mot Required

5 Resource ate Reglster fesource Cost Desalls Register

6 UserDefined 1 Resource Code = Description |+ *Scale Factor 2| v *Scale Factor 3 - [lom |+ flaborBase < Travel |« Premium = [Holiday » |Savings = |Pension = |Vacatlon - | Subslstencel = | Health & Welfare - | Apprenticeshlp - | Unsefined Fringe 1 = | U
7 10000 LC2 Carpenter Jouneyman 150 200 528504 210 [T [T 066 [ 200
8 10001 LSUPF Foreman Fipe 150 200f $2950) 210 000 e 02 0o 066 044 a0 0.6 0.00 000
9 10002 LSUIW Fareman Iron 150 200l s3052) 2430 1) e o2 am 068 [ am 0ss .00 am
i 10003 LSUC Fareman Civi 150 200f 5318 510 oo e om am 056 [ am 056 .00 000
11 10004 LELIBM Foreman Bollermaker 150 200f 3252 2610 000 00y 0x: 4o 066 [ a0 [ 0.00 000
12 10005 LPF1 Lead Pipe Fadricator 150 20 5353 2710 1) e om am 066 [ am 0ss 9.00 am
13 10006 LPF2 Iourmeyman Pipefimer 150 200f 53452 2810 oo e 0m oM 066 [ am 066 0.00 000
4 10007 LoFS Bipefitter & 150 200f s 2610 oo oo o oo o6 L aoa 0ss 0.00 am
15 10008 P4 Fipefimer 8 150 200l 336924 3010 a0 aw  om  om 066 [ 000 0ss .00 am
16 10009 LBML Lead Bailermaker 150 200 53752 3110 1 e 0m am 066 04 am 066 0.00 000
1 10010 Loz Joumeyman Bailermaker 150 200f saeol 3210 .00 000 0 oo 066 P 200 0.6 0.00 0,00
i

19

5. Go to Estimate. Right click and select Paste from the context menu.

1
1
1

10007 wr3 Poefatm & StancardlLabr Rate Fle Carpenter Scastvent Wiage Tone A e £ Link thisfeld to Ecel %00 00 oo .00 0o
1 e cel
1
1

0008 wF4 Poeftter 8 Standard Laber Ruate Fle Carpenter Southarest \Wage Zone A .00 $0.00 .00 0.0 .00 .00
10009 weM1 Lead Bodermaker Standard Labor Rate Fle Carpenter Soutwest Wage Zane A w00 000 .00 0w .00 w00 000 .00 .00
w0 ez Jousmeyman Bodermaker Standerd Labor Raste Fle Carpenter Soutwest \Wage Zone A 0.0 s000 .00 0.0 $0.00 .00 0.0 000 .00

6. You will be prompted with a Are you sure you want to insert these values? message as before.
Select Yes to continue.

3.8.4 Manual Set-Up of Scales 2 & 3 - Optional

If the organization wants to have more in-depth cost details for each scale rather than using scale
factors the same procedure will be utilized to copy Labor burden, fringes, and other add-ons to setup
Scale 2 & Scale 3.

ey g= For Base Wage Factor Columns will not be active if your organization is using method 2.
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3.8.4.4 Resource Rate Register

Cast - o Labor Rate Recard
A | Labor Rented £ Installed Equpment | Supples | Unigue
Find: | [Search Por..]) —|  Saved views: | Previow

Rescurce Rotsource Fie Uit of Praductity Defuin Waste % Uit Cost Linit Cost st Coat Lise Bade ‘Wage

Code e LT Desmpton Meazre Factor Quariaty add-on (scaie 1) Goled  Gaen Y frame

+ 1M1 Labor Rate Lead Bodermaker Standard Labor Rate Fie Hour LoD L00 $37.50 46,65 $62.20 U5, Dollar

+ Mz Labor Rate Journeyman Bodermake: Standard Labor Rate Ple Hour Lo0 100 350 815 $64.20 U5, Dollar

+ 12 Laber Biate Carpenter Jomeyman Standud Labor Riste Fie Four 100 100 2850 L8 $4.0 U5 Dollr

+ R Labor Rate Lead Poe Fabricater Standaed Labor Rate Fie Hour 100 10 #3290 $40.55 5420 US. Dol

+ F2 Labor Rate Jewsmeyman Poefitter Standard Laber Rate Fie Hewr .00 100 3450 $A215 $56.20 LS. Dol

+ PF3 Labor Rate Ppefitter & Standard Labor Rate Fie Hour 100 100 43550 $ALES 458.20 LLS. Dollar

+ LPF4 Labor Rate Poefitter B Standard Labor Rate Fie Hour LoD Lo00 $36.50 4515 $60.20 U5, Dollar

+ L5 Labor Rate Foreman Bodermaker Standard Labor Rate Ple Hour Lo0 100 3250 39,15 $52.20 U5, Dollar

+ s Laber Baate Foremen Crel Standard Labor Bite Fie Four 10 100 3150 748 $50.10 U5 Dollr

3.8.4.5 Resource Cost Details Register

Cost Breakdown Structure (CBS) Register Resource Rate Register [ Resource Cost Details Register @ llawaeR{wrd
Drag columns here to group

User Resource

- Resouroe File Crganizational Geographic
Defined 1 =

Categary Area

Descripbion

Bl 10000 c2 Carpenter Jourme yman Standard Labor Rate File Canpentear Southwest Wage Fone A
10001 LSUPF Foreman Pipe Standard Labor Rate File Carpenter Souttwest Wage Zone A £34.65
10002 Lsunw Foreman Iron Standard Labor Rate File Carpenter Southwest Wege Zone A $36.15

Step by Step — Manual Setup of Scales

1. From the Scale column header, click the filter icon..

2. Set the From and To values to 2.
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Cost Breakdown Structure (CBS) Register Resource Rate Register 1 Resource Cost Details Register Ol Labor Rate Record

Drag columns here to group
User. . Resource - Resource File Organizational Geagraphic Wage
Defined 1 — Code DeaCindony Description Categary Aren Zone Scale S Tosd LB Baas Travel

= 10000 Lc2 Carpenter Journeyman Standard Labor Rate File Carpenter Southwest Wage Zone A voues  NumericFilters $0.00
10001 LSUPF Fareman Pipe Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10002 Lsuw Foreman Iron Standard Labor Rate File Carpenter Southwest Wage Zone A I] From | 2 To| 3 $0.00
10003 Lsuc Foreman Civil Standard Labor Rate File Carpenter Southwest. WageZone A | | $0.00
10004 LsuBM Fe ! k ! abor Rate File Carpenter Southwest Wage Zone A - $0.00
10005 LPF1 Lead Fipe Fabricator Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10006 LPF2 Journeyman Ppefitier Standard Labor Rate File Carpenter Southwest Wape Tone A 80.00
10007 LPF3 Pipefitter A Standard Labor Rate File Carpenter Southwest Wage Zone A $0.00
10008 LPF4 Bipefitter B Standard Labor Rate File Carpenter Southwest Wage Zone A €0.00
10009 LEM1 Lead Bolermaker Standard Labor Rate File Carpenter Southwest Wage Zone A £0.00
10010 LEM2 3 abor Rate File Carpenter Southwest Wage Zone A €0.00

Clear Filter Custom Close.
3. Back on the excel spreadsheet, highlight the base rates to bring in.
vao = &
il A ] l c I M 1 N L o | 3 L a | ® | s | T u v W b | ¥ | z

1 Bequies |

2 il ey —

3 Mot Required |

4

5 g ozt Detals Register

& User Defioed | Resource Code - Description [ *Scale Facor 2|~ | *Scale Factor 3| |~ ftaborBase [~ [Travel - Premium - Holiday - Savings = Pension - | Vacation - | Subslstence - | Health & Wellard = Apgrenticeship - | Undefined Fringe 1~ | U

7 10000 LEX Carparter lourmeyman 2210 [ 00 02  0m 066 0es 000 (3 000 000

[ 10001 LSUPF fareman Fipe 150 210 0.0 00 02 00 066 084 200 06 000 000

9| 10002 LsUIW Fareman Iran 150 2210 000 om0 0w 086 oa am 0 000 00

10 10003 LSUC Fareman Civil 150 510 (13 00 02 0m 066 [ 00 056 000 00

1] 10004 LEURM fareman Sl lematker 150 610 o0 00y 62 000 066 0 000 0.6 000 0.00

12| 10005 LFF1 Lead Pipe Fabricator 150 1710 oo om0, 066 08 om (T3 000 oo

13 10006 LPF2 Ioumeyman Pipefier 150 810 000 0 0 oM 066 [ 200 056 000 00

4] 10007 LEFS Fipefitier & 1% 2810 o0 a0 a2 0600 066 [T 000 06 0.00 000

15 10008 LPF2 Fipefimer § 150 3010 om0 m ez 0w 0566 Qs w0 08 000 0o

16 10009 LML Lead Boilarmaker 150 3110 0.0 00 02 om 0566 nes 000 066 000 000

17, 10010 LAM2 loumeyman Bailermaker 150 3210 .00 000 02 00 066 0.4 000 066 0.00 000

18] ¥

"

5. Go to Estimate. Right click and select Paste from the context menu.

Cost Breakdown Stracture ((DS) Regeter Resource Rate Register rmuumecmmkiewtn ﬁluburmwemud

Find: | [Search For., ]

il

0002 Laaw Starcderd Labor Rate Fie Carpenter e
03 LSC Starcard Laber Bate Fig Carganter oo
10004 L5UBH Standard Labor Rarte Fie Carpenter E
0005 LPFL Starviard Laber Rate Fis Canpentsr .00
10006 LPF2 Stancard Lshor Alate Fie Carpenter .00
10007 LFF3 Standard Labor Rate Fie: Carpenter Wiage Zone A #4365 | B Lk this fusle b Excel 000
10008 LR34 Starciard Labor Rate Fie Carpenter Wage Zone A SA5.L5 |84 Uslink 00
10009 LB Standard Labor Rate Fle Carpenter Wiage Tone A LT i A6 $0.00 S000 ) S000
10050 LBMY Standard Labor Rate File Carpenter Wage Tone & 54815 #3815 000 ot ot

6. You will be prompted with a Are you sure you want to insert these values? message as before.
Select Yes to continue.
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7.

Follow the same procedure for scale 3.

3.8.4.6 Non Labor Resource Setup

3.8 Importing Resources

The same principles can be applied for the other resource types within InEight Estimate. This

procedure covers installed material, but can also be used for the other six resource types.

3.8.5 Creating A Materials Saved View - Resource Rate Register

Create a view to mirror both the register and excel sheets to easily bring information back and forth

from the two applications.

Example of columns

User Defined 1

Resource Code

Description

Resource File Description - Validated Tag field
Geographic Area - Validated Tag field

Wage Zone - Validated Tag field
Organizational Category - Validated Tag field
Tag 1 - Validated Tag field

Tag 2 - Validated Tag field

Currency - Validated Tag field

Apply Standard Tax - Validated Tag field
Unique Sales Tax

Unit of Measure - Validated Tag field

3.8.6 Creating A Material Resource

Follow the step by step once you have information filled out in excel.

InEight Inc. | Release 24.7
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Step by Step — Creating the Resource

1. Open the excel file.

2. Sort the sheet by sequential number in the Sort Code field.
3. Highlight the cells you want to bring into the estimate.
4

Copy the cells using right click and selecting Copy from the context menu.

) b Calib 1 KA == #- Evwnpla & Genenl . r, By [Ep| s Iy Enums..m ‘2“' p B Coeate poF
Pute P Sonait Condiioenl Formitss Col | st Delebe Format | 20 Sot & Fingit | o Chaege Seting:
wite c He Mmea-B==ws 5 . Sensiinity . o o3 1 Conditicewl Fomnstas Cel ruart Delebe Format B Fin
" Fromatpime B 7 U B DA S < e L IEha e . $-% Wa Fommstting= Tables Syless = =« PO Figers Selecte [ BetchPOF
Cligboad ™ feem & Sngemet = Seritivity Humbes 5 Stybers Calls Editing Blurbean
AT = 2 10000
A B c 1] E E ] H ! J K L M
1 red
H [valicated Field |
:
4 Column Headers may differ based on Design Decision item 867
5 u |
6 User Defined 1 - i
TR Siandard Material Aot
B ‘Sandard Material Rate File
i Coarse Aggregate 1-172 in Standard Material Rate File Asphalt Plant Asphalt UE Dollar TRUE 5 Ton
10 fa Fime Aggregate ‘Semndand Materisl Aate File Asphalt Plant Asphalt US. Dallar TRUE 5 Tan
1 Aggregate Maul Cusrry to Flant  Standand Material Rabe File dsphalt Flant Asphalt U5 Dallar TRUE S Ton
L ¢ Inter Rate File Asphalt Flant Asphalt W5 Dollar TRUE 5 Tan
Rk o Sand ‘Standand Material Rate File Asphalt Flant Asphalt U5 Dollar TRUE 5 Ton
14 Tack Standard Material Rate File Asphalt Pave U Dollar TRUE 5 Gallon
15 3 Aggregate Baze Rock ‘Standard Material Rate Pile Ll US. Dollar TRUE 5 Ton
AL ¢ Cancrete 8000 P31 ‘Saandard Materisl Rate File Canerete Canerete U5 Daller TRUE 5 Cubiic Yard
17 h Cancrete 3500 F31 ‘Swmndand Material Rate File Concrete Concrete U5 Dollar TRUE 5 Cubic Fard
1t DitClass A ‘Standard Material Rate File Earthemrk Water/Sewer . Dollar TRUE 5 Cubic Yard
151 DirtLlass § ‘Standard Material Rate File Eartheork Water Sewer S Dollar TRUE 3 Ton
i’ et A paaders Masia ot Mactsies Macksis Ty T hisih
Labor | Cwned Eqp | Rental Egp Permanent Equipment Supplies ) '
Select deRination amd press ENTER a¢ chasse Paite Average SI0TS  Cownt: 180 Sum: 180061 B m

5. Open Estimate to the Resource Rate Register.

6. Select the User Defined 1 column in the Installed Material tab of the Resource Rate Register.
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Cont Breakdown Structure [CBS) Regeier Besource Rabe Register O

Al | Lebor | ConstnahonEgupment | Aevied Corstructon Egupment || Instsled Hatensl

Uiser Riesouroe o Riesuroe File
Definesd 1 Code bans Dezsripbon
| ﬂ P

7. Right click the empty cell and select Paste from the context menu. A pop up will appear asking
Are you sure you want to insert the selected values?

8. You will be prompted with a Are you sure you want to insert these values? message. Click Yes

to continue.

3.8.7 Create A Material Saved View - Resource Cost Details Register

Installed Material Resources are now in the system. You can apply rates to those resources. Create a
view to mirror the accompanying excel sheet or create one to bring in the associated resource cost in

the details register.

Step by Step — Material Saved View

1. From the Ribbon, select the Actions tab.

2. Under the View section, select the Resource Cost Details option. The Resource Cost Details

Register opens.
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3.

\\[eJg = Create a view to mirror the accompanying excel sheet or create one to bring in the
associated resource cost in the details register.

From the Saved views drop down, select the Installed material view to filter down to only
material resources.

Right click a column header and select Column Chooser.

Drag and drop the columns into the view identified below.

Cost Breaksown Strutture ((B5) Register Rescurce Rate Register Resource Cost Detads Register  ©

Swes T Tom  lser  ldorBae  lsborBwden  LsbarFrnges  Traed  Premum holdey  Sawngs  Peson  Vamtn ) coqsicending Mopremiceshp  UndefnedFringe 1 UndefredFringel  Undefine

= [ ] 1 smo s .00 s0.00 s0.00 0.00 .00 s0.00 $0.00 900 | Z| Sot Bescending s0.00

Lz 1o .00 50,00 .00 20,00 . 000 0.0 w Clear All Sorting .00

0o 00 20,00 .00 .00 20,00 000 0.0 #.00 .90 0.00

wr 1 mm s 0.0 .00 w000 000 000 0.0 w000 so.c0 | [ Sroup By T Cokmnn w00 Disfault Caniize &
w2 1 mom s 0.00 .00 .00 0.00 .00 000 30.00 .00 Hide Thiz Column ¢ 5 t

$.00

17F3 1 s 50.00 0.00 0.00 $0.00 0.00 .00 0.00 0.0
1PF4 1 am W .00 0.0 .00 0.0 .00 .00 0.0
ey 1w 000 .00 00 $0.00 $0.00 .00 $0.00 0.0

e 1 mm o 0.0 0.0 wi @ .00 0.0 $0.00 .00 0.0
LW 1 oam s @00 0.0 .00 .00 5000 0.0 0.0 .00 g0 | BestFr
e 1 osm B .00 0.0 w0 @ e .00 0.m w0 00 Best Fit (ol columm)
v FixedMane
Fised Laft

Ficed Right

Example of columns — The level of detail and utilization of specific cost categories is a decision for each

organization:

User Defined 1 - Non editable fields from resource rates register
Resource Code - Non editable fields from resource rates register
Description - Non editable fields from resource rates register

Resource File Description - Non editable fields from resource rates register
Geographic Area - Non editable fields from resource rates register

Wage Zone - Non editable fields from resource rates register
Organizational Category - Non editable fields from resource rates register
Unit of Measure - Non editable fields from resource rates register
Currency - Non editable fields from resource rates register

Total - Non editable fields from resource rates register

Installed Materials

Undefined Materials
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o Sales Taxes

e Undefined Fees

» Undefined

 Billing Rate

« Billing Rate Markup
 Billing Rate Markup %

3.9 QUANTITY CHECKING

The Quantity Checking feature allows you to compare the quantity of a superior cost item to the sum
of its relevant subordinate cost item quantities. This setting enables the use of the Quantity Check and
Quantity Warning columns in the Cost Breakdown Structure. The use of these columns can assist in
confirming whether or not your quantities are correct.

e g=0 The subordinate cost item quantities need to have the same unit of measure as the
superior cost item before you are able to choose the Quantity Check column.

In the example below, break a concrete pour cost item into four subordinate parts. The Forecast (T/0)
Quantity of the superior item will be 156875.00 tons of concrete. Start by dividing each of the four

parts into 35000.00 tons each. Once you have broken out this concrete pour, determine if you need a
fifth pour or if you should distribute the remaining quantity to the four pours. The factors you keep in

mind are the trips and time involved in the extra pour vs capacity of equipment.

Step by Step — Quantity Checking

1. From the Ribbon, select the Setup tab.

2. Under the section Initialize, select Job Properties. Then select the Cost Basis tab.

NOTE

Quantity checking starts by turning the feature on in the Job Properties. If you want
to have quantity checking turned on for all jobs in Estimate, then this setting needs

to be turned on in the Master Job Properties. The Master Job Properties is located

in the Library.

3. From the Rules data box, select the Activate Quantity Checking check box.
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Estimate Quote Price Execulion Integrations

¥ L SR e R [
J B = B
(&) | = ™ & Lx B Al
Job Properties | Foundation  PayItem & Bid Wizard | Resource __ Resource | Costltem Standard | Reporis
- Eetup Data = Proposal Rates = iow Materials  pssemblies | Assemblies  Tables
Initialize Resources Assemblies Reports
Cost Breakdown Structure (CBS) Register Job Properties ©

Overview | Sequrity | Cover Sheet | CostBasis | Minority Setup I Fuel Cost I Job Trading | Job Folder Tags | Competitors | Pricing

Standard Shift Arrangements Standard 'Wage Rate Compasite Rules
[] Lok Cost ltems to Pay Rems

Work Hours per Shift 8.00 Seale 1: 100.00 | =5 Pay Item Linit Price Precision: I:l
Activate PBS Changes Log
soez [ om% O

{14 Activate Quantity Checking |

Shifts per Day: I—lﬂﬂl Seale 3 Iﬂ * [ Mainkain €85 Structure at Level: |G
5.00

Days per Week:

Pay Hours per Shift:

shift [ Rate Caloulator When man-count changes: {®) Change UM [ Man-Hour
() Change Days

4. Next bring a couple of columns into your view on the Cost Breakdown Structure (CBS) Register.
Right click on the column header and choose Go To Column.

5. The Go To Column dialog box appears. Have the Include columns that are not currently in the
view check box selected.

E?‘j:m = Description i!é;'fm g:vagru o g::m g;(nmt Unit Cost .(r;nticc:ssl; ?ﬁnlfa‘h'm driven) E&Zm driven) Labor Total Cost
+ a2 Finegrade Subgrade Square Yard Superior CI Detsi DrectCost 015 $75,898.36

Bas | st MENNPSSRE

+ 431 Place Aooregate Base Ton Superior € Detal _ $163 | $73,460.92

+ 432 Blue Top Aggregate Base Square Yard Superioe €T Detal _ 006 $24,106.42

Bs Asphalt Concrete Hot Mix Type A Ton Pay Item Detad Direct Cost $4262 $1,491,560.59

+ 51 Furnish & Haul Hot Mx Ton Superior CI Detai $39.27 §1,374,562.54

+ 52 Install Hot Mix Type A Ton Superior CI Detai $117,018.05

—E&nﬂc.mnnsm Linear Feet Pay Item Detal

+ 61 Furnish RCP Materisls near Feet Superior CI Detal

+ 62 Excavate RCP Trench Cuble Yard Superior CI Detal Column:

+ 83 Instal RCP Ppe: Linear Feet Superior CI Detal T N

7 sceilel ] Cubic Yard Superior CT Detal Include coly Period Count Mismatch Period Count Mismatch No
=7 ConeretePour - Srowter Gl Detal Phase Code Phase Code

+ 2 Concrete Batch One Ton Fixed g Days Plug Days

+ 72 Concrete Batch Two. Ton Fixed Quantity Check Quantity Chedk No
+ 7.3 Concrete Batch Three Ton Fixed Detal Quantity Driver fes
e Quantity Warning No

+ 2.4 Concrete Batch Four Ton Fixed

_Eﬂ-m Force Main (SDR21) Linear Feet Pay Item

Quote Group

6. Click OK when you have selected your preferred columns.

Next, toggle the check box for the Quantity Check column.
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3.10 Security in Estimate

B cooete Pour

+ 7.1 Concrete Batch One
+ 72 Concrete Batch Two
+ 7.3 Concrete Batch Three
+ 7.4 Concrete Batch Four

W seoa

Remaining Quantity: 16,875.00 Ton

I Fixed
Fixed

9320 As you check Quantity Check for the four batches of Concrete, the superior cost
item Quantity Warning turns yellow. This is indicating a quantity warning. Hover
your mouse over the superior cost item Quantity Warning column. Then, an
overlay message appears showing the quantity discrepancy. Apply this discrepancy
to the Subordinate cost items. That way, the superior cost item with be the sum of
the parts.

'

8. The remaining quantity is 16875.00 tons which does not warrant a fifth pour.

3.10 SECURITY IN ESTIMATE

3.10.1 Role based permissions

Estimate uses a role-based security model, where users can be assigned to a role on a project. A role
identifies if a user has been granted access for various permissions to perform defined functions in

Estimate.

A role is a collection of permissions that defines a user’s responsibilities on a project or in an

organization.

Role

v

A

Pemm
1 2 3

-

Role B

-
1

For example, Johny can be an Estimator on Job A and a Lead Estimator on Job B, giving him elevated
permissions to perform actions that a less responsible estimator may not permitted to perform.
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Estimator

Job A

Receive
Quotes

Manage
Cost tems

Resource

Lead Estimator
Job B

Update Create

Rates Estimates

Versions of

Manage
Snapshots

Access the
PBS
register

Estimator
Job C

Update
Resource
Rates

Receive
Quotes

Manage
Cost ltems

Roles are created and managed in the Roles and Permissions page in the Suite Administration section

of InEight Platform (Suite Administration > Roles and permissions).

Arcount Admanistrator
O  Accownt sdministrator- All Roles
Account Admmistrabar- Copy

AJL New Role LIV

]

|

AJL Role 2

AJL Rode 72

oo

AL - NoEditRole
AL - YesEditRole

AL Role &

o o0o

AL Role B

AL RoleC

]

|

AL-no Templates, Mo Library

Default Role

oo

Dev/Ops Adminestrator
Estamate-AddJob-noViewSnapshot

Estimate-addJob-viewsnapshot

o oo

Estenate- AddSnapshot

Estanate-nosdd Jeb-ViewSnapshot

[m]

(]

Estimate-ViewSnapshat
EStAME1Er

Foreman

] a0

Integration Seltings

D 2023 InEsght Inc. Privaecy Statement

Aecount Adminstrator

Account Administratar

Account Admunistratar

testing synch of roles to estimate

et role to do something somewhere
maybe this is the last roled

Raole cannot edit lbrary

Role can edit libeary

Role A for use in test cases

can delete snapshats

Role to test more stuff

user cannot acoess Libeary or Templates
Default Role

Dev/Ops Adminesirator

Testing ESIFale peimisains soensfio
Testing Estimate pEMMiSSions Soenanio
Testng Estamate permissaons soenanio
Testing Esbimate permissons scenafio
Testing Estimate permissaons scenano
Estanator

Foreman

Integration Seitings

Isrms 8 Condions | X232

Adrinestrator level a

Level 3 - Aecount Admin =
Level 3 - Account Admin
Level 3 - Account Admin
Level 3 - Account Admin
Level 1 - Project Admin
Level 2 - Organization Admin
Level 3 - Account Admin
Level 3 - Aceount Admin
Level 3 - Aceount Admin
Lievel 3 - Account Admin
Level 3 - Account Admin
Level 3 - Account Admin
Level 0 - Base

Level 3 - Account Admin
Lével 3 - Avcount Admin
Level 3 - Account Admin
Level 3 - Account Admin
Level 3 - Acecunt Admin
Level 3 - Account Admin
Level 1 - Praject Admin
Lavel 1 - Project admin
Level 3 - Account Admin

IMEIGHT &

The following image shows how the Estimator role has been defined with permissions to launch

Estimate, add and edit jobs, and view snapshots, but it does not have permissions to delete jobs or add

and edit snapshots.
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= far Suite administration / Roles and permis

Roles and permissions > | Edit role Cance

Role details

* Name Description * Admanistrator level
Estimator Estimator EVE T4 i
Permissions
Suite administration w
Organization and project w
Master data libraries v
Model v
Document L
Estimate ~
Select all
Jobs [ select all Snapshots [ Select al
Launch Estimate {@) View snapshots
(%) Add jobs O] (#) Add snapshots
[# Edit jobs | [ Edit snapshots (§

(x) Delete jobs
-

Cabadla

& 2023 inEsght inc Privacy Statement Teames & Conditions w333 INEIGHT

For more information on setting up roles in InEight Platform, see Roles & Permissions in the Knowledge
Library.

3.10.2 Security in Estimate

The capacity to grant permissions in a job and what can be performed is accomplished with a
combination of permissions that exist in both Platform and Estimate.

Generally, permissions managed in Platform determine which users can launch Estimate and who can
manage jobs, snapshots, templates and access the Estimate library. Permissions managed in the
Estimate determine which users are granted permissions to specific commands and destinations solely
in Estimate.
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For any user to use Estimate, they need to have a role that has been granted the Launch Estimate
permission, which is found in the Estimate blade of the Roles and permissions page when editing the
details of a role.

= fat  Suite administration / Roles and permissions

Roles and permissions > Edit role

Role details
* Hame Description * Administrator level |
Estimator Estimator Leve Project Admin |
Permissions J
Suite administration / w
Organization and project v
Master data libraries “
Model w
Document R
Estimate A
D select all rch
Jobs (] Select all Snapshots
Launch Estimate @) View snapshots
(#) Add jobs [J (¥) Add snapshots
[ Edit jobs [ [ Edit snapshats (T

[ (x) Delete jobs

3.10.3 Granting permissions to access Jobs and Snapshots

When creating jobs in Estimate, it is required to associate new estimates with existing Platform
projects and all the related OBS contents.
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J[el 2 Multiple estimates can be assigned to a single Platform project. In this case, permissions
granted to users on a project will be the same permissions for all the estimates belonging
to that project.

InEight Estimate

— ) Saved Views ~ .'_'i Colors ‘-‘,_ External Reports - a About Estmate raé
— ”
2 Tides - £} Output Settings = %) External References - @5 Releaze Notes
Customine Estimate @, InEight
Help (%) InEight.com University
Customize Help
O Platform projects
M, Project ID Project Name Status Created Date
Core Project: ™  Project A4558
", \ Project A4097 Project A4997 Pl 4/1/2020 3:56: 14
Code: * [a4998 [ Project A4958 Project A4538 e 41/2020 3:56:14
) Project A4999 Project A4999 Mew 4f1/2020 3:56:14
Description: Clemson Cresk Restoraton project] Project AS Project AS P 412020 3:52:36
Project ASD Project ASD Mew 4/1/2020 3:52:37
Project AS00 Project 4500 P 4172020 3:52:41
[] Auto-Update Job in Connacted Analytics Project AS000 Project ASD00 New 4/1/2020 3:56:14

CAHCE:

This Platform project is used to assign roles for the purposes of granting various permissions.

To grant permissions to a particular user on a Job, go to the User Management page in InEight
Platform, edit the user, and then assign the user a role on a project on the Roles tab of the Add or Edit
User slide-out panel.
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| Q

Dev/Ops Administrator v | \ ~ | <]

2023 Clow Creek Shoreline Restoratio

2020 Concrete Repairs Program | 499
Superintendant v | Bridge Deck Repairs and Shoulder Re- | ©

Springbrook Golf Course Dynamic Sig

| Retaining and Noise Wall Rehablitatic

Superintendant v
) #0270 Clow Cresk Shareline Resinsatin -
1 ] 3
Superintendant . Steel Structure Training Job | 105091 A N ]
Superintendant v Steel Structure Partner Job | 105004 X v B2
Foreman . Steel Structure Training Job 3| 105093 ® v 2
Foreman v Steel Structure Training Job 2 | 105092 . @

Back “ Cancel |

For more information on managing users, see the User Management section in Roles & Permissions in

the Knowledge Library.

In Estimate on-premise, roles are created and managed in the User Roles register. After
the role is created, users can be assigned to the role from the list in the Windows Active
Directory Users and Groups in Estimate. The Users assigned role as determined by the
currently logged in user is used to grant permissions at the application level. Because
Estimate on-premise uses the computer’s logged in user in determining the user’s role,
roles cannot be segregated by job. To enforce job-level security in Estimate on-premise,
populate the list of users allowed in the job on the Security tab of the Job Properties
form.
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3.10.3.1 Organizational Breakdown Structure

Projects in Platform are required to have an Organizational Breakdown Structure (OBS) assignment.
The OBS assignments can be utilized for assigning roles and granting permissions to all jobs belonging
to a node in the OBS.

In the following example, Johny has been assigned as the Lead Estimator for the Site Work node of the
OBS, which grants him the permissions assigned to the Lead Estimator role for every estimate created
that belongs to the Site Work node in the OBS.

@ oetans © roLes

Roles (1) (¥ Add role
* Role * Organization/Project
Lead Estimator * Site Work woow m
e
v | Site Work =

2023 Clow Creek Shoreline Restoration | 4¢
2020 Concrete Repairs Program | 4992404
Bridge Deck Repairs and Shoulder Reconst
Springbrook Golf Course Dynamic Sign Ins

Retaining and Moise Wall Rehabilitation am _

L 3

J[el 2 Permissions are cumulative, so if a user is assigned multiple roles on a single project, the
role with the most permissions is applied when attempting to access various functions.

3.10.4 Granting permissions to destinations and commands

Estimate can grant permissions at a deep-rooted level by assigning which roles can access specific
forms. You can also assign certain roles that can perform specific commands or actions that can be
performed within those forms.
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Integrabons

& print rew gy Cony B ik Fieid W w CJ
& Preview e R Paste Lin ik Field - »
- Expand [  Show Classic Navigation Befresh List of
% Export bo Excel il Dowr Collapse = Apcesshie Objects Mgesshie Objects
Print Edit Workbook View Tools
User Roles Register O - Access Control Register O
Saved vews: Standard Vies - Tvee i e Y S W Standard Vies -
Fiole Name = Descripiion
e ey . Type = Category = Subcategory = Ribbon Name
B Command
Foreman Foreman
B Destination
Integration Settings Integraton Settngs
ISRoke IS Role ] IEY
B Account Code Utilization
KHMROLEL KMROLEL Reasts
2 Account Record
Lead Estimator Lead Estimator dhvison =t
Ma0 testdevel O @ Address Book Record
MG-1 et doved 1 Address Book Register
MLG-2 ipatdeved 2 B Attachments Register
MQ-3 testdevel 3 = Bond Cost Them Record
MLQ-3- Copy w/Add Projects | testdevel 3 E Cash Flow
NP1 Estimate Full Access Competitor Record
K-z HP-2 B Competitors
Rile 01 Engineer Fuote 01- Engineer Connected Anabytics
Role 1 -Engineerr Role 1- Engineer - = Cost Breakdown Striscture ((B5) Register
Role 2 - Estmator Roie 2- Estimator Destination Cost Breaidovn Structure (CBS) Fegster | Form Cost Bresiadovwn Structure (CES) Register
Role 3 -Lead Estimator Role 3-Lead Estmator o Cost Curve Record
R 4 - Regional Adein Role 4- Riagional Adein B CostTtem Assembly Inputs
Rale 5 - Admimn Fale 5 Admin O Cost Item Assembly Record
Fole & - Sethings Admin Rode &~ Settings Admn Cost Item Assembly Register
Finle 7 - Engineer & Root Role 7-Engineer & Root . It R 1
Role 8- Admin 2 Role 8- didmin 2 B "
5]~ Aole3-Snapshots-Add,vi... | 5]-Role3 . o
55 Defsalt Quoke: Record Iy

Ag-Entered Curenty  As-Entered Units

e 1

Onelvve-QA-23.2  Library

Permissions are managed in the Access Control Register in the Setup tab of the Library.

This register is a list of accessible objects, which can be used to grant or restrict permissions to various
roles. By default, the register is organized by type, then by category. Removing the grouping lets you
search for key words using the search capabilities of the register.
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Access Control Register O

pag|
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Type Category Ribbon Mame
Destination Fuel Cost Record Fuel Cost Record =
Destination Geographic Area Record Geographic Area Record
Destination Haul Calouator Record Haul Caloulator Record
Destination Job Properties Job Properties
Destination Job Register Job Register
Destination Job Snapshots Job Snapshots
Destination Job Status Register Job Status Register
Destination Main Form Main Ferm
Destination Microsoft Excel Microsoft Excel
Destination Organizational Category Fecord COrganizational Category Fecord
Destination Pay Item & Proposal Register Pay Item & Proposal Register
Destination Pay Item Record Pay Item Record
Destination PBS Change Record PBS Change Record
Destination PBS Changes Register PBS Changes Register
Destination Period Resource Quantities Period Resource Quantities
Destination Price % Add-On Record Price % Add-On Record
Destination Price Breakdown Structure Price Breakdown Structure
Destination Price Category Record Price Category Record
Destination Quantity Roll-Up Record Quantity Rol-Up Record
Destination Quote Comparison & Award - Costitems  Quote Comparison & Award - Cost items
Destination Quote Comparison & Award - Resources Quote Comparson & Awand - Resources

The Type of the accessible object is one of the following:

e Command: Actions that are in the main ribbon navigation.

e Destination: A form or location within the application. Restricting this type of permission means that
all the actions that are available in the form are unavailable.

* Register Command: These are the commands that appear for the specified register and are
commonly accessed either by using the actions menu in the navigation ribbon when the register is
active or using the right-click context menu commands on the records in a register.

Categories and subcategories can be used to further group and identify various accessible objects.

The Ribbon Name column provides the navigation path and name of the object as it appears in the
ribbon navigation. The Show Classic Navigation Accessible Objects button on the Actions tab of the
Access Control register can be used to identify accessible objects as they might have existed in the
legacy version of Estimate, and are still available to assist users who may have set up Access Control
prior to the newer ribbon navigation.

Follow these steps to set up Access Control on an Accessible object:
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1. Identify the role or roles in the User Roles register, then right-click to copy.

* In the Access Control register, you can filter on the Role Assigned field to help you see the
associated roles with Access Controllable objects.

User Roles Register - Library

Actions

Actions

= Print [40open & LinkField =h Print New G Copy & Link Field
':i]:l Preview % Copy UnLink Field ':a Preview Delete E Paste UnLink Field
&' Export to Excel &' Export to Excel Cut Fill Down
Print Edit Workbook - Print Edit Workbook
Drag columns here to group Saved views: . Standard View - ‘ Drag columns here to group
Role Name - Description Subcategory A Ribbon Name
1_MR 1_MR * Work Breakdown Structur...  Actions > Edit > Copy
— Account Administrator E :Qpen Work Breakdown Structur...  Actions > Edit > Cut
Account Administrator- 4 — Copy Work Breakdown Structur...  Actions » Edit > Delete
Account Administrator-{ Work Breakdown Structur...  Actions > Edit > Fill Down
Account Administrator- ¢ "F& Link this field to Excel Work Breakdown Structur...  Actions > Edit > New
Account Adrministrator-(C.2__e S Work Breakdown Structur...  Actions > Edit > Open
Account Administrator- Cop...  Account Administrator Work Breakdown Structur...  Actions > Edit > Paste
Account Administrator- Cop...  Account Administrator Work Breakdown Structures ~ Actions > Edit > Copy
Account Administrator- Jay...  Account Administrator Work Breakdown Structures ~ Actions > Edit > Delete
Account Administrator- Josh  Account Administrator Work Breakdown Structures ~ Actions > Edit > Fill Down
Account Administrator- KS Account Administrator Work Breakdown Structures ~ Actions > Edit > New
Account Administrator- Lav Account Administrator-Lav Work Breakdown Structures ~ Actions > Edit > Open
Account Administrator- Shu...  Account Administrator — Work Breakdown Structures ~ Actions > Edit > Paste
Account Administrator- sree...  Account Administrator Work Breakdown Structures ~ Actions > View > Clear Filter
Account Administrator- Sri Account Administrator Work Breakdown Structures ~ Actions > View > Default Data Bl
ACS Admin Kiewit ACS Admin . Work Breakdown Structures  Actions > View > Filter > Filter tc
— Workers Comp Overrides Actions > Edit > Copy
> ~ Workers Comp Overrides Actions > Edit > Cut

Ac.Fntarad Curranms

Arc.Frntarad |l Inite

77 1INNA 1ikhrare

2. Select one or more accessible objects in the Access Control register and right-click to paste.
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Reole Mame &
=  Estimator

Foreman

Integration Settngs

15 Rike:

KNROLEL

Lead Estmator

Mmoo

MLG-1

M-z

MmQ-3

MLG-3- Copy w/Add Projects

NP1

HP-2

Role 01~ Engineer

Role 1 - Engnesrr

Raole 2 - Essmatorr

Feghe: 3 - Lead Estimator

Role 4 - Regional Admin

Role 5 - Adminn

Role & - Sttings Admin

Fole 7 - Engineer @ Root

Feple: 3- Admin 2

£J- Role3-Snapshats-Add,wi

correctly made.
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Saved views: | Standard View

Description

Inbagration Settngs
IS Roke:
KNROLEL

testevel O
sty 1
negtdeel 2
testdevel 3
testievel 3
Estmate Full Access
HP-2

Rigle 01- Engneer
Role 1- Engneer

Role 2- Estimator
Role: 3- Lead Estimator
Role 4- Regional Admin
Role 5- Admin

Reoke §- Settigs Admin
Rl 7- Enginesr @ Root
Feple: 3- Admin 2
83-Roled
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Access Control Register O

Type

Pay Item & Propossl Regster
Pary Item Record

Period Resource Quantiies
Price: 3¢ ddd-On Record
Price Breakdown Struchure
Price Category Record
Quantity Rol-Up Record
Quaote Comparison & Award - Cost items
Quote Comparison & Award - Resturoes
Quote Cast [hem Record

Quote Group Tag Record

Quote Group Tags Regster

Quote Recond

Quote Regster

Guote Resource Item Record

Reports

Request for Quote (AFD) Record
Request for Quote (RFQ) Regster

3.10 Security in Estimate

Ribbon Name

Job Status Register
Main Form
Microgoift Exoel

Organizatonal Category Record

Pay [tem & Proposal Register
Pay [bém Recond

PS5 Change Record

e L]
PES Chang gster o
Period Resource Quantite

Price % Add-On Record |
Price Ereakidawn Shructung

Mew
Delete
Cut

Copy

S Paste I

Price Category Reoord

Quantity Rol-Up Record
Quote Comparisn & Awa| &
Mr I&ﬂll-l:::-‘

Eill Dicrvn

£ Link these fields 1o Excel

UnlLink from Exeel

Quoite Cost Item Record
Quote Group Tag Record
Quote Group Tags Regster
Quote Record

Quote Regeter

Quote Resource [tem Record
Reparts

Request for Quate (RFQ) Recand
Request for Quote (RFQ) Register

3. Expand the detail records of the accessible objects to verify the role assignments have been
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User Roles Register O

Rl Mame B
Estimator
Foreman
Enbagration Settngs
IS5 Roke.
KNROLEL
=  Lead Estmator
MG
MQ-1
Moz
MQ-3
MLG-3- Copy wiAdd Projects
NP1
HP-2
Fole 01~ Enginser
Rioke 1 - Enginesrr
Robe 2 - Esfmaborr
Role 3 - Lead Estimator
Role 4 - Regional Admin
Role § - Adminn
Rl & - Settings Admin
Rl 7 - Engineesr @ Root
Role 8- Admin 2
&3- Role 3-Snapshots-Add, v

55

Sanved views:
Descriplion
Estimator
Foreman
Integration Setfings
IS Rile:
KNROLED
Lead Estmator devision
testevel O
bestdavel 1
testdevel 2
testdevel 3
testdevel 3
Estimate Full Access
he-2
Rgle 01~ Engineer
Role 1-Engnesr
Rigle 2- Esmator
Righe 3- Lead Estmator
Figle 4- Regional Admin
Roke 5- Admin
Righe - Sattings Admin
Righe 7- Enginesr @ Rool
Righs 5- Admn 2
53-Role3

Access Control Register

Type

= |~ Destination

B rs chance Record

Estimate Essentials User Guide

Category

ok Status Register

Main Farm

Macresoft Excel

Organizational Category Recond
Pay Item & Proposal Regster
Prany Item Racond

PES Changes Fegster

Ribbon Name
Job Status Register

Main Form

Microsoft Excel

Organazatonal Category Record
Pay [tem & Proposal Register

Pay Item Reoord

PS5 Change Revard

PES Changes Register

Period Resource Quantities

Price: % Add-On Record

Frice Breakdown Structure

Frice: Category Record

Quantity Rol-Up Recond

Quote Comparison & Award - Cost items
Quote Comparison & Award - RESOUNCES
GQuote Cost Item Record

Quote Group Tag Recard

Quote Group Tags Register

Period Resturce Quantites

Frice % Add-On Regord

Price Breakdown Struchure

Price Category Recand

Quanitity Roll-Up Record

Quate Compaison & Award - Cost ters
Quote Comparison & Award - Resources
Cuote Cost 1tem Record

Quote Group Tag Recond

Quoie Group Tags Register

MeJ=0 You can drag and drop the Roles onto the accessible objects in these two registers.

If no roles are assigned to an accessible object, no restrictions are applied to the accessible object, and
anyone with access to the application will be able to access that destination or command. When

setting up Access Control, be sure to identify the commands and destinations in Estimate that you

want to restrict permissions to, and then assign the roles to explicitly grant permissions to those

accessible objects.

In the following example, both Estimators and Lead Estimators are permitted to invoke any of the
actions on the records in the PBS Changes Register, but only the Lead Estimator is permitted to

activate or deactivate the PBS Changes Log. Because no roles have been assigned to the Activate ‘View

Change Record’ prompt, anyone with access to the application will be able to perform that action.
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User Roles Register @
Drag columns here to group
Role Name: =
Estmator
Foreman
Integrabon Setings
IS Role:
KNROLEL
=+ Lead Estimator
MLO-0
MLQ-1
MLg-2
MLg-3
MLG-3- Copy wiidd Projects
NP1
NP2
Role 01- Engineer
Role 1 - Engineerr
Role 2 - Estimatorr
Role 3 - Lead Estmator
Role 4 - Regional Admin
Role 5 - Admnn
Rl & - Settrge Ademin
Role 7 - Enginesr  Root
Rinle 8- Adein 2
51- Role3-Snapshots-Add, vi.

55

Integration Settings
15 Roke

KM ROLEL

Lead Estimator division
testdevel 0
testdevel 1
astdevel 2
testdevel 3
test-devel 3
Estmate Full Access
MP-2

Rde 011 Engineer
Fole 1- Enginser
Role 2-Estimator
Ruole 3- Lead Estmator
Rede 4-Regional Admin
Rlole: 5- Admin

Rede §- Settings Admin
Role 7- Engineer @ Rloot
Role 8- Admin 2
5)-Role3

3.10.4.2 Access Control Report

Category

PBS Charges Register
PBS Charges Register
PES Changes Register
PBS Changes Register

fES Ol =

PES Changes Register

PBS Changes Register

PBS Changes Register
PBS Changes Register

3.10 Security in Estimate

» |PBS 1718

Ribbon Mame

Actions: > Edit > Copy
Actions > Edit > Cut
Actions: > Edit > Delete
Actions. > Edit > Fill Down
Actions > Edit > hew

Actions > Edit > Open

Actions > Edit > Paste

Actions > Tools > Activate Changes Log

Actions > Tools > Activate View Change Record Prompt
Actions > Toals > Deachvate Changes Log

Ptk M 51 = Frens

You can use the Access Control report to audit user permissions, command access, and various

restrictions without having to search through the Access Control register for this information.
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Reports - Access Control (Excel) ©

- Resparts -
5 . Filé name  C:\Jsers\Paul Downloads \AccessControlEaport. kisx
;p' r
- Paul Trippi
» & R
» g " File Home Insert Page Layout Formulas Data Review View  Automate Help U Comments | | = Share ~
» O
(1] . .
» @ 0 (] - I Ribbon Mame b
» = A B C D 3 F -
e 1 |Tvpe Category |Ribbon Name |1_MR 719-R1  Account Administ
» E 2  Command
3 Command
Ausch 4  Command
2o Register 5 Command Bond Cost Item Record Actions > View > Default Data Blocks
InEight Schedude Cost Risk [xsx 6  Command Bond Cost [tem Record /A
v o Ubrary 7 | Command Cash Flow Mt':ons = Print El Pagel Setup
FP— 8 |Command Cash Flow Actions > Print > Preview
s 9  Command Cash Flow Actions = Print > Print
Master Foundation Setup Data 10 Command Cash Flow Actions > Tools = Cash Flow Options No Mo No
» Master Resources 11 Command Cash Flow Actions > Tools = Display Settings No No No
Master Resource W 12 Command Cash Flow Actions > Tools » Worksheet No Mo No
Access Control {Exced) 13 Command Cash Flow /A
» Saved Views (Library) 14 Command Cash Flow /A No Mo No
Custam Reports 15 Command Column Captions {Context Menu) = Change Caption...
» Saved Views 16 Command Column Captions (Context Menu) = Reset All Captions...
. N N 17 Command Column Captions (Context Menu) > Reset Caption...
18 Command Connected Analytics Actions > Tools > Auto-Update
P P ——— N A A sl Ambinme s Tanle s fannalilndass - 1
Access Control (Excel) Export @ L v F

The report makes it easier to find the role names along with their associated Yes and No access
permissions to each form in Estimate.

A | B | C | 8] | E F G
MAecount Acecount Administrator-

1 Type Category Ribbon Name Administrator Al permission Design - Eng - Admin  Design - Eng - Project Admin  Design
2 | Command
3 Command
4 _Command
5 Command Bond Cost Item Record Actions = View > Default Data Blocks
B _({:rnmand Bond Cost Item Record NfA
7 Command Cash Flow Actions > Print > Page Setup
8 Command Cash Flow Actions > Print > Preview
] _-Command Cash Flow Actions = Print > Print
10 | Command Cash Flow Actions > Tools > Cash Flow Options No Mo Yes No No
11 | Command Cash Flow Actions > Toals > Display Settings Mo Mo Yes No Mo
12 Command Cash Flow Actions > Tools > Waorksheet Mo No Yes No No
13 | Command Cash Flow M/A
14 | Command Cash Flow N/A Mo Mo Mo Mo No

Step by Step — Access Control Report

1. Open a job, and then select the Setup tab.

2. Click the Reports icon.
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You can access the Reports menu from the Setup, Estimate, Quote, Price, and
Execution tabs.

File Setup Estimate Quote Price System Integrations

H ¥ Bt &L % a B B

2 Equipment

Job Propertes  Foundation  Pay Item & Bid Wizard | Resources | __ ) Resource CostItem  Standard Reports
hd Setup Data = Proposal - iR Materials Assemblies | Assemblies  Tables
Initialize Resources Assemblies /Reports

3. Expand Library Module, and then select Access Control (Excel).

4. Select a file name, or choose another file name path.
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File name | C:'\Users\Downloads\AccessControlExport. xsx

5. Click Save, and then click Run.
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@ Save As
4 4 » ThisPC » Downloads v 0 2 Sear
Organize « Mew folder
E5 0SDisk (C) # *  Name Date modified Type
Git Project
it Projects 4 ~ Last week (1)
Compliancel ) ) )
@ InEight Control Celumns List (1).xlsx 11/7/2023 2:08 PM Micrasoft E
Control
) ~ Last month (5)
EstirnateCloud
Schadule @ AccessControlExpertals: 10/26/2023 8:57 AM Microsoft E
@ Excel importxlsx 10/23/2023 5:32 PM Micrasoft E
@ OneDrive - InEight @ Suite Administration PT.xlsx 1041172023 10:41 AM Microsoft E
Platform tepics.xlsx 10/9/2023 3:42 AM Microsoft E
[ This PC = piess _
- @ Roles-and-Permissions-Workbookxlsx 10/6/2023 9:25 AM Micrasoft E
;’ 3D Objects
~ Earlier this year (9
I Desktop ¥ @)
Documents @ InEight Control Celumns List.xlsx 9/20/2023 3:49 PM Microsoft E
@ improved.xlsx 9/20/2023 12210 PM Micrasoft E
‘ Downloads
<
File name: | C:\Users\Downloads\AccessControlExport.xls:
Save as type: |1(|su files (*xlsx)
» Hide Folders Save
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File name | C:\Users\Dawrloads\AccessControlExpart. dex

3.10 Security in Estimate

@ savehs

4 & > ThisPC > Downloads

Organize +  Mew folder

AT 0SDisk(C) 4 * Mame

GtProjects # | oot week (1)

Compliancel :
32 InEight Contral Columns List (1)alsic

Control
~ Last manth (5)
13 AccessControlExportxlsx
32 Excel importadsc
@ OneDrive - InEigh B3 Suite Administration PT.xlsx
£32) Platform topicsalsc

EstimateCloud
Schedule

Date modified

11/7/2023 2:08 PM

£ Search Dawnloads

Type

Microsoft Excel Work...

Microsoft Excel Work...
Microsoft Excel Work...
Microsoft Excel Work...
Microsoft Excel Work...

Microsoft Excel Work...

Microsoft Excel Work...

Microsoft Excel Work...

[ This PC
- 32 Roles-and-Permissions-Workbook.xlsx
¥ 3D Objects i
I Deskeop ~ Earlier this year (9)
2 Documents 834 Inight Control Columns List.xlsx
$ Downioad ) improved.xlsx
ownloads
File name: | (&

Save as type: |xlsx files (“xIsx)

-+ Hide Folders

Save

Cancel

\e

Run Close

What's Next: Open the Access Control Excel file to filter, sort, or perform any type of audit to help you

determine user or role access.

3.10.5 Granting permissions to the Estimate Library

In Platform, permissions relating to the Estimate library are found in the Master data libraries

permission section.
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= fat  Suite administration / Roles and permissions

Roles and permissions > Edit role

Master data libraries

Select all
Account code structure Select all Contacts Select all Cost c:
¢} View Account code . ) View contacts =)
(¥ Add Account code (¥) Add contacts |
[=*} Edit Account code [} Edit contacts
(x) Delete Account code Promote contact to user
Approve/Reject Account code (x) Delete contacts

Approve all account codes

Cost centers Select all Currency Select all Discipl
¢} View cost centers =)
(¥ Add cost centers (¥) Add currency :
[=* Edit cost centers [ Edit currency |
() Delete cost centers (%) Delete custom currency |
Estimate Select all Field attributes Select all Generz
[=*} Edit estimate library éy View field attributes =)
Use templates (¥) Add field attributes :
(#) Add template [ Edit field attributes |
[=# Edit template () Delete field attributes |

(%) Delete template

To grant Estimate library permissions to a role, the role must be an Administrator Level 3 - Account
Admin. If not, the permissions are not selectable on the Add/Edit Role setup page.
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Suite administration / Roles and permissions

Roles and permissions >  Add role

Role details
* Name Description * Administrator |eve
Estimate Administrator Lewvel 3 - Account Admin v i)
Level 0 - Base
X . Level 1 - Project Admin
Permissions :
Level 2 - Organization Admin
Level 3 - Account Admin h
Suite administration

Organization and project

Master data libraries

The Master data libraries permission section is also where the permissions controlling which roles can
manage templates are found.

3.10.6 Common roles used when securing an Estimate

The process of creating an estimate for a bidding opportunity commonly requires unrestricted access
to the capabilities of Estimate so that estimators can work efficiently. However, depending on the level
of data governance within an organization, you might want to preclude certain users from accessing
some of the more sensitive parts of Estimate. If changes were made, either accidentally or otherwise, it
could impose detrimental impacts on the organization.

Estimate’s security model is very detailed and robust. When designing a security model that restricts
certain features and functionality of Estimate, each company must weigh the benefit of the protection
of such restrictions which could bring unwanted or uncontrolled changes and negatively impact the
productivity of the estimating process. While it is possible to create a very detailed and robust security
model with many different roles for individuals within an organization, it is not necessary to set up and
maintain roles for all of Estimates accessible objects. It is likely a company can effectively secure their
sensitive data with no more than a couple roles granting permissions to a few commands and
destinations.

A common way to implement security on the Estimate application is to restrict access to certain
system level settings, such as who can modify data in the library, or who can change any company
specified custom column captions.
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The following are some of the more common Roles a company may set up, describing the purpose of
the role and typical permissions:

¢ Lead Estimator: Lead Estimators are commonly assigned to estimates based on their knowledge
and experience. They may be precluded from creating or deleting estimates themselves or
changing any system level settings, but commonly have full access to all the capabilities needed
to create and maintain the estimates they are assigned to.

¢ Estimate Manager: Estimate Managers are commonly responsible for identifying bidding
opportunities and determining which opportunities to pursue. Once it has been determined that
the company will pursue an opportunity, the Estimate Manager creates the estimate and assign
it to a Lead Estimator based on resource availability relative to all the bidding opportunities the
company will be pursuing. These roles manage the creation of estimates and assist in ensuring all
the necessary supporting data is available, such as assigning appropriate project attributes or
including needed resource libraries.

¢ Administrator: Administrators ensure accessibility and availability of the solutions utilized by
estimators. Typically, they control system level settings and activities that would affect company
standards, such as changing column captions, ability to define corporate views, list of job
statuses and ribbon settings. Other typical permissions restricted to only the Administrator level
roles are the ability to access the User Roles register and the Access Control register.
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Lesson 3 Review

1. When you create a new job folder, all category labels defined in the Library Foundation Setup
Data Register will be copied to the new job folder automatically.

a. True

b. False

2. This resource type is a catch-all and can be used for anything from dump fees and security to
creating subcontractors as a resource.

a. Installed Materials

b. Unique

C. Labor

d. Construction Equipment

3. The Construction Equipment and Rented Construction Equipment Resource Rate Records include
consumption rates that will factor with the fuel cost you define where?

a. Library Foundation Setup Data

b. Library Resource Rates

o

Job Properties

o

Cost Breakdown Structure

Lesson 3 Summary

As a result of this lesson, you can define, adjust and explain:
e Library Job Properties
e Library Foundation Setup Data Register
e Library Resource Rate Register

e Library Assembly Register
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LESSON 4 — PROJECT SETUP

Lesson Duration: 45 minutes

Lesson Objectives

After completing this lesson, you will be able to:
¢ Create a new project
e Enter Job Properties

e Create pay items in the Pay Item & Proposal Register

Lesson Topics
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4.1 JOB CREATION

4.1.0.1 Platform project association

You can associate your estimates with additional master data, such as project data from the Project
details page in Platform. Associating Platform projects lets you organize estimates directly from
Platform’s Organizational Breakdown Structure (OBS). Your location assignment in the OBS determines
the access you inherit and the visibility you have to other areas of the OBS.

Extracting Platform project master data directly into Estimate promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

InEight Estimate

Developer Tools Integrations

— (& Saved Views ~ i Colors ~ ‘_-‘; External Reports ~ @ e About Estimate

,Z‘ Titles ~ Q Output Settings ~ ‘J External References ~ G Release Notes

Customize Estimate InEight
Help @ InEight.com University

Customize Help

DT Platform projects

M\ Project ID Project Name Status Created Date
Core Project: ™ | Project A4998 -

Project A4937 Project A4997 New 4/1/2020 3:56:14
- i \ [@l Project A4998 New 4/1/2020 3:56:14
Project A4999 Project A4999 New 4/1/2020 3:56:14
Description: Clemson Creek Restoration project] Project AS Project A5 New 4/1/2020 3:52:36
‘ Project ASD Project ASO New 4/1/2020 3:52:37
Project AS00 Project A500 New 4/1/2020 3:52:41
[] Auto-Update Job in Connected Analytics Project AS000 Project A5000 New 4/1/2020 3:56:14

Platform project specific master data can be maintained in one place, then it can flow directly into
Estimate in the Cloud. Certain project data such as location and forecast start and finish dates are now
maintained in Platform which helps to enforce data consistency and reduce duplicate entries.

The fields that are located in Setup > Job Properties > Overview that are maintained in Platform and
integrate into Estimate consist of: Project ID, Organization, and Notes. The fields on the Estimate Cover
Sheet tab include Location, State, City, Country, and Latitude and Longitude, Forecast Start and Finish,
and Duration.
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Job Properties ©
Overview | Cover Sheet | CostBasis | Minority Setup | Fuel Cost

Code: 4985362 version 1

Project ID: |4985362

Description: | 2020 Clow Creek Shoreline Restoration Project

Overview Cover Sheet | CostBasis Minority Setup | Fuel Cost | Job Folder Tags Prici
Identification

_ Location: Scottsdale, AZ
Notes: | shoreline Restoration project

City: Scottsdale

County:

Country: | United States O...
State: | Arizona

Latitude: 41.77287

Longitude: -88.14793

The Project ID field in Estimate is a hyperlink field that takes you directly to the project Details page in
Platform.

Job Properties ©

Overview | CoverSheet | CostBasis | Minority Setup | FuelCost | JobFolder Tags
Code: 4985362-v1

Project ID: [4985362

Description: [ 2020"

Jow Creek Shoreiine Restoration Project - Original Estimate

Project details

DETAILS

All projects & organizations >  Edit project

Project settings [ Cancel ]

Project details /‘

#' *Project ID 4 Notes

4985362 o) shoreline stabilization and revegetation of
ative turf g n designated areas to restore impaired
ecological i o the impacted area
* Name

2020 Clow Creek Shoreline F,
*Phase @
Pre-Execution -

When modifications are made to any of the integrated fields in Platform, then saved, the changes
automatically show in Estimate. For example, if you need to change the name of the project in
Platform to show the year 2023 instead of 2020, this change is reflected in the in the Job Properties >
Project Name field form in Estimate.
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Project details y

(
| T __/‘

* Project ID

4985362

* Name

| 2023 Clow Creek Shoreline Restoration|

~

{

N

Job Properties ©

Overview | Cover Sheet | CostBasis

Mry
Code: 4985362-v1

Project ID: |4985362 /

Description: | 2020 Clow Creek Shoreline Reg?®™

Cash Flow

Equipment Maintenance

Benchmarking

1 Project Name: [2023 Clow Creek Shoreline Restoration

4.1.0.2 Job Register Management

Estimate Essentials User Guide

An advantage to associating Estimate with Platform project data is the capacity to manage multiple

versions of Estimates from one source project.

For example, if you have multiple addendums issued for the same project, you can maintain a version

of the estimate for each addendum you’ve received.

Job Register ©
Project ID Description = Country
4985362 2020 Clow Creek Shoreline Restoration - Per Addendum 1 United Stat.
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 2 United Stat...
4585362 2023 Clow Creek Shoreline Restoration - Per Addendum 3 United Stat
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 4 United Stat
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 5 United Stat...

State

Tlinois
Tlinois
Tlinois
Tlinois
Tlinois

Latitude

41.77287
41.77287
41.77287
41.77287
41.77287

Longitude

-88.14793
-88.14793
-88.14793
-88.14793
-88.14793

Grouping estimates together using a common project means there is no need to structure and enforce
a job coding schema in Estimate on the Job Code, or use tag fields or user defined fields to identify and
manage different versions of a project in the Job register.
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Job Register ©
ProjectID =

Eﬂj' B Description B Country State Gty Latitude Longitude
S Unassignec

5 = 4985362
4985362 2020 Clow Creek Shoreline Restoration - Per Addendum 1 United Stat.. Dnois  Mapervile 4177287  -88.14793
4985362 2020 Clow Creek Shareline Restoration Project - Original Estimate United Stat... Dinois  Napervile 4177287  -88.14793
4985362 2020 Clow Creek Shareline Restoration Project - Per Addendum 1 United Stat... Dinois  Napervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 2 United Stat.. Mnois  Mapervile 4177287  -88.14793
4985362 2023 Clow Creek Shoreline Restoration - Per Addendum 3 UnitedStat.. Dinois  Napervile 4177287  -88.14793
4585362 2023 Clow Creek Shoreline Restoration -Per Addendum 4 United Stat . Dinois  Napervile 4177287  -88.14793
485362 2023 Clow Creek Shoreline Restoration - Per Addendum 5 United Stat . Dnois  Napervile 4177287  -88.14793
B 4985922
B 4992404
B 4996059

Job register grouped by Platform project

Grouping by organization lets you see projects batched in an organizational breakdown level, and lets
you see a listing of projects in an organizational breakdown format and projects derived in Platform.

Job Register © \ -

Organization =

Organization = Source Job Praject Name Description de Status Schedule L

— @ Unassigned -
B Estimate Infrastructure

Estimate Mining |

=P =2 Estimate Power
Estimate Power m SR-2023FEB restored .00000  Bidding Microsoft Proj
Estimate Power Saas-Fulllmport232 SR-DBY| 207414 Bidding Primavers
Estimate Power DWH-2 SR-2023FEB SR-2023FE8 \ 00000  Bidding Microsoft Proj
Estimate Power SR-Job2 SR-2023FEB from existing 9000  Bidding Microsoft Proj
Estimate_Infrastructure_South Central |

—p = 5100000 - PKS Inc
5100000 - PKS Inc Rail Rail 00000  Bidding Microsaft Proj
5100000 - PKS Inc $1201-—name 51201 1.00000  Bidding Microsoft Proj
5100000 - PXS Inc SR-Job3 03102022 03102022 \ 00000 Bidding Microsoft Proj..
5100000 - PKS Inc KwiSaa52212-5el 226-5R 0000  Bidding Primavera
5100000 - PKS Inc D8-0209 New projectname: 2:38  SR-TESTAPI-123 | 000 Biddng Manual
5100000 - PKS Inc new proj API Job from Import 000 | Bidding Microsoft Proj... 7

“ »
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OBS filter tree

You can use the organization tree filter to see where estimates exist in the OBS.

When the Organization Tree Filter is enabled, you can see the jobs that are associated with an
organization tree node in the new OBS filter tree. This helps you locate and organize estimates to more
quickly inside of an organization hierarchy.

File Setup Estmate System Integrations

= Print & New Copy Clase s e
.
'ﬁ Preview Dedete Paste {4 il Down -
. Job Status
&' Export to Excel Cut Load
Print Edit Tools

Job Register ©

Organization > Drag cok ere o group

Name = In Use Deseri
w
Clari
India
[] WCAD'
101924 [] Waterkoo
~ SB2000 - Energy 101579 East Rai
»  SC2002 - Oil, Gas & Chemical 102447 Border W
»  SC2003 - Power 190001 150001
> 5C2004 - Industrial 150002 ] 15000
d 190003 ] o
¥ SE4000 - Mining L
150004 15000
» SB5000 - Other —
I
, 24-5 Fulllmport TO1 L] 24-5Fu
24-5 Selectivelmport TO1 NP1-245
245802 [] BC2
5 o
120

If you group by Project ID, and then select a node in the organization, you can see all the projects and
their associated estimates belonging to that part of the organization. For example, there are three
estimates associated with project 4985362 and one estimate associated with projects 4992404,
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5013592 and 5013787. This view shows you the relationship between all the project and estimate
associations.

Job Register ©
Organization X
ProjectID =

Name

~ = o Code Desaription =
_ = 4985362 3
QW 4985362 4985362 2020 Clow Creek Shoreline Restoration
_ 4985362 4985362-v2 2020 Clow Creek Shoreline Restoration - revised per Addendum #1
_ 4985362 4985362-v3 2020 Clow Creek Shoreline Restoration - revised per Addendum #2
Mg = ass2404 1
_ 4992404 4992404 2020 Concrete Repairs Program
= o sewsssz 1

5013592 5013592 Springbrook Golf Course Dynamic Sign Install
= 5013787 1

Step by Step — Create a New Job

1. From the InEight Estimate Backstage view, under the Create a new Job from... section, select
Scratch, or select New > Scratch from the left sidebar menu.
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Library - Estimate

InEight®
ESTIMATE

Open a recent Job

ﬁ Mare...

Training Job
Training Job -
Maricopa County...

Close All Jobs

Jobs

Templates

Snapshots

Create a new Job from...

Scratch Template Existing Job Bid Wizard

Archive | Restore

On the New Job dialog, select a Core Project from the drop-down.
Modify the Code field.
Type in a description of the job in the Description field.

Determine if you want to check the "Auto-Update Job in Connected Analytics" box.

o 0o bk v DN

Click OK to create the new project.

4.2 JOB PROPERTIES

When you create a new project, the Job Properties form automatically displays. This is where you can
enter basic information about the project. To open the Job Properties form at any other time, on the
InEight Estimate landing page, select the Setup tab and click Job Properties.

4.2.1 Overview Tab

The Job Properties form opens to the Overview tab.
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Overview - Overview Tab

T T R

1

InEight Inc. | Release 24.7

Code

Project ID

Description

Status

Project Name

Organization

Notes

Job created by

Source Job

This is the name of the Estimate job and can be change at the
time of creation, but cannot be changed after.

The Project ID originates from Core and cannot be changed.
Click on the Project ID to navigate to the Project Suite Core
project.

The Description can be changed at any time.

Indicates where in the process this job is (e.g., Bidding,
Awarded, etc.)

* When searching for jobs in the Job Folders list, you can filter
and sort jobs by their status

* These job statuses can be adjusted to fit your company
requirements in the Jobs Register, Tools Menu, Job Statuses.

Information in this field derives from Core.

Information in this field derives from Core.

Notes can be added in the Core project at any time and is used to
document project specifics.

Indicates the user or entity that initially created the job.

The name of the original job that the job was copied from.
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Job Properties © <

Code: TramlngJubWastdlstn:t Status: [Biddng |~ | Organization: | 5100000 -PKS Inc

Project ID: |Training Job Pro]ect Name: Training Job o
Description: | west district freeway’ South project
Core Project: * | Training Job o

g Code: * [Training Job West district
Notes:
Description: West district freeway 5 South project.| o

Overview | CoverSheet | CostBasis | Minority // m(e Benchmarking | Alternates

[] Auto-Update Job in Connected Analytics

(
/
(

Last Saved: 4/4/2024 10:37:12 AM

Job created by: Paul o

Source Jub

el = When you copy a job, the new job shows the name of the person who created the copied
job, and the name of the source job the job was copied from.

4.2.2 Cover Sheet Tab

The Cover Sheet tab is where you can define much of the general information about the project. It
includes fields to identify the job’s location, contacts, and bid details.

The following fields are available:
* Job Location
 City, County, Country, Province/State
e Job Type
e Engineer
e Owner
e Architect
e Forecast Start and Forecast Finish
* Bid Date and Bid Time
* Bid Location

e Estimator
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e Opening Type and Proposal Type
e Liguidated Damages (if applicable)

Cost Breakdown Structure (CBS) Register Job Properties © =
Overview Security Cover Sheet | CostBasis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors Pricing Schedule Cash Flow Equipmen r
Identification
Location: |I-1El MP 100 to MP 120 | Type: |Highway and General Engineering | Contract Duration:
City: Engineer: | Example Engineer -- Fred Jones B Time Measure: | Contract Days ~
County: Qwner: | Example Owner — Jerry Slate = Forecast Start: | 1/5/2014 -
Country: | United States - Architect: | Example Architect -- Robert Frost [zl Forecast Finish: | 6/5/2014 -
State: | Arizona M Duration: 150
Proposal
Bid Date: | 12/23/2013 - Opening Type: ‘Puhhc ‘
Bid Time: ‘IU:UU:UU PM Proposal Type: ‘Unlt Price ‘
Estimator: | Example Prime Contractor 1 —Tom Cross O] PlanHolders: ‘ 5 ‘
Mo 11 o

The fields on this tab can be helpful for historical reference and job classification. It is good practice to
complete as many of these fields as possible, so you can reference and find the project later. These
fields can be updated as needed at any time.

4.2.3 Cost Basis Tab

The Cost Basis tab has some important settings that will affect how costs are calculated in your
estimate. The settings reviewed below are the ones you need to consider.

e e

1 Standard Shift The default standard shift arrangements are set up as 8 hours per shift,
Arrangements 1 shift per day, and 5 days per week; this can be changed if a project
requires a different standard shift arrangement.

2 Standard Allows you to indicate what percentage of your labor hours will be
Wage Rate regular time (Scale 1), overtime (Scale 2) or double time (Scale 3). You
Composite: can enter these percentages manually, or you can use the Shift Rate

Calculator to obtain a more accurate figure.

3 Lock Cost For this sample job, you will check this box. When Cost Items are
Items to Pay locked to Pay Items, your level 1 estimate structure is controlled by your
ltems: list of pay items.
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I T S

4 Default The default will be set to U.S. Dollar, but this can be changed if

Currency: needed.
5 Sales Tax This field is not required but may be used to automatically apply a sales
Rate: tax to all your material and rental items. The default is set to zero.

Cost Basis Tab Overview

Job Properties @ =
Overview | Samn Cover Sheet ‘ Cost Basis tup | Fuel Cost | Job Tracking | Job Folder Ta@umpehturs | Pricing | Schedule | Cash Flow | Equipmen L3
Standard Shift Arrangements Standard Wage Rate Composite Rules
Lock Cost Items to Pay Items [] Preserve ariginal Cost Item
Waork Hours per shift Scale 1: 100.00| % Pay Item Unit Price Precision: 2 Data Source
Pay Hours per Shift: 8.00 Scale 20 0.00] % [ Activate PES Changes Log
[] Activate Quantity Checking

shifts per Day: 1.0 Scale 3: Ya
i i [[] Maintain CBS Structure at Level: o
Shift / Rate Caleulator When man-count changes: (@ Change UM / Man-Hour

a (O Change Days
Currency Standard Rates

| Sales Tax Rate: 5.00( g |

!!

Days per Week:

Default Currency: | U.5. Dollar -

Resource | Assembly Filter

Resource / Assembly Type ™ Resource f Assembly File ... » Geographic Area [al Wage Zone [l Organizational Category [l Import Filtered
Labor Rate [aI [All [ fam [All Resources
Construction EquipmentR.... [ Mone] [ Mone] [ Mone] [ Nore)

o I e T Y P s e R T I e P he

< > € > € > € > < >

oK | | Cancel

4.2.4 Shift Rate Calculator

Take a closer look at calculating your shift rates using the Shift Rate Calculator. For this example, you
will walk through setting up 2 shifts for your project.
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Step by Step — Shift Rate Calculator

1. Onthe Job Properties > Cost Basis tab, select the Shift Rate Calculator button.

Job Properties @
Overview Security Cover Sheet Cost Basis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors Pridng Schedule Cash Flow Equipment L3

Standard Shift Arrangements Standard Wage Rate Composite Rules
Lock Cost Items to Pay Ttems [ Preserve Original Cost Item

Work Hours per Shift 8.00 Scale 1z 100.00 | % Pay Item Unit Price Precision: Bokaisoure

[ Activate PBS Changes Log

II

[] Activate Quantity Checking
shifts per Day: 1.00 Scale 3z

Pay Hours per Shift: 8.01 Scale 2: %
.

[] Maintain CBS Structure at Level: 0

Days per Week:

Shift / Rate Calculator When man-count changes: (® Change UM / Man-Hour L\\)

() Change Days

Currency Standard Rates
Default Currency: U.S. Dallar - Sales Tax Rate: %

Resource [ Assembly Filter
T

2. For Shift 1, type a number value of hours in the Monday through Friday Work Hours fields.
» You can enter up to three shifts for the project

3. For Shift 1, type a number value of hours in the Scale 1 fields.
» Scale 1 will be your regular time and Scale 2 will be any overtime

Shift [/ Rate Calculator Record - Training Job

Ejl Copy Calaulator from Library

Ej! Copy Calculator to Library

e Clear Al

Tools

shift Rate Calculator Name: |[Enter Name] |

Monday Tuesday Wednesday Thursday Friday Saturday Sunday Totals
e | | | | | | |
#  Work Hours 10.00 10.00 10.00 10.00 10.00 3 0.00 50.00
Scale 1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

4. Enter a number value for hours in the Scale 2 fields (just Monday through Friday).
5. For Shift 2, type a number value for hours as you did above in Step 3.
6. Click OK.
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Shift 2
Work Hours 12.00 12.00 12.00 12.00 12.00 0.00 0.00 60.00
Scale 1 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 2 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00
Scale 3 0.00 0.00 0.00 0.00 0.00 0.00 0.00 0.00

» Now you have a blended shift arrangement, and your labor rates are a blend of
64.18% straight-time and 35.82% overtime

Job Properties ©

Owverview Security Cover Sheet Cost Basis Minority Setup Fue

Standard Shift Arrangements Standard Wage Rate Composite

Work Hours per shift Scale 1: %
Pay Hours per Shift: Scale 2: %
Shifts per Day: 1.71 Scale 3: g

Days per Week: 7.00 Shift / Rate Calculator

4.2.5 Import Filtered Resources
You may have noticed the bottom portion of your Cost Basis tab called the Resource Filter.

Resource f Assembly Filter

Resource [ Assembly Type Resource / Assembly File ... Geographic Area Wage Zong Organizational Category
Labor Ratz [al [ai [ai [al
Construction Equipment R... [ mone] [ Mone] [ mione] [ mone]
Rented Construction Equi... [] Mon-Blanks] [] Mon-Blanke] [ Mon-Blanks] [] Mon-Blanks]
Installed Material Rate [ standard Labor Rate File [ southwest [ wage Zone A [ Truck Driver - Teamster
Installed Equipment Rate [] Wage Zone B [1 supervision
Supply Rate [] carpenter
Unique Rate [ welder
Resource Assembly [] Mechanic
Cost [tem Assembly [] operator
Standard Table [] remediation

[ Laborer

[ 1ron Waorker

Select your filters from left [ Finisher - Concrete
to right
oK Cancel
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The Resource Filter portion of the Cost Basis tab is the most important part of Job Properties. You use
it to import your labor, equipment, and materials from the Library. Until you import filtered resources,
you have no resources (labor, equipment, materials) in your project.

Updated resource rates can be imported into the Library on a regular basis. It is important to update
and have the “Latest & Greatest” rates available to import into your estimates.

You will import the rates you need using a set of four filters called Resource Attributes. Especially for
labor rates, filtering by these attributes allows you to pare down the master list to just the resources
you need.

Each of the resource filter categories are open for use as determined best by your business. The
following are examples of common uses:

Resource Attribute Filters

Name Description

Resource File  This attribute can be used to designate the rate type or the year to which the
Description rates pertain.

Geographic This attribute is used to designate regions, cities, or provinces based on

Area geographical location of a project.

Wage Zone This attribute is typically used specifically for labor resources. For example,
it may designate the trade and union agreements your labor resources
belong to.

Organizational  This attribute can be used to designate what trade or work type your
Category resources pertain to.

Resource filters become more specific from left to right, so it makes sense to start with Resource File
Description and end with Organizational Category. The geographic area, wage zone and organizational
category attribute titles can be changed to meet your business needs for filtering resources.

TIP You can sort the filter lists by clicking on the filter category titles.

The following steps walk through using the Resource Filter to import resources.
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Step by Step — Import Filtered Resources

In your Job, go to the Job Properties > Cost Basis tab, select the Labor Rate resource type.
Under Resource File Description, select Standard Labor Rate File.

In the Geographic Area, select an Area.

For Wage Zone (Work Center), select a Wage Zone.

For Organizational Category, select All.

Follow the same steps for the remaining resource types.

N o g bk~ w D=

Select the Import Filtered Resources button to bring your selected resources into the job.

e For this example, we'll select the following filters for the Labor resource type:

Resource | Assembly iter

Resource | Assembly Type Resource | Assenbly Fe .. Geographic Area Wage Zone Organizationel Category

e e O O O 1)

Canstructon Equpment .. [ o] [ ere] [ Dhene] [ ione]

Rented Construction Equi.. [ bon i) [ Donfians] [ Don k] [ Dok

Installd Materil Rate Standard Labar Rate Fle Sautwest Viage Zone A ] TruckBriver -Teamster
Instaled Equipment Rate: [ Viage ZoeB [ supervion

Supply Rate ] capenter

I nimia Dta 7T welder

Me = You must select “Import Filtered Resources” to import your resources. Clicking OK on the
Job Properties form will not import your resources.

4.2.6 Fuel Cost Tab

On this tab you can enter the cost for fuel (or other energy sources). These unit cost will be multiplied
by the consumption rates entered on each equipment record to define the fuel operating cost of each
piece of equipment. The Cost per UM fields default to $0.00.

Step by Step — Enter Fuel Costs

1. Inyour job, open the Job Properties > Fuel Cost tab.

2. In Cost Per UM column, enter a dollar amount into the following:
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¢ Diesel
e Gas & Gasoline

¢ Off Road Diesel

Job Properties &
Owerview Security Cover Sheet Cost Basis Minority Setup Fuel Cost I

Drag columns here to group

Cost

Fuel - Par Curre. . - Account
Type UM Code
Diesel 24,20 | .5, Dollar Gallon

Gas £3.90 | .5, Dollar Gallon

Gasoline £3.90 | W.5. Dollar Gallon

Off Road Diesel £3.20 | U.5. Dollar Gallan

3. Currency should read U.S. Dollar and UM should read Gallon.

4.2.7 Job Folder Tags Tab
On this tab, you can enter tag fields to label your project, so you can reference it later.

Job Properties @

Overview | Security | Cover Sheet | CostBasis Minarity Setup Fuel Cost | Job Tracking Job Folder Tags Pricing | Schedule Cash Flow Equipment Maintenance | Benchmarking | Alternates

Job Folder Tag Assignments

Tag 1: - Tag 13: -
Tog2: | | Tag 14: -
Tag3: | | Tag 15: -
Tag 4: - Tag 162 -
Tags: | | Tag 17: -
Tag 6: ‘ | Tag 18: -
Tag7: | | Tag 19: -
Tag 8: - Tag 20: -
Tag s - Tag 21: 0.00

Tag 10: - Tag 22: -

Tag 11: - Tag 23: -

Tag 12: - Tag 24:
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Many of these fields are validated fields, meaning you can choose from options in a drop-down list.
The names of these tags and the drop-down values are defined at a master level within the Library
Foundation Setup Data. Some job folder tags are setup to be date fields or numerical fields. These tags
are used to sort and filter the job register as well as for selecting which past estimates to utilize for
benchmarking.

4.2.8 Schedule Tab

The Schedule tab is used to define the scheduling options for the integration between InEight Estimate
Primavera or Microsoft Project. The settings you define here determine what information is sent to
your scheduling tool, and how it will be structured.

¢ At the top of the Schedule tab, the Integrated Schedule can be set to Primavera or Microsoft
Project or Manual

¢ You will need to confirm the proper settings are defined on each of the Schedule sub-tabs. These
settings are defined in detail in Lesson 12 — Schedule Integration

Job Properties ©

Overview | Security | CoverSheet | CostBasis | MinoritySetup | FuelCost | JobTracking | JobFolderTags | Pridng | Schedule | CashFlow | EquipmentMaintenance | Benchmarking | Alternates

| Integrated Schedule: [ Always use Plug Days when updating Estimate from the schedule

Schedule Currency: U.S5. Dollar -

| CostItemRollUp | Login Options | Mapping Options | Resources | ExpenseCosts | Actuals | Tags | Activity Calendars

[] Automatically calculate Plug Days when rolling up cost items for scheduling purposes
Longest scheduled days among all rolled up costitems

Total scheduled days for all ralled up castitems

Note: When rolling up cost items for scheduling purposes, the Plug Days of the superior cost item
villl be recalculated when & change is made to the scheduled days of a subordinate.

To force immediate recalculation of Plug Days for superior cost items, use the Recalculate Plug Days'
button or the ‘Calculate Plug Days... command on the Tools’ menu in the CBS Register.

Recalculate Plug Days

4.2.9 Other Job Properties Tabs

There are several additional tabs on the Job Properties form. The other tabs will not be discussed here
because they are either used for project controls, or they will be covered at another time.

Other Job Properties Tabs

Name Function

Minority Setup  Used to set up minority participation goals (for example, DBE or MBE) and
you want to track minority participation goal attainment status during the bid
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Other Job Properties Tabs

process,

Job Tracking Used to select the code that will be used when tracking job progress, define
the planned production calculation, define the percent complete calculation,
define the forecast methods, and define markup rates for calculating earned
revenue on Time and Expense pay items.

Pricing Used to define how you want the Balanced Unit Price for each of the job's
pay items to be calculated when using the AutoPrice feature. You can also
choose form several options in determining how markup is defined.

Cash Flow Defines the cash flow rules (payment terms) that are used in the calculation
of Job Financing and cost/revenue realization to generate the curves that
display on the Cash Flow form.

Equipment Used to define the calculation of maintenance labor man-hours based on
Maintenance equipment utilization, to capture the impact on total man-hours when
changes are made that affect the job's total value.

Benchmarking Used to establish the historical data to be used for benchmarking the current
job, and to define the default benchmark graph display and calculations.

Alternates Used to define Alternate Scenarios, to assess the impact of those scenarios.
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Exercise 4.1 — Define Job Properties

In this exercise, you will continue to define your Job Properties from the job you have created in two
parts. Complete the following steps:
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1. On the Cover Sheet tab, fill out the following fields:

Job Location 90th Street & Shea

City Scottsdale
County Maricopa
Country United States
State Arizona

Type Infrastructure
Engineer Fred Jones
Owner Jerry Slate
Architect Robert Frost
Contract Duration 80

Time Measure Calendar Days
Forecast Start October 15, 2019
Duration (days) 70

Bid Date and Bid Time 10/1/2019 2:00 PM
Estimator Jim Sly

Bid Location 123 Main Street
Owner's Estimate $500,000.00

Opening Type Public

Proposal Type Unit Price

Plan Holders 10

Liquidated Damages  $1000.00 Per Day
RFQ Contact Jim Sly

In this part 2 of this exercise, you will continue to define your Job Properties from the Job you have
created. Complete the following steps:
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2. On the Cost Basis tab:
e Ensure the Shift Arrangement is 8 hours a day, 5 days a week
¢ Ensure the Wage Composite is set to 100% Scale 1

e Ensure the Sales Tax is set to 8%

You should end up with similar results

The following Cover Sheet properties are defined:

Job Properties O
Overview | Seaity CostBasis | MinoritySetp | FuelCost | JobTrading | JobFolderTags | Compebtors | Priang | Schedue | CashFlow | EquiomentMaintensnce | Benchmarking | Aernates
e l l | I I | | I
Location: |Scottsdale Tripe: :ll'-"fﬂtwtlufi Contract Duration: an:
City: [Scottadale | Engineer: | Example Engneer - Fred Jones ]  TimeMessure: | Calendar Days -
County: [Maricapa | Owner: | Example Onner - Jerry Slate ] Forecastmart: | l0/15/019 -
Country: | US - Architect: | Example Anchibect -- Riobert Frost r| ForecastFinish: | 1224/2019 -
State: | AZ = ﬂuntlon:: '-'ﬂj
Latitude: | 0.00008]
Lengitude u.nnucn:
Proposal
Bid Dake: | 10/1/2019 - Opening Type: [public
Bid Time: Proposal Type: _'L.'th.'!(t
Estimator: | Hard Dollar Corporation - Chief Estimater -- Jen Sy ) Hunﬂald:r::'_ I:Or
Bid Lacation: [123 Main Sreet | Liguidated Damages: | $1000.00]
Ownérs Estimate: - SSDC,?I]E.DH: Lig. Damages Per: | Day -

RFQ Contact: | Hard Dolar Corporation - Cheef Estmaitor - Jm Sly

The following Cost Basis settings are defined:
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Exercise 4.1 — Define Job Properties

Congratulations, you have completed this exercise!
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Import Filkered
Resources

Cancel

Job Properties O
mlmwlmm:m&mlmmlmﬁm MWT$|WHM|MIM|MM|WIW Benchmarking Alternates
Standard Shift Amangements Standard Wage Rate Composite: Rudes
[ Lock Cost Items to Pay ltems [ Preserve Original Cost ftem

‘Wark Hours per Shift | S-Dﬂ] Sealel: | 100.00|% Pay Item Unit Price Precision: [ 2| Cata Suarce

Pay Hours per Shift: &.00 Scale 2: 0.00) %% Dl actvate PS Changes Leg

. . = [ Activate Quantity Checking
Shafit: Day: 1.00 Seale 3: 0.00 | %%
AeeaA| ] et / [] Maintain CBS Structure at Level: 1
Days per Week: S.00 Shift | Rate Caleulator Vihen man-count changes: () Change UM/ Man-Hour
(®) Change Days

Currency Standard Rates

Default Cumrency: | U.5. Dolar . Sales Tax Rate: %
Resource [ Assembly Filter

Resource | Assembly Type Resource | Assembly Fle ... Geographic Area Wage Zone Crganizational Catagory L)

Labor Rate O O tan Orn & ran

Construction Equipment R... [ reone] [ iMene] [ one] [ vore]

Rented Construction Equi. .. [ [reon-Blanks) [ frion-Blanke] ] [Mon-Elaris] [ [Mon-Elanks]

Instabed Material Rate £ standard Laber Rate Fie ] southwest =] wage zone & [0 Trudk Driver - Teamater

Instaled Equipment Rate [] Wage Zone B [ supervision

Supply Rate [ carpenter

Uhigue Rate [ welcer

Resaurce Assembly (] Mechanic

Cast [tem Assembly [ cperator

Standard Table [ Remediation v
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4.3 PAY ITEM CREATION

Pay items typically represent the owner required deliverables a contractor must submit pricing for.
Within InEight Estimate, pay items are used to distribute the cost calculated in the Cost Breakdown
Structure and all markup, fees or contingency calculated in the Price Breakdown Structure to a list of
defined items. This allows the total estimate value to be distributed to a structure that is different then
the CBS. Pay Items are predominantly used by Contractors to prepare a bid sheet. Owners may use pay
items to identify funding sources or for various reporting needs.

Many Bid Forms are organized by grouping bid items for related scopes of work. Pay items within the
Pay Item and Proposal screen can be grouped in a hierarchy by utilizing the Position Code column.

You can create pay items in the Pay Item & Proposal Register. Access this form by selecting the Setup
tab > Pay Item & Proposal.

Estimate Quote Execution System Actions

B | B|Y &Lx. 2 a B @

23 Equipment

Job Properties  Foundation | Pay Item & | Bid Wizard = Resource __ ) Resource CostItem  Standard Reparts
- Setup Data ~ Proposal Rates =~ = Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports

I T S

1 Proposal and Item Related to pricing during bid close-out. You can disregard them at
Recaps this time.

2 Pay Item Number Represents the bid item number from the client (if they give you
one) or can be a number you specify. This field is alpha-numeric

3 Position Code Controls the way pay items can be grouped, and provide you with
an efficient way to sort.

4 Description You can enter a pay item description.

5 Pay Quantity and The Pay Quantity is the quantity provided by the client.
Forecast (T/O) The Forecast (T/O) Quantity is your measured quantity for the
Quantity item.
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4.3.1 Overview - Pay Item & Proposal Register

Pay Item & Proposal Register ©

o

Proposal Recap - Training Job X | | Item Recap - 200 SITEWORK & ROADWAY
Current Target Forecast | Variance UnitPrice  TotalPrice  UnitPrice  Total Price
Price: | $6,569,735.00 | $5897,950.68 | $6,577,22380 | $67178432 | CUT peeten ) |G |G =
A [ Tamn [ oo ]
Markup: $967,477.27 | $315692.95 | $1,04471627 | $729,02332 | CUT e ST a0y
Margin%: 15.03 535 1588 | $731,83684 | CUT varkup 150,145 718,700,
Profit (arkup records) $0.00 $568,618.53
= Business Overhead $150,141.93 $150,141.93
Drag columns b group Saved views: | Standard Ve
Pay n:me_ Positon :6 Lock Lock G o Pay Forecast (T/0) | Unitof Curency | UnitPrice Total Price UnitMarkup  Total Markup nit
Number Code. Quantity Price Quantity Quantity Measure (current) (current) (balanced) (balanced) Distribution
=[5 200 1 0 | | smEwork aroaDwAY U.S. Dolar $150,141.93
+ 6410100 11 Mobiization 1.00 1.00 [LumpSum | U.S. Dolar $395,600.00 §737.74 §737.74 $4,435.45
+ 210102 2 Clearing & Grubbing 10.00 10.00 | Ace U.S. Dolar $5,900.00 ,000.00 $257.19 $2,571.93 $1,25161
+ 22020183 13 Undassified Excavation 50,000.00 50,000.00 | Cubic Yard  U.S. Dolar $5.50  $275,000.00 $0.30 51434072 $0.83
+ 3035912 14 Aggregate Base 40,000.00 45,000.00 | Ton U.S. Dollar $26.50  $1,060,000.00 $0.94 $37,486.40 $2.05
+ 3034263 15 Asphalt Concrete Hot Mix Type A 38,000.00 35,000.00 | Ton U.S. Dolar $42.45  $1,613,100.00 2% $94,505.14 $471
= a00 2 0} | | water s sewer U.S. Dolar $718,550.00 $34,584.99
+ 413 0464 [[2.1 36 Inch RCP Culvert Class Il 1,000.00 1,024.00 | Linear Feet  U.S. Dolar $97.45 $97,450.00 $4.33 $4,325.59 $9.94
+ 8000220 22 10 Tnch PYC Force Main (SDR21) 12,000.00 12,000.00 | Linear Feet U5, Dollar $22.50 35400000 5143 $17,165.84 $3.04
+ 8000330 23 241nch PVC Gravity Sewer (SOR35) 3,000.00 3,000.00 | Linear Feet  U.S. Dolar $64.50  $193,500.00 $3.16 $9,984.98 7.2
+ 8000400 24 4Foot Diameter Manhole 16.00 16.00 | Each U.S. Dolar $4,600.00 $73,600.00 $225.57 $3,609.08 $486.68
= 500 3 . | | smucturaL concreTe s sriDGes U.S. Dollar $631,895.00 $32,304.21
+ s01(4) 1306 |[3.1 Structural Excavation & Backfl 800.00 800.00 | Cubic Yard | U.S. Dolar $28.00 522,400.00 5139 $1,111.52 $3.16
+ so(a) 1322 || 3.2 Steel Reinforcement 30,000.00 30,000.00 | Pound U.s. Dollar s1.70 $51,000.00 $0.08 $2,5%.15 $0.13
ERECARE I | EX 55000 550,00 | Cubic Yard | 11S. Dolar sse5.M SaR3250.00 ©7.45 233643 <6768
2 $6,569,735.00 $315,692.95

4.3 Pay Item Creation

Unit Mar
(urrent

Total
Distrbution
$319,521.54
$4,435.45
$12,516.08
$41,414.20
$32,054.63
$179,101.18
$76,228.25
$9,944.34
$36,531.54
$21,965.47
$7,786.90
$78,703.66
$2,525.23
$4,011.30
ss7.5%6.9
$645,755.99

Step by Step — Create a Pay Item

page.

¢ The Pay Item & Proposal Register displays

Use the Tab key to move to the Description column and type a description.

Open your job and select Setup tab >Pay Iltem & Proposal from the InEight Estimate landing

In the Pay Item Number column, in the first blank row, type a number value.

Leave the Pay Quantity at 1.00 and change the Unit of Measure to LS (Lump Sum).

¢ The Forecast (T/O) Quantity will auto populate to match your pay quantity, but can be

changed later

¢ You can tab to the next row to create additional pay items if needed

Drag columns heg D
Pay Iter ock Row .
Mumber rice Number =

+ 1000

InEight Inc. | Release 24.7

Line
Number

11

Description

Mobilization

Find: | [Search Foy

Pay Unit of Unit Price
Quantity Measure (current)
100 Ls £0.00

Total Price
{current)

40,00

Saved views: | Simple View -

% Margin

0.00
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4.3.2 Pay Item Prices by Category

Owners are increasingly requiring more information from contractors as part of their bid submissions.
Many times, this is a further breakdown of a bid price such as separating the price of an item based on

its labor cost, material cost or man-hours. Select columns in the Pay Item & Proposal register enable

users to summarize their pay item prices by up to 10 price categories.

In addition to seeing the price by category, these additional columns also give users better visibility

into how the price is established, including columns for the total cost, total distribution, total markup

and markup percent. These new columns make it easier to verify that the distribution of unassigned
cost and markup are calculated as intended by the estimator.

Pay Item osition _ Lodk Lock
Number Price
B
+ eatom0 | 11
+ 210102 12
+ 20183 13
+ 33512 14
+ 3423 15
= 200 2
+ 413(F)0464 2.1

Description

SITEWORK & ROADWAY

‘Asphalt Concrate Hot Mix Type A
WATER & SEWER
36 Inch RCP Culvert Class 1Tl

100

00
50,000.00
20,000.00
38,000.00

1,000.00

100 | LumpSum
.00
50,000.00  Cubic Yrt
4500000 Ton
3500000 Ton

1,024.00 Linear Feet

rrrrrr

U.S. Dolar
U.S. Dolr
U.S. Dolar
U.S. Dolar
U.S. Dolar
U.S. Dolar
U.S. Dolar
U.S. Dolar

LABOR
Cos

Distribution

LABOR
Merkup

LABOR
rice
(balenced)

$291,828.52
52,4451
$14,880.57
$62,230.08
$98,794.33
s1a7.43
$128,895.30
51,6029

$51,472.21
$385.80
§7,30127
$9,800.01
s15,808.75
s18,17457
20,324.84
53,0849

§7,224074
560.85
s34.82
$1,595.91
$2.473.10
2,740
$3,202.02
4698

$350,525.47
$2,897.16
22,5266
$73,576.00
$118,083.28
$133,492.35
$152,422.76
$23,17466

$394,302.06
$81,365.50
22,405.37
$73,19.96
17174265
112,437,659
$167,735.34
$28,284.7%

248
298
23:2
248
248
2.8
248
248

$385,600.00
£5,200.00
$5.50
$26.50
s92.45

$97.45

4.3.3 Standard Proposal report

The Pay Item Standard Proposal report is located in Execution > Reports > Pay Item & Proposal >
Standard Proposal, and is intended to be used as a bid form, and distributed to other clients, partners,
and contractors. In the Details box below, you can determine which key fields you want included and
shown on your standard proposal report.
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Reports - Standard Proposal ©
« Reporis

[=) 10b Properties
Foundation Setwp Data

o
> &
>l
&

Resources
Resource Assemblies
Cost Breakdonn Structure
= Quotes

S Price Breakdown Structure

© B PayTtem 8Proposal

Pay ltem Currency Comparison
Pay ltem Price Brezkdonn
> [& siling Rate Reports
» € JobTradking
Estimate Comparison Report
Audit
Job Regster
> o Lirary odude
Custom Reports
Saved Views
v BudgetBxports
AsSystems

American Contractor (versions 4.1
Bickek Vision

Budget Fie Worksheet

CGC (version 34.3)

CGC (version 35.0)

aMiC

Comma Delmited Fie

Settings: | Defauit

Print | Detsis | Layout | Hesder/Footer

Show the below Pay tem dtaiis
Line Number

Pay Ttem Number

PositionCode
[ subtotals

[ Running Totals

[ Suspended ttems

Include Adcitonal Proposal pages
(] Cover sheet

[ Preferences Sheet

Uit price precsion

Filter by currency: No Fiter

Show the below Proposal header items

[J30bCode [3b City

[ 70b Deseription [ 36b County
[Jsid Date [J20b state
[sid Time [ 30b Country
[J3obLocation

‘Term for Document
@ Proposaljeid
O Tender

O custom

1

® Truncate values based on decimal precision

O Do nottruncate values (show decmal precision)

Certification Text:

Oione

® custom \

4.3 Pay Item Creation

Signature Block:

[ submitted By

InEight Inc. | Release 24.7

JE—— ]

Print | Detais

Layout

Header/Footer | Proposal

roposa
INEIGHT - PALL T
Job

RIPA
Code:

Description:

Job Gode:

Job Descrpton

Jobciy

Job County

BidDa
BidTine.

Positon Code LineNo.

n

Training Job
Training Job - Maricopa County No. TM292¢

Trasing <o
Trasing Job- Maricopa Gouty No TWER#

ez
2000
Proposa

PayltemMo. Descripion

Subtotal Descrpion
m SITEWORK & ROADIAY
410100 Mobkzain
012 Clearng & Grbing
00183 UnciassfedSxcamm

Aopregaie B
34253 tsphat ConcrteHalMKTeA
w0 WATER SSBAER
41380481 38 InchRCP Culvert Cess I
30020 10InehPVC Force Main (SORZ)
0030 24Inch PV Gravity Sewer (SDRE)
0040 4Foot DiameterMartoe
S0 STRUCTURALCONGRETE & ERDGES
S5 Stnura Excavation Bkl
SOSA) 132 StesiRenfoanar

Quany Unitofesswe

0 Lmesm
PP

000 2 Y

0000 T

55,0000 Ton

1,000 LinearFest
12,0000 LinearFoxt

300000 Lnexr Fezt

S

0.0 Cubic Yad

30,0000 Pourg

UnitPrie

E

sE0m
EEY
Xy

a2

B
By
o

4600

X

£

Total Pre:

3,402,70000

ES

©
S0
7R
1200000
3100
e
a0
5400000
w500
e
s
2400

£1,00000

Page 221 of 417



Exercise 4.2 — Create Pay ltems

Estimate Essentials User Guide

Exercise 4.2 — Create Pay Items

In this exercise, you will practice creating pay items in the Pay Item & Proposal Register. Complete the

following steps, using a job of your own.

Position Code | Pay Item Number Pay Quantity | Unit of Measure

1.1 6410100
1.2 2010102
1.3 202 0183
2 400

2.1 800 0220

SITEWORK & ROADWAY
Mobilization

Clearing & Grubbing
Excavation

WATER & SEWER

10 PVC Pipe

You should end up with the following results:

1 LS
10 Acre
50,000 CY
1,000 LF

Position - Pay Item

Code Mumber
+ 11 641 0100
+ 1.2 2010102
it L3 2020183
800 0220

Description iy

Quantity
SITEWOREK & ROADWAY
Mobilization 1.00
Clearing & Grubhing 10.00
Excavation 50,000,000
WATER. & SEWER
10 FVC Pipe 1,000,00

Forecast
(T/0)
Quantity

Unit of
Measure

1.00 LS
10.00  Acre

50,000.00 CY

1,000.00 | LF

Congratulations, you have completed this exercise!
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Lesson 4 Review

1. This is where you enter basic information about the job as well as define your cost basis.
a. Pay Item & Proposal
b. Job Properties
C. Library
d. Job Folder

2. On the Job Properties form, this tab is where you enter information such as the start
date, bid date, job type and location.

a. Overview
b. Cover Sheet
C. Cost Basis
d

Foundation Setup Data

3. These are the project deliverables; anything the owner agrees to measure and pay for.

a. Cost Items
b. Resources

C. Target Price

d. Pay Items

Lesson 4 Summary

As a result of this lesson, you can:
¢ Create a new job
e Enter Job Properties

¢ Create pay items in the Pay Item & Proposal Register
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InEight’
ESTIMATE

LESSON 5 — DIRECT COSTS

Lesson Duration: 30 Minutes

Lesson Objectives
After completing this lesson, you will be able to:

¢ Explain the Cost Breakdown Structure and its purpose
¢ Create cost items
e Add costs and production

e Manage cost item details

Lesson Topics

InEight Inc. | Release 24.7
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5.1 COST BREAKDOWN STRUCTURES

The Cost Breakdown Structure (CBS) is the main form where you will do your cost estimating.
e Itis the hierarchy of work activities that make up the estimate
e Each row in the CBS represents a work activity or organizing category and is called a cost item

To access the Cost Breakdown Structure, from the InEight Estimate landing page select the Estimate
tab, then under the Breakdown Structure section select Cost Breakdown Structure (CBS).

Price Execution System Actions More Actions

BASE -
Workbook Schedule  Cash Flow Indirect Price Breakdown Reports

ﬁ : .-i s m -= & ES E ?; Alternate Scenario: Fl_T;l
b

Cost Breakdown

Structure (CBS) Cost Items Structure (PBS) = | £y Alternates

Breakdown Struc... Res... Workbook Schedule Indirect Cost Overhead and Pr... Alternates Reports

Overview - Cost Breakdown Structure (CBS) Register

T T

1 Actions Shortcut icons allow you to edit cost items and import items from other
Menu sources such as Excel.

2A CBS Tree  The CBS Tree filter shows the CBS hierarchy and is used to quickly help
Filter Mode filter cost items, instead of scrolling the CBS to locate certain cost items.
(drop- The CBS Tree Filter lets you choose between a filter mode or a new
down) navigation mode.

2B CBS Tree  Both Filter and Navigation modes on the left side of the page provides you

Filter or with the visibility of your entire CBS structure, as well as giving you the
Navigation  option to navigate and filter throughout the CBS estimate. The Cost ltem
Mode record can also be tiled next to the tree to make navigating and filtering
possible, while viewing all the cost item record details at the same time.
3 Left CBS This side of the register contains all of the estimate activities (cost items)
register that you create or import, organized into a parent-child hierarchy.
4 Right CBS  This side of the register contains numerous columns for cost detail,
register production values, and user-defined tags and fields.
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Training Job - Estimate

System Integrations More Actions

= print @ rew G Copy Split Indent Link Field CostTtem Assembly Resource / 4 w E s Tee e o
B Preview Delete Paste Split by Cost Type Outdent Unlink Field | 38 Subordinate Cost tem | g Subordinate Assembly Resource Assembly - » - Filter -
Ewpand/  Filter  Clear ||| CBS Tree
& Export to Excel cut Filbown T Toagle Suspended E-% Dependent Cost Ttem Collapse ~ o Filter Filter
Navigation
Print Edit Workbook Insert View - Q 2
Cost Breakdown Structure (CBS) Register @ -
&) 4
e cas Tree (Filter Mode) X || brag columns here to group A4 w5 Saved views: | Standard Vien SR
Coae Description cas I Optional Forecast Unitof Total Cost Subject Cost
= Position Code = Description Code (T/0) Guantity Mensre Unit Cost (Forecast) subject Cost R Allocated
- 108
og Prime Bond | = J08 20.00 | Mie $204,138.13  $5,882,762.51 u +
ag Price % Add-On Prime Bond PRIME BOND 1.0q | Lump Sum $47,148.68 $47,198.68
EI Job Financing Price % Add-On PRICE % ADD-ON 1.0 | Lump Sum §295,638.13 $295,638.13
oo
oo Indrect Cost Esc: Job Financing FINANCE EXPENSE 1.0q | Lump sum $33,105.26 $33,105.26
ao Direct Cost Escal . -
ag 1 Indirect Cost Escalation INDIRECT COST ESCALATION 1.0 | Lump Sum $2,131.11 $2,13L11
ao Indrrect Cost Add]
ag Direct Cost Escalation DIRECT COST ESCALATION 1.0g | Lump Sum $15,048.80 $15,048.80
ao Direct Cost Add-(
[=]=] -
Indirect Cost Add-On 1.0q | Lump Sum $5,888.67 $5,888.67 $294,433.42 2.00
> @@ 1 SITEWORK &RO)
Direct Cost Add-On DIRECT COST ADD-CN 1.0q | Lump Sum 5104,088.34  $104,088.3F  §5,204,417.24 2.00
> @@ 2 | WATER & SEWE
s B3 SRUCTLRAL CO LISt SITEWORK & ROADWAY 200 10g | Each $2,469,151.5  $2,464,161.56
s P54 moUSTIAL AR + 11 Mabilization 6410100 1.0g | Lump Sum $11,309.51 $11,909.51
» &8 comveRciaL + 12 Clearing & Grubbing 2010102 10.04| aae $3,918.50 $39,184.97
> g6 | GUARDRALL &SI B .3 Undassified Excavation 2020183 50,000.00) | Cubic Yard 5468 $233,915.81
> @@ 7 IndrectCosts + 131 Excavation 131 50,000.0) | Cubic Yard £3.00 $149,922.88
[E][8 | speci Risk Alow + 132 Embankment 132 50,000.0d | Cubic Yard 5168 $83,992.94
B 14 Agoregate Base 3035912 45,000.09 | Ton $15.40 $692,928.99
+ 141 Furrish & Haul Base Material 141 45,000.09 | Ton $1154  $519,513.30
+ 142 Finegrade Subgrads 142 400,000.00) | Square Yard 018 £75,89.36
= 143 Instzl Aggregate Base 143 45,000.0d | Ton §217 $97,567.33
+ 1431 Place Aoaregate Base 1431 45.000.09 | Ton 5163 £73.460.92 M
107 $5,882,762.51
4 » »

5.1.1 Cost Item Terminology

The CBS contains both direct and indirect costs.

¢ Direct Cost Items contain costs that pertain directly to the deliverables of the project. Therefore,
direct cost items are typically assigned to pay items

¢ Indirect Cost Items contain overhead costs that are not directly associated with particular
deliverable items but contribute to the total cost of the project (e.g., supervision, site office,
safety supplies, bid securities). Occasionally an indirect cost item may be assigned to a pay item
(e.g., Mobilization costs that are indirect but assigned to a Mobilization pay item).

InEight Estimate uses various terms to describe the parent-child relationships of the multiple levels in
the CBS:

Superior A Superior cost item has subordinate (child) items below it that determine
hours and costs.

Subordinate A Subordinate cost item is a child to a Superior cost item.

Terminal A Terminal cost item has no subordinate items. Resources, costs, and
production can only be added at the terminal cost item level.
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o= A Terminal cost item may or may not be a subordinate.

The levels of the CBS are referred to as Level 1, Level 2, etc., as you drill down in the structure. As costs
are defined on the terminal items, the sum of the terminal cost items roll up to the superior cost items.

TIP A superior cost item can have no costs of its own; its costs are strictly the rolled-up total
from the subordinate cost items below it.

You can use superior cost items as buckets for organizing your work.

As hours and costs are defined on the terminal items, the sum of the terminal cost items roll up to the
superior cost items.

5.1.2 Work Breakdown Structures

The Work Breakdown Structure (WBS) allows you to reorganize the estimate using different formats
such as Construction Specifications Institute (CSI) MasterFormat or UniFormat. WBS formats are used
when you need multiple variations and summary reports of an estimate. The WBS retains the same
relationships between items as in the original estimate while only changing the view and items
arrangement in the WBS hierarchy.

To view the Work Breakdown Structure View Register, in the Ribbon select the tab Estimate > Work
Breakdown Structures.

Overview - Work Breakdown Structure (WBS) View Register

S | e

1 WBS Use the WBS Tree to filter to a particular WBS item.
Tree

2 WBS When a specific WBS item is selected in the WBS
Grid Tree, all subordinate WBS items display in the WBS
grid.

3 Cost The Cost Items associated with the WBS
Items  subordinate in the WBS Grid displays in this data
block.
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Cost Breakdown Structure (CBS) Register Quote Register Quote C ison & Award - Work Structure View Register @ -
WBS Tree % (}orag columns here to group Find: | [Search For...] =] seved views: | Stondard view -]
- Uit of Total Cost
wes: [ ceas - Code = Desaription Quantity et Currency Unit Cost e
e 4
s T B ceas ivil Engineering Account Code System 100 Each U.S. Dollar $2,494,088... $2,494,088.07
=
s v Engincering Account Cade System 10 GENERAL PROVISIONS 1,00 Lump Sum U.5. Dolar $35,05451  §35,054.51
0 GENERAL FROVISIONS _-Irm 100 Each U.S. Dollar $14,00000  $14,000.00
o S o o EEOC—— =
> 12 PAVEMENT WORK OFFICE FACILITIES 100 Each U.S. Doller $2,000.00 $2,000.00
> 13 BRIDGE WORK UTLITES 100 Each U.s. Dollar $8,000,00 8,000.00
> 14 CONCRETE STRUCTURES _-u)n}:rw 1.00 Each U.S. Dollar $14,624.39 §14,624.39
> 17 PIPE WORK 10.20.100 MOBILIZATION 100 Load U.5. Dollar $11,909.51  $11,909.51 +]
37 $2,494,088...
_ = =
Cost Items x
Drag columns here A Find: | [Search For...] | saved views: [ standard view
s N . optional Forecast Unitof Total Cost Allocation Cost Resource Assembly
Poston Code —  DescrRten Code {T/0) Quantity Mezsure R e R CATENS/  pgjustment  Quantity
S o+ 231 Setup Yard UNASSIGNED 1.00  Lump Sum $4,000.00 $4,000.00 I U.S. Dollar O o,
1 100 $4,000.00
P »

5.1.3 Locked vs. Unlocked Approach

There are two basic approaches to structuring your cost items and pay items. You can choose to work
in a “locked approach” or an “unlocked approach.”

In a locked approach, level one cost items are automatically created and assigned to pay items. This
locked approach works well when pay items adequately represent the work plan. Subordinate cost
items inherit the pay item assignment of superior cost items.

Pay ltem &
Proposal

Pay Iltem 1

Pay Items
Pay Item 3 | Pay ltem 2
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Meyg= If the Lock Cost Items to Pay Item rule is checked in Job Properties, InEight Estimate will
automatically create level 1 cost items in the CBS Register for each of your pay items.

The unlocked approach may work better when the pay items do not adequately represent the work
plan. You can then assign your cost items to your pay items in any arrangement. Companies looking to
standardize the way they estimate and use templates will want to use this approach as it allows you to
dictate the cost breakdown structure. Owners will also typically use the unlocked approach since pay
items are not necessary to their estimating process.

Pay Item &
Proposal

Job Properties ©

[12]
=
@
=
>
®
o

-
=
2
>
®©
o
o~
=
2
>
®
o
™
=
)
=
>
©
o

The option of working in a locked approach vs. an unlocked approach is available in the Job Properties
Form, on the Cost Basis tab under the Rules section. By selecting the checkbox for Lock Cost items to
Pay Item, you are choosing to work in a locked approach.

4EEEEE————

Owverview | Security | Cover Sheet I Cost Basis I Minarity Setup | Fuel Cost | Job Tracking Job Folder Tags | Competitors | Pricing | 5

Standard Shift Arrangements

Woark Hours per Shift
Pay Hours per Shift:
Shifts per Day:

Days per Week:
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Standard Wage Rate Composite

Scale 1t oG
Scale 2: oG
Scale 3: oG

Rules
I Lock Cost Ttems to Pay Items I C
Pay Item Unit Price Precision: 2
[] Activate PES Changes Log
[] Activate Quantity Checking
[] Maintain CBS Structure at Level: 0

(@ Change UM { Man-Hour
(O) Change Days

‘When man-count changes:
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5.1.4 Take-Off Quantities

In the Cost Breakdown Structure, estimated quantities are entered into the Forecast (T/O) Quantity
field with a corresponding unit of measure. The quantity will default to 1 each when you create a new
cost item and should be updated to reflect the work being estimated.

CBS

Ezs‘;::on = Description ?;;asjanﬁty

+ 1 Mobilization 1.00
+ 2 Clearing & Grubbing 10,00
2 3 Unclassified Excavation 50,000.00
+ 3.1 Excavation 50,000.00
+ 3.2 Embankment 50,000.00
= 4 Agoregate Base 45,000.00
+ 4.1 Furnish & Haul Base Material 45,000.00
+ 4.2 Finegrade Subgrade 400,000.00
B 43 Install Aggregate Base 45,000.00
+ 4.3.1 Place Aggregate Base 45,000,00
+ 432 Blue Top Aggregate Base 400,000.00

Meaga Forecast (T/O) Quantities are only used for your cost items in the CBS Register.
Pay Quantities are used for final pricing in the PBS and Pay Item & Proposal forms.

Because the training project is a “locked” job, you already have level 1 cost items, and their default
take-off quantities are populated from their corresponding pay item quantities.

The following step by step walks you through adjusting the default take-off quantities on a couple of
your cost items.

Step by Step — Adjust take-off quantities

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Inthe Forecast (T/O) Quantity column, the Forecast (T/O) Quantity is brought over from the Pay
Item & Proposal Register, but here you can adjust it if needed. Practice adjusting the Forecast
T/0 quantity of one of your cost items.

e For this example, we’ll change Clearing and Grubbing to 15.00 Acre and Excavation to
40,000 CY.
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1 - SITEWORK & ROADWAY
11 Mobilization

1.2 Clearing & Grubbing

1.3 Excavation

2 WATER & SEWER

st 10 PVC Pipe

5.2 COST ITEM CREATION

Estimate Essentials User Guide

1.00
1,00
15,00
40,000,00
1.00
1,000.00

Each
L5
Acre
CY
Each
LF

During estimate development, you will create new cost items to break down your work into specific

activities. You can create superior and subordinate cost items as needed to organize your work.

5.2.1 Insert Subordinate Cost Item

You can add subordinate cost items in two different ways:

Option 1

Right-click on the row header of the superior cost item and select Insert Subordinate.

Drag o .'--\." ns I eré to group I-‘E LDPI
.-!"I Paste
CBs Desaiol _
Pasition Code =T ipton | Fill Down
]
= J08 L Link this field to Excel
Prime Bond .
! UnLink from Excel
Price % Add-On !
Job Financing ! Indent
Job Management & Equ Qutdent
General Expense
Insert
1 Mobilization

Clearing

Insert Subordinate

Insert Dependent Cost [tem
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5.2 Cost Item Creation

The row header is considered the far left edge of the CBS row where the small arrow appear appears

above. It is used to open records and perform actions on items instead of clicking on cells within the
row which will allow you to directly type into the selected cell.

Option 2

Click on the Subordinate Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.

Quote Price Execution System Actions More Actions
Fill Down g Cost Item + Assembl
Split 4% | 7= subordinate Cos%tem &= Subordinate Assen
Toggle Suspended H Dependent C4#t Item
Insert
) Register ©
Drag columns here to group Find: | [Search For...]
CBS
= . i Forecast
Position = Description -
Code (T/O) Quantity
+ 1 Mobilization 1.00
= 3 Unclassified Excavation 50,000.00
+ 3.1 Excavation 50,000.00

5.2.2 Insert Cost Item

You can add cost items at the same level in two different ways.

Option 1

Right click on the row header of the superior cost item and select Insert.
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- Finegrade Subgrade

CBS = Lopy

Position Code S f:ﬁ Paste

+2  Clearing & Grubbing &b Link this field to Excel
=3 UndassifiedExcavation | L Unlick from Excel
kil Excavation - | :

EE Embankment 4=  (utdent
=4 AggregateBase .

+ 41 = Insert

Insert Subordinate

= 43 Install Aggregate Base

|

Insert Dependent Cost Item

+ 431 Place Aggregate Base E' Insert Cost ltem Assembly |
+ 432 B Ao eqate Base ‘== |Insert Cost Item Assembly as Subordinate
55 AsphaktConcretemotrixtyy | S
+ 5.1 Furnish & Haul Hot Mix = Insert Resource
| fe 4 £ N Lot A T A b, o 2 i
Option 2

Click on the Cost Item icon on the Cost Breakdown Structure (CBS) Register toolbar.

Quote Price Execution System Actions Mare Actions
" Fill Down - == Assembly Z
| split - B bordinate Cost Item | f Subordinate Assembly | '§
; Toggle Suspended H Ddoendent Cost Item
Insert
i)} Register ©
Crag columns here to group Find: | [Search For...]
EES.ﬁ Forecast Unit of
osiman (T/O) Quantity Measure
1,00 Lump Su
10,00 Acre
50,000.00  Cubic Yz
o000 e
+ 3.2 Embankment 50,000,00  Cubic 'z
I
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Because the project you are working in is a “locked” job (where cost items are locked to pay items),
your CBS Register will already have level 1 cost items representing each of your pay items, and each
cost item will be assigned to its corresponding pay item.

The following step by step walks you through creating a subordinate (child) cost item for one of your
level-one cost items.

Step by Step — Create a subordinate cost item

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on a cost item and select Insert Subordinate.
¢ This creates a new subordinate cost item below your selected cost item
3. For the subordinate cost item, enter a description.
4. Add a quantity and select your Unit of Measure.

¢ For this example, we’ll insert a subordinate under Clearing & Grubbing for Clearing

=1 SITEWORK & ROADWAY 1.00 Each
+ 1.1 Mobilization 100 LS
B 1.2 Clearing & Grubbing 15.00 Acre
+ 121 Clearing 15.00 Acre

1.3 Excavation 40,000.00 CY
= 2 WATER & SEWER 1.00 Each
+ 2.1 10 PVC Pipe 1,000.00 LF

TIP You can create a subordinate at the same level, by right clicking on an equal-
level cost item and selecting Insert.

5.2.3 Move Cost Items

As you develop your estimate, you may need to move cost items around in the Cost Breakdown
Structure. To move a cost item:

1. Select the row header of the cost item you wish to move. If you select a superior cost item, it will
bring the subordinates along with it.
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2. Drag and drop the cost item to the right place in your structure. Notice one of two cursor
symbols appears:

The symbol with three equal bars will drop the cost item at the same

level as the cost item you drop it on. =9
The symbol with a subordinate bar will make the cost item become a =
subordinate to the one you drop it on. P
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Exercise 5.1 — Create cost items

Exercise 5.1 — Create cost items

In this exercise, you will practice creating additional cost items. Create the following cost items,

using your own job.

Code Description Forecast (T/O) Quantity Unit of Measure
1.2.2 Grading 10 Acre

1.3.1 Excavate 40,000 CY

1.3.2  Haul 40,000 CYy

41 Furnish Pipe Materials 1,000 LF

4.2 Excavate-Install-Backfill Pipe 1,000

You should end up with similar results:

LF

1.00 Each
+ 1.00 LS
B 12 Clearing & Grubbing 15.00 Acre
L2l Clearing 15.00 Ae
+ 122 Grading 10.00 Acre
B 13 Excavabion 40,000.00 CY
+ 131 Excavate 40,000.00 €Y
Ny Haul 40,000.00 CY
=2 WATER&SEWER 100 Each
B 21 10 BVE Pipe 1,000.00 LF
+ 211 Furnish Pipe Materials 1,000.00 LF
+ 212 Excavate-Instal-Backfll Ppe 1,000.00 LF

Congratulations, you have completed this Exercise!
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5.3 COSTS AND PRODUCTION

For the cost items you’ve created, you can now add their costs and production. All information for a
cost item is contained in a Cost Item Record.

5.3.1 Cost Item Record

You can open the Cost Item Record by either double clicking on a cost item row header, or right
clicking and selecting Open.

Cost Item Record Overview

I T R

1 Cost Item Provides general information about the cost item. It displays the cost
Header item’s take-off quantity, Unit of Measure, and Cost. It also indicates what
Information  Cost Source is being used.

The Cost Segment drop-down is used to differentiate estimated costs in
the Direct Costs, Job Overhead or Business overhead categories.

2 Costing Section where costs are defined. There are three ways to enter costs:
Area Detail, Plug, and Quote. The Cost Summary tab summarizes whatever
costs are defined.
Under the Cost Segment drop down, you can choose

3 Data Blocks Contains a set of tabs for entering additional information including
production, shift arrangements, man-hour factors, notes, and scheduling
information.
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Cost Ttem Record @

CBS Code: Optional Code: Description: Forecast (T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
BRI 2020183 Unclassified Excavatian 50,000.00 | Cubic Yard $4.68 $233,915.81 | U.S. Dollar
ICEET— |3.1 | |acavatmn \ | ﬁu,uuu.uu\ | cubic vard - | $3.uu| | $149I92.aa\ | u.s. Dollar |
PI Assignment: PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:

2020183 30 Unclassified Excavation Direct Cost 50,000.00 | Detal - [Base -

Cost Item Summary | £ Detal: $3.00 | & Plug : $0.00 | CJouote : $0.00 | Allocation | Employment Setup X
4
. Cost Cost . Total Identification
Cost Category Unit Cost Total Cost :n‘a;]éshetd Adjustment € Adjustment E"E Lz Biling i ) .
otal Cos! Percent Amount = Amount i Code: ETWT Type: Construction Equipment Rate
D tion:
. Total $3.00 §149,922.88 §149,922.88 0.00 £0.00 $3.28 $153,881.06 SSCIPH O ke T
» | Labor 80.66  §33,170.48  §33,170.48 0.00 $0.00 $0.93  $46,438.66 Quant\tv“{fLEtSS) Wgztde%
aste): -on:
> | Owned Equipment $2.34 | $116,752.40 $115,752.40 0.00 50.00 $2.35  $117,442.40
»  Rented Equipment 50,00 50,00 50,00 0.00 50,00 50,00 50,00 Quantity: Pmd"g";ﬂf 1
actor:
> | Supplies £0.00 £0.00 $0.00 0.00 £0.00 $0.00 $0.00
> Materials £0.00 £0.00 40,00 0.00 £0.00 £0.00 £0.00 CostDriver:
» | Subcontract £0.00 50,00 $0.00 0.00 50,00 $0.00 $0.00 S,
> Fees £0.00 50,00 $0.00 0.00 50,00 $0.00 $0.00
»  Allowance .00 .00 £0.00 0.00 .00 £0.00 .00 Unit Cost: §29.60 Total Cost: $1,302.40
Custom Category1 £0.00 50.00 $0.00 0.00 3 50.00 $0.00 50.00 Maintenance Labor Cost
Undefined .00 .00 .00 000 3 .00 .00 .00
& @ & = = & Unit Cost: $0.00 Total Cost: $0.00 ]
e : g
& = —
e & 5 F %8 2. A =

5.3.2 Cost Segments

The Direct Costs, Job Overhead, and Business Overhead cost segments helps to classify the scope of

work so you can report on direct vs indirect costs, and accurately control how markup is spread
throughout your bid. This differentiation is necessary to effectively price work based on the risk profile

of each segment of cost.

Cost Item Record ©

CBS Code: Optional Code:  Description:

WATER & SEWER

R [+56) 0

| |36 Inch RCP Culvert Class 11T

PI Line Number:

PI Assignment:
413(B) 0464

PI Description:

B 60

36 Inch RCP Culvert Class III

Cost Item Summary

S Detail: $67.54 | # Plug:$0.00 | (O Quote: $0.00

Forecast (T/0) Qty:  Unit of Measure: Unit Cost:
1.00 | Each | §496,284.83
1,024.00| | Linear Feet -] $67.54
Cost Segment: Pay Quantity:
Direct Cost s 1,000.00

M Description
Business Overhead
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5.3.3 Cost Sources

You can define costs on a cost item in one of three ways, called Cost Sources:

Detail  This is the recommended costing method, where labor, equipment, and material
resources are defined, along with productivity, to determine costs.

Plug This method allows you to enter a unit or total cost directly, without needing to enter

resources or production. This should rarely be used, but does have a couple of use
cases:

» Place holder value until you get more information (from subcontractors or
designers)

» For preliminary estimates when limited information is available

Quote  The Quote cost source is for contractors, subcontractors or vendor quotes.
» Creating and managing quotes is covered in Lesson - Quote Management

Company: Aceme Guardrail

Cost Category Urit Cost  Total Cost Conlact Johnson, Joe
Dozer D8 = Total $1.090.00 $1.090.00 Phone: 555-555-5555
|Scraper 623 [ ! @ Labor 450000 $500.00 Uit Price: $31.00
.l:urnpac:lor Smooth Dirum | # Owned Equipment $59000  $590.00 Band: $0.00
.l:urnpac:lor Sheeps Foot | & Rented Fouinment 400N 0 NN Conditions: $0.00
|Laborer [ Taves: $0.00
. ' \ Toa LI

Detail Plug Quote

Crews,
Resources, &
Productivity

Directly Subcontracts
Entered Cost

On each Cost Item Record, InEight Estimate gives you the option to define both Plug and Detail values
on each respective tab.
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5.3.3.1 Plug Tab

5.3 Costs and Production

The Plug tab allows user to input unit or total cost to any of the listed cost categories which can be

customized based on company requirements.

Cost Breakdown Structure {(CBS) Register

Cost Item Record @

CBS Code: Optional Code:  Description: Forecast (T/O) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
v 1200 0100 Toll Booth 100 | Each $25,264.55 525,264.54 U.5. Dalar
[®] 171 0220 | [site Preparation i 1.00 §3,564.55] | $3,664.55 | | U.5. Dallar
PI Assignment: PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
12000100 170 Toll Booth Direct Cost 1.00 | Detail ~ | | BASE -
Cost Item Summary | S Detail : $3,664.55 | % Plug:$2,500.00 | CJQuote: $0.00 | Allocation Cost Ttem Setup X
Cost Category Unit Cost Total Cost Default Pay Rules -
Scale 1@ Scale2:  Scale3:
v | Total $2,500.00  §2,500.00 a
» | Labor 50,00 40,00 Composite Wage Scale:
»  Owned Equipment £0,00 0,00 hours worked, pay
»  Rented Equipment 0,00 40,00
»  Supplies 0.00 $0.00 Default Shift Arrangements
» | Materials $0.00 £0.00 ‘Work Hours per Shift: Shifts per Day: Days per Week:
»  Subcontract $2,500.00 $2,500.00 0| | Loo] | 5.00
» | Fees $0.00 $0.00 Default Properties
» | Alowance .00 $0.00 Account Code: | 8000 r."
Custom Category 1 §0.00 $0.00
Cost Ci 1| L -
Undefined $0.00 0.00 ost curve: | Linear -
Biling Rate $0.00 $0.00 J L
Biling Rite Markup $0.00 £0.00 . Sr. ] 2 DR A Bk
.
5.3.3.2 Detail Tab
Cost Breakdown Structure (CBS) Register Cost Ttem Record © =
CBS Code: Optional Code:  Description: Forecast (TfO) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
n 17 1200 0100 Toll Booth 1.00 | Each §25,264.55 §25,264.55 | | U.5. Dollar
[®] 171 0220 | ‘Site Preparation | | 1.00| | Lump Sum . 53,554.55‘ | $3,664.55| | U.5. Dollar
PI Assignment: PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
1200 0100 170 Toll Booth Direct Cost 1.00 | Detal ~ | | BASE -
CostItem Summary | £, Detai : $3,664.55 | & Plug: $2,500.00 | [ JQuote:$0.00 | Allocation Cost Item Setup x
Drag columns here to group Find: | [Search For...] Saved views: | Previous View - Default Pay Rules -
Scale 1@ Scale2:  Scale3:
- Quantity ‘Waste Composite Wage Scale:
EﬁA = Cuun i::2;E$ Description {Less ) Qua... 'L\
Waste) Add-on For every hours worked, pay
= 1|0z Laborer 3.00 E
Default Shift Arrangements
2 01 Operator Class 1 100 E
Work Hours per Shift:  Shifts per Day: Days per Week:
3 EGl4G Grader 14G 100 E
racer 00| | o] | 5.00
4 ETWT Water Truck 1.00 E
5 LTt Teamster 100 g  DefaultProperties
. Account Code: | 8000 =
Cost Curve: | Linear - - D
- >
y - .
) , L. 8. =s. &.

Entering both a detailed and plug cost allows you to define costs at a higher summary level initially

(Plug tab), and then define more detail as the estimating process progresses (Detail tab). You can
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review and compare your plug and detail values by toggling between tabs, but your cost item will only
contribute the total cost from one of the tabs based on which cost source is selected.

You control which cost is used by selecting Detail or Plug in the Cost Source field on the Cost Item
Record.

ie =
Forecast (T/Q) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
1.00 | Each £24,100.00 £24,100.00 | U.S. Dollar
| | 1.00] | Lump Sum - £2,500.00 £2,500.00 . Dollar
Cost Segment: Pay Quantity: Cost Source: Iternate:
Direct Cost 1.00 | Plug w | | BASE -
4 Description
Dguote 1 80,00 Allocation Cost Item Setup
Detail
sved views: | revious view - Defaut Pay Rules
. Quote
Quantity Waste i Composite Wage Sce
{Less %o Qua... "
Waste) Add-on For every hod
3.00 E
Default Shift Arrangemer,
1.00 E
Work Hours per Shift:
1.00 E ’—SDDI [ %
1.00 E
100 E Default Properties
Account Code: | 8000 el
Cost Curve: | Linear - -
4 »
NRE; Sr. 2. 2 =s5.. 2 B

TIP The Quote Cost Source can only be selected from the Quote Comparison & Award form.
See Lesson 8 — Quote Comparison.

5.3.4 Plug Costs

The following steps walk you through defining a plug cost on a cost item.

Step by Step — Define a plugged cost

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for a cost item and select Open.
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3. In the Cost Source drop-down field select Plug.
4. In the left section of the cost item, select the Plug tab.
5. Click in the Unit cost or Total cost field for a cost category and type in a Numeric Value.

e For this example, on the Mobilization cost item, we’ll add $10,000 in the Total Cost field
for both Labor and Owner Equipment.

Eal 200 SITEWORK & ROADWAY
[=] 1.2 §41 0100 Mobilization
Pl Assignment: PlLine Number; Pl Description:

41 0100 w11 Mabilization

CostItemSummary | £ Detal:$0.00 ff, Plug: 520,000.00 | (' Quote:$0.00 | Alocation

Cost Category Uik Cost Total Cost

w  TotE £.20 1000, D0 £20,000.00
»  Laber $10,000.00  530,000.00
» | Cwmed Equipment $10,000.00  $10,000.00

M mencbonrl Coms s manib S0 Wt ]

5.3.5 Detail Costs

The Detail cost method is also defined on the Cost Item Record. On the Detail tab, you can add
resources (labor, equipment, and material) and define production.

On the Production tab (right side of screen), define production by entering one of the following:
e Aduration, or
¢ A unit per duration, or
¢ A duration per unit

When you enter a production value, all the other production fields will auto-fill based on what you
entered.
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CostItem Summary | S, Detail: $11,909.51 | & Plug: $20,500

Crag columns here to group

.00 | CJQuote : 500.00

Allocation

o [Berdrard | sedvews: [revmver <]

Resource

Quantity

Wiaste

EEA E C. Assembly Description \(b:ss;) ;/.,ddﬂn Quantity
1|im1 Teamster
> 2|enr Lonboy Traler
3| e Tractor Truck

1.00
1.00
1.00

Unit of Product...
Mea... Factor

Each 100
Each 1.00
Each 100

W..
H...

Pay

H...
80.00 80.00
80.00 80.00
80.00 80.00

Unit
Cost

s30)
s39
$79)

| Resourcesl

Estimate Essentials User Guide

Production
| Production | Qty Driven
Hourly
Duration Driven Resources Resources
Customize Display
Shifts: 10.00 0.00
Hours:| 80.00 0.00
Man-Hours;| 80.00 0.00
Equip-Hours: 160.00 0.00
«
A y . -
F.o e 2. o =s. &

The hours defined on the Production tab drive the labor and equipment resources you employ on the
left, multiplying their unit costs by the production hours.

When you employ material resources, their costs are driven by the quantity you enter into the quantity

field.

The Total Cost of each resource is added together to give you the Total Cost for the cost item.

Cost Breakdown Structure (CBS) Register

Cost Item Record @

CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure:

OB 6410100 | [Mobilizstion i 1.00] | Lump Sum

PI Assignment: PILine Number: PIDescription: Cost Segment:
Muobilization Direct Cost

6410100 10

L

Cost Item Summary 3,[_)etall + §11,909.51

Drag columns here to group

Plug : $20,500.00

(] Quote : $500.00

Allocation

Find: | [Search For...] Saved views: | Prw'

el T =l om o
Add-on Wasts) (Forec...
2 CI Duration 1.00 $2,688.00 | U.5. Dollar
3 CI Duration 1.00 $6,272.00 | U.S. Dollar

Cost
Curve

Employ:

Employed C...

Employed C...

Unit Cost: Total Cost: Currency:
§11,5909.51 $11,909.51 | U.5. Dollar
Pay Quanti Cost Source: Alternate:
1.00 | Detail = | | BASE
Production
~ | Durati
Work Duration Driven Resources
;Ei‘;r; Customize Display
< | | oays[  wan|«
Sh\f‘ts:
Huurs:
Man—Hnurs:
Euuip-HUurs:

*
a
F
10
'

x

Step by Step — Detail costs

1.
2.

multiplying their unit costs by the production hours.
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On the Detail tab, add resources (labor, equipment, and material).

On the Production tab, define production (duration, unit per duration, or duration per unit).

The hours defined on the Production tab drive the labor and equipment resources on the left,
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5.3 Costs and Production

e With material resources, their costs are driven by the quantity entered in the quantity field.

Cgst Ttem Summary

S0ead:s15 | @ Pg:§0.00 | O Quote: $0.00 | Mlocation

Saved vews: - O
- Resource Paar Quantity Waste % . et
Code Assembly — (Less Waste) Add-on Quantity M
LTl Teamster 2.00 Eac
ETDT Dump Truck 200 [Eady
MER Aggregate Base Rlock 45,500.00 500  47,775.00 Ton

RESOURCES

5.3.5.3 Add Cost Detail

The following steps walk you through adding resources and production on a cost item.

Step by Step — Add cost detail

1.
2.
3.
4.

Select the Detail tab.

Right-click on row header for a cost item and select Open.

From the Estimate tab, select Cost Breakdown Structure (CBS).

Resource Selection icon to open the Resource Selection Register.

Select OK.

©® N o O

11,
12.

Select a resource.

Click OK to close the record.

Select a resource tab (e.g., Labor).

Repeat the steps to add additional resources as needed.

Type a numeric value in the Days field, then press Tab.

From the lower-right section of the form, select the Production tab.

A blank row is available to define your costs. With your cursor in the code field, click the

Click in each resource’s quantity field to change their quantity as needed.

¢ For this example, we’ll add cost detail to the Clearing cost item, adding the following labor
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PRODUCTION
Durstion Driven  Factored Duration  Qty Driven Corst Item
Resources Driven Resources  Hourly Resources  Summary
45.00 45.00 0.00 45.00
45.00 45.00 000 45.00
350.00 360.00 0.00 360.00
720.00 7X0.00 0.00 720.00
720.00 720,00 0.00 720.00
[ co Sofrod. BMan. Streso. T=Sche. & user
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and equipment resources and production value:

Resource Quantity
LL2 Laborer 2
LO1 Operator Class 1 1
FL988 Loader 988 1

Cost Item Production Value (in Days)

8

5.3.5.4 Add Assembly

Step by Step — Define cost detail by adding an assembly

1. From the Estimate tab, select Cost Breakdown Structure (CBS).

2. Right-click on the row header for one of the cost items and select Open.
3. Select the Detail tab.
4

. With your cursor in the Resource Assembly field, click the Resource Assembly Selection icon to
open the Resource Assembly Selection Register.

o

Select an assembly, then click OK.

6. Because this crew includes duration-based resources, you need to enter a Production value.
Select the Production tab.

7. Type a numeric value in one of the production fields (e.g., UoM/day), then press Tab.

¢ For this example, on the Grading cost item, we’ll add a Grading assembly with a
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production value of 1 Acre/Day.

| I |Gradi|1q

1 10.00] | Acre

PI Assignment: PILine Number: PIDescription:
2010102 B 12 Clearing & Grubbing

Cost Item Summary | 5, Detai: $1,397.01 | # Plug:$0.00 | O Quote: $0.00 l ﬂmmn|

Cost Segment:

| Direct Cost

5.3 Costs and Production

InEight Inc. | Release 24.7

Drag columns here to group Saved views: I Previous View
Toon | EEE e MM, MY e
- 1 CGRADE Grading Crew 1.00

Nmbes = | Cde | LS00 | Descrpton Qs aste  Adgon | Cumntly
= 1 ETWT CGRADE  Water Truck 0.50
2|z CGRADE  Laborer 1.00
3|Lo3 CGRADE  Operator Class 3 2.00
4 | EG14G CGRADE  Grader 14G 100
5 ECOMP1 CGRADE Compactor Smooth Drum 1.00
6 LO4 CGRADE  Operator Foreman 100

4

. L E——

Unit of
Measure

10|

stsggi
13

-

- $1397.01] | §13,970.09| | U.S. Dolar
Pay Quantity: Cost Saurce: Alternate:
- 567 | Detal -] [Base

Production x
F
Duration Driven  Factored Dura
ces Driven Resoun
Days 10.00 U
Shifts 10.00 1
Hours 80.00 8
Man-Hours 320.00 32
Equip+ours 200.00 200
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Exercise 5.2 — Define cost detail

For cost items you create in InEight Estimate, you need to add resources, assemblies and production
to define their costs. In this exercise, you will practice defining cost details. Complete the following
steps, using your job:

Add the following or similar resources and production to your 1.3.1 Excavate cost

item.
LO1 Operator Class 1 1
LL2 Laborer 2
LL3 Labor Foreman 1
EX225 Excavator 225 1

CY/Hour 400

Add the following resources and production to the 1.3.2 Haul cost item.

LO1 Operator Class 1 1

LL2 Laborer 2
LL3 Labor Foreman 1

LT1 Teamster 1
EL950 Loader 950 1

ETDT Dump Truck 1
EX225 Excavator 225 1

CY/Hour 400
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Add the following resource and quantity to the 2.1.1. Furnish Pipe Materials cost

item.
MPP10 Pipe 10” PVC SDR21 1,000 with 5% Waste % Add-on = 1,050 LF

Add the following assembly to the 2.1.2 Excavate-Install-Backfill Pipe cost item.

CPIPE PipeCrew 1

Add the following production value to cost item.

Days 3

You should end up with the similar results:

100 Each $37,021.21 £87,021.21

1.00 LS $20,000.00 $20,000.00

15.00 Ace §1,399.82  $20,997.25

15.00  Ace $468.48 §7,027.16

10.00  Ace §1,397.01  $13,570.09

40,000.00 €Y $LI5  $46,023.96

40,000.00 €Y €043 $17,227.04

Haul 40,000.00 CY §.72  $28,796.93

=2 WATER&SIWER 100 Each $9,603.73 $9,603.73
2 21 10 PYC Pipe 1,000.00 LF $9.,60 $9,603.73
mr Furnich Pipe Materials 1,000.00 LF $3.54 $3,538.08
mr Excavate-Instal Backfil Pipe 1,000.00 LF $5.07 $5,065.,65

Congratulations, you have completed this exercise!
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5.4 COST ITEM DETAILS

The Cost Item Record contains other tabs (called Data Blocks) in addition to the Production tab, for
storing and calculating information specific to that cost item.

Cost Item Setup X

Cost Item Setup Pg Period Quantities “

Scale 1: Scale2: Scale3:

Composite WageScale: | 100.00] [ 0.00] [ 0.00 [] use Period Quantities

For every 8.00] hoursv.'orked,pay. 8.00| hours

Default Shift Arrangements Execution
Work Hours per Shift: Shifts per Day: Days per Week: Allow As-Built: | None -
8.00| 1.00] 5.00
Default Properties
Account Code: | 1020 Tag 1: | Estimator 1 -
Cost Curve: | Linear - Tag 2: | Roadway -
Worker's Comp Override: - Tag 3: -
Quantity Driver: | Pay Item Tag 4: -
Quantity Roll-Up: i Tag 5: -
Quote Group Tag: - Tag 6: - —
4 >
| Ze Emplo.. [5) Notes [#Costlt.. 2:Produc.. 22 ManH.. 2S2Resou.. ™= Schedule & UserD.. > Bench... |

You can add to or adjust the information on these tabs as needed, based on the cost item’s
circumstances. In this section, you will review three of the tabs (in addition to the Production tab) you
will likely use most often: Cost Item Setup, Notes, and Man-Hour Factors.

5.4.1 Cost Item Setup

On the data block where the Production tab was found, there is also a Cost Item Setup tab where you
can adjust wage scale and shift arrangements for a specific cost item.
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Cost Ttem Setup x

Default Pay Rules Period Quantities -
Scale1: Scale2:  Scale 3:

CompositeWageScale:l 1uu.nu| | n.un| | u.nn| [] Use Period Quantities
Far ever)' hours \f.'orlv.en:l,m‘,-I hours

Default Shift Arrangements Execution
Work Hours per Shift:  Shifts per Day: Days per Week: Allow Az-Built: | Mone -
| o] | Loo] | 5.00
Default Properties
Account Code: | 1020 e Tag 1: | Estimator 1 -
Cost Curve: | Linear - Tag 2: | Roadway -
Worker's Comp Override: - Tag 3: -
Quantity Driver: | Pay Item Tag 4: -
Quantity Roll-Up: it Tag 5: -
Quote Group Tag: - Tag 6: -
Minority Goal Allowance: Tag 7: -
Phase Code: | Tag 8: -
Tag 9: -
When man-count changes: (@ Change UM [ Man-Haur Tag 10: -
(_) Change Days Tag 11: -
Tag 12: -
Suspend: [] Tag 13: -
Tag 14: -
Tag 15: - o
1 3

E_,. Emplo... E‘ MNotes E’ CostIt.. | Sz Produc... a‘;ﬁ Man-H... .-.' Resou.. ‘== Schedule a UserD... == Bench...

The composite wage scale and work and pay hours are used in the calculation of the cost of employed
labor resources. The data reported on the Default Pay Rules tab is, by default, the composite wage
scale and work and pay hours defined on the Job Properties - Cost Basis tab for the current job.

These settings can be modified from the default on a cost item-by-cost item basis.

The Pay Rules for cost items can also be defined or modified on the Cost Breakdown Structure (CBS)
Register in the Scale 1, Scale 2, Scale 3, Work Hours Rules, and/or Pay Hours Rules columns in the row
of the subject cost item.

5.4.1.1 Cost Curves

Cost curves are used to determine how the cost of a cost item is distributed over time. The main
benefit of defining the cost curve for a cost item is to create a more accurate estimation of the cash
flow over the life of a project.

The schedule dates entered on a Cost Item are used to define the periods across which a cost item will
incur its costs. A cost item’s start and finish dates can be entered manually by the user or established
using Schedule Integration, and the time periods (day, week, month, quarter, year) are determined in
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the Cash Flow settings in Job Properties. For more information on scheduling, see topics Microsoft
Project and Primavera.

By default, Cost Items have a linear cost curve, which distributes the cost of the cost item equally
across all periods for the Cost Item. There are 5 different types of cost curves that can be selected from
in the Cost Item Record > Cost Item Setup page.

Cost Item Setup
Default Pay Rules Period Quantities
Scale1: Scale2: Scale 3:
Composite Wage Scale: | 100.00 0.00 | ouo|  [JusePeriod Quantities

Fu:-n!w!ry. 8.00| hours worked, pay| B8.00| hours

Default Shift Arrangements Execution
Work Hours per Shift: Shifts per Day: Days per Week: Allow As-Built: | None
| soo| | 100 | 5.00
Default Properties
Account Code: | 1110 P Tag 1: | Estimat
Cost Curve: | Linear o - Tag 2: | Roadw:
Worker's Cofnp Override: | A Description Tag 3:
Quantity Driver: | Back Loaded Tag 4:
Quarntity Rall-Up: Bell Shaped Tag 5:
Quotg Group Tag: Front Loaded Tag 6:
Minaority Gogl Allowance: Tag 7:
Phase Code: Tag 8:
Tag 9:
When man-count changes: | = Tag 10:

Back Loaded Costs are low for most of an activity's
timeline, but then increase towards the end.
This curve type starts out with a lower slope
and gradually becomes steeper as the work
progresses. Most resources are assumed to
be consumed later in the activity and may be
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Bell Shaped

Front Loaded

Linear

Cost Item Periods
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(continued)

more characteristic of subcontracted work
where costs are incurred as the work nears
completion.

Expenses are low at the start of an activity,
increase during construction, and decrease
as the project approaches completion. Bell
shaped cost curves incur the maijority of their
costs towards the mid-point of the work and
exponentially increase and decrease from
the beginning to the end of the activity. This
type of curve can be characteristic of larger
portions of work that start with a few
resources, ramp up to a peak, incurring
more costs during the ramp up, then ramp
back down as the work nears completion.

A front-loaded cost curve is when costs are
incurred early in a activity. This can happen
for several reasons such as early
procurement of materials to take advantage
of lower prices or to address long lead times.

Linear cost curves take the total cost of the
activity and spreads it equally amongst the
specified periods.

Invoked by using the Period Quantities
feature (described below). Cost ltem Periods
are used to customize cost curves based on
the quantities consumed in various periods.
In comparison to the other curves which
spread the items total cost proportionally
based the chosen cost curve, the Cost Item
Periods option can generate a more precise
distribution of costs to specific periods
because the user can simply define how
much quantity of work is getting completed in
each specific period.

5.4 Cost Item Details
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You can also choose to create your own custom cost curve by clicking on the add button in the Cost
Curve drop-down menu.

Account Code: | 1110 -

Cost Curve: | Linear o -

Comp Override: | &% Description
Juantity Driver: Back Loaded
Bell Shaped
Front Loaded
ote Group Tag:
q-.l-‘-I ﬁllA'!llq.".,'A-
Custom cost curves let you define your own from and to durations along with their associated values,
which need to add up to 100%.

jantity Roll-Up:
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.-l" Cost Curve Record - Training Job — | X

Description: * |Expeditedpruj&ct5 ]

i
Number of Points: ] ]

From Duration % To Duration % Value % 1
S d < ]
50 50 5
20 50 101
50 50 10
50 100 30
100 100 10 | 4
100 100 10
100 100 20 |
L
100.00
t
oK Cancel

Cash Flow

All cost curves, regardless of type, impact the generation of the cash flow graph. The Cash Flow form
provides a graphical representation of the cash flow and resource utilization of your project, so you can
quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

To generate a cash flow curve, the estimate must be populated with schedule dates either directly
from integration with Primavera, Microsoft project, or input manually.
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510000000 —

£80,00000

$60.000.00

$40000.00

£20000.00

- IE BN BN BN BN =B .
Y ., - % :, 5,
% s, % s, 2, o,

. %, %, %, %, o,

= 3 . 3
il 4 v o4 - v i

Schedule Last Updated 3262013334 FM

B Construction Equpment (5) I Labor (F) Total rice __ Total Cost
(current) - Cash (Forecast] - Cash

Cash flow options

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.
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=
B « B i ) I:::
- T
- £2 Eguipment a
Job Properties  Foundation  Pay Item & BidWizard =~ Resources Resource CostItem  Stardar
Report: =

e

- SetupData *  Proposal - o Materials  Assembles | Assemblies Tahles

Initialize Resources Assemblies

Cash Flow Job Properties @

Cverview | Cover Sheet | Cost Basis | Minority Setup | Fuel Cost | Job Folder Tags | Pricng | Schedue | Cash Flow
| Revenue timing

Bills are submitted to the owner: Average calendar days elapsad from billing to collection:
(C) at the end of the jab Amount of each billing that is withheld by owner as retainage: 5 00| %
(®) Every manth on this day: |25 Retainageis released: (®) At the end of the job
) Every |1 weeks () On a spedfic date:
() Every | 1 | days [ seread revenue using the same Cost Curves as the contributing Cost Ttems
Cost timing
Bills are received from subcontractors Average calendar days elapsed from recaipt of invoice to payment: 35 days |

and vendors:
O atth 4 of thaioh Amount of each invoice received that is withheld by you as retainage: 5.00( %
e end of the jo

Retainageis released to (@) At the end of the job
(®) Every manth on this day: 25 subcontractors and vendors:
o . . () On a specific date: | -

Every el
O Every T = Apply cash timing rules for all procurable cost categories {non labor and equipment),

even if their cost source is not set to "Quote™?

Cost of money : : Quaniities
Average annual interest rate paid ta borrow money {when cost exceeds revenug): | 8.00] % () Pay Quantity
Average annual interest rate earned (when revenue exceeds cost): [ 3.00] % (®) Forecast (T/0) Quantity

Reportng Periods Dates
Period setting for cash flow: | Day - Early Start | Finish -

Cash Flow Display Settings

cangesd

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
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Cash Flew Display Settings
Settings: | Previous -

A Display this text a2 a custom report title;

Example cash flow

Period Week -

Cost kems
Total Cost

a {Farecast)

0 Tatal Price

{current)

Tatal
Eota&m

(Ferecast) - Cash

Tatal Price
(% (current) - Cash

[[] Cash Flow
[] Finence Cost

s Built
Dol Cost

O CE-Total Cost
Eamned (jo-date)

Cash Flow example

Cost Calegones

Labor

Ownad Equipment
Rented Equipment
Supplies
Matenzls
Subcontract

Fees

Allowance
Cusiom Category1

Undefined

Estimated
O -
O
O
gy
O
O
O
my
O
O

As-Built

O

O

OoO0ogoooogao

OO0O0ooooaoao

Planned
To Date

O

O
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Resources

4] Resource Utilization

Summarize resources by | Resource Type ~

Get data from: (® This job's utilized rescurces

(O All Library resources
Value City Cost ABGty ABCost
B Labar

[l Construction Equipment

[ Rented Construction Eq..
[7] Installed Material
[ Installed Equipment
[ Supply
[ unique
Quantity: Cost
None ~ Stacked Bar ~
As-Built Guantity As-Built Cost:
Mane ~ Nane w

Using the Period Quantities cost curve type as an example, on the Cash Flow graph, you can see that
50% of the total cost for this cost item, represented by the red line, is incurred in the first period of the
project. Half of the project’s cost is incurred during the first period of the project’s lifespan as
determined by what is entered in the cost item’s period quantities.

A reason why half of the project’s cost is being used during the first period could be that resources
available to perform the project happen to be mostly available during the front end of the project.
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Number of Peniod Quantities: 5 Re-spread quantiies

uanaty value %
2 o+ 562500 1250
3 otz 562500 1250
4 0403-2014 5,625.00 1250
5 04042014 5,625.00 1250
$100,000.00 45,000.00 100.00
Forecast (7/0) Qv 45000
Quantity left to spread:
$20,000.00—
$60,000.00——
Total Cost
4000000 | (Forecast] - Cash
471272014
£50,495.37
$2000000—|
1S , v, - %, o, %,
: EX N N
- ®, -, '&-’-J),’ S q-‘-l,,( b,

Schedule Last Updstec: 9252013 &34 P

W Construction Equipment (§) N Labor (5) __ Total Prce Toral cost
(current) - Cash (Forecast) - Cash
Date Range Cost Ttem Range
St 3ma0n v ] Stan: [4y
End: [Byijaoie <] Eedi [43 - s

@ Ester a plug nember directly in the PES

After the first period, the project incurs the remaining balance of the total project cost of $95,000. This
is spread equally with quantities of $5,625 amongst the last three periods. This information helps you
to better understand when the owner provides payment, in addition to deciding if more project
funding or financing is needed.

$100.000

$30.000.00

$40.000.00-

20,000.00.

Schedule Last Updated: 32572011 934 PM

M Constraction Squipment (§) I Labor (5) Tatal Price Total Cost
= (currens) - Cash = (Forecast) - Cash

Date Rangs Cost lem Range Click and drag in the graph 7] Include Finance Cost in this Job's Targst Price
areata 2o al

ually

ST | Yz ~] St [43 O Calaulate astomatically according to the Cash Flow graph

a Reset Loor
el T -] Enet (a3 B ®e

3 plug number directly in the PBS
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Perhaps most costs on this one item will be incurred at the end of the activity, such as a subcontractor
billing for most of his work as it nears completion. If it’s determined costs are incurred towards the end
of the activity, you can attribute most of the cost items quantity in the last period. You can add any
number of additional periods to a custom cost curve or to a cost curve defined by period quantities
curve and the costs will be proportionally spread across the actual number of periods defined by the
Cost Items start and finish dates and cash flow settings. Be aware reducing the number of periods in a
front or back end loaded curve may show a steeper total cost in some periods.

Schedue
"2 ovoraons
3 04022014 247500 5.50
4 04032014 2,475.00 5.50
5 04042014 2475.00 5.50
6 04052014 247500 550
7 04052014 247500 550
8 04072014 247500 550
9 04082014 2.700.00 6.00

$100,000.00
10 | 0409-2014 22,500.00 50.00

45,000.00 100.00

$80,000.00 )
45000

]

$60,000.00—

$40.000.00—

£20,00000—

Using period quantities as the cost curve helps you determine how much of a cost item’s cost is going
to be spread in different durations of time.

Period Quantities

Like the other four cost curves, Period Quantities are used to customize cost curves, which show you a
graphical representation of the cash flow and resource utilization so you can assess the proper
financing and resource project needs. When the Period Quantities check box is selected, the Cost
Curve automatically changes to Cost Item Periods.
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Cost Ttem Setup

Default Pay Rules Period Quantites
Scale 1: Scalel: Salel
Compaosite Wage Scale 100.00 0.00 0.0¢ A Use Period Quantities
Forevery| 8.00) hours worked, pay| 8.00| hours

Default Shift Arangements

Work Hours per Shift: Shifts per Day Days per Week Bullt:  None -
B.00 LD0 5.00
Default Properbes
Account Code: | 1122. 100 Tag L: | Estmator 1 Tag
& Cost [tem Periods 21 Roadway Tag
jorke L] '1..
antit ver: | Supesio 4 Tag 18
ol-Up 110. 2 5 Tag
uote Tag Tag & Tag
13 Al L 100.0 e Ta
P & Cod B a
Tag 24
When man-count changes: (@) Change UM [ Man-Hour Tag 10 - Tag 25
_) Change Days Tag 11
end: [] ac
Tg
a9 -
4 »
'E-. Employme '_—,| Motes : Cost Item 2 Preducion 22 Man-Hour z‘ Resource = Schedule a ser De! Be: ar

The Period Quantity calculator uses the cost item quantity assigned to various periods to calculate the
specific percentages attributable to each range of periods covered by the cost item. The purpose of
using period quantities is to spread costs via the cost curve in the cash flow analysis. For example, if
you have an item where 50% of the cost is incurred when you start the work because you have to buy
all the material first, then you would want a customized cost curve to reflect that this is how the costs
will be incurred over time when building that work.

In the example below, since 50% of the cost is incurred when the project starts, period one's quantity
is 50% of 45,000 Forecast (T/O) Qty which is 22,500. The remaining costs are then spread equally
across the remaining three periods.
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CBS ; . Forecast
Pasition Code = UeGTp Lo Finish (T/0) Quantity
8 43 Install Aggregate Base 3/31/2014  5/26/2014 45,000.00
Period Quantities
Number of Period Quantities: 5 Re-spread quantities
Period # Schedule Quantity Value %
1 03-31-2014 22,500.00 50.00
2 04-01-2014 5,625.00 12,50
3 04-02-2014 5,625,00 12,50
4 04-03-2014 5,625.00 12,50
&
Forecast (T/0) Qty: 45000
Quantity left to spread: 0

You can also choose to select the Re-spread quantities button to spread the quantities equally among
the periods entered in the Number of Period Quantities field.

Number of Period Quantities: s | Re-spread quantities |
Period & Schedule Quantity Value %

2 9,000.00 20.00

3 9,000.00 20.00

4 9,000.00 20.00

5 9,000.00 20.00

45,000.00 100.00
Forecast (T/O) Qty: 45000
Quantity leftto spread: 0

oK Cancel
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Step by Step — Adjust shift arrangements

1. From the Estimate tab, select Cost Breakdown Structure (CBS).
2. Right-click on the row header for a cost item and select Open.

3. Select the Cost Item Setup tab in the lower-right portion of the form (the tab name may be
abbreviated).

4. In the Default Pay Rules data block, adjust your Composite Wage Scale as needed.

15.00] | Ace - | SI,U!':I.':Ijl | 51hr1':lti.':|!| U5, Dollar -
Cost Segment: Pay Quantity: Cost Source: Alternate:
Direct Cost 10.00 | Detail = | | BASE -
Cost Item Setup X

- Default Pay Rules P

Scale 1: Scale 2: | Scale 3:

Quantity Composits Wage Scale: | EIZI.IZIEI| | | 0.00 | [
(Less
Waste) For every| 8.00| hours worked, pay| 8.00| hours
Default Shift Arrangements 1
Work Hours per shift: Shifts per Day: Days per Week:
| 80| | 1.00| | 5.00
Default Properties

- | #

5. Under the Composite Wage Scale, adjust the number of hours and paid as needed

Cost Item Setup

Default Pay Rules
Scale1:  Scale2:  Scale 3:

Composite WageScale: [ 80.00] [ 2000] [ 000
For every| 10.00| hours worked, pay| 10.00| hours
Default Shift Arrangements
‘Work Hours per Shift: Shifts per Day: Days per Week:
| a nn| | 1nn | | c nn |

6. In the Default Shift Arrangements data block, make changes as needed.
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Cost Item Setup
Default Pay Rules
Scale1: Scale2: Scale 3:
CompositeWageScale:| su.un|| 2u.un|| u.uu|

For every| 10.00| hours worked, pay| 10.00| hours

Default Shift Arrangements
‘Work Hours per Shift:| Shifts per Day: Days per Week:
| 10.00 | El| | 5.00

P b P mrbime

* For this example, we’ll make the following changes on the Clearing cost item:
e Composite Wage Scale — 80% Scale 1, 20% Scale 2.
e For every 10 hours worked, pay 10 hours.

e Default Shift Arrangements — Change Work Hours per Shift to 10.

Cost Item Setup

Default Pay Rules
Scale1l: Scale2: Scale3:

Composite\.-.rageScare:l 100.uuH 0.00 \ u.uu\

For every| 8.00| hours worked, pay| 8.00| hours

Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:
[ s.00| | 00| | 5.00

5.4.2 Notes

On the Cost Item Record, you can enter any cost item-specific instructions, parameters, or general
information on the Notes tab. Below are a few examples of the kinds of notes you might enter:

e For a Hauling cost item: There should be very little waste. If so, we can spread it out in the right
of way at MP 111

¢ For a Structural Excavation and Backfill item: The backfill cannot be the native material. Have
to use clean base rock

¢ For an Underground Pipe cost item: The average depth is close to 10 ft.
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TIP You can use the Notes tab to reference cost item changes (e.g., changing shift
arrangements, changing a resource rate).

5.4.3 Man-Hour Factors

For items that have known risks or potential resource concerns, you can apply a Man-Hour Factor to
take those risks into consideration.

Man-Hour factors are applied on the Man-Hour Factors tab on the Cost Item Record. Factors are
applied in relation to 1, where slower production is greater than 1 and faster production is less than 1.

TIP Man-Hour Factors affect both Labor and Equipment Hours.

For example, if you predict production to be 20% slower due to weather concerns, you would type 1.2
in the weather factor field.

Man-Hour Factors >
Man-Hour Factors
Factor Name: Factor:
Factorl:l:@'
Facorz[
Factor3:
Factor4:
FactorS:
FactorE:
Factor?:
FactorS:
Factorg:
FactorlD:
FactorComposite: 1.2000
o BB 200|802 = & 5

Even after defining a Man-Hour Factor, the Production tab will still display the original Production
values.

¢ To see the factored Production values, click the Customize Display link on the Production tab
and select Show Man-Hour Factors

e Both original and factored production are then displayed on the Production tab
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Production b4
Qty D
H
Duration Driven Resources Resc
Customize Disolav
DI Show Man-Hour Factors I
Sh Show All

TIP You can apply Man-Hour Factors to multiple cost items at once by Multi-Editing selected
cost items on the CBS Register.

5.4.4 Unique Identifier

You may have noticed when you made changes on the Cost Item Setup tab, that the fields you changed
and the Cost Item Setup tab became highlighted, indicating they were altered from their original state.

Page 266 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 5.4 Cost Item Details

Cost Item Setup
Default Pay Rules
Scale 1@ Scale 2: || Scale 3:
Composite Wage Scalf: | 8000 [ 20.00] | 0.0]
Fore'.'erg-I hours worEea,pay- Rours
Default Shift Arrangements
Work Hours per Shift: Shifts per Day: Days per Week:
| ool | Lon| | 5.00|
Default Properties

Account Code:
Cost Curve: | Linear -
Worker's Comp Override: -
Tag 1: -
Tag 2: -
Tag 3: o
Tag 4: -
Tag 5: -
Quantity Driver: | Superior CI -
Quote Group Tag: -

Minority Goal Allowance: | 100.00

Phase Code: |

When man-count changes: () Change UM f Man-Hour

(O) Change Days
Suspend: []

s

Bl B fo- 8B 2. = &

[icb

On the CBS Register, the cost item you edited now has a Unique Identifier in the row header indicating
the cost item was altered from the default values set in the project job properties or in the project
library of resources rates.

= JuB
d Prime Bond FRIME
\dd-On Price % Add-On PRICE
icng Job Financing FINAP
igemern] Job Management & Equipment JOB
¥pense General Expense GENEI
an + 1 Mobilization 1000
2Grubk: S Clearing & Grubbing 2000
n + 2.1 Clearing
lipe o W 22 Grading
3 Excavation 3000
+ 3.1 Excavate
+ 3.7 Haul

If you hover over the identifier, a pop-up menu appears indicating what data points were changed.
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+ Ll
+ 2.2

Scale 1

Scale 2

This same identifier will show up for resources as well, if you make changes to the employed resource’s
cost to be different than the original resource rate imported from the Resource Rate Register.

CostItem Summary | S, Detal: $972.93 | # Plug: $0.00 | [Jouote:: » Employ Breakd X

Dféndol [Search For...] Saved views: | Previous View - Cost Category
~ Total
Row . Resource

Ny, B Code Assembly Description > .
» | Owned Equipment pei
1Lz Laborer »  Rented Equipment $0.00 $0.0
2 lo1 Operator Class 1 > | Supplies $0.00 $0.C
3 =98 Loader 983 > | Materidls $0.00 $0.C
» | Subcontract $0.00 0.0
» Fees $0.00 $0.C
> Allowance $0.00 0.0
Custom Category 1 $0.00 $0.C
Undefined $0.00 0.0
Biling Rate $28.00 $40.8
Billing Rate Markup $0.00 §0.0
Rillin R ate Markn o, nnn nr’

“ »

ke
3

5.4.4.2 Highlight Unique (Delta) Toggle

You can turn the highlighting of unique resource and cost item fields off and on from the Actions menu
of the Cost Item Record, under the View section.
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Training Job - Estimate

File Setup Estimate Quote Price Execution System
I‘:] rl-l-l E Display Parent Information ;.":A Highlight Unigue {Delta) Resource Fields ib Edit Resource F
!‘_-_?I Display Biling Rate EE Highlight Unique (Delta) Cost Item Fields | "= Insert Subordin
Split Default
Data Blocks Break Cost Allo
Edit View
Cost Breakdown Structure (CBS) Register Cost Ttem Record @
CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit
A c 2n3 anca Ammbhalé Fameaba Lk Wi Toma A ac ana nn | | Tem

5.4.5 Cost Drivers

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
the cost driver is Cl Duration, meaning their costs are driven by the duration of the cost item. If you
want an Operator to only be assigned to a specific cost item or work activity for half the time, you can
change its quantity to .5 and it will be driven by half of the cost item’s hours.

Drag columns here to group Find: | [Search For...]
. X - Waste Qual
W R T T AT T S .
1 L2 Laborer Each £29.00
2 101 Operator Clas... 1.00 Each £29.94
3 EL938 % Loader 938 1.00  Each £73.75
ry

To enter work hours manually for the employed resource, you can change the Cost Driver option to Cl
Quantity or Fixed.

Drag columns here to group Find: | [Search For...] Saved views:

Row . Fm Resource Description Quantity Unit of Unit Cost E;:‘ESE E‘;‘:;‘ﬁt" nven
Mumber Assembly Mea... Cost Driver o \Waste) tomiz
- Y =S I = Y N Y oo -
2 Lot Operator Clas... 1.00 Each $29.94 | # Description
3 EL9&8 Loader 983 1.00  Each §73.75 | cI puration

Fixed
Scheduled Periods

T8
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With CI Quantity as your cost driver for the Operator, you can adjust the Work Hours manually, where
previously that column was read-only.

Let’s say you want your Operator to work specifically 80 hours.

Drag here to group Find: | [Search For...] Saved views: | Previc
,
O I i S ST S P - S
Add-on v
2 | e N = I N Cl Quantty
2 o1 Operator Clas... 1.00 Each §29.94 120.00 120.00 CI Duration
3 EL%38 Loader 988 100 Each §73.75 120,00 120,00 CI Duration

However, since the resource is now quantity driven, if you change the Forecast (T/O) Quantity to 50
you will see that the work hours will still adjust from 12 to 40.

Cost Breakdown Structure (CBS) Register Cost Item Record ©  Cost Item Record

cBS Code: Optional Code:  Deseription: I Forecast (T/0) Qty: [Unit of Measure:  Unit Cost: Total Cost: Currency:
[E]22 | [clesring [ s0.00] !Cub\t Yerd - st156.70] | $57,835.7| | U.S. Dolar
PLAssignment:  PILine Number:  PIDescription: Cost Segment: Pay Quantity: Cost Source: Alterate:
2010102 20 Clearing & Grubbing Direct Cost 5000 | Detal - [ease
Cast Item St Sopetailzs1,156.70 | # Pug:60.00 | CJQuote:$0.00 | Alocation Production X
Find: | [SearchFor...] | Saved views: | Previous View Factored  QtyDriv *
ration Driven Hou
eeeeeee —— —— unitof unit work Fay st o Resoures  Resou
Assembly . Cost urs Hou oo o (x 1.2000
V3 1u2 Laborer 0.50 Each s22.00 290.00 20.00 c g b
2 101 Operator Clasi.. 100 Each $29.94 480.00 48000 [= 48.00 4.
3 mss Loader 385 100 Each 7375 460.00 460.00 c 480.00 450,
480.00 240,
280.00 0.

If you want it set at 80 hours no matter what changes you make to your quantity, you can change the
cost driver to Fixed. Then when you change the Forecast Quantity to 500, the work hours for the
Operator will not change and will remain at 80 hours as shown below.

CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure
[m] 22 | [clearing i 500.00] [CubicVard
PIAssignment:  PILine Number: PIDescription: Cost Segment:
010102 20 Clearing & Grubbing Direct Cost
Cost Item Summary E‘,getaul: $106.33 | ¥ Plug: $0.00 | (JQuote: $0.00 | Alocation
> group Find: | [Search For...] - | Saved views: | Previous View
’ Waste Quantity
. Resource . Unit of Unit Work. Pay Cost Pre
Code Description Quantity % (Less
Assembly Mea... Cost Hours Hours edon Driver Wasts) Fa
/5 1 w2 Laborer 0.50 Each 35,00 | sn.nnl 0.00 Fixed
2 Lot Operator Clas... 100 | Each $29.94 430,00 430.00 CIDuration
3 EL988 Loader 988 100 | Each §73.75 480,00 480.00 CI Duration

If you followed along and made any adjustments to cost item 2.1 Clearing, change the Cost Driver for
the Operator resource back to Cl Duration and the Work Hours back to 100.
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5.4.6 Suspend Cost Items

The Suspend feature allows you to turn cost items on and off in order to perform “what-if?” analysis or
evaluate alternative approaches to the work.

A cost item can be suspended in InEight Estimate for various reasons including the following:

Manually suspended cost items
Suspended parent
Parent with cost source that is not Detail (plugged or quoted)
Parent cost item with a zero quantity
Pay item is suspended
Allocated cost items
Alternate scenarios:
¢ Overridden by another alternate

¢ Alternative is not active

Suspended cost items do not contribute any cost to the job's total value. Suspended items can be un-
suspended at anytime in order to be included in the total project value.

Step by Step — Suspend a Cost Item

1.
2.

On the Cost Breakdown Structure (CBS) Register, select a cost item.
Right click on the selection and select Toggle Suspended from the menu.
e You can also select Toggle Suspended under the Edit section of the Actions tab up above

¢ You can also suspend cost items by checking the Suspend checkbox on the Cost Item Setup
tab of a cost item record
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e If a superior cost item is suspended, its subordinate cost items are automatically
suspended as well

E S EXCavate ETRVVRTIV

3.2

Haul

40,000.,00

CY

41
4.2

+ 4+ o+ 4
s

10" PVC Pipe
Furnish Pipe Materials
Excavate-Instal-Backfil

1,000.00
1,000.00
1,000.00

5

¢ The costs associated with these cost items will no longer contribute to the estimate

5.4.6.3 Editable Man-Hour Factors in Suspended Cost Items

You can edit Man-Hour Factors for a suspended cost item by creating and maintaining cost items,
including Man-Hour Factors. This can be accomplished in a suspended state while having the scope of
work included in your estimate. The cost to contribute is excluded from the scope of work until you are
ready to make it part of your estimate.

Bl P il Mvnn Vst (107 Bnagrmliin B il L]
= L it 1 Ll LA L Gl
I.I-_ | | Ii!i_ bI'.IH . 1 ik
e ey p- S Sy PG 1 e 00 i wnar Pl S DA T
[ rotes |
3 e e Yok i B (B el -
Ll Dol 00 | EE) | v [T —
e N S 1 | Lo [T v [ T =
it g
(g
:} BB aF P L
|_.i )
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5.4.6.4 Unsuspend a Cost Item

Follow the step by step below to unsuspend a cost item.

5.4 Cost Item Details

Step by Step — Unsuspend a Cost Item

1. On the Cost Breakdown Structure (CBS) Register, select a cost item.

2. Right click on the selection and choose Toggle Suspended.

¢ You can also select Toggle Suspended from the Edit section of the Actions tab

¢ You can also unsuspend cost items by unchecking the Suspend checkbox on the Cost Item

Setup tab of a cost item record

5.4.6.5 Suspend Column

Within the CBS Register, the Suspend column indicates which cost items are suspended.

CBS
Position Code

45
=
45

+ +/m + + o +

1
2
21
2.2
3
3.1
3.2
4
4.1
4.2

Description
Mobilization
Clearing & Grubbing
Clearing
Grading
Excavation
Excavate
Haul
10" PVC Pipe
Furnish Pipe Materials
Excavate-Install-Badkfil

Suspend

Forecast

(T/0) Qui

¢ Hover over the checkmarks to see why the cost item is suspended

+ + o+

Gud Haul

4 10" PVC Pipe

4.1 Furnish Pipe Materials
4.2 Excavate-Install-Backfil

'

k Parent is Suspended

¢ You can suspend and unsuspend cost items by checking and unchecking the checkboxes in the

Suspend column as well
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5.4.7 Adding Cost Adjustments

Estimate Essentials User Guide

Total Cost and Billing Adjustments can now be made in the CBS register which can be viewed either

from the Standard view of the CBS register, or a saved view affiliated with change.

Cost Breakdown Structure (CBS) Register @

Fostin Coge = | D=ton

B 35 REBAR

+ 351 Rebar

+ 352 Post Tension Tendons

+ 353 Crane

CREYS 034100 - Precast Structural Conarete
+ 361 Precast Panels

+ 362 Crane

Ea DIV 04 - MASONRY

B a1 042000 - Unit Masorry

Setup & Maintain Scaffolding

‘Additional Month

Netting on Exterior

DIV 05 - METALS

Forecast t
{T/0) Quantity

1.00
1.00
1.00
1.00

2,800.00

27.00
100
1.00
1.00
1.00
1.00

Lump Sum
Lump Sum
Lump Sum
Lump Sum
SQFT

EA

Lump Sum

Lump Sum

Lump Sum

Monith

Month
Lump Sum

Lump Sum

$2,618,414.00
$2,512,724.00
$0.00
$105,690.00
$128,640.00
$64,320,00
$64,320.00
$2,326,834.67
$2,325,334.67
$1,879,709.33
$170,382.67

$105,360.00
$105,360.00
€0.00
$0.00
$354,880.00

$20,381,473.74

Find: | [Search For...]

: | CostItem

Adjustment View

Cost. Total Cost Total Cost Labor Cost Labor C Owned Equipment Cost q
Adjustment Adjustment Amount Adijustment Percent Adjustment Amount Adjustme Adjustment Amount 4

$0.00 0.00 $0.00 0.00 0,00

$0.00 0.00 $0.00 0.00 0,00

0,00 0.00 $0.00 0.00 30,00

0,00 0.00 $0.00 0.00 50,00

0.00 0.00 $0.00 0.00 0.00

v $1,708,826.67 1000.00 .00 0.00 .00

$0.00 0.00 $0.00 0.00 $0.00

0,00
0.00
$0.00

$1,733,328.68

. T T

0.00 $0.00
0.00 .00
0.00 $0.00

$17,567.79

0.00
0.00

0.00

$0.00
0.00
50,00

$176.78

Adjustment fields have been added to the CBS to view and modify the adjustment amount and

adjustment percent without going into each individual cost item.

Any adjustment made to the Adjustment Amount fields on the CBS register will then have the

Adjustment Percent field automatically calculated. Changes made to those fields will be highlighted in

yellow signifying an adjustment has been made.

+ 3.6.1
+ 362
LI

=241
+ 4Ll
+ 412

- T

2 414

t 40141

T 4142
4.1.4.3

=5

261

Precast Panels
Crane
DIV 04 - MASONRY
042000 - Unit Masonry
MU walls

Precast Concrete Caps

Steel Embeds

Scaffolding

Setup & Maintain Scaffolding

Additional Month
Netting on Exterior
DIV 05 - METALS

27.00
1.00
1.00
1.00
1.00
1.00

1.00
2.00
0.00
0.00

1.00

EA
Lump Sum
Lump Sum
Lump Sum
Lump Sum

Lump Sum

Lump Sum

$64,320.00
$64,320.00
$2,326,834.67
$2,326,834.67
$1,879,709.33
$170,882.67

Lump Sum $105,360.00
Manth $105,360.00
Manth $0.00
Lump Sum $0.00
Lump Sum $854,880.00

$20,381,473.74

$0.00
$0.00

$1,708,826.67
$0.00

$0.00
$0.00
$0.00

$1,733,328.68

0.00

0.00
0.00

$0.00
0.00

.00
$0.00

0.00
0.00

0.00
0.00

$0.00 0.00

.00 0.00

.00 0.00
$17,567.79

Other adjustments fields in the CBS register include the many adjustments fields that have been added
to the Billing Rates View.

A new Saved view called Cost Item Adjustment View has been added to the Cost Breakdown

Structure.
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Exercise 5.3 — Manage cost item details

In this exercise, practice adjusting your cost item details. Complete the following steps, using your
Job:

1. Open the Cost Item record for cost item2.2 Grading.

2. From the Cost Item Setup tab, change the Composite Wage Scale to 80% Scale 1,
20%Scale 2. Also adjust for every10 hours worked, pay 10 hours.

3. Change the Default Shift Arrangements to 10 Work Hours per Shift, 1 Shift per Day, 5Days
per Week.

4. From the Man-Hour Factors tab, apply a Man-Hour Factor of 1.1 to the same cost item.

5. On the Notes tab, type Added man-hour factor due to hard soil conditions.

You should end up with similar results.

Production
Duration Driven  Factored Duration
Cost Item Setup Resources Driven Resources
Default Pay Rules + | o L L
Scale 1:  Scale2: Scale3: Shifts 3.00 8.80
Composite Wage Scale: | 80.00] [ 20.00) [ 0.00] Hours 80.00 £3.00 Notes
For every| 10.00| hours worked, pay| 10.00 | hours R0 .00 =l Added man-hour factor due to hard soil cone
Bquip-Hours 200.00 220.00
Default Shift Arrangements
Wark Hours shift:  shifts Day: Da er Week:
urs per Shi ifts per Day ¥S per We Acre/Pay 125 e
| 00| | uoo| | 5.00
AcreShift 125 114
AcreHour 0.13 0.11
Acre Man-Hr 0.03 0.03
AcreEquip-Hr 0.05 0.05

Congratulations, you have completed this exercise!
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Lesson 5 Review

1. Resources, costs, and production can only be added to what type of cost item?
a. Superior
b. Terminal

C. Parent

2. What Cost Source is used for defining resources and production?
a. Plug
b. Detail

C. Quote

3. On the Cost Item Record, what tab is used for changing the cost item’s Default Shift
Arrangements?

a. Cost Item Setup
b. Production
C. Man-Hour Factors

d. Notes

Lesson 5 Summary

As a result of this lesson, you can:
¢ Explain the Cost Breakdown Structure and its purpose
¢ Create cost items
¢ Add costs and production

e Manage cost item details
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ESTIMATE

LESSON 6 — INDIRECT COSTS

Lesson Duration: 45 Minutes

Lesson Objectives

After completing this lesson, you will be able to:
e Explain how indirect costs are defined in InEight Estimate
e Estimate default indirect cost items

e Estimate user-defined indirect cost items

Lesson Topics

InEight Inc. | Release 24.7
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6.1 INDIRECT COSTS OVERVIEW

Indirect costs such as the cost of prime bond, mobilization, or site supplies are typically overhead costs
that are not directly associated with a particular project deliverable but contribute to the total cost of
the project. However, indirect costs can be assigned to a pay items. This gives you the flexibility to
more accurately control the cost basis of bid items and strategically price the work to maximize cost
recovery and profit.

Once your direct costs are defined, you can add indirect project costs. Estimate provides two ways you
can create indirect costs:

1. Default Indirect Cost Items: These are pre-built cost items created by InEight Estimate, located
at the top of the CBS Register.

CBS )
Position = Description
Code
= JOB
Prime Bond
Price % Add-On
Job Financing
Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On
Job Management & Equip...
+ General Expense
Direct Cost Add-On

2. User-Defined Indirect Cost Items: Any cost item you create in the CBS Register that is not
assigned to a pay item is considered indirect cost.

= 23 Job Overhead - Indirect ...

Fey -
e —

s Utilities
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TIP The Cost Breakdown Structure (CBS) located in the Library under the Estimate tab,
Master Breakdown Structures section, controls which of the default indirect cost
items to copy into new job folders.

6.1.1 Navigation to Indirect Costs

From the Estimate tab of the InEight Estimate landing page, you can quickly access indirect costs from
the Indirect Cost section.

Estimate Quote Price Execution System
ﬁ '_= Account Code Utilization a ResourceRates - m - Oad Job Finance
& Wark Breakdown Structures E; Resource Utilization oo % Price % Add On
Cost Breakdown - Workbook Schedule  Cash Flow Indirect P
Structure (CBS) &= Resource Cost Details - - Cost Items E] Prime Bond 3
Breakdown Structures Resources Workbook Schedule Indirect Cost

¢ Select Indirect Cost Items to open the Cost Breakdown Structure Register filtered to only your
indirect costs

¢ You can select Prime Bond, Price % Add On, and Job Financing to access those indirects

The following section takes a closer look at the default indirect cost items.

6.2 DEFAULT INDIRECT COST ITEMS

InEight Estimate contains various default cost items to help you calculate your indirect costs.

6.2.1 Independent Indirect Cost Items

Independent indirect cost items function very much like the direct cost items you defined previously:
e Job Management & Equipment

¢ General Expense

6.2.1.1 Job Management & Equipment

The sample Job Management & Equipment Record below shows that you can add resources and
production just like in your direct cost items. Supervisory staff resources were added, and the
production duration is set to 100 days.
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Cost Breakdown Structure (CBS) Register Cost Item Record  © -
CBS Code: Optional Code:  Description: Forecast {T/0) Qty:  Unit of Measure: Unit Cost: Total Cost: Currency:
= 108 MANAGEME| [fob Management & Equipment 1 1.00| | Lump Sum - $157,096.28 $157,096.28 | | U.S. Dollar
PIAssignment:  PILine Number:  PI Description: Cost Segment: Pay Quantity: Cost Source: Alternate:
Job Overhead 100 | Detail - | | Base -
CostItem Summary | S, Detsil : $157,096.28 | % Plug: $0.00 | (D Quote:$0.00 | Allocation Production X
Erag cobns here o 1 i S views: Fatored %
Duration Driven
= i Duration Driven Resources Resources
Row . Es Description Quantity Unit of T Work Pay Waste % Quantity Prody
Number Measure Hours Hours Add-on (Less Waste) Factd
1 Customize Displa (x1.0000)
2 LSSEC  Secretary 100 Each $20.41 80000 800.00 v T 1000
3 LSPE Project Engineer 100 Each $5L03  800.00  800.00
Hours: 800.00 800.0
4 ETST Service Truck 100 Each $50.60  800.00  800.00
Man-Hours:| 2,400.00 2,4000
5 ETPU Pidkup 200 Each §15.90  1,600.00  1,600.00
Equip-Hours:| 2,400.00 2,400.0
*
P E—Ti

The following Step by Step walks you through defining resources and costs for your Job Management &
Equipment indirect cost item.

Step by Step — Add job management & equipment costs

In your job, from the Estimate landing page, select the Cost Breakdown Structure (CBS).
Double-click on the row header of the Job Management & Equipment indirect cost item.
Add resources by clicking in the Code column and selecting the Icon.

Select the Production tab.

Enter a production value.

L

Click OK to close the record.

¢ For this example, we'll add the following resources and production:

Resource Quantity
LSSEC Secretary 1
LSSUPT Project Superintendent 1

Cost Item Production Value (in Days)

70
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Step by Step — Add general expense costs

1. From the Estimate tab, select the Cost Breakdown Structure (CBS).
2. Right-click the row header of the General Expense row header and select Open.

¢ You could add existing resources here, but in this case, you will create an ad hoc resource.

3. In the first blank row, enter a description, quantity and unit of measure.
4. Click on (highlight) that row, and then click the Resource Employment Breakdown tab.
5. Type a numeric value in the Undefined Supplies cost category.
6. Click Ok to close the record.
e For this example, we’ll add General Office Supplies, 1 Lump Sum, $1,000 in the Supplies
category.
= [GENERA BPE | [Genersl Bpense 106 [ Lump Sum . $1,000.00 $1,000.00 [ U.5. Dolar
Pl Assignment: Pl Lime Number: P Description: Cost Segment: Pay Quantity: Cost Sowrce: Alternate:
Job Crverhead - 1.00 | Detad = | BASE
CostItem Summary | S, Detad : $1,000.00 | & Plug: $0.00 | {2 Quote: $0.00 | Alocation Ressurce Employment Breakdown
Saved views: | Previous Vie -] JO|| Cost Category Scale 1
= - » Tol $1,000.00
A L I L~ P -~ S A (M o
> | General Office Supp... L.od 0.0 L0 LumpSem - »  Owned Equipment £0.00

»  Rented Equipment £0.00

6.2.2 Dependent Indirect Cost Items
The other default indirect cost items are dependent indirect cost items, meaning their costs depend
on other costs, prices or hours. They include:

¢ Direct and Indirect Cost Add-On

Direct and Indirect Cost Escalation

Prime Bond

Price % Add-On

Job Financing
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¢ Man-Hour Add-On

Actions

uspended él!, Link Field Cost Item

Unlink Field Subordinate Cost Item

I H Dependent Cost Item

Workbook

It’s possible to assign any assigned or dependent cost Item to any of the 3 cost segments and provides
greater control over where costs exist in the Price Breakdown Structure (PBS).

Cost Breakdown Structure {CBS) Register ©  Pay Ibem & Proposal Register

) GrOUD

CES Cost Pay Tham Pay e |

Position Code = Descripton Sagment Assigrment Pasition Code I
-] 108
, T - - ]
Price % Add-On M Desaription
Job Financing Business Overhead
Indirect Cost Escalation EEN
Direct Cost Escalation Job Orverhead
Indirect Cost Add-On
Mobilization
=1 SITEWORK & ROADWAY
+ 11 Mobilizaticn "
+ 12 Clearing & Grubbing Dt Uomt AT 12
= L3 Undassified Excavation Direct Cost 2020183 1.3
+ 131 Excavation Direct Cost 2020183 1.3

6.2.2.2 Default Dependent Cost Item Deletion

a2 If you need to use additional dependent cost items, you can create your own, but you
must delete all the existing default dependent cost items first.

The following steps walk you through deleting your existing default indirect costs so you can create
your own.
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Step by Step — Delete existing default dependent cost items

1.
2.
3.
4.
5.

From the Estimate tab, select Cost Breakdown Structure (CBS).

Select an Indirect Cost Item by clicking on its row header.

Press and hold the Ctrl or Shift key to select multiple indirect cost items.
Right-click on the selection and select Delete.

Select Yes to confirm you want to delete the selected cost items.

6.2.2.3 Prime Bond

The following steps walk you through adding and defining your prime bond for the job.

Step by Step — Define prime bond

1.
2.
3.
4.
5.
6.
7.

From the Estimate tab, select Cost Breakdown Structure (CBS).

Right-click on the row header for any cost item and insert Dependent cost Item.

On the resulting Attention prompt, select Based on Bond Table.

Click OK.

Right-click on the Prime Bond row header and select Open.

Use the Table Name drop-down to choose a table (e.g., Example: General Construction).

Click OK to close the record.

Multiple bond rate dependent items

For certain projects, it may be desirable to calculate costs for bond or insurance premiums based upon
multiple different rate tables. It is now possible to add multiple bond/rate table based dependent
items in the CBS.

For example, in addition to having a prime bond, the job may also require insurance coverage where
the premium is calculated using a rate table-based approach. This can now be accomplished by adding
another Bond/Rate-table based dependent cost item to the job.
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Cost Beeskiown Structure ((B5) Register O

:hm - S 3:'- r’“a.l:'f-:q..-r.-, f-:‘rr urat it E?:f:; Hated Lurreny ;:::m devvini]
g ol Moo M STEIAL 45551300 54 . U5, Dok 548239

Frime Bond R BD 100 Lump Surm $42,305.50 $42,%05.5 U5, Eoker

[Tes— LR 100 Lusp s P T L R T T U5, Bl

Jab Fanancing FIHANCE EeE L0 Lusp S fr 1A R ] 0,8 13 U, Dol

Indirect Cost Eacalation POTECT COST FSCALATION L0 Luep S £ £3,13L11 WS, Bolar

Direct {osk Euraliaticn DERECT COBT ERCALATION 100 Lusp Sum FL5 080 5,080 Us, Colar

Ancirect Cost Add-On L0 Lump Sum ALY gL WS, Colar

Dérech Cost Add-0m RRICT 0T ADD-ON 100 g Furm FEOAEH O 45, Colar
B SITDWORX & ROAIWAY o L0 Each ALY AL U5, Coler L1833
+ L1 Wobkizaton LR L0 g Sm FLLA. 5L LR U5, Colar 1
+ L2 Diearig & Grubbng ET B e AT ] M, 18497 U5, Colar e
8 L3 Urciansted v st ET SO0 b Vard WE RILHISAT U5, Colar BLET

Deleting Bond Tables

Delete bond tables that are not applicable to your estimate by selecting them and then clicking the
Delete button. You can customize the Bond Table window to only view the tables that are relevant to
your estimate from the Table Name drop-down list.

Baond Table *
Identification
Table Name: | EXAMPLE: GENERAL CONSTRUCTION [ Edit Mame Delkete
%, Table Name
Last Maintenance:
EXAMPLE: EARTHWORK
sond Bt Loyers |
From EXAMPLE: PAVING $1,000
- ENAMPLE: PIPE 10.80000 =
EXAMPLE: UNDERGROUMD UTILITIES 2.30000
R
e Bond Required 7.
5,00000
-
R J AR Oy 4, 80000
$20,000,000.01 §40,000,000.00 3, 50000
£40,000,000.01 £80,000,000.00 300000 w

o Bond Table [ CostitemSenp  [F) notes o= Scheduls

6.2.2.4 Price % Add-On

The following steps walk you through defining the Price % Add-On.
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Step by Step — Define a price % add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Job’s Price.

2y Attention
Choose what type of Dependent Cost Item to add:
(@) Based onJob's Price

(") Based on Job's Finance Cost
Based onBond Table

{(C) Based on Direct Costs

{C) Based on Indirect Costs

(C) Based on CBSMan Hours

D Based on CBS Equipment Hours

{_) Based on Resource Utilization

{_) Based on Assembly Utilization

Conce

3. Click OK.

4. Double-click on the Price % Add On row header to open the record.
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Eggt'on Code = EeConce gs;ljennal fI
= JOB
Job Management & Equipment JOB MANAGEMENT &E...
General Expense GEMERAL EXPEMSE
Prime Bond PRIME BOND

Price % Add-On

PRICE % ADD-ON
1000

E‘

5. The Price % Add-on Record opens to the Description tab. Type a description in the Description
field and enter a numeric value for rate.

Cost Breakdown Structure (CBS) Register Price % Add-0On Record ©

CBS Code: Description:
Price % Add-0n

Description Dependency

Drag columns here to group

Account
Code

Description Rate

Pl Office Overhead

6. Click OK to close the record.

. For this example, we’ll enter a description of Office Overhead and a rate of 4%.

6.2.2.5 Direct Cost Add-On

The following steps walk you through creating a Direct Cost Add-On dependent cost item.

Step by Step — Define a direct cost add-on

1. From the Cost Breakdown Structure (CBS) Register, right-click on the row header for any cost
item and select Insert Dependent Cost Item.

2. On the resulting Attention prompt, select Based on Direct Costs.
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3. Click OK.
4. Double-click on the Direct Cost Add-On row header.

5. On the Description tab, type a description in the Description column.

Cost Breakdown Structure (CBS) Register Direct Cost Add-On Record ©

CBS Position Code:  Description:

|Direct CostAdd-On

Description | Dependency | Cost Categorization Allocation

Total Cost i

Description / Curre... (Forecast) y

& ESmaIITu:u:uIs &

6. Press the Tab key (you can define additional rows for other add-on costs as needed).
7. Click on the Dependency tab to see what contributes to your subject cost.

8. For this activity, leave the default (lower) button selected.

Toggle Include Al (O Define the Subject Cost by viewing all available items and clicking the Include box for the desired items

(Affects displayeditems only) | ® Define the Subject Cost using column filtering (all current and future items that match the filter will be included automatically)

9. On the Cost Breakdown tab on the right, add an add-on rate (percentage) or cost at any of the
cost category levels you need.

e This updates the Total Cost (Forecast) of your item on the Description tab
10. Click OK to close the record.

* For this example, we’ll create a new Direct Cost Add-On, giving it a description of Small
Tools with a rate of 10% on the Labor cost category
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CBS Pasition Code: Description: Total Cost: Currency: Alternate:
[Direct Costadd-on ' U.5. Dolar - | [Base -
PIAssignment:  PILine Number: PIDescription: Cost Segment: Pay Quantity:
| | homhest -
Description | Dependency | CostCategorization | Allocation Cost Breakdown ®
Saved views: | Standard Vie - Cost Catagory g‘:;{‘“ Rate Cost
Description Currency Total Cost (Forecast) v Total £99,107.22 575 £5,701.35
7,013, .00 L
#  Small Tooks U.5. Dolar $5,701.36 »  Labor §57,013.62 10. $5,701.36
»  Owned Equipment $38,555.52 0.00 §0.00
» Rented Equipment £0.00 0.00 £0.00
¥ Supphes £0.00 0.00 £0.00
»  Materials §3,276.00 0.00 50.00
»  Subcomiract $0.00 0,00 £0.00
» Fees $262.08 0.00 50.00
»  Alowance £0.00 0,00 20,00
Custom Category 1 £0.00 0,00 £0.00
Undefined 50,00 0.00 50.00

6.2.2.6 Repositioning Dependent Cost Items

Repositioning dependent cost items creates a simpler way to manage the hierarchy of your project by
placing items of more importance ahead of other line items.

Since dependent cost items can now be repositioned, a Position Code field has been added with the
functionality similar to column remaining the same. The below listed dependent cost item fields are
now exposed in the CBS register so you can more easily see the various percentages used in dependent
items.

e Subject Cost

* Subject Cost Rate

e Subject Billing Amount
e Subject Billing Rate

These columns can also be found in the new saved view Bid Review.
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CBS N 5 -
Position Code = escription
= J0OB

Prime Bond

Price % Add-On

Job Financing

Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On

+ Job Management & Equipment
+ General Expense
Direct Cost Add-On

+ 1 HMobilization
+ 24.1.2 Day Two

25 Prime Bond

26 Price % Add-On

27 Job Financing

28 Indirect Cost Escalation

29 Direct Cost Escalation

30 Indirect Cost Add-On
+ 31 Job Management & Equipment
+ 32 General Expense

33 Direct Cost Add-On

6.3 User-Defined Indirect Cost Items

Optional
Code

PRIME BOMD

PRICE % ADD-OM

FIMAMCE EXPENSE

INDIRECT COST ESCALATION
DIRECT COST ESCALATION
INDIRECT COST ADD-0OM

JOB MAMAGEMENT & EQUIPMENT
GEMERAL EXPENSE

DIRECT COST ADD-OM

6410100

PRIME BOMD

PRICE % ADD-OM

FIMAMCE EXPENSE

INDIRECT COST ESCALATION
DIRECT COST ESCALATION
INDIRECT COST ADD-OM

JOB MAMAGEMENT & EQUIPMENT
GEMERAL EXPENSE

DIRECT COST ADD-0M

6.3 USER-DEFINED INDIRECT COST ITEMS

You may prefer to create your own indirect cost items. You create user-defined indirect cost items the

same way you create direct cost items. The only difference is that your indirect cost items will not be

assigned to pay items. One advantage of creating your own indirect cost items is the ability to create a

parent-child structure for your indirect costs.

Here is an example of user-defined indirect cost items, expanded to show their employed resources:
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Eggﬁu:un Code = Tl 'E'I?;S;lgﬁanﬁty rI:I"II;i.:sDLTrE R Fu:turanlaé:ausstg
B 5 Indirect Cost 1.00  Each 5$10,584. 36 $10,584.36
- Head Office 1.00  Each 5370.32 5370.32
 mewion  camy TP o 2
= 1 Head Office Project ... 1.00  Each 8.00 3.00 £45.29 £370.32
- 52 Field Office 1.00 Each £1,775.04 $1,775.04
Comemion w2
/% 1 Field Office Clerk 1.00 | Each 4,00 4.00 533.00 5152.00
i 2 Field Office Safety M... 1.00 | Each 800 &.00 562,38 5499.04
3  Field Office Site Supe... 1.00 | Each 15,00  16.00 570,25 51,124.00
- 33 Site Fadlities 1.00  Each 5905.00 5905.00
 eion ey TP o O
= 1 Field Office Telephone 0.50  Month £250.00 £125.00
2 | Field Office Trailer 1.00  Each 0.00  0.00 £5.94 £0.00
3 | Pick Up Truck 1.00  Each 30.00 80.00 £9.75 £730.00
+ 5.4 Misc. Expenses 1.00 Each £2,755.00 £2,755.00
+ 5.5 Supervision 1.00 Each £4,769.00 £4,759.00

Step by Step — Add user-defined indirect cost items

Let’s walk through a specific scenario for this step by step.

[y

At the bottom of your CBS, create an indirect cost item called Job Overhead with a Forecast
(T/0) Quantity of 1 and Unit of Measure of Each.

2. Add two subordinates under the new cost item named Job Trailer and Utilities. Job Trailer is 1
Each but change Utilities to 1 Lump Sum.

3. Open the Job Trailer cost item by double-clicking on the row header.

¢ Assuming there is no Job Trailer in our Resource Rate Register, you will create this
resource “on the fly”.

4. In the Detail grid, click on the Resource Register icon in the Code field as if you were going to
select from the Resource Rate Register.

5. On the Resource Rate Register, click the Rented Construction Equipment tab.
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®©® N O

9. Click OK to close the Resource Rate Record.

6.4 Cost Allocation

Right-click on one of the Line Items and select New to add a new resource.
Enter a Resource Code of RIT and description of Job Trailer.

In the Amount column enter 25 for the Rented Equipment category.

10. Select the new resource you created, then click OK to return to the cost item record.

11. On the cost item record, adjust the Job Trailer quantity to 2.

12. On the Production tab, enter 70 days.

13. Click OK to close the record.

14. On the CBS register, select the Utilities cost item by double-clicking on the row header.

15. Create an ad hoc resource on this cost item called Electricity, which will be 1 Lump Sum.

16. Finally, go to the Resource Employment Breakdown tab and enter 1500 in the Custom Categoryl

row.

17. Click OK to close the record.

=3 Job Overhead
= 31 Job Traier
Row Resource
MNumber — Code Assembly Description
- 1 RIT Job Trailer
- 32 Utiiies
Row Resource e
MNumber — 2iis Assembly Description
- 1 Electricty

6.4 COST ALLOCATION

1.00 Each $31,740.00 £31,740.00

1.00 Each $30,240.00 £30,240.00
Quantity Waste % : Unitof  Work Pay . Total Cost
(Less Waste) Add-on SRy Measure Hours Hours L (Forecast)
2.00 Each 1. | 1,1. §27.00 $30,240...

1.00 | Lump Sum $1,500.00 $1,500.00
Quantity Waste % . Unit of Work Pay - Total Cost
(Less Waste) Add-on L Measure Hours Hours L e (Forecast)

1.00 0.00 1.00 Lump .. $1,500 00.00

The Cost Item Record - Allocation tab lets you to spread costs from a single Cost Item Record to one or
more other cost items in the Cost Breakdown Structure (CBS) Register.

» Allocation Item - The cost item to be allocated, where you define the quantities, resource
employments and the logic that determines how to allocate the item throughout the bid.

» Allocation Target - A cost item to be the recipient of allocated cost, as defined within the
Allocation Item. There may be one or many Allocation Targets for one Allocation Item.
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« Distribution - A read-only cost item in the CBS representing an Allocation Target's
proportional share of the Allocation ltem.

You can choose from several methods to determine specifically where and how much cost to spread:

» Quantity - Specify the amount of the Allocation ltem to be spread to each Allocation
Target.

» Proportionately based on another field - Allocate proportionately by one of many
available cost item values, usually based on time or cost.

» Percentage - Specify the percentage of the Allocation ltem to spread to each Allocation
Target.

» Unit Cost - Use the unit cost from the Allocation Item and the quantity of each Allocation
Target to drive the Forecast (T/O) Quantity of the Allocation Item.

Cost Item Allocation is a good means of spreading costs throughout a bid for the purpose of
determining appropriate bid prices.

(\e3 = Only Level 1 cost items can be allocated, including Add-On and Escalation dependent cost
items. A subordinate cost item cannot be allocated, and a cost item that is assigned to a
pay item cannot be allocated.

6.4.1 Cost Allocation

With Cost Item Allocation, you can track the cost of one broad cost item by distributing the cost of that
item to other cost items, so that the cost can be tracked on a more detailed level. This gives better
visibility into the cost that makes up an item. For example, you can spread ST&S from one cost item to
multiple cost items that will use ST&S.

Imagine that a large portion of your scope of work for the job you are bidding has concrete. You face
the options of batching your own raw materials or purchasing the materials from a supplier. You can
use cost allocation to create the cost of a batch plant and allocate it to different items, and then
compare this unit cost to the unit cost of purchasing the materials from a supplier.

The Allocation tab allows you to spread costs from an Allocation Item to one or more Allocation Target

(s).

[\[e]p= In the Allocation Target list, the [Unit of Measure] Quantity column caption displays the
Unit of Measure of the Allocation Item. For instance, if the Allocation Item's Unit of

Measure is Cubic Yards (CY), then the caption displayed for this column is CY Quantity.

A Distribution cost item is created as a read-only subordinate cost item under each Allocation Target. It
is copied proportionally with the quantity/cost defined to each different item in CBS.
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6.4.2 View Filter Excludes Cost Item Allocation Details

A View Filter option is added to show only the level 1 cost item distribution in the allocation
destinations to provide you with a clear and comprehensive view of the CBS register, especially when
there are many allocations. When you are allocating cost items, the allocations are created in the
destination cost item by creating a copy of the entire allocated cost items structure. This filter allows
you to simplify the view by displaying only the parent level allocation cost item.

Eh print [Aooen  $<cut il Down T}, Toogle Suspended | £ Link Field CostItem Assembly o Resource ¥ E 85 Tree Filter Mode:
R Preview @ Nen  Bhcopy [ soiit Indent Unink Field | 2 Subordinate CostItem | T Subordinate Assembly | 2 Resource Assembly ” 4 » Navigation
N Expand/ | Fiter  Clear | CBSTice
@ exporttoExcel | @@ Delete [ Paste &2 Spiitby Cost Type Outdent Dependent Cost Ttem Colapse = | = Filter Filter Epandics pree
Print Edit Workbook Insert ¥ Filterto CES Level
Job Properties. Cost Breakdown Structure (CBS) Register W Fiterto Tenminal Cost hems
Drag columns here to group Y Filter to Direct Cost Items.
Forecast ¥ Filter to Indirect Cost Items L WBS: CEAS
s o Optional Unitof Total Cost Hours > fubject Cost
Posion Code = | DesTpton Code o Measre | UnitCost (Forecast) R (Duration riven) | o rate (cvi Engn
Quantity S Filter by Cost Source Plug System) De
= 08 2000 M $3,996,575.15  §79,931,503.08 ] U.S. Dolk 527,454.2
e oler W Filter by Cost Source Quote
Prime Bond PRIVE BOND 100  Lump Sum $312,587.53  $312,557.53 U.5. Dolar BOND
¥ Filter by Cost S Detail
H y Cost Source Detai
Price % Add-0n PRICE % ADD-ON 100 lumpSum  $3,785,175.55  $3,785,175.55 U.s. Dolar TaXES
-
Job Financing FINANCE EXPENSE 100 | Lump Sum $974798.06  §974,798.06 U.s. Dolar ¥ Filter to Schedule Relations FEES
Indirect Cost Escalation INDIRECT COST ESCALAT. 1.00 | Lump Sum $2,131.11 $2,13111 U.S. Dolar ¥ Filter by Resource LABOR INC
Direct Cost Escalation DIRECT COST ESCALATION 100  Lump Sum $637,106.87  $687,306.57 U.S. Dolar W Fiter by Resource Acsembly LABOR INC
Indirect Cost Add-On 100  Lump Sum 446,251.25 $96,251.26 U.S. Dolar - 2.00 LABOR SET
¥ Filter by Resource Account
Direct Cost Add-On DIRECT COST ADD-ON 100 LumpSum  $1,449,050.93  §1,449,952.93 U.S. Dolar 2.00 LABOR SET
4
=1 SITEWORK & ROADWAY 200 100 | Each 68,690,789, §68,690,780.87 U.S. Dolar sm,4e2.3 »  Filter by Resource Type PAVEMENT
+ 12 Clearing & Grubbing 2010102 10,00 Age $3,918.50 $33,184.97 U.S. Dolar 80.00 W Filter by Unique (Delta) Cost ltems CLEARING
=
13 Undassified Excavation 020183 50,000.00  Cuble Yard 468 §233,915.81 U.5. Dolar 216/ W iter Cost hemswith Excel Links COMMON £
+ 131 Excavation 134 50,0000 Cuble Yard 5300 $149,522.88 U.5. Dolar 125. COMMON £
I Y Filter Allocation Distributions Subordinates I
+ 132 Embankment 132 50,000.00  Cubic Yard s168 $83,992.94 U.s. Dolar 166.6) EMBANKME
2 4
B 14 Augregate Base 035312 45,000.00  Ton $1,487.10  $66,919,557.30 U.s. Dolar 5195540 »  Filter Resources with Waste Percentsge UNTREATE
+ 141 Furnish & Heul Base Material | 1.4.1 45,000.00  Ton $1154  $519,513.30 U.S. Dolar 360.00 12.20.080 BUY MATEF
+ 142 Finegrade Subgrade 142 400,000.00 | Square Yard 10000 $40,000,000.00 U.S. Dolar 168,757.77 11.70.300 FINEGRADI

«

({15 Allocation Distribution Subordinate] EQUAL False)

Step by Step — Cost Allocation

From the Ribbon, select the Estimate tab.

2. Under the Breakdown Structures section, select Cost Breakdown Structure (CBS). The
Cost Breakdown Structure Register opens.

3. Select the Concrete Batch Plant cost item.

= 8 Project Indirect Costs 1,00  Lump Sum
LR Crane Service 30,00  Day

+ 9.1 Buy Raw Materials 1,000,00 C¥

+ 9.2 Batch/Mix /Haul Concrete 18,00  Day

= 10 Eguipment Related Indirects 1.00 Each

+ 10.1 Maintenence 1.00 Each

n
-1
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4. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Item Record opens.

5. Select the Allocation tab.
6. Check the box for Allocate this Item’s Cost. Keep the By Quantity option selected.

Allocate this Item's Cost

Allocation distributions inherit target Pay Item Assignment
How do you want to determine allocation percentages?
(® by Quantity
(O proportionately based on
() by Percentage

() by Unit Cost (drives the Allocation Item's Forecast (T/0) Quantity)

7. Check the Include box for the cost item Box Culvert Footing to allocate cost to it.

goB:non Code = Desciption Indude H:i;::re ?;ggzsﬁentiw

1 Roadway Excavation cy 344,820.24
11 Short Haul Excavation CY 74,083.28
12 Medium Haul Excavation cY 109,740.72
13 Long Haul Excavation cY 160,196.24
2 Structural Concrete (Class S) (FC=3,... CY 229.87

Box Culvert Footing
211 Erect & Strip Footer SFCA 597.00

Take note of the Allocation Percentage and Total Cost to be Allocated columns.
This shows the percent of the total allocation gty allocated to that cost item and
the total cost to be allocated to that item (notice that is the total cost of the
Concrete Batch Plant).
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- 3 3
CBS = Description Uit o Forecast cY Allocation Percent o Total Cost to

Position Code = Indude Measure | (T/0) Quantity Quantity Parcentage: Total Cost be Allocated
1 oY 344,820.24 0.00 0.00 0.00 $0.00
H oY 74,8328 0.00 0.00 0.00 $0.00
H oY 109,740,72 0.00 0.00 0.00 0,00
| =1 160,105.24 0.00 0.00 0.00 $0.00
| oy £0.00
______ 595.5

] SFCA 597,00 0.00 0.00 0.00 £0.00

8. The Box Culvert Footing item just gained all of the Concrete Batch Plant’s distribution
cost items (highlighted in purple). Navigate back to the CBS Register.

Drag columns here to group

c8s . Uit of Forecast o
Position Code —  Descption IS Measure (T/0) Quantity Quantity Percentage

160,196.24 0.00
229.87 0.00
- 52.84 52.84

0.00

9. Find the Box Culvert Footing cost item. The distribution cost items are added as its
subordinates.
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- Forecast
Position Code s (T/0) Quantity
1.00

'

E—mamrm

10. Inthe Cost Item Record, check the Include box for the cost items, Box Culvert Walls and
Box Culvert Deck.

11. In the Account Code column, click on the Filter icon. Filter to account code 13 for all of the
concrete items. Once done, click OK.
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Account
Code Alternate Desaric

(Custom)
(Blanks)

(Non blanks)
| 11.22.100

11.22,200
11.22.300
V| 13
13.2.1
13.3.2
| 13.3.3
13.3.4
13.8.1
| 13.8.2

‘ CK 'Earu:el
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12. Select the Erect and Strip Deck code, hold <Shift>, and select the Footer code to muli-
select all of the codes in between. Then, tight click and select Toggle Included.

13. Check the Include box in the Include column for the cost item Column, round. The CY
Quantity is now highlighted yellow. This is because this cost item’s UoM is Each and not
CY.

PCoszan Code ATl Include 31:;30;& ?E)faqs:antw g:annt\a

4.2.4 East Wing Wall v CY 4,22 4,22
425 West Wing Wal v cY 4,93 4.93
4.3.1 Footer b 41.67 41.67
4.3.3 Pier cap I} CY 18.67 0.00
4.4.1 Footer cY 41.67 0.00
4.4.2 Column, round Each 3.00 0.00

14. Right click on the Account Code column, and select Clear Filter from the context menu.

15. Under the cost item Column, round, the subordinate cost item Place Column Concrete
has a UoM of CY. Manually enter that cost item’s Forecast (T/O) Quantity into the Column,

round’s CY Quantity field.
IEGE;:mn Code Peacpian Include E\I;I:::JFI'E E'?_:S;'S:aﬂﬂw \'.{.uar: ity
Pl 432 Column, round Each

43.2.1 Erect & Strip column forms SFCA 508.94 0.00
4.3.2.2 Install embeds EA 9.0 0.00
4.3.2.3 Place Column Concrete oy 0.00
43.2.4 Rub &Patch SF 508.94 0.00
433 Pier cap oY 18.67 0.00

16. Select the Account Code filter and reselect the option 13.

17. Inthe Include column, check the Include box for all of the remaining cost items with this
filter. Then, remove the Account Code filter.

Ec?ssiton Code pesapion Include ﬁ:;i;f:re
4,2,5 West Wing Wall o CY
43.1 Footer v cY
4.3.2 Column, round o Each
4.3.3 Fier cap v (=4
4.4.1 Footer ol cY
4.4.2 Column, round " Each
4.4.3 Pier cap v cy

6 Drilled Shaft Foundation (60") (Structure # 2929 - Drilled Shaft Foundation) o LF

18. Fix the CY quantity for the other Column, round cost item.

Page 298 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide

Igg;\ion e Description Indude
44.1.3.1 Buy Raw Materials

4.4.1.3.2 | Batch/MixjHaul Concrete

4.4.2 Column, round ;
4.4.2,1 Erect & Strip column forms

4.4.2,2 Install embeds

Place Column Conorete

4424 Rub &Patch

4.4.3 Pler cap \.f
44.3.1 Erect & Strip Pier

4.4,3.2 Erect & Strip Bulkheads

4.4.3.3 Install embeds

Unit of
Measure

Day

6.4 Cost Allocation

Forecast cY
(T/0) Quantity Quantity

41.67 0.00
0.75 0.00
3.00

508.54
9.00

508.94 0.00
18.67 18.67
382.50 0.00
28.00 0.00
6.00 0.00

19. Fix the CY quantity for the Drilled Shaft Foundation (60”) cost item.

IEoB: tion Code Description Indude
5 Reinforcing Steel (Structure #2929)

5.1 Reinfordng Steel

6 Drilled Shaft Foundation (60™) (Structure # 2929 - Drilled Shaft Foundation) v
6.1 Buy Reinforcing Steel

6.2 Dril Abutment Shafts

6.3 Erect Rebar Cage

6.4 Place Rebar Cage

7 Drilled Shaft Foundation (72") (Structure # 2929 - Drilled Shaft Foundation) v
il Buy Reinforcing Steel

Unit of
Measure

Forecast cyY

(T/O) Quantity Quantity
175,235.00 0.00
175,235.00 0.00

306.00
47,482.52

300.00 0.00
58,189.36 0.00

20. 20. Fix the CY quantity for the Drilled Shaft Foundation (72”) cost item.

CBS

Position Code DeCpon

6.5 Pour Concrete

7 Drilled Shaft Foundation (72°) (Structure # 2929 - Drilled Shaft Foundation)
7.1 Buy Reinforcing Steel

7.2 Drill Abutment Shafts

7.3 Erect Rebar Cage

Place Rebar Cage

7.4
8 Project Indirect Costs

Include

Unit of
Measure

cY

Forecast oY
(T/0) Quantity Quantity

222,53 0.00
300.00

1.00 0.00

21. Notice in the Allocation Details section, that we have over-allocated this cost item. The
Concrete Batch Plant quantity is 1,000 CY, whereas we have allocated 1,172.59 CY.
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Allocation Details

To Be Allocated

$81,895.53 +11,000.00 CYJ= $81.90/CY

Current Allocation

$81,895.53 +1,172.59 CY}= $69.84/CY

Over-Allocation of 172.5939369 CY

6.4.3 Cost Allocation to By Unit Cost

Having an under allocation or over allocation is ok, but it can be fixed by updating the Forecast (T/O)
Quantity of the Concrete Batch Plant. To do this, change the cost allocation to by Unit Cost.

How do you want to determine allocation percentages?
(O) by Quantity

(O proportionately based on

(") by Percentage

@by Unit Cost (drives the Allocation Item’s Forecast (T/O) Quantity)

Step by Step — Cost Allocation by Unit Cost

1. Change the cost allocation to by Unit Cost. When the Attention dialog box appears, click
Yes to continue.

2. Now the Allocation Details warning states the quantities are fully allocated.
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Allocation Details

To Be Allocated

$96,030.20 + 1,172.59 CY = $81.90/CY

Current Allocation

$96,030.20 + 1,172.59 CY = $81.90/CY

Quantities Fully Allocated

6.4 Cost Allocation

3. Notice also that the Forecast (T/O) Quantity of the Concrete Batch Plant has updated to
1,172.59 CY to match the allocated quantity, and the Total Cost has updated to
$96,030.20 to keep the unit cost at the original $81.90/CY.

Forecast (T/O) Qty:  Unit of Measure: Unit Cost:
1,172.59] CY - £81.90
Cost Segment: Pay Quantity:
Job Overhead - 1,172.59

Total Cost:

$96,030.20

Cost Source:

Detail

4. Return to the CBS Register. The distributed cost items all have a unit cost of $81.90.

CBS Forecast

Pasition Code (T/0) Quantity
= JOB

=1 Roadway Excavation

+ 1.1 Short Haul Excavation

+ 12 Medium Haul Excavation

+ L3 Long Haul Excavation

= 2 Structural Concrete (Class 5) (FC=3,00...
= 21 Box Culvert Footing

+ 211 Erect & Strip Footer

+ 2.1.2 Place Footer Concrete

B 213 Concrete Batch Plant

+ 2131 Buy Raw Materials

1.00
344,820.24
74,883.28
108,740.72
160,196.24
229.87
52.84
537.00
52.84

Unit of
Measure

Lump Sum
CcY

[w

cr

CY

cY

[

SFCA

cr

5284 CY
5284 CY

Unit Cost

$1,121,620...
$1.55

$0.58

$0.81

§2,52
§377.25
$209.15
$10.26
$11.37

£35.62

Total Cost
(Forecast)

$1,121,620.97
$535,419.74
$43,695.89
$88,620.58
$403,103.26
$86,719.63
$11,051.67
$6,123.68
$600.65
$4,327.33
$1,882.06

5. The original “Concrete Batch Plant” cost item has a total cost of $96,030.20.
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30.00  Day §1,871.89 £56,156.73 LS. Dollar
+ 9.1 Buy Raw Materials 117259 cf -
+ 9.2 Batch/MixfHaul Concrete 2111 Day $2,570.96  $54,264.46 L.S. Dolar

6. Navigate to the CBS Register. Double click the Project Indirect Costs cost item to open it.
7. Select the Allocation tab. Check the box for Allocate this Item’s Cost.

@!\Ilncate this Item's Cost

Allocation distributions inherit target Pay Item Assignment
How do you want to determine allocation percentages?
(@) by Quantity
() proportionately based on

() by Percentage

() by Unit Cost (drives the Allocation Item's Forecast (T/0Q) Quantity)

8. Select the proportionately based on radio button. From the drop down, select Shifts
(Total).
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How do you want to determine allocation percentages?

() by Quantity
(@ proportionately based on | -1
(O) by Percentage Shifts (Duration driven)
Shifts (Non-Duration driven)
() by Unit Cost (drives the All

Shifts (Total)

Subcontract Total Billing Amount
Subcontract Total Cost

Supplies Total Biling Amount

CBS | Supplies Total Cost

3g columns here to group

Position Code Descriptic

9. Filter the Account Code column to 13. Once done, click OK.
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Alternate
Descripti

Account
Code Alternate

. (Custom)

' (Blanks)

| (Non blanks)

| 11.22.100

| 11.22.200

| 11.22.300
13

| 13.2.1

| 13.3.2

| 13.3.3

| 13.3.4

| 13.8.1

| 13.8.2

oK | Cancel |
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10. Select all of the cost items. Then, right click on the selected cost items and select Toggle
included. Ensure that all of the Included boxes are checked.

Esgtinn Code Lescrgtion Incude b}:;;jre
4.2.5 West Wing Wal v cY
4.3.1 Footer v CY
4,3.2 Column, round o Each
43.3 Pier cap v oY
4.4.1 Footer v Y
4,4.2 Column, round v Each
4.4.3 Pier cap v CY

& Drilled Shaft Foundation (60™) (Structure # 2929 - Drilled Shaft Foundation) v LF

7 i Drilled Shaft Foundation (72") (Structure # 2929 - Drilled Shaft Foundation) | v LF

11. Onthe CBS Register, verify that all of the items have cost items distributed proportionately
by shifts.
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. Forecast Unit of
Pasition Code or s (T/0) Quantity Measure

QEQQQ""

6.5 DEPENDENT COST ITEM ALLOCATION

Step by Step — Dependent Cost Item Allocation

1. From the CBS Register, right click on the first cost item and select Insert Dependent Cost
Item from the context menu.

2. When the Attention dialog box shows, select Based on Direct Costs. Once done, click
OK.
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2 Attention

Choose what type of Dependent Cost Item to add:
(O) Based onJob's Price

(O) Based on Job's Finance Cost
(") Based onBond Table

@Bas ed on Direct Costs

(O Based on Indirect Costs

(O Based on CBSMan Hours
O Based on CBSEquipment Hours
(O Based onResource Utilization

(O Based on Assembly Utilization

I oK I Cancel

3. Find your new cost item. Then double click to open the cost item record.

=8 Project Indirect Costs 1.00
+ 8.1 Crane Service 30.00
=9  Concrete Batch Plant 1,172.58
+ 8.1 Buy Raw Materials 1,172.59
+ 9.2 BatchMix/Haul Concrete 21.11
= 10 ' Equipment Related Indirects 1.00
+

wmose [T
Day £1,871.89
cY £81.90
cY §35.62
Day $2,570.96
Each $765,467.24

§76,467.24

Lumnp Surm

4. Inthe CBS Position Code Description, enter the description Small Tools & Supplies.

5. Enterin the cost item, “ST&S”.
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Descripon CLmency Total Cost (Forecast)

6. Inthe Cost Breakdown default data block, set the labor rate as 5%.

Cost Breakdown x
Cost Category Eﬂg{ea Rate Cost
« Total £1,003,3... 0.00 £0.00

»  Owned Equipment £545,478... 0.00 £0.00

» Rented Equipment £0.00 0.00 €0.00

7. Inthe Cost ltem Record, select the Cost Categorization tab.

8. Under the Cost Categorization Method, select the Use Custom Categorization radio
button.

Cost Seament: Job Cverhead -

Cost Categorization Method: () Use DefaultCategorization

Use Custom Categorization

9. Find the Supplies Cost Category and check the box next to Supplies.
10. Select the Allocation tab. Then, check the box for Allocate this Item’s Cost.

11. Select the proportionately based on radio button. From the drop down, select Labor Total
Cost.
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Description ‘ Dependency

Ilocatethis Item's Cost

Allocation distributions inherit target Pay Item Assignment

Cost Categorization | -/ Allocation

How do you want to determine allocation percentages?
() by Quantity

() by Percentage Forecast (T/O) Quantity
Hours (Duration driven)
by Unit Cost (drives the Allq
Hours (Mon-Duration driven)
Hours (Total)

. | Labor Total Biling Amount
Drag columns here to group

Labor Total Cost

CBS D iofi Man Count
Position Code ==

@Iprnpurtiunately based on v

12. Inthe Cost Item Record, filter the Account Code column to 13. Once you are done

selecting the filter, click OK.
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Account Alternal
Code Alternate Desarip

(Blanks)
(Mon blanks)
11.22.100
11.22.200
11.22.300
V] 13

13.2.1
13.3.2
13.3.3
13.3.4
13.8.1
13.8.2

0K Cancel

13. Inthe Cost Item Record, check the Include box in the Include column for every cost item.
14. Return to the CBS Register. The ST&S is distributed to all of the selected cost items.
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g::hm o Descripton ?E;ac;:mm H:;:je Unit Cost Ef;if;s‘; Currency

= 108 1.00  Lump Sum $1,132,483... $1,132,983.91 U.S. Dolar
] et Toos & uppes o S0k 086238 .ot
=1 Roadway Excavation 344,820.24 CY $1.55 $535,419.74  U.5. Dollar
+ 11 Short Haul Excavation 74,883.28 CY $0.58 §432,695.89  U.S. Dollar
4o i3 Medium Haul Excavation 109,740.72 CY $0.81  $33,620.58 U.5.Dollar
+ 13 Long Haul Excavation 160,196.24 CY $2.52  $403,103.25 U.S.Dollar
22 Structural Concrete (Class S) (FC=3,00... 225,87 Cf $420.05  498,628.03 LS. Dollar
=21 Box Culvert Footing 5284 CY $136.60 $7,218.11  U.S. Dollar
T2 T Erect & Strip Footer 597.00 SFCA $10.26 $5,123.68 U.S. Dollar
+ 212 Place Footer Conarete 52.84 CY §11.37 500,65  U.S. Dollar
+ 213 Small Tools & Supplies 0.05 Lump Sum §10,862,95 $493.77 U.S. Dollar
=2 22 Box Culvert Wals 87.86 CY £572.99 §50,341.83 U.S. Dollar
+ 221 Erect & Strip Wall 5,757.00 SFCA $5.13 $29,525.99 U.S.Dolar
+ 222 Erect & Strip Bukheads 131.79 SFCA $15.39 $2,027.69 LS. Dolar
+ 223 Place Wal Conarete 87.86 CY $17.05 $1,498.08 LS. Dollar
+ 224 Rub & Patch 922.51 SF $0.61 $561.08 L.S. Dollar
=2 225 Project Indirect Costs 0.29  Lump Sum §56,156.73 $15,235.20 | U.S. Dollar
+ 2251 Crane Service: 8.67 Day £1,871.89 £16,235.20 U.S. Dollar
+ 226 small Tools & Supplies 0.05 Lump Sum $10,862.95 $493.77 U.S. Dollar
= 23 Box Culvert Deck 43.53 Cf $237.72 $11,535.59 U.S. Dollar
+ 231 Erect & Strip Deck 1,310.21 SFCA $5.13 $6,713.68 .S, Dollar
+ 232 Place Deck Concrete 48.53 CY $17.05 $327.43 LS. Dollar
=2 233 Project Indirect Costs 0.08  Lump Sum §56,156.73 £3,494.71 U.S. Dollar
+ 23.3.1 Crane Service 187 Day §1,871.89 £3,494.71 U.S. Dollar
+ 234 Small Tools & Supplies 0.05 Lump Sum $10,862.95 $493.77 U.5. Dollar
2 24 Box Culvert Wing Walls 40.85 CY $726.51 $29,532.50 U.5. Dollar
+ 241 Erect & Strip Footings 563.67 SFCA $5.13 $2,390.88 LS. Dollar
+ 242 Eract & Strip Wingwals 1,067.56 SFCA $15.35 416,425,656 LS. Dollar
+ 243 Place Wing Wall Concrete 40.65 CY $17.05 $693.13 LS. Dollar
= 244 Project Indirect Costs 0.16  Lump Sum $56,156.73 $9,029.05 U.S. Dollar
+ 2441 Crane Service 4.82 Day §1,871.89 55,029.05 U.5. Dollar
+ 245 Small Tools & Supplies 0.05  Lump Sum $10,862.95 $493.77 U.5. Dollar
=3 Reinforcing Steel (CBC Extn at STA 395... 35,372.00 b $0.73 $25,750.82 | U.S. Dollar

6.5.1 Turning Off Cost Allocation

If you determine that you no longer want to spread the cost of an Allocation Item, you can turn off cost
allocation for that cost item. The logic that you created to spread the costs are retained, so you can
easily turn it back on later.

ey g= Distributions cannot exist in the CBS when a job is published for Job Tracking. To remove
Distributions, either break the Cost Allocation link or uncheck the Allocate this Item’s
Cost check box on the Cost Item Record - Allocation tab.

Step by Step — Turning Off Cost Allocation

From the CBS Register, select the Concrete Batch Plant Cost ltem Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Iltem Record opens.

3. Select the Allocation tab. Uncheck the box for Allocate this Item’s Cost.
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] Iallu-:ate this [tem’s Cost

Allocation distributions inherit target Pay Item Assignment

by Quantity
proportionately based on

by Percentage

Estimate Essentials User Guide

by Unit Cost (drives the Allocation Item's Forecast (T/0) Quantity)

4. Once done, click OK to return to the CBS Register.

oK Cancel < Prev

MNext =

5. All of the distribution cost items are gone, but the quantity and the total cost of the
Concrete Batch Plant has not changed.

ﬁmﬁ Code Descripbon ?E;gﬁmuw Ur-:;irre Uit Cost ?.:Ef;f:::; Currency
- Project Indirect Costs .00 Lump Sum 856, 156.73 £56,156.73 L.5. Dolar
+ 8.1 Crane Service 30.00 Day §1,871.89  $56,15.73 U.S.Dolar
) T — v172.5 (S $96,030.20 C

+ 9.1 Buy Raw Materials 1,172.59 CY §35.62  $41,765.74 U.S. Dolar
+ 9.2 Batch /Mix/Haul Concrete 2111 Day §2,570.95  §54,269.95 U.S.Dolar
= 1D Equipment Related Indirects 1.00 Each £76,467.24 $75,467.24 LS. Dolar
+ 1.1 Maintenence 1.00 Each §76,467.24  $76,467.24 U.5. Dolar

6.5.2 Breaking a Cost Allocation Link

To make a Distribution a permanent part of the CBS, and permit its costs and quantities to be directly
editable under the cost item(s) to which it has been distributed, break the Cost Allocation link.
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Step by Step — Breaking a Cost Allocation Link

1. From the CBS Register, select the Project Indirect Costs Cost Item Record.

2. From the Ribbon, select the Actions tab. Under the Edit section, select Open. The Cost
Item Record opens.

3. Select the Allocation tab. Then go to the CBS Register in the record.

4. Select the costitem with a Cost Allocation Link. Then from the Ribbon, select the Actions
tab.

5. Under Tools, select Break Cost Allocation Link.

Estimate Quote Price Execution System
Iﬂ.?j rl-l-. "= Display Parent Information E,_-,_ Highlight Unigue (Delta) Resource Fields E»_; Edit Resource Periods

733 Display Biling Rate 21 Highlight Unique (Delta) Cost Item Fields = "= Insert Subordinate

Spiit Default
Data Blocks J Break Cost Alocation Link

Edit View Tools

6. When the Attention dialog box shows, click Yes to continue.

Attention

You have chosen to break the Cost Allocation link from the Cost
Allocation tem to the Distribution ltems. This will make the
Distnbution ltems permanent Cost [tems in their current locations.

If this Allecation ltem or any of its Distributions are included as a
dependency on a dependent cost item, then breaking this link could
result in a change to this job’s target pnice.

This action cannot be undone. Do yvou want to continue?

‘ Yes I Neo

7. The original cost item still exists and is now becomes editable. All the distribution cost
items are now editable as well. They are now permanent items and are no longer
highlighted in purple either.
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= 6 | Drilled Shaft Foundation (60") (Struct... 306.00 LF
+ 6.1 Buy Reinforcing Steel 47,432.52 b
+ 6.2 Drill Abutment Shafts 306.00 LF
+ 6.3 Erect Rebar Cage 400 EA
+ 64 Place Rebar Cage 4,00 EA
+ 6.5 Pour Concrete 222,53 CY
E 66 Project Indirect Costs 0.03  Lump Sum
+ 6.6.1 Crane Service 0.82 Day
Shaft Foundation (72") (Struct... 300.00 LF
+ 71 Buy Reinforcing Steel 53,182.35 b
+ 7.2 Drill Abutment Shafts 300.00 LF
+ 7.3 Erect Rebar Cage 4,00 EA
+ 7.4 Place Rebar Cage 4,00 EA
+ 7.5 Pour Conarete 314.16 CY
= 76 Project Indirect Costs 0.04 Lump Sum
+ 1.15  Day
1.00  Lump Sum
1,172.58 | CY
1,172.59 CY

6.5.3 Pay Item Assignment for Allocation Distribution in an Unlocked
Job

In the Cost Item Record - Allocation tab, the check box Allocation distributions inherit target Pay
Item Assignment was added. When the check box is selected in an unlocked job, the system uses the
same allocation distribution for the cost item’s costs anytime the cost item is copied and added to a
job. For a locked job, this is the normal system behavior. This option is always selected and cannot be
edited.
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Cost Breakdown Structure (CBS) Register Cost Item Record ©

CBS Code: Optional Code:  Description:

_ | | |Ean:rete Batch Plant

Pl Assignment: PILine Number: PIDescription:

Cost Item Summary | S Detail: $81.50 | & Plug: $0.00 | ([ JQuote: $0.00 | Allocation L

[] Allocate this Ttem's Cost

I ~ Allocation distributions inherit target Pay Iltem Assignment

How do you want to determine allocation percentages?

by Quantity

proportionately based on |

by Percentage

by Unit Cost (drives the Allocation Item's Forecast (T/0) Quantity)
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Exercise 6.1 — Define Indirect Costs

In this exercise, you will practice entering Indirect Costs. Complete the following steps, using your

Job:

1. Double click on the Price % Add On row header.

2. You already have Office Overhead as your first line item. In the next blank row type
Corporate Insurance in the Description field and enter a rate of .10.

3. Click OK to close the record.

4. Double click on the Direct Cost Add-On row header.

5. You already have Small Tools as your first line item. On the Description tab, type Safety &
Training in the next blank row’s Description field, then press Tab.

6. The Dependency Cost Breakdown appears on the right. Enter a rate of 5 for Labor Costs

only.

7. Click OK to close the record.

You should end up with similar results like below:

Cost Breakdown Structure (CBS) Register Price %% Add-0n Record O
(BSCode: Description:
Price % Add-On

s here Sigday [Seanch For..] =|  Savedviess: | Previous View

Diescription Fiate m“'
= | Office Overhead 4.00
Comorate Insuranoe .10
Page 316 of 417

Total Cost
§8,082.87

Cost Item Setup x
Pr g g a
Carrency: | U.S. Dolar
Accoust Code: o
Cost Carve: | Linkar

Tag I:
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Cost Breakdown Structure (C85) Register Direct Cost Add-OnRecord ©
CBS Position Code:  Diescription: Total Cost: Alt
[Birect Costadd-on | $8,845.47 | BASE
Descriotion | Dependency | Cost Categorization | Allocation Cost Breakdown
Drag ﬂuj:t: [Search Fer...] | Saved views: | Previous View - Cost Category Subvect Cost Rate Cost
w Total $130,759.83 .35 $2.548.49
Total Cast L
Desaiption g Cure... (Forecast) dl » Lebe §58,969.83 5.0 $2,998.99
smal Tools U.S. Dollar §5,895.98 » Owned Equipment $68,251.92 0.0 #0.00
= | safety & Training ™ » Rented Equpment 0.0 0.0 $0.00
.l »  Suppies $0.00 0.0 $0.00
»  Matesdials $3,276.00 0.0 $0.00
»  Subcontract 000 0.0 0,00
» Fees §262.08 0.0 $0.00
¥ Alovesnce 0,00 0.00 0,00
Custom Category 1 2000 0.0 @ $0.00
Undefined 2000 0.0 @ $0.00

Congratulations, you have completed this exercise!
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Lesson 6 Review

1.

Default indirect costs are pre-built created by InEight Estimate, located
within the CBS Register.

a. billing rates
b. costitems

C. payitems

By default, any cost item you create in the CBS Register that is not assigned to a pay item
is considered indirect cost.

a. True

b. False

The cost segment field in the CBS is used to indicate:

a. Whether your costs will be considered job overhead, business overhead, or direct
cost.

b. The source of your costs (Detail, Plug or Quote).

C. What pay item your cost item is assigned to.

Lesson 6 Summary

As a result of this lesson, you can:

¢ Explain how indirect costs are defined in InEight Estimate
e Estimate default indirect cost items

e Estimate user-defined indirect cost items
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LESSON 8 — QUOTE MANAGEMENT

Lesson Duration: 60 Minutes

Lesson Objectives

After completing this lesson, you will be able to:
¢ Create and publish RFQs
» Define quote pricing
e Compare and award quotes

e Create and analyze scope items

Lesson Topics
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8.1 QUOTE MANAGEMENT OVERVIEW

8.1.1 Quote Management Workflow

When you make the decision to send out RFQs (Requests for Quote), as the estimator you will outline
the specifications for the request, select the vendors you wish to contact, and issue the request for
quotes.

When you receive quotes back from vendors, you can enter their pricing into InEight Estimate, where
you can compare them, award them, and update your CBS costs in one fluid process without the need
to re-enter data in multiple locations. InEight Estimate lets you enter multiple vendor quotes to enable
price comparison.

TIP Awarding a quote in InEight Estimate does not mean the vendor is awarded the contract,
but rather that their price is selected as the carrying cost in the bid.

InEight Estimate provides a built-in workflow for managing your quotes, consisting of three steps:
1. Creating and publishing Requests for Quote (RFQs)
2. Updating quotes with vendor/subcontractor pricing
3. Comparing and awarding quotes
InEight Estimate has a separate form to manage each step:
1. Request for Quote (RFQ) Register

2. Quote Register

3. Quote Comparison & Award

Quote

Comparison
& Award

8.1.2 Quotes and Quote Groups

Typically, an estimate contains two types of quotes:
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1. Quotes for resources (materials, equipment) purchased or rented from suppliers.
2. Quotes for subcontracted work.

In InEight Estimate, quotes from suppliers are managed at the resource level. In other words, you can
use material resources to represent the items purchased from the supplier.

For the cost items in your project that you plan to subcontract, you can manage quotes at the cost
item level, using the cost items themselves as the descriptions on the quote request.

You can use Quote Groups to group together multiple resources or cost items that will be sent in an
RFQ package. Using quote group tags can save a great deal of time generating packages of items to
request quotes for.

8.1.2.1 Resource Level Quote Groups

When sending out quotes, you may want to organize your resources into groups based on the type of
material, such as pipe, aggregate, or concrete. When creating Requests for Quote, you will be able to
select your pre-defined quote group and it will bring all the related resources along with it. You can
assign quote groups using a pre-defined tag called a Quote Group in the Resource Rate Register.

Below is an example of resources with a quote group assigned:

Resource Rate Register ©

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies Unique

oL oeon = it et
+ IECT Cooling Towers Process Equipment Install Standard Instaled Equipment Rate... | Each
+ IEFC Feeder Controls Landscaping Work Standard Installed Equipment Rate... | Each
+ IEHS Heating System Process Equipment Install Standard Installed Equipment Rate... | Each
+ IEPHP Pump High Pressure Commercial Work Standard Installed Equipment Rate...  Each
+ IERMT Raw Material Tank Concrete Materials Standard Installed Equipment Rate...  Each
+ IERS Recovery System Process Materials Standard Installed Equipment Rate... | Each
+ IEST separator Tank Process Materials Standard Instaled Equipment Rate... | Each

8.1.2.2 CBS Level Quote Groups

For your subcontracted items, you can assign quote groups at the cost item level to group together
subcontractor work, such as Commercial Work or Landscaping Work. These labels are assigned using a
pre-defined tag called Quote Group in the Cost Breakdown Structure register.
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257 = Description

Position Code =

Forecast

(T/c)
Quantity

1.00
1.00
1,00

1,000.00

200,00

1,000.00

8.2 REQUESTS FOR QUOTE

Estimate Essentials User Guide

Unit of
Measure
Lump Sum
Each

Each

Linear Feet
Linear Feet

Square Feet

Quote Group T

Structural Painting
Process Equipment Install
Commerdal Wark
Guardrail Work

Guardrail Work

Sign Work

Requests for Quote (RFQs) are invitations to sellers that include a requested list of items or

services/pricing and terms. When you create an RFQ in InEight Estimate, you are able to indicate the

line items you want to include in the quote, and the vendor(s) to whom you want to send it.

8.2.1 Request for Quote (RFQ) Register Overview

To access the Request for Quote (RFQ) Register, from the InEight Estimate landing page, select the
Quote tab, then click on Request for Quote (RFQ).

File Setup Estimate Quote

I ® (= Quote Group Tags @

I i
) Minority Setup
Address Reguest For | Quotes
Book Attachments Quate (RFQ)
Setup Quote Management

Execution System

A
5 [

Actions

Resources Cost Items

Quote Comparison & Award

[

Reports

Reports

¢ The RFQ register lists all of the RFQs you’ve created, with a Description, a Status, and a Response

Deadline Date
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Cost Breakdown Structure (CBS) i Rate i | for Quote (RFQ) Register © |
Drag columns here to group
A [ Response Response Published RFQ Buyer's
Description 2. HES Deadline Date Deadine Time Date Instructions Spedial Terms D D2 foals o=

MNew 1f3/2020 11:00 AM D D D

8.2.2 Request for Quote (RFQ) Record

You can double click on the row header, or right-click on any request for quote in the Request for
Quote Register and choose Open to access an existing Request for Quote (RFQ) Record.

g Response
Description = Status Deadline Date

Open

New

Delete
Cut
Copy

Paste

BEFrTY [

Eill Down

6

Link this field to Excel
UnLink from Excel

"y
U

Overview - Request for Quote (RFQ) Record

e e

1 RFQ Each record contains a Description, Deadline Date and Deadline Time
Description  fields to identify the RFQ and indicate when a response is due.

2 RFQ Tabs The record is organized into tabs where you can define the items for the
quote, terms & conditions, and the seller companies to receive the RFQ.

3 Statusand  The Status and Published Date let you know if it is new or published (sent
Published out), and when it was published.
Data
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Request for Quote (RFQ) Record & =

Description Status
Guardral Items New
Published Date
Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup |

Resources Cost Items

Drag columns here to group Saved views: | Standard View - ,D
CBS = Quote Group - Optional - .
Position Code = RECIE Tag = Code pescpc Quantity

= A1 o 6.1 Guardrail Work 1500 0100 Guardrail Typ... 1,000.00
6.2 6.2 Guardrail Work 1500 0200 Guardrail Typ... 200.00

Cancel New... < Prev Next =

8.2.3 Create an RFQ

When putting together your RFQs, you will be able to select the appropriate material resources and
cost items for which you need quotes in your estimate. To create a new RFQ, you have a few options:

¢ Create RFQ from scratch: This creates an empty RFQ Record for you to define

e Create RFQ from Quote Group Tag(s): This option lets you create an RFQ from a quote group so
you can add multiple materials or subcontract items at once

¢ Create RFQ using Default Seller data: In your address book you can store vendors with a list of
their default materials. This option lets you select the vendor and have it automatically find their
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materials in the job

Cost Item Identification

Usethe following field; CBS Position Code -

Please select from the following options:

D ipti
(@) Create RFQ from scratch Escription

() Create RFQ from Quote Group Tag(s)

Only show Quote Group tags that
are currently utilized in this job

On the resulting RFQ record, only
list resources with utilization
currently greater than zero

() Create RFQs using Default Seller data

This option scans the job for all
Resources and Quote Groups
utilized in the job. For any that are
listed inthe Address Book as
'Default Quotes’ for the Sellers you
select on the subsequent selection
register, a new RFQ record will be
added for each Seller listing their
default items.

Create separate RFQ records faor
each Quote Group, per seller?

Ok Cancel

The rest of this section walks through each tab on the RFQ Record in more detail.

8.2.3.1 Line Items

The Line Items tab lists the resources or cost items selected for the RFQ, including the Description,
Quantity, Quote Group, Currency and other user-defined tags.
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Response Deadline Date:

Line Items

Terms & Conditions

Resources

Cost Ttems

Drag columns here to group

cBs .
Position Code = RFQID
= 6.1 & 6.1
6.2 6.2

Quote Group _ COptional
Tag = Code
Guardrail Work 15000100
Guardrail Wark 1500 0200

8.2.3.2 Terms & Conditions

Description

Guardrail Typ...
Guardrail Typ. ..

Estimate Essentials User Guide

/25 2003 - Respaonse Deadline Time: |11:00 AM

Vendor Companies Attachments Setup

Quantity

1,000.00
200,00

Unit of
Measure

Linear Feet

Linear Feet

This tab provides ample space for you to enter terms, conditions and instructions that need to be
included on the RFQ.

Response Deadline Date: | 7/29/2009 -

Response Deadline Time: [11:00 AM

Line Items Terms & Conditions endor Companies Attachments Setup

Buyer's Spedial Terms & Conditions

‘ Any penalites assessed by the owner due to quality control compliance deviations by the supplier will be deducted from the supplier's payment.

RFQ Instructions

lease contact site super John Smith @ 623-555-6982 for delivery instructions.

8.2.3.3 Vendor Companies

New... < Prev Next >

You will use the Vendor Companies tab to select the suppliers or subcontractors that will be receiving
the RFQ. This is done by selecting them from the Estimate Library Address Book. This tab will store all
of the pertinent contact information for each seller, including their fax number and/or email address

so that you can send them the RFQ.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line Items Terms & Conditions Vendor Companies Attachments Setup

Cir=m e ireme Fere 20 Arenr
Drag columns here to group

Vendor Contact == Status ?thlal?'ll':SIQ-luan fties Vendor Phone
= 5UB18 SIB18 - Mel Blank Mew W 111-222-3232

sSUE4 SUE4 - Harry Belefony Mew o 111-222-1111

Venl3 Ven 13 — CARRIE Matty Mew W 111-333-3434
» ]

The following options are particularly noteworthy:

¢ Publish Item Quantities: If you want the RFQ to specify your take-off quantities, select this
checkbox. If you want to keep that information to yourself and let the vendors or contractors
determine their own quantities, deselect this checkbox

¢ Publish by Fax: If you choose to publish by fax, InEight Estimate creates a Word document with
a template filled out. It is ready to print and send, but you have the opportunity to double-check
the information before emailing the RFQ

[l When RFQs are generated for multiple vendors using the Publish by Fax option, be
sure to separate the MS Word document pages and send only the correct pages to
each vendor.

¢ Publish by Email: If you choose to publish by email, the Word document is created, the
template is filled out, it is attached to an email, and automatically sent to the email address
listed for that vendor in the Address Book

When using the Publish by Email option, the process is automatic and it does not

give you the opportunity to double check your information before the RFQ is
emailed. For this reason, it is recommended to Publish by Fax, review the
information, and then email the RFQ manually.

8.2.4 Attachments

This tab allows you to specify any electronic files that need to be attached to the RFQ, such as drawings
or specifications for the work.
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Response Deadline Date: | 7/29/2009 - Response Deadline Time: [11:00 &AM
Line Items Terms & Conditions Vendor Companies Attachments Setup

Drag columns here to group Saved views: Previous View - ,C)
File Mame =N Description Location File Type File Size Attached By Date Attached
plumber quote.pdf plumber quote  Job Folder Adobe Acrob... 166875 Paul Trippi@ine...  7/31/2023 11:08:21 AM

=

8.2.5 Setup

The Setup tab lets you indicate what information will display on the published RFQ template, including
custom tags. In addition to selecting tags and adding notes on the Setup tab, you can also specify your
RFQ Publication Settings and can choose whether you want to include the instructions, special terms
and conditions, notes and attachments.

Description

Guardrail Items

ResponseDeadline Date: | 7/29/2009 - Response Deadline Time: [11:00 AM

Line [tems Terms & Conditions Vendor Companies Attachments Setup

Tag 1: Notes
Tag 2: -
Tag 3: -

RFQ Publication Settings
Cost Ttem Identifier: CBS Position Code -

Include RFQ Instructions

Include Buyer's Special Terms & Conditions
Include Notes

(] Include Attachments

Publish Ttem Quantities
Publish To File
Publish By Email
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8.2.6 Publish an RFQ

Once created, InEight Estimate allows you to generate a Microsoft Word RFQ template that can be

faxed or manually sent via email to the supplier or subcontractor.

When you complete all of the fields that are required for this RFQ, you are ready to publish the RFQ, To
do so, select all of the vendors that you want to receive the RFQ and click Actions > Publish on the RFQ

Record ribbon.

Step by Step — Create and publish an RFQ

This exercise walks through a specific example using the Training Job.

1.

o

10.
11.

From the Estimate landing page, select the Quote tab.

2. Select Request for Quote (RFQ).
3.
4

From the Actions tab, click on the New icon to create a new RFQ.

. Select Create RFQ from Quote Group Tag(s), leaving the checkboxes checked to only show

guote groups and resources that are being used.
Select the Aggregates quote group from the right panel.
Click OK.

In the Response Deadline Date field, select a date two weeks from today, and for the Response
Deadline Time, type a time stamp (e.g. 11:00 am).

Response Deadline Date: | 7/259/2009 - Response Deadline Time: [11:00 &M

Line Items Terms & Conditions Vendor Companies Attachments Setup

Select the Terms & Conditions tab.

Create and type Prices are good for the duration of the contract in the Buyer’s Special Terms &
Conditions field.

Type in All items to be delivered to jobsite by supplier’s trucks in the RFQ Instructions field.

Select the Vendor Companies tab and click in the first blank row in the Company Name column.
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Line Items Terms & Conditions Vendor Companies Attachments Setup

Lrag columns Nere o group

Vendor Contact = Status IPthla?'il':SSuanﬁﬁes Vendor Phaone
SUB13 SUE 18 -- Mel Blank Mew b 111-222-3232
SUB4 SUB4 - Harry Belefony Mew W 111-222-1111
Venl3 Venl1d -- CARRIE Matty Mew " 111-333-3434

12. Click on the Address book . icon, and then select the following example vendors:
e Example Vendor 1: Pat Roberts
e Example Vendor 2: Stan Mark
e Example Vendor 4: Lester Slim

13. Click OK.

14. Make sure Publish to File is checked for all vendors.

15. Uncheck Publish by email for each vendor.

16. Select the sellers to whom you want to send the RFQ.

e Word opens the file automatically for you to review; and from here you can either print it
or send it in an email as an attachment
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REQUEST FORQUOTATION

Job:  Training Job Trairing Job - Maricopa County Mo, TM2924

TO: FROM:

Name: | Pat Roberts Name: | Tom Cross
Company: | Exampls Yendor 1 Company: | Example Prime Cantractor 1
100 Tenth Street 400 First Street Suite 4000
Hometown, AZ BB0060 Hometown, AZ 530004

Phone; | 111-123-2134 Phone; | 111-122-1111
Mobile Phone: Mabile Phone:
Fax: | 222-123-1234 Fax; | 222-112-2211
Email: Email:

Job Information: Training Job
Training Job - Mericopa County Mo, TM2924
‘Ownier: Example Owner
Job Type: Highway and General Engineering
Job Location: 1-10 MP 100 to MP 120
City: Phoenizx:
‘County: Maricopa
State [ Province: Arizona
Country: United States
Bid Location: Engineer's Office
Bid Date: 11812020
Bid Time: 10:00 P
Measurement System: English

Reaniact far Dunta (REO) Infarmatinn®

17. On the Actions tab of the record, select Publish to create your RFQ document.
18. Select the folder to publish to.

19. Click OK to save the RFQ Record.

8.2.7 RFQ Email Draft

When sending out Requests for Quotes (RFQ) on a bid, it is essential to be able to effectively
communicate the project requirements to potential subs or suppliers to ensure you have good quote
coverage within your estimate. Email RFQs open as a draft email message, giving you, the sender, the
opportunity to control specifically what is sent and customize the message before sending it out to
subs and suppliers.
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RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924 - Message (HTML)

File Message Insert Options Format Text Review Help @ Tell me what you want to do
B - | [Tmesnewrov 2 v B T U 2 A-E-iE-EE - B8 B |1 L R B
F]
B> To Charlie Bravo
Send Ce
Subject RFQ from InEight Corporation - SKIP for Training Job - Infrastructure: Training Job - Maricopa County No. TM2924

REQUEST FORQUOTATION

Job: Training Job-1 Training Job - Maricopa County No. TM2924

TO: FROM:

Name: | Harry Belefony Name: | Tom Cross

Company: | Example Sub #1 Company: | Example Prime Contractor 1
600 First Street Suite 5000 400 First Street Suile 4000
Hometown, AZ 889006 Hometown, AZ 889004
Phone: | 111-222-1111 Phone: | 111-122-1111
Mobile Phone: Mobile Phone:
Fax: | 222-221-2212 Fax: | 222-112-2211

Email: | charlieb1234@example.com Email:

Job Information: Training Job-1
Training Job - Maricopa County No. TM2924

Owner: Cwmer
Job Type: Highway and ral Engi ng
Job Location: I-10 MP 100 to MP 120
City: Phoenix
County: Maricopa
State / Province: Arizona
Country: United States
Bid Location: Engineer's Office
Bid Date: 1/6/2020
Bid Time: 5:00 AM

Request for Quote (RFQ) Information:
Publication Date:  &21/2020 3.57 PM

Response Deadline Date: 77292009 11:00 AM

8.3 QUOTES

When you receive responses to your RFQ, the next step is to enter their pricing in the Quote Register.
The Quote Register stores all of the quotes you have for that job. Each quote has a Description and a
Quote Status, and each quote displays seller contact information.

In this case, an estimator in charge of receiving quotes would need to determine how best to input
these quotes within the Quote register.
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8.3.1 Sample Received Quote Scope Sheet

Overview - Received Quote Scope Sheet

T T

1 Section one Scope item one includes 4 items the subcontractor has considered as
work to be done onsite. You may want to consider adding all 4 items as
individual quotes. Then creating a package identifying these quotes as
on-site work, totaling $203,000.

2 Section two Scope item two includes 3 items the subcontractor has considered as
work to be done offsite. You may want to consider adding all 3 items

as individual quotes. Then creating a package identifying these quotes
as offsite work, totaling $24,650.

3 Exclusions The subcontractor is showing 9 items they excluded from their scope of
responsibility.

4  Qualifications  The subcontractor has included 3 stipulations pertaining to this bid. If
selected all 3 are considered accepted terms.
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Received
Quote Scope Sheet

DATE: 12/19/2019
PROJECT: TRAIMING JOB TRAINING JOB - MARICOPA COUNTY NO. TM2524
LOCATICN: PHOENIX, AZ

SITE CONCRETE: FORM, SUPPLY AND INSTALL

ONISTE IMPROVEMENT S

Vertical Curb; Curb and Gutter; Valley Guitter w/ rebar

4" thick broom finish walk with wire mesh; ramp w/ domes

Flow-Through planer slab and walls

8" thick crosswalk paving with rebar 36" x 36" pattern broom finish and 187 x 36" pattern
colored aggregate finish (1 location only @ 16% street entrance)

W=

Price: $203,300
OFFSITE IMPROVEMENT 5
1. Curb and Gutter
2. HC Ramps w/ domes; planter w/ rebar
3. 36" x 36" patterned finish walk w/ wire mesh
Price: $24,650
EXCLUSIONS:
1. Layout of li and grades
2. Site grading
3. Aggregate base and/or compaction; sand cushion
4. Sealants, caulking and waterproofing; precast items
5 Misc post footings and masonry wall footings
6. Supply of embedded iron or metal
7. Demolition
&. Traffic control and pedestrian protection

QUALIFICATION
1.

Price valid for bU days
2. GC will provide a concrete pump washout area
3. 5% retention will be released 45 days after completion of our work

Alternate Price to furnish and install 4" aggregate base under parking structure lab. Sand
by others. Price based on rock being placed prior to piles, pilecaps and grade beams.
$24,100

This proposal is good for thirty (30) days from the data herein, after which time Summit Construction reserves the
right to review the proposal for any changes in price. Please call me if you nead any further information.

Rick
Estimator

8.3.2 Quote Register Overview

To access the Quote Register, choose Quote > Quotes on the main InEight Estimate menu or click the
Quotes icon on the toolbar.
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Quote Register @

Drag columns here to group

Description = EZchnpﬁon SQtL.Ia%JtEs Seller Company %‘;F .I'%;\;::’I-dad Currency
Aggregates Aggregates Accepted Example Vendor 1 —-PatRob... Example Vendor 1 £402,192.00  $402,192.00 U.5. Dollar
Aggregates Aggregates Accepted Examig Vendor 4 DBE — Les... Example Vendor 4... £0.00 $0.00 .S, Dollar
Aggregates Aggregates Accepted Example Vendor 2 — Stan Mark ~ Example Vendor 2 40,00 0,00 U.S, Dallar
/% Asphalt Materials Accepted Example Vendor 1 --Pat Rob...  Example Vendor 1 §1,115,97...  §1,102,50... U.S. Dallar
/% asphalt Materials Accepted Example Vendor 2 - Stan Mark ~ Example Vendor 2 $1,263,17... $13,671.00 U.S. Dollar
Electrical Work Electrical Work | Accepted Architectural Designs, Inc, — ... Architectural Desig... £4,200,00 £0.00 .S, Dollar
Electrical Work Electrical Work ~ Accepted HD Engineering Group — Rog...  HD Engineering Gr... £4,450.00 $0.00 U.S. Dollar

8.3.3 Quote Record Overview

The Quote Record establishes who the vendor is, along with quoted prices and all terms and
conditions. Once a requested quote returns, you can either create the quote in InEight Estimate from
scratch or convert the original RFQ to a quote and enter the supplier or subcontractor pricing. Each
Quote Record contains additional fields and options for managing the quote.

Quote Records utilize data blocks allowing you to reposition tabs, detach tabs into individual windows,
and redock tabs in new locations. Using the data blocks layout, you can input and maintain important
guote data like Vendor Qualifications and Special Terms & Conditions.

Right click on any existing quote in the Quote Register and choose Open to access the Quote Record.

Overview - Quote Record

e |

1 Header  You can include detailed contact information about the supplier or
block subcontractor. This automatically fills when you select the seller from the
Address Book. The External Ref field can be used to access information
specific to the bid/quote.

2 Price The Price data block contains a breakdown of pricing information for the
block qguote, including taxes, item conditions, and special conditions.

3 Quote The tabs at the bottom of the screen hold detailed information regarding the
tabs quote.

4 Default Data blocks include Special Terms & Conditions, Qualifications, Packages,
Data Taxes, Vendor's Profile, Setup, and Minority.
Blocks
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Quote Record ©
Header

Desription: | Pipe Materials

Estimate Essentials User Guide

o

Vendor: | 1128354 Abertaltd - 0010... izl| Vendor Name: 1128354 Alberta Ltd Vendor Phon

Contact: | <Ad-Hoc Contact> 2

Primary Email ‘ Last Name: ‘

External Ref.:
Resources CostItems o
5 Saved views
Code = RFQID Quote Group = oot Description No Split Free
1 1 1 pay item 1 v
2 2 2 pay item 2 v
> & . .

8.3.4 Header Block

Awarded

e: 780-920-3163

First Name: Contact Office:

Contact Mobile:

Duration

, | Specal Terms & Conditions ~ Qualifications ~ Packages  Taxes

OptionalCode: Extended Price: $0.00
Date: [7/20/2023 Ttem Taxes: $0.00
Quote Tax:
Source: Sond
Currency: | U.S. Dolar Ttem Conditions: £0.00
Status: | Incomplete Special Conditions:

Ignore: [] Reason: Total: $0.00

Special Terms & Conditions X
o "

Buyer's Special Terms & Conditions

[ vendor's Special Terms & Conditions

Special Conditions Adjustments: $0.00
Distribute Special Conditions: () Evenly 9
Include Special Conditions costs forunawarded quo

Vendor's Profile  Setup  Minority

Cancel New... Prev Next >

The Header block portion of the screen is where you enter in description information pertaining to the

guote, along with vendor/contractor information.

There is an External Ref field you can use as a hyperlink for attaching any supporting bid quote

attachments from the vendor/contractor.

On the right portion of the header block is where you enter optional information related to:

e Optional Code — a code used to reference the received quote.

¢ Date — date the quote is received.

¢ Source — this is the method by which the quote was received. The options are email, fax, hard

copy, phone, and other.

¢ Currency — system of money in general use for a particular country..

¢ lIgnore — by ignoring the quote, and providing a reason, the quote will turn grey in the Quote

Comparison & Award screen.

8.3.4.1 Quote records

The Quote record header block includes a vendor field with a searchable address book library register
drop-down list. You can select shared vendor data to populate your quote header record with

Platform’s shared master data.
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Quote Record ©
Header
Description: | Asphalt Materials

Vendor: | 1128354 AbbertaLt... [2]|| Vendor Name: 1128354 Alberta Ltd Vendor Phone: 780-920-3163
Contact: | Alberta — Frank Ma... {2 First Name: Frank Contact Office:

Primary Email: Frankmatty@gmail.com Last Name: Matty Contact Mobile:

External Ref.:

Address Book Register - Library

Vendor ID Vendor Name = Vendor Type Tax ID Tax Jurisdiction Address 1
= 0010087554 1 Alliance Geomatics LLC 2001 461564451 4803300400 12614 120th Ave NE -
+ 1 NP -Vendor2 1_NP - Vendor2 1_NP Vendor 12345 abc S0th Street
+ 1 NP -Vendorl 1_Vendor1 1_NP Vendor
+ LNP-Vendori  1_Vendorl 1_NP Vendor
0010099934 10X Engineered Materials LLC 2001 824568213 1516913100 1162 Mancheser Ave
0010053934 10X Engineered Materials LLC 2001 824568213 1516913100 1162 Mancheser Ave
4 »

Using Platform’s shared data also reinforces accurate Estimate quote reporting. For example, you can
report on which vendors and contacts have been awarded quotes or run a report on how many RFQs
have been sent to select vendors and how many RFQs were returned for certain jobs. Additionally,
using Platform shared vendors makes it possible to report on all activity related to a particular vendor.
Examples include seeing how many subcontract agreements have been executed in InEight Contract,
or how many claims/issues a vendor has been involved with in InEight Change. The predominant value
for Estimate using Platform vendors, along with other InEight applications, ensures that the same
vendors are being used by all applications.

8.3.5 Price Block

The Price block includes the quotes extended price, along with any additional taxes, bonds, item
conditions, and special conditions.

8.3.6 Quote Record Tabs

8.3.6.2 Resources & Cost Items

The Resources & Cost Items tab displays the resources or cost items quoted, along with their estimated
guantities and units of measure.
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¢ A Unit Price column is included on this tab for entering the quoted pricing from the seller, either
manually or by pasting from an electronic format

o If a Package code is entered, the Unit Price field is greyed out, and the Package code amount is

used

¢ Additional columns are provided for making conditional amount or percentage adjustments to
the quote to manage last-minute changes

¢ A note field is included for explanation changes

¢ A No Split option indicates that the seller will only provide the quoted goods or services if they
are selected to provide all listed items. They will not provide one quoted item without you
procuring all others from them as well.

¢ You can check an item as Free for circumstances where the vendor will include the price of one
item with another. Marking the included item(s) as free reminds you there is no quoted price for
that item

Resources | Costltems

o group Find: | [Search For...] | saved views: | previous view

Extended

L Quote Optional . Unitof
Package Code RFQID e £ Description Nospit | Free | Awarded  Du Quanty et unicprice B

50,000.00  Cubic Yard $0.00 0.00
50,000.00  Cubic Yard P1 PL  §200,000.00

31 3.1 3.1 Excavation, scrapers
P1 32 3.2 3.1 Excavation, trucks

50,000.00  Cubic Yard P1 P

v L

v 1
1 3.3 3.3 3.2 Embankment. v 1
v 1

P1 3.4 3.4 Rock Excavation 3,000.00 Cubic Yard P1 P

Cost item tags and user defined fields

There are 25 tag fields in the Quote Record register cost items tab. There are also 15 user defined
fields that let you sort, filter, and group on selected quote records more efficiently.

For example, you can use tags and user-defined fields to isolate certain cost items, or group cost items
together.

$30,200.00
s

OptianalCade:

Y Phone: | 1112223232

Fae 2221111 000

53020000

Page 338 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 8.3 Quotes

8.3.7 Data Blocks

The Quote Record utilizes data blocks that allows you to customize the layout and focus on data block
tabs that matter most to you. You can select the default data block action in the ribbon to revert back
to the default setting, which shows all six data blocks.

Data Block tabs include:
¢ Special Terms & Conditions
e Qualifications
e Packages
* Taxes
e Vendor's Profile
e Setup
e Minority

File

.F‘: Package Entire Quote O |
2

Refresh Default | o
Data Blocks

Edit Tools View |

]

etup Estimate Quote Price ‘ Actions

The seven data blocks appear at the bottom right of the screen.
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Special Terms & Conditions

Buyer's Special Terms & Conditions

Vendor's Special Terms & Conditions

Special Conditions Adjustments: | 5E|.DE||

Distribute Special Conditions:  (C) Evenly (@) Using Weighted Average

Include Special Conditions costs forunawarded quotes in Comparable Totals

Drag columns here to group Saved views: | Standard View g | p

Row

Number = Scope Item Quote Group = Induded Amount % of Total Notes

Fl

Special Terms & Conditions  Qualifications  Packages Taxes Vendor's Profile  Setup  Minority

It’s possible to move the entire data block, or individual data blocks to other parts of the screen. For
example, select the Special Terms & Conditions header row, and drag to the desired part of the screen.

Special Terms & Conditions

drag and move

Buyer's Specia g & Conditions

Seller’s Special Terms & Conditions

Drop the data block on top of an arrow where you wish to land the data block.
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Qualifications
Bond

Rate/§1,000: -
Bond Cost:

Insurance

$0.00

$0.00

|:| Vendor can provide a BOND for all work quoted

e —
e
sondngrone: |

[[] AddBond Costto the Quote

Cost of BOND to be added to quoted price:

[[] vendoris INSURED as required by applicable law

srncecompany: [
e sgens [ ]

Qualifications Packages Taxes Vendor'sProfle Setup Minority

[ vendor's Special Terms & Condi

Special Conditions Adjustments: [_ ]
< >

Cancel | New... < Prev Next >
The data block will now reside on the left side of the screen.
Quote Record ©
Header
Description: | Pipe Materials Optional Code:
Date: | 7/20/2023
Vendor: | 1128354 Alberta Ltd - 0010... EEI| Vendor Name: 1128354 Alberta Ltd Vendor Phone: 780-920-3163 Source:
Contact: | <Ad-Hoc Contact> 5@| First Name: [:I Contact Office: | | Currency: | U,S. Dollar
Primary Email: I I Last Name: ‘:I Contact Mobile: | | Status: Incomplete
External Ref.: I | Ignore: [] Reason:
| Special Terms & Conditions X Resource L Qualifications
Buyer's Special Terms & Conditions =) - } toc| Bond
‘ Dvendnrc:nprnmdeaEuNDfor allwork quoted
= R Bonding Company: l:l
[ vendor's Special Terms &Conditions 1
I 2
= -
Special Conditions Adjustments: [ AddBond Costto the Quote
Distribute Special Conditions: (O Evenly (@ Using Weighted Average Cost of BOND to be added to quoted price:
[ Indude Special Conditions costs forunawarded quotes in Comparable Totals Rate/$1,000: | 50.00
Drag columns here to group Saved views: | Standard View - Bond Cost: $0.00
ROy Scope Ite te Group = Amount % of Total N Ineurance
Number = S EEEERD = oun ortes : [] vendoris INSURED as required by applicable lay
Insurance Company:
Insurance Agent:
- -—
< > < » Qualifications  Packages Taxes Vendor's Profile

8.3 Quotes

You can also close a specific tab if it’s not commonly used. In this example, you can right click on a tab
(like Special Terms & Conditions) and select close.
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P Float
Dock

Spedal Terms & Co ol
Close

8.3.8 Data Block Tabs

8.3.8.3 Special Terms & Conditions

Special Terms & Conditions is where you can include buyers and sellers special terms, add fixed cost to
the quote, and include/exclude scope items.

Special Terms & Conditions *

Buyer's Special Terms & Conditions

Vendor's Special Terms & Conditions

Special Conditions Adjustments: | SD.DD|

Distribute Special Conditions:  (_) Evenly (@) Using Weighted Average

Include Special Conditions costs forunawarded quotes in Comparable Totals

Drag columns here to group Saved views: | Standard View [ }3
[Eow = Scope Item Quote Group = Induded Amount % of Total Motes
Number

%0.00

4

Spedial Terms & Conditions | Qualifications Packages Taxes \Vendor's Profle Setup  Minority

8.3.8.4 Qualifications

This tab allows you to include bond. You can enter the bond rate and the system will calculate the total
Bond Cost or vise versa. This tab also allows you to enter insurance contact information and seller
license information. If the vendor in the address book already had this information, then this
information will get pre-filled when the seller is assigned to the Quote.
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Qualifications ¥

Bond ~
Vendor can provide a BOND for all work quoted

Bonding Company: . |

Bonding Agent: |American |

Bonding Phone: |

Add Bond Costto the Quote

Cost of BOND to be added to quoted price:

Rate/$1,000: $0.00 |
Bond Cost: |p» $330.00]
Insurance

[] venderis INSURED as required by applicable law

Insurance Company: l

Insurance Agent: |A merican

Insurance Phone: |

License
[] vendor is LICENSED to perform all work quoted

Licensor: | |

ID: |EZ-Licinse-.-’ll |

Class:

W

Special Terms & Conditions  Qualifications Packages Taxes Vendor'sProfile Setup  Minority

8.3.8.5 Packages

Using the Packages feature lets you logically organize quotes into an arranged collection of like
grouped packaged quotes. You can determine how to enter quotes from subcontractors and classify
them into a package grouping. When you create a package within the Packages block, and give it a
monetary value, you can then assign that package code to one or more quote records. The package
code is limited to three characters.

When comparing various vendor quotes in the Quote Comparison and Award form, with each quote
containing its own scope of work, you can easily distinguish which items belong to each package. This
helps to identify which quotes to award in your decision-making process.

As an example, the following Civic Center Parking Structure quote has three packages defined in it. The
P1, P2, and P3 on the left represent the grouped package numbers that will be used to determine the
package structure in the quote record. The vendor that submitted this quote shows detailed estimates
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defined for each of the three packaged items, but there is no breakdown provided in the quote of how
much each line item is worth. Rather, this quote is showing a package price for each collection of items
(scope of work).

Civilworks Inc. Phone (758) 555-9854

125 Maple S5t

seve ®* Civic Center Parking Structure
Dmnrlnhrtim Addendum 1-6
w#m Price
DEMOLITION, EXCAVATION AND GRADING (PARTIAL) $150,780.00
Site Clearing of trees and bushes
Demo of AC Paving, Concrete Curbs and Walks
Sawcut AC Paving and Concrete

Remove storm drain, SS, CB's, MH & pole bases
P1 Rough grade parking structure pad, commerical pad
Place 127 non-expansive fill

Fine grade pads

Demo and remove 16th street curbs and paving
Grade for new roadway

Grade for exterior concrete sidewalks

2 mobilizations )
Site Clearing of trees and bushes

P2 Demo curbs, excavate for paving

Demo median on 16th Street, place temporary paving section
Patch pave parking lot with 3° AC over 6* AB

£1139,900.00

PAVING (PARTIAL)
P3 Place aggregate base for AC Paving, curts and walks
Place 5" asphalt conorete section
Key Exclusions: shury seal, stiniping, fencing, conorete work

OTHER ITEMS
Load out stockpiled clean spolls $26.00/CY
Grade, fabric, place 4° AB for contractor parking (63,000 SF) $0.85/5F
Excavate Duct Bank $5,900,00
Patch pave AC outside pave area (500 5F) $8.00/5F

STANDARD EXCLUSIONS:

Any permits, fees, inspections, plans, bond premiums, soll testing, etc.

Amy hard rock excavation. (Hard rock Is defined as unable to be removed by CAT D6 or CAT 325
Excavator)

Any trenching for footings of bullding or masonry Structures.

Ay temporary fencing or trench plating.

Ary export of materials other than spedfically included offhauls.

Spoils over 12 In diameter will be offhauled at an additional agreed to cost.

Any structure demolition or removal, (Conarete, asphalt, fending, trees, bulldings, signs, masonry)
Ary and all landscape repadr, Installation, or removal

Ary storm water pollution préevention of erosion control unless spedifically mentioned.

Base rock under concrete wallways of buliding slab areas unless spedfically mentioned

Pl

S0 MmN,

—_
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Estimate's Package feature lets you pick all the cost items that belong to a particular package, then
assign the price to that collection of packages. It then proportionally distributes the total package price
across all of the corresponding cost items when comparing and awarding.

Quote Register Quote Record @
Header Total
Description: | Site work Optional Code: Extended Price:
Dater T Tem Taes:
Quate Tax:

Wendor: | Civiworks Inc. - Ven 07 @ (2| Vendor Name: |Civilworks Inc. Vendor Phone: 480 535 5698 Source: - —

Contact: | Civitworks Inc. — John Jacobs [-}E] First Name: | John Contact Office: Currency: | U.5. Dollar - Ttem Conditions:
Primary Email: jacobs jacobs @civilworks.com Last Name: |Jacobs Contact Mobile: Status: Received Special Conditions:
External Ref.c | Ignore: || Resson: Total

Resources | CostItems Packages
R Saved views: | Frevious Vew P rag coumms here to graup seved views: | prev
Code & Desaription Amount
Package = Code = gruu”ﬁ gg‘é]s”a' Description Na Split Duration Quantity Urit of Measure Urit Price E;‘E”dﬂ' Curre Pl Demo, Exav,Grading | $150,780.00
PR e —— P2 Assisted ParkingLot | §43,535.00
P1 13.1 131 Excavaton v 1 50,000.00 CubicYard p1 p1 stsp7enoo us| L Padig $133,000.00
P1 142 142 Finegrade Subgrade v 1 400,000.00  Square Yard Pl P1 us| *
P1 15 3034263 Asphalt Concrete Hot.. v 1 3500000 Ton PL PL us.
P1 16 13.1 Grading v 1 .00 Cubic Yard P1P1 us.
= P2 (Assisted Parking Lot)
P2 41 ProcessEqui.. 700 Process Equipment v 1 100 Each P2 P2 $43,535.00 US
P2 421 421 Remove & Dispase Co... v 1 200 Each P2 P2 us.
P2 5.1.1 0220 Site Preparation v 1 .00 Lump Sum P2 P2 us.
& P3 (Paving)
P2 17 13.1 Paving v 1 100 Cubic Yard P3 P3 $133,00000 US.
-
3

, | SpedslTerms .Conditions  Qualifications  Packages  Taxes VendorsProfie  Setup  Miority

Cancel New.

Step by Step — Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.
2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).
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Cost Breakdown Structure (CBS) Register Quote Register ©  Quobe Record

RFQ)

Descripkion . Descriplion
= Pipe Material
% | Pipe Materials

Pipe Materials
/2. | Pipe Materials

4. In the Description field, type in or replace the description.

5. Inthe Contact field, select a contact.

Qe
Status

Received
Received
Recsived

Examgle Vendor
Example Vendor
Example Vendy
Example Vendor

Cost Breakdown Structure (CBS) Register ©  Quote Register Quote Record ©

Header

Description: || Fipe Materials for site improvements.

Contact:| Example Vendor 1 - Pat Roberts

Compary Name: Example Vendor 1

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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REsoirCes Cosk I'tems

RO e e b e

Code Quite Growup
/& mPPI10 Pipe Materiak

MPP 24 Pipe Materials

MPR 15 Fipe Matenals

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost Items.

Dhesoripon

Pipe 10" PYC SDR21
Pipe 24" PYC SDR3S
Pipe RCP 36 In

10. On the Packages tab, enter the following 2 new records:

e Code: P1

¢ Description: On Site
e Amount: $200,000
e Code: P2

¢ Description: Off Site
e Amount: $300,000
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Cooe Desaophon
Pl On Site
= P2 Off Site

11. Type in P1 under Package for cost item 7.
12. Type in P2 under Package for cost item 8.

Resources Cost Items

to grofind; | [Search For...] = | Saved views: | Previous View
Package Code RFQID S‘Q"'u‘l‘: et
Pl 7 Pipe Materials 800 0220
# ez -|s Pipe Materials  BOO 0330
13. Select OK.

10 Inch PVC Force Main...
24 Inch PVC Gravity Se._.

Estimate Essentials User Guide

Amount
£200,000. 00
S300.000. 00
Packages
P2 Off Site s}ﬂﬂ,zzi

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

» Quote Comparison and Award shows the newly created quote with the associated

package quotes.
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oo v 1 e for s
Egoe et i el

T 82251 HF1 129000000 £ P1 $300,000.00 | P1  $200,000.00
T ssam S px000.00 &2 ua,m.uu.dﬂ' ,000.00
$428,694... §416,000.00 $425,000.00 | $500,000.00
SAIRE0 4 b, DeH EH) % 000, D ), D0 03
$AZR,694.. $0.00 $0.00 | $0D0
SA28,654... $416,000.00 $425,000.00 | $5000,0:00.00
$0.00 000 $40.00 $0.00
10/13/2009 41, 10/13/2019 44, | 11/13/2019 4:3...

e The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.
Example Vendor 1
Pipe Materials for site
Improvements.
________ L
PL  £200,000,
Eg ————————— % Award
P2 $300,000,
& = Award And Lock
Lock
Unlock
et Edit Quote
8.3.8.6 Taxes

Iltem Tax and Quote Tax have been combined to display on a single data block called Taxes. Using the
taxes feature allows you to add item taxes to each item's price. You can also add taxes to the quote.
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Taxes

Item Tax
Add Item Taxes to each Item's Price

Quote Tax
Add Taxes to the Quote

Taxes to be added to Awarded Total as a Percentage of Total:

Total Tax: [ 5450.00

Spedal Terms & Conditions  Qualifications  Packages | Taxes | Vendor's Profile  Setup  Minority

8.3.8.7 Seller’s Profile

The Seller’s Profile tab populates with address book notes and alternate contact information.

Vendor's Profile

Address Book Motes

Example....save for training as needed.|

Alternate Contact Information

[] Mame:
[] Email:
[] Phone:

[] Fax:
[] Mabile:

Spedal Terms & Conditions  Qualifications  Padkages  Tawes | Vendor's Profle | Setup  Minority

8.3.8.8 Setup

This tab provides extra space for any additional notes and tags to be assigned to the quote.
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Setup *
Current Status
RFQ Status:
Last Update: 5/5/2020 7:05:03 PM
Quote Origin: WMFarr
Tags
Tag 1: | Pipe
Tag 2:

Tag 3:

Motes

Spedal Terms & Conditions ~ Qualificatons  Packages Taxes Vendor's Profile Minority

8.3.8.9 Minority

This tab allows you to determine if the seller qualifies for any type of minority business, and the ability
to apply a certification number.
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Minority
Minarity Business Enterprise
[J#endor gualifies as the following type of MINORITY BUSINESS ENTERPRISE on this job:

DBE DBE Certification: [ |
MBE MBECertification: [ |
WBE WBE Certffication: [ |
OBE1 OBE1 Certification: |:|
OBE2 OBE2 Certification:| |
OBE3 OBE3 Certification:| |
OBE4 OBE4Certification:| |
OBES OBES Certification: |:|
OBE6 OBEG Certifications| |
OBE7 OBE7 Certification:| |

Special Terms & Conditions  Qualifications  Packages Taxes Vendor's Profle  Setup | Minority

52| Ifany of your Data Blocks become deleted on a Quote Record, simply click the
Default Data Block icon.

ate
L C

Refresh Default
Data Blocks

Tools View

8.3.9 Create a Quote from RFQ

Walk through the steps of creating a quote from an RFQ.

TIP To create a quote from scratch, click the New icon on the Quote Register and fill in the
guote details and seller fields manually.

Step by Step — Create a quote from RFQ

This exercise walks through a specific example using the Training Job.
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From the Estimate landing page, select the Quote tab.
Select Request for Quote (RFQ).

Open the RFQ record for which you’ve received quotes.

w0 o=

Select the Vendor Companies tab and select the vendors for whom you need to create quotes.
In this case, select all the vendors.

5. From the Actions menu, select Create Quote.
6. Click OK on the Quotes created prompt.
7. Close the RFQ record and the RFQ register.

8.3.10 Enter Quote Details

Now that you have quotes created, you can enter pricing.

Step by Step — Enter quote details

This exercise walks through a specific example using the Training Job.

To open the Quote Register, select Quote from the Estimate landing page.
Select Quotes from the Quote Management section.

Open the Aggregates Quote Record for Vendor 1 — Pat Roberts.

On the Resources tab, make sure No Split is unchecked for all items.

o k 0N~

Also on the Resources tab, enter the following unit prices:

MBR Aggregate Base Rock $8.00
MDIRTB Dirt Class B $6.00

6. Click OK to close the Quote Record.
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Step by Step — Create a multi-packaged quote

1. From the InEight Estimate landing page, select the Quote tab.
2. Click on the Quotes icon under Quote Management.

3. Double click on an item (e.g. Pipe Materials).

Cost Breakdown Structure (CBS) Register Quote Register O  Quole Record
Descrpton = T | Deserption Stahs | SO
= Pipe Materiak Received  Example Vendar
£ | Pipe Materials Recsived  Example Vendor
Pipe Matenals Received  Example Vendor
/% | Pipe Materials Received  Example Vendor

4. In the Description field, type in or replace the description.

5. Inthe Contact field, select a contact.

Cost Breakdown Structure ({BS) Register ©  Quote Register Quote Record ©
Header

Description: || Pipe Materials for site improvements.

Contact:]| Example Vendar 1 - Pat Roberts g

Compamy Mame: Example WVendor 1

6. Click OK

7. Select the Cost Items tab on the left side of the screen.
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HESOUr D& Coek Thems

Code Quaote Group
/& mPP10 Pipe Materialks

MPP 24 Pipe Materials

MPR 35 Fipe Matenals

8. Add a cost item under Cost Items.

9. Then, add another cost item under Cost ltems.

Estimate Essentials User Guide

Descrighon

Pipe 10" PYC SDR21
Pipe 24" P¥C SDR35
Pipe RCP 36 In

10. On the Packages tab, enter the following 2 new records:

e Code: P1

¢ Description: On Site
e Amount: $200,000
e Code: P2

e Description: Off Site
e Amount: $300,000
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Coode
Pl

Desorpton
On Site
OFF Site

11. Type in P1 under Package for cost item 7.

12. Type in P2 under Package for cost item 8.

Resources Cost ltems

to grofind: | [Search For...]

Paduage Code RFQID

P1 7

& P2 ~|B

13. Select OK.

Saved views: | Previous View

Quote Optional
Group Code

Fipe Materials 80D 0220 10 Inch PVC Force Main..
Pipe Matenals 800 0330 24 Inch PVC Gravity Se...

Description

8.3 Quotes
Ammournt
£.200,000.00
300,000, DD
Packages

Code Description Amount

Pl OnSite $200,000. 00

P2 Off Site 300,000, 00

14. Under the Quote Comparison and Award ribbon, select Cost Items.

15. Under Quote Groups, select Pipe Materials.

» Quote Comparison and Award shows the newly created quote with the associated

package quotes.
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e e e 1 for s
Frw Mateiain v e

T 83251 PP 85000000 HPL $300.000.00 |PP1 $200,000.00
T ssamsa e §1200000 P2 iLE..m.'.I.{H]..qF ,000.00
SA2B694. 5416,000.00 Hu.-llui 5500, 0:00.00
SAIR,604... 54 16,000 00 $4.25,000.00 5500, 000 00
$4TR,694... $0.00 $0.00 | $0.00
$428,694.. $416,000.00 $425,000.00 | £ 500, 00,00
$0.00 50.00 $0.00 50.00
1/A3/2009 &1...  11/13/2009 4ed... | 10/13/2009 43...

¢ The Package Price can quickly be modified in the Quote Comparison and Award form by
selecting the Edit Package action in the Actions tab or by using the right click context
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menu.

Example Vendor 1
Ppe Materials for site
mprowements,
. . . [ ]
|§ PL  $200,000.

% Award

P2 $300,000,
& = Award And Lock

Lock
Unlock
et Edit Quote

$500,000. Edit Cost tem

8.3.11 Use Unit Price or Extended Price on Quote Record Item

It's possible to enter the Extended Price for a Quote Item, and the Unit Price is then calculated, which
makes entering quotes more efficient and results in less errors.
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Optional Code:

H o [mmam oate
Mobile: Source:
Fax: 222-123-2134 Currency: | U.S. Dollar
Email: Status: Received
] tonore: 01

‘Special Terms & Conditions.

oot (e o <] | swrets soeca Tema condvons

o free  Awaded  Duraton | Quanity  Unitof Measure Unitprice | Extended Curency | Defat
/5 waam v 1 3500000 Ton $3800 $1,100,000.00 [UsS. Dolar L e o
T AsphaltMaterisk | Fine Aggregate v 1 186000 Ton .00 £13,020.00 |U.S. Dolar
>

8.3.12 Duplicating an Existing Quote

You can create a new quote by duplicating an existing quote from the Quote Compare & Award form.
Duplicate Quotes will contain the same scope as the quote that you previously copied.

Step by Step — Duplicate an existing quote

1. From the InEight Estimate landing page, select the Quote tab.
2. Select the Resources icon under Quote Comparison & Award.

3. Highlight any row under the Quote column you want to duplicate.

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Resources

Drag columns here to group Fing: | [Search For...] | saved views: | Standard Vien -
i

ndor 1| Exemple Vendor 2 Example Vendor 3 EX2mRle Vendor &

gesuurce = Desaripton Utiization Unit of Unit Cost Plug Detal
ode Count Measure (Seale 1) s Asphalt Materials Pipe Materials Pipe Materials
MAAM ‘Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 $3413 R @ $3150 & £35.70 3417 #3413
MAFA Fine Aggregate 1,850.00 Ton §7.25 $8.19 819 § & $7.25 & $7.35 $6.19 .19
| Ppe 10-PvC sDR21 <
MPP24 Pipe 24" PVC SDR35 3,000.00 et $22.05 $20.98 $20.45 $20.48 .48 & $50 §& $22.05
MPR36 Pipe RCP 361n 1,024.00 Linear Feet $32.55 $34.13 $34.13 $3413 $3413 & 43150 § & $32.55
‘Scope Items
‘Summary
Minarity Type DBE
Quoted Total $1,406,973.75 5000  $1,171,10070  $1,325,646.00 $266,616.00 $271,471.20
Comparzble Total < $1,40697375  $1,406573.75  $§1,308747.30  $1,463,29260  $1,53594315  $1,540,79835

4. Select the Actions tab.

5. Under the Quotes section, select the Duplicate Quote icon.
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B print G By QuoteGroup | G Set Al to Reviewed @ [ ooplcnte Quote | @3 Package Entre Quote | § Avard Lock 5 ©Quiedtons
N 74 &

R Preview 3 roups Set Al to Not Reviewed L4 2 Ignore Quote Edit Package Y& Award And Lock Unlock [I“ .u it Pric

EditResource Edit Quote i

Quote Group Status | Res

Quote Register Quote Comparison & Award - Resources  ©

Example Vendor 1 Example Vendor 4
stz

: ammmbe ey e ot Pt :::a‘.a: o
- .
wAFA Fine Aggregate 1,860.00 Ton §7.25 8.9 w19 3 & $7.25 59 57,35 .19 519
MPP1D Pipe 10" PVC SDR21 12,600.00  Lin $13.65 $3.28 $3.28 $2.28 .28 & 1260 § & $13.65
MPP24 Pipe 24" PVC SDR35 3,000.00 $22.05 20,48 $20.46 $20.98 0.9 & 2520 § & $22.05
MPR36 Pipe RCP 361n 1,02400 $32.55 $34.13 $74.03 $94.13 3413 & £ § @ $3255
Scope Items
Summary
Minority Typs DBE
Quoted Total $1,406973.75 $000  $1,171,10070  $1,325646.00 $266,616.00 527147120
Comparabie Totel < $1,40697375  $140697375  $1308,74730  $146329260  $1535943.15  $154079835

» The resources and prices from the quote you previously selected have been copied
into a new Quote Record.

6. From the Header block, enter in any missing information.
» The information listed in the Header block will not copy over to the duplicated quote.
7. Enter additional Cost Items in the Quote tabs data block.

o Check the default data blocks for any information you want to add to your duplicate
quote.
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Request for Quote (RFQ) Register Quote Register Quote Record @

Header
Description:  Asphalt Materials
Vendor: | <#Ad-Hoc Yendor = [+] E|I|| Vendor Name: Vendor Phane:
Contact: | <Ad-Hoc Contact> [+] i|I|| First Name: Contact Office:
Primary Email: Last Name: Contact Mobile:
External Ref.:
Resources | Cost Items |
Drag columns here to group Saved views: | Standard View
N - L Mo ) . ) . Extended
Code = Quote Group = Description Split Free Awarded Duration Quantity Unit of Measure Unit Price Price Currency
J4 MAAM Asphalt Materials Asphalt Mix (Finish) ] 1 35,000.00 Ton $30.00 §1,050,000.00 U.5. Dollar
MAFA Asphalt Materials Fine Aggregate ] 1 1,860.00 Ton $6.90 $12,834.00 U.5. Dollar
* (=] =] =]
Pl

8. Once done, click OK.
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Exercise 8.1 — Quote Management

When you receive quotes from vendors, you will need to record their pricing and conditions in their
Estimate quote records. In this exercise, you will practice entering quote details. Enter the following
guote record details, using the Training Job:

Quote Name: Seller Name: Example Vendor 2 - Stan Mark

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $7.45

MDIRTB Dirt Class B Not Quoted (delete)
Special Instructions Seller is NOT willing to split items.

Quote Seller Name: Example Vendor 4 - Lester Slim

Name:

Aggregates

Resource Description Unit Price

Code

MBR Aggregate Base Rock $8.15

MDIRTB Dirt Class B FREE

Special Instructions Seller is NOT willing to split items.

You should end up with similar results like below:

Description ER)Egcriphon Seller Contact Name IQ':t?atIe
Aggregates Aggregates Example Vendor 4 DBE -- Lester Slim Slim, Lester $408,834.56

Aggregates Aggregates Example Vendor 2 -- Stan Mark Mark, Stan $373,719.94

Aggregates Aggregates Example Vendor 1 -- Pat Roberts Roberts, Pat $402,192.00

Congratulations, you have completed this exercise!
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8.4 QUOTE COMPARISON & AWARD

Now that you’ve received quotes and entered pricing information, you will compare them to
determine which is the preferred vendor or contractor to carry their pricing in your estimate. The
Quote Comparison & Award forms improve visibility into comparative analytics, while increasing
efficiencies in populating the estimate with quoted values.

The Quote Comparison & Award screen is designed to closely match the layout of a vendor comparison
sheet. It's designed to show all scope items with prices provided by multiple vendors and substitute
pricing where items have been excluded.

Now that you’ve entered contextual quote information in the Quote Register, the Quote Comparison &
Award screen provides you with the ability to make better, and more efficient determinations for
awarding the quote.

8.4.1 Quote Comparison & Award Overview

To open the Quote Comparison & Award form, select Quote > Quote Comparison & Award.

Overview - Quote Comparison and Award Form

T T R

1 Resourceand  You can show either your quoted resources or cost items.
Cost Iltem Filter

2 Quote Group This section provides checkboxes to further filter your items. The

Filter Quote Group Filter allows you to mark the quotes as reviewed.
3 Quote Your quotes display with the vendor name plus the quote description.
D . R
Vgizgftlon and * Awarded items have an award symbol *
If an item is designated as No Split, it has a chain link icon ¢
* Awarded and Locked items have a lock symbol next to the award
i
symbol -
4 Cost Source The cost source can either be a Plug or Detail type.
Type

Page 364 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide

M =2

RequestFor  Quotes
Quote (RFQ)

||E 3 Quote Group Tags

@ Minority Setup
[@ Attachments

'y
&

Resources  CostItems

B

Reports

Address
Book
Setup Quote Management

Quote Comparison & Award Reports

Quote Comparison & Award - Costitems ©  Quote Register

8.4 Quote Comparison & Award

Quote Group(s) % [l brag columns here to group o o Find: | [Sez
L Desaption = Revizwed cBs . Forecast Unit of Uit Cost Total Cost P et Example Sub #2 Example Sub #1 ED Enonesmg
Electrical Work Pasition Cade (T/0) Quantity Measure (Forecast) Guard Rail Items Guard Rail Items Cnrn:rehe St
v Guardrail Wark 18 Guardrail Type 2 1,000.00 Linear Feet $24.00 (D $24,000.... §25,000.00 § & s200000 & $25,000.00 & $50,000.00
Sign Work 19 Guardrail Type 3A 200.00 Linear Feet $31.00 (D $6,200.00 $7,000.00 o0 § & $6200.00 & $6,000.00
Scope Items
- I [ [ N Y (N S R
e
Quoted Total $32,000.00 $0.00 $30,200.00 $31,000.00 $50,000.00
Comparable Total < $32,000.00 $57,000.00 $30,200.00 $31,000.00 $57,000.00

8.4.2 Edit Mode

You can make last minute modifications to the quote price directly in the Quote Comparison and

Award form.

When in Edit mode, the quote item's price, unmodified by the quote's bond cost or special conditions,
can be updated. You can modify the Unit price or the Extended price for each of the quote items that

are not part of the package or marked as Free.

The updates made to quote items in Quote Compare and Award will update the estimate in real time

allowing you to see the impact of the changes in the estimate.

Quote Comparison & Award - Cost items @

‘Quote Group(s)

100 Lump Eum 4$285,000.00 (0 $235,000.00 $275,500.00

Bectrical

Summary
Fnshes (o 9) Minerity Type

Fee Protecten Ouated Totel $3,656,700.00 5000 526500000 5252520000
Foundations Comparsbla Total < £3,656,700.00  §3,810,300.00 £2,810,300.00 £2,810,200.00

HUAG

Lancscaping Werk
Masonry
Plmbng

Rebar Inctall
Scaffolding
sheet et
Sitevork.

Steel

$543,567.00

$294,000.00
$2,819,200.00

$2,865,807.00
£2,865,807.00

8.4.3 Substitute Values

You can display a substitute value by selecting Actions > Substitute Values.

Notice the entered quotes. One of the vendors did not give pricing for three of the CBS items.
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HD Engineering
Group
Conrete, Sitework

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 O $24,000.00 £25,000.00 & $50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 O $6,200.00 £7,000.00
20 Type 4 Signs 1,000.00 SquareF... $15.00 & $15,000.00 § $15,000.00
27.1 Electrical Wark 1.00 Each £5,000.00 §5,000.00 § $5,000.00

When you compare this quote to the others, it can be difficult to see if the total cost of the quote is
high or low because it is missing some of the pricing. InEight Estimate can help you make an “apples to
apples” comparison by filling in a substitute price for items that are missing.

Duplicate Quote Package Entire Quote Award Lok '9 @ Quoted Items "= Zero Items f’ Configure Totals
5
Ignore Quote Edit Package Award And Lodk Unlock < Unit Price :j Scope Items Ih Set Substitute Ranking
Edit Quote Edit Prices —
B Substitute Values| (% Ignored Quotes Default Data Blocks
Quotes View

You can tell when it’s a substitute value because the price displays in italics.

HD Engineering
Group
Concrete, Sitework

18 Guardrail Type 2 1,000.00 Linear Feet $24.00 O $24,000.00 $25,000.00 & $50,000.00
19 Guardrail Type 3A 200.00 Linear Feet $31.00 O $6,200.00 £7,000.00 £7,000.00
20 Type 4 Signs 1,000.00 SquareF... $15.00 & $15,000.00 % $15,000.00
27.1 Electrical Work 1.00 Each £5,000.00 & $5,000.00 § $5,000.00

InEight Estimate grabs the substitute value from one of four places:

Awarded splittable quote

Lowest splittable quote you’ve received

w o=

Detail (this only applies to quoting cost items)
4. Plug cost (the rate defined for that resource in InEight Estimate)

You can set the order for a substitute value by selecting Actions > Set Substitute Ranking.

'q @ Quoted Items =1 Zero Items Z"} Configure Totals
G
(e Unit Price 5, scope Items [ Set Substitute Ranking
Edit Prices -
Bh substitute Values @ Ignored Quotes  [[TT] Default Data Blocks

View

On the resulting Substitute Ranking window, you can use the up and down arrows to change the
selection order. It will look from the top to the bottom of the list. The plug being in red represents the
most risk, while the Awarded Splittable Quote is the least risk. Users can modify the color coding of
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these Substitute values by navigating to System Customize dialog and then selecting Substitute Quote

Ranking in the colors sections.

Awarded Splittable Quote [ |
Lowest Splittable Quote F
Detail | |
Plug |
¥
oK Cancel

Note that the substitute values are color-coded so that back on the Quote Comparison & Award form
you can see the source that your substitute value comes from. When you hover- over a substitute
value it displays the vendor whose substitute value has been used.

Example Vendar 1 Architectural
Pipe Materials for site = Designs, Inc.
improvement 2 Electrical Work

¢ Pl £300,000.00
¢ P2 §125,000.00

WU

N

=)
54

HD Engineering Group
Lowest Splittable Quote

When you use a substitute value, it is included in your Comparable Total so you can have a more

realistic comparison of your quotes.
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= Print % Quote Groups | Set Al to Reviewed Edit Quote Lack Quoted Ttems Scope Ttems [ Set Substitute Ranking |-I-I-I ) Session Recap
B Preview ) Al Ttems Set All to Not Reviewed Award Unlock [Z] unit Price =) Ignored Quotes % Auto Award -
Edit Default
& Export to Excel Award And Lock Edit Package || B Substitute Values | 5% Configure Totals Data Blocks
Print Layout Quote Group Status Cost Ttems Quotes View Tools
Cost Breakdown Structure (CBS) Register Request for Quote (RFQ) Register Request for Quote (RFQ) Record Quote Register Quote Comparison & Award - Cost items @
Quote Group(s) X Drag columns here to group Find: E
- Desaription = REeied ces FreTe - ?}éf“ g;‘“ Unit Total Cost £ et Example Sub #2 Example Sub #1 H? EEQ‘"EE”"Q
Electrical Work Position Code Quantity o Cost (Forecast) Guard Rail Ttems Guard Rail [tems Conerete, Sitework

Electrical work 2 _Ic.:-bﬂ'rwez 1,000.00 Linear.. $24.00 (O $24,000.00 $25.00 2500 | § & $24.00 7 $25.00 _
Blectrical work 3 19 GuardrailType3a 20000 Linear.. $31.00 ¢ $6,200.00 $35.00 gm0 B $3L00 @ so.0 [

v Guardrail Waork _lrnlnnml- 1.00 Each $40,00... O $40,000.00 $25,000.00  §25,264.55 % & $40,000.00
Fipe Materials SremEs
" SignWork "
Vinorty Ty |
Quoted Total $57,000.00 $25,264.55 $30,200.00 $71,000.00 _
[ Comparabie Total <] $57,000.00 $57,264.55 $55,464.55 $71,00000 | $82,26455
Awarded Total $0.00 $0.00 $30,200.00 $40,000.00 _
Quoted Items Total $57,000.00 $25264.55 $30,200.00 $71,000.00 _

Spedal Conditions $0.00 $0.00 £0.00 $0.00 _
> Last Update 7/29/2000 2:21=... 11/13/2019 9:0... _

8.4.4 Display Ignored Quotes

You can view ignored quotes by selecting Actions > Ignored Quotes.

You can ignore a quote by right clicking on the subcontractor header, then selecting Edit Quote.

Example Vendaor 1 Example Yendor 4
Pipe Materials for site DBE
improvements Pipe Materials

Example Vendor 2
Asphalt Materials

Award
T Award And Lock
Lock

Unlock

& §13,671.0

Edit Quote

| e |
-
P
(-

Duplicate CQuote

LT
.x-,__!i

b

Ignore Cuote

5

L

Package Entire Cuote

D Edit Package
$1,325,646.0]

%1,463,292.6/

£

Edit Resource

N
Z;E;

From the Quote Record screen, select the Ignore check box and also a Reason, then select OK.

Page 368 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide 8.4 Quote Comparison & Award

Currency: | LS, Dallar _
Status: Ignored
Ignore: Reason: =
M Description
Packages
IDn Mot Lse
Drag columns here to grd Non Compliant -
end Code = De
e
%.
)

Al If the quote record is already awarded, you will not be able to select the Ignore option.

If the Ignored Quotes button is pressed, the ignored quote will display in grey. An ignored Quote
cannot be awarded. The ignored quotes get appended to the right end of the QC&A form.

: Award ﬂ Lock 'o Quoted Items =1 Zero Items f‘ Configure Totals O Session Recap
-
:h Award And Lock E| Unlock [l Unit Price Cj Scope Ttems Ih Set Substitute Ranking % Auto Award ~
Edit Prices . —
Ba substitute Values @ Ignored Quotes | Iff] Default Data Blocks
View - Tools -
pte Comparison & Award - Costitems @ \ -
Find: | [Search For...] =d views: | Previous View -
Unit of Unit Cost Total Cost Detai Example Sub #3 Example Sub #2 Example Sub #1
Measure (Forecast) Sign Items Guard Rail Items Guard Rail Items
Linear Feet $24.00 (D $24,000.... $25,000.00 $25,000.00 $25000.00 § & $24,000.00
Linear Feet $31.00 (O $6,200.00  £7,000.00 $7,000.00 $7,000.00 § &  $6,200.00
Square F... $13.00 (D $13,000.... $15,000.00 $13,000.00 | & $11,000.00 £13,000.00
%
£500.00
%
%47,000.00 $0.00 $11,000.00 $30,200.00
%47,000.00 %45,000.00 %43,000.00 $43,200.00
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8.4.5 Export Quote Comparison and Award to Microsoft Excel

The Microsoft Excel file generated when you export the Quote Comparison & Award form closely
resembles the form in Estimate, so users of this output can more clearly understand what the
estimators knew when they made determinations on which numbers to carry.

File Home  Insert Page Layout Formulas  Data  Review  View  Automate Help  Developer © Comments 3 Share ~
< = i) AustaSum = A 0 &
i L cut Calibe - AN E=E - [EBWeeet Generel - B B B == E é\mSun v O @ 5
e Fill ~
Pase LIPS Bl I u- e A |l=Z=== — § - 9 9 |4i gy Conditionsl Formatas Cell | Insen Delete Fomat Sot& Find& | Analyze | Sensitivity
« < Format Painter — sl - | =S =|E Formatting ~ Table~  Styles ~ « v v | @O~ Fiter~ Select~ | Data -
Clipboard Ll Fant Numbér s Stybes Cells. tarting Analyss Sensitivity ~
a1 cas v
E F G H [ ] [3 L M N [a]
Total Cost 1_Vendorl ‘Cooper Outdoor Advertising Inc WonderBoyB WonderBoyB
1 | unitcost |- (Forecast) = Plug - Detail | Guard Rail items = Guard Rail Items ~ Guard Rail Items ~ | Guard Rail Items -
2| 524,00 $24,000.00  $25,000.00  $25,000.00 § & $24,000.00 7 71 52421875 $562,344,000.00 ¢ $562,344,000.00
3 s31.005 $6,20000  $7,00000 5700000 & & $6,200.00 7 11 $6,781.25F $145,272,200.00 & $145,272,200.00
4
5
&
7
8 $0.00 $0.00 $30,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
] $0.00 $0.00 $0.00 $0.00 50.00 $0.00
10 $0.00 $0.00 $0.00 50.00 $0.00 50.00
11 $0.00 $0.00 $0.00 $0.00 $0.00 50.00
12 $0.00 $0.00 $0.00 $0.00 50.00 $0.00
2 $32,000.00 $0.00 $20,200.00 $31,000.00 $707,616,200.00 §707,616,200.00
14 $0.00 $0.00 $0.00 50.00 50.00 50.00
15 $32,000.00 $0.00 o $30,200.00 $31,000.00 $707,616,200.00 $707,616,200.00
16 $0.00  $32,000.00 $0.00 50.00 $0.00 50.00
17 $32,000.00  $32,000.00 $30,200.00 $31,000.00 $707,616,200.00 §707,616,200.00
18| $0.00 $0.00 $30,200.00 50.00 $0.00 50.00
12 5/11/2023 2:38:01 AM 7/24/2023 11:24:01 PM 6/2/2023 12:29:38 AM 6/2/2023 12:37:37 AM
20
21
2
a| -
Formatted Data | Raw Data 3 [ v
Ready T Accessibinty: iwestigate B B M -—— o

The Quote Comparison & Award form changes frequently in the closing hours of a bid, which can
prompt estimators to keep track of what the subcontractor and supplier quotes might have looked like
at any point throughout the bid closing. Some estimators rely on such bid leveling information but do
not want to access live information directly in the application, making it crucial to produce an identical
output file of the Quote Compare & Award form at any given time.

To create the Quote Comparison & Award Excel file, click on the Export to Excel icon. Enter a file name
for the Excel file, and then click Save.
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Estmate B Frice st e fctons _

= Print (4 ByQuoteGrowp G g'. 2 Duplicate Quote e © Al Items [£2] urit Price Scope Iter

B, Preview 3 All Quote Groups | @& w: & Ignore Quote el (2 Quoted Items B2 Substitute Values (% Ignored Q
o Edit Resource | Edit Quote Edit Prices

& Exportto Excel | 37 All Quote Items (O Unquoted Items | 127 Zero Items $% Configure

Layout e Resources View

° Export spreadsheet to.. X Baved views: | Standar

1+ ¥ 5 ThisPC » Downloads [ Search Downloads

Organize ~ New folder = - (2]

iF OSDisk (C) # ™ Name Type Size A

GitProjects £ Yesterday (2)

£ InEight Control Columns List.xlsx’ Microsoft Excel Work... 47
@ improved.xlsx ! Microsoft Excel Work... 16
~ Last week (1)

@ Contacts_09142023051609.xIsx Microsoft Excel Work... 10

File name:

Save as type: | Excel files (*xlsx)

~ Hide Folders

8.4.6 Additional Quote Comparison and Award functions

The Quote Comparison and Award form contains other notable functions which improves the process
of selecting the quote that brings the greatest value to the estimate.

Overview - Additional Quote Comparison and Award Functions

T T R

1 Asterisk nextto  An Asterisk (*) is displayed on a quote to indicate when that quote

Quote Item includes quote items appearing in other Quote groups.
2 Zero value Award quotes to Plug or Detail when its value is zero.
Plug/Detail
3 Updated Quote  Quote Item Tool tip displays details including:
Items Tool tip e Unit Price
» Extended Price
* Bond
o Taxes
» Special Conditions

an indicator for a delta quote item

InEight Inc. | Release 24.7 Page 371 of 417



8.4 Quote Comparison & Award Estimate Essentials User Guide

Quote Comparison & Award - Costitems ©

e o graup Find: | [SearchFar..] | Saved views: | Prevous vew
vhcaet = of aet Ca# Concrete i Horin Concrete N
Desaoton CRrgmowty  vemee MOt SR A et Conuton, . G e Gy | e
Formwork. 100 Lump Sum $2,399,113. O $2.39,11070  £,281,200.00 & 852520000
place and finsh 100 Lump Sum 0o 2 woo  prssmnlf oo ls $205,000,00 &  $294,000.00
Scope Items
—— 2
Moarity Ty
s B D D
Quoted Tomsl $3,656,700.00 $0.00 $285,000.00 $2.525,200.00 $294,000.00

I o T T T R R R o T

8.4.7 Configure Totals

You can display and sort additional Summary Totals, Special Conditions, and Last Updated fields by
selecting Actions > Configure Tools.

@j Configure Totals - O x

Caption Visible Sort

= Seller v Mone
Quote Description o Mone
Minarity Type o Mone
Motes V' Mone
Extended Price Mane
Item Taxes Mone
Quote Tax Mone
Bond Mone
Item Conditions Mane
Quoted Items Total Mone
Special Conditions Mone
Quoted Total v‘ Mone
Substitute Values Mone
Comparable Total v‘ Ascending
Awarded Total Mane
Last Update Mone

Al Y
Options

Location: () Tap (®) Bottom
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The Options radio button give you better control for viewing totals at the tops of the screen or after
the quotes.

After selecting additional captions, the new fields appear at the bottom of the Quote Comparison &
Award screen. Notice that the caret symbol next to the Comparable totals in the below screenshot
indicates that the Quotes are sorted based on Comparable totals in an ascending order.

CEBS

Position Code Description
18 Guardrail Type 2
19 Guardrail Type 3A
20 Type 4 Signs
Scope Items
Mabilization
SurveyLayout

Temporary Traffic control de...
Summary

Minarity Type

MNotes

Extended Price

Item Taxes

Quote Tax

Bond

Item Conditions

Quoted Items Total

Special Conditions

Quoted Total

Substitute Values

Comparable Total <

Awarded Total: $43,200.00

Last Update

8.4.8 Adding Notes to Quote Comparison & Award

The Notes feature within the Configure Totals tool, allows you to quickly add, edit, and view notes for a
guote in the Quote Comparison & Award form. Having visibility into the notes such as phone
conversations with vendor/supplier, quotes that need clarification, or notes on other attributes will
help you in making better decisions on who to consider when awarding a particular quote.
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Step by Step — Add the Notes section to Quote Comparison & Award form

1. From the InEight Estimate landing page, select the Quote tab.
2. Select the Resources icon under Quote Comparison & Award.

» Notice the absence of the Notes section. This is the default option until you follow the
next steps.

Select the Actions tab.

4. From the View section, select the Configure Totals icon.

B 2 oy Quote Grop | G2 et Al toRevewed e 2 Duplcate Quote | @ Padge Entre Quote | 3 Averd o o Damsites  mretes [P otoretods | | O sesmrean
- 2 , & =
& preview B Al Quote Groups | 3 Set Al ootrevined | B B tgnore Quote Eatpodkace award Aok | (5 unock | (1 Unitprice Sotima] [ setsbsteranng | 3 Auto Award
Satresource carquore [
@ Export toExcel | &3 All Quote Ttems B Substiute Vaues 2 lonored Quotes [ Default Dota Hodks

print Layout Quote Group Status | Resources Quotes View Tools
BS) Register i & Award - Resources ©
Drag coumns here to group Find: [ BearchFor..] |  Saved views: | Previous View
Exampie Vendor 1| Example Vendor 4
BRI L coamen = wes s S cmma IR G
maAM ‘Asphalt Mix (Finish) 36,750.00 Ton $31.50 $34.13 $34.13 R $3150 & $35.70 $94.17 $3013
PP 10 Pe 10"PYC SOR21 12,600.00 Linear Feet 1365 5.8 $228 s228 5328 & s2e §&  s1365
MPP24 Pipe 24" PVC SDR3S 3,000.00  Linear Feet $22.05 s20.98 s20.48 $20.48 s @ 250 § & $22.05
MPR36 PipeRCP 361 1,024.00 Linear Feet $32.55 $34.13 9013 $3413 $34.13 @ 150 § @ $32.55
Scope Items
Summary
Minority Type oBE
Quoted Total $1,406,973.75 5000 $1,17110070  $1,325646.00 $266,616.00 $271,471.20
Comparable Total < 5140697375 $140697375 5130874730  $146329260  $153594315  $1,54079835

5. Select the check box in the Visible column for the Notes caption.
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Caption

Seller

Quote Description
Minority Type

-

Extended Price
[tem Taxes

Quote Tax

Bond

Item Conditions
Quoted Items Total
Spedal Conditions
Quoted Total
Substitute Values
Comparable Total
Awarded Total

A Y

Options

Location:

QO Top

6. Select OK.

Configure Totals

Visible

8.4 Quote Comparison & Award

B IESUESHES

(®) Bottom

Mone

Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Ascending

Mone =

Cancel

» The Notes section displays on the Quote Comparison & Award form.

& Award - Resources ©

B5) Register
Drag columns here to group
Resource pescr
= escripton
MaAM Asphalt Mix (Fiish)
MaFA Fine Aggregate
P10 Pipe 10°PVC SDR2L
P24 Pipe 24°PUC SDR35
PR3 PpeRCP 36 In
‘Scope Ttems.
Summary
Minorty Type

Utizaton  Unitof Uit Cost

Measre | (Scdle D) 62
3675000 Ton s150 s
135000 Ton 725 w19
1260000 Lnear Feet s13.65 £
5300000 LnearFest 2205 £
1,020 e Feet s2.55 41

Detal

Find: | [search For..]

-] saved views: [ revious View -

Example Vendor 1

Example Vendor 4
Pipe Materials for site | DBE

Example Vendor 1 Example Vendor 2

Aaphaltvaterds  Acphaltvatends | PP Neterink N
7417 § & $3150 & $35.70 $94.17 $34.13
819 2 & $7.25 & $7.35 $8.19 $8.19
$3.28 $3.28 $3.28 & $1260 % & $13.65
2.4 2.4 w48 @ 2520 § & 52205
$34.13 $34.13 9413 @ 5150 § & $3255

3

| e e w1~ NS Y I T - N
Quoted Total $1,406,973.75 $0.00 Example Note| 5.00 $266,616.00 $271,471.20

Comparable Total
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< $1,406973.75

$1,406973.75 260 5153594315 $154079835
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8.4.9 All Quote Groups Layout

The All Quote Group icon, located within the Quote Comparison and Award ribbon, allows you to see
all the quote groups at the same time.

Estimate Quote Execution System

Integrations

= Print 3 By Quote Group | 2 Set All to Reviewed ET’ @ 25 Duphcate Quote | (%3 Padkage Entire Quote
", Preview o5 All Quote Groups | T Set All to Not Reviewed 0 lgnore Quate | [T Edit Package
EditCost | Edit Quote
Ef Export to Excel | 5} All Quote Items Ttem
Print Layout Quote Group Status Cost Items

Quotes

You can make appropriate quote group selections based on understanding how choosing a quote
group impacts the entire estimate. In addition, the quote groups layout provides you with the visibility
and flexibility in aligning scopes, and being able to perform an efficient comparison of various quotes.

Features of this layout include:

Overview - Quote Groups Layout

I T S

1 Totals per Quote Ability to see the Awarded Total Plug, Detail and Quote amount per

Group Quote Group
2 Total Awarded Visibility into the Total Awarded Amount per Quote Group
Amount

3 Comparable totals  Better visibility into the Comparable totals per Quote Group

4 Expand/Collapse Expand/Collapse individual or All Quote Groups to display the
guote items
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& print (3 By Quote Group | §% & N @ 52 Duplicate Quote | (%3 Package Entire Quote % Award =1 s ( Quoted Ttems =7 Zero Ttems
% Preview 2 All Quote Groups b " z Ignore Quote Ef’_'.‘ Edit Package ﬁ Award And Lock E| el Unit Price ] Scope Items
Edit Resource | Edit Quote Edit Prices
& Export to Excel | 525 All Quote Items B2 substitute Values (% Ignored Quotes
Print Layout Resources Quotes View
Cost Breakdown Structure (CBS) Register Quote Comparison & Award - Resources @
Drag columns here to group Find: | [Search For...] Saved views:
Quote Group = Plug Detail Quote Quote Group Total
= i= Asphakt Materials $0,00 $0,00 $1,171,100,70 $1,171,100,70 o
Coe = Descrpton St e e ) g e Moot ateds hophat Mt
MAAM Asphalt Mix Finish) 36,750.00 Ton $31.50 §34.13 $34.13 8 & $31.50 & 435,70
MAFA Fine Aggregate 1,850.00 Ton §7.25 $8.19 @819 8P $7.35 & $7.35
Scope Ttems.
Summary
Minority Type
Quoted Total o $1,269,327.15 50.00 $1,171,100.70 $1,325,646.00
Comparable Total < %1,269,327.15 $1,269,327.15 $1,171,100.70 %1,325,646.00
o I Awarded Total: §1,171,100.70 $0.00 $0.00 $1,171,100.70 $0.00
Evupe Materials 80,00 $0.00 §271,471.20 $271,471.20
Resource . Desciption Utilization Unit of Unit Cost. Plug Detai Example Vendor 3 E’éamPlE Vendor 4
Code Count Measure (Scale 1) Pipe Materials Pipe Materials
MPP10 Pipe 10" PVC SDR21 12,600.00  Linear Feet $13.65 $3.28 328 @ s1260 § & $13.65
MPP24 Pipe 24" PVC SDR35 3,000.00  Linear Fest §22.05 §20.48 $20.48 | @ 2520 % & $22.05
MPR36 Pipe RCP 36 In 1,024.00 | Linear Feet $32.55 §34.13 $34.13 | @ 3150 § & $32.55
Scope Items
Summary
Minority Type o DBE
Quoted Total $137,646.60 50.00 $266,616.00 $271,471.20
| Comparable Total < $137,646.60 $137,646.60 $266,616.00 $271,471.20
Awarded Total: §271,471.20 %0.00 0.00 %0.00 $271,471.20

E

You can scan through all the quote groups in the estimate and see if you are carrying the most
appropriate quote. You can also review the Totals per Quote Group and better analyze the risks in the
estimate based on whether the cost is a plug number, detailed estimate or a quoted value.

8.4.10 Compare and Award Quotes

To award an item, right click on that item and select Award.

Example Sub #3 Example Sub #2 Example Sub #4 DBE
Guard Rail Items Sign Items

Sign Items

$25,000.00 % & $24,000.00
$7,000.00 § &  $6,200.00

£25,000.00
£7.000.00

$11,000.00 -

Award And Lock

Lock
$500.00
Unlock
(<} Edit Quote
&5 Duplicate Quote
% Ignore Quote
%% Package Entire Quote

Edit Package

$0.00
$0.00 & Edit Cost ltem

DBE

T
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The Award icon displays next to the awarded item(s).

Example Sub #2
Guard Rail Items

£24 000.00
$6,200.00

Once you award a quote in InEight Estimate, you can see it adds the Awarded Total on the comparison
screen, and the pricing updates automatically in the Cost Breakdown Structure.
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CES Forec... Unit Total

Position Code Description gdfaog :12 ggistt %Foosrin:a Plug Detail EﬁZTdDIREaﬁL}?::mi Eﬁaal;nclla Eaﬁ%?::r;;
17 Toll Booth 1.00 Each $40,000... (O $40,0... £25,000.00  §25,264.55 % & $40,000.00
18 Guardrail Type 2 1,000.00 Linear ... $25.00 (O $25,0... £25,000.00 & £24,000.00 § & $25,000.00
19 Guardrail Type 3A 200.00 Linear ... $30.00 (O $6,00... §7,000.00 £7,000.00 | & $,200.00 § &  $6,000.00
20 Type 4 Signs 1,000.00 Square... $15.00 & $150... § $15,000.00
27.1 Electrical Wark 1.00 Each $5,000.00 % £5000.. §  %5,000.00
Summary
Minority Type
Quoted Total $77,000.00 $25,264.55 $30,200.00 $71,000.00

Comparable Total %99, 764.55

$72,964.55

Awarded Total : ]
Quoted Items Total $77,000.00 $25,264.55 $30,200.00 $71,000.00
Spedial Conditions $0.00 $0.00 £0.00 %0.00
Last Update 7/29/2009 2:21:... 11/13/2019 5:0...

Jleg= You can award multiple Quote items by selecting all the items and then using the right
click context menu to award.

8.4.10.1 Open Status

If a quote is yellow, this indicates that the quote record is open in another screen. Closing out of the
guote record, will turn the record back to gray.

Drag columns here to group Find: | [Searc
AR R
Conerete, Sitework
18 Guardrail Type 2 1,000.00 Linear Feet $24.00 (D $24,000.... £25,000.00 5 & s2a00000 & $25,000.00 |2 £50,000.00
19 Guardrail Type 34 200.00 Linear Feet $31.00 (O $6,200.00 £7,000.00 700000 § &  $620000 & $5,000.00 £7,000.00
Scope Items
Summary
Minority Type
Quoted Total $32,000.00 %0.00 5$30,200.00 531,000.00 $50,000.00
S Comparable Total < 432,000.00 %57,000.00 $30,200.00 531,000.00 457,000.00

8.4.10.2 Award Status

The Award Status indicates whether or not all quotes are awarded within a quote group.

Quote Register Quote Comparison & Award - Costitems ©
Quote Group(s) || brag columns here to group
S]  |Desal.Z  [Revewy | g - ntcost | ol Cost lo o] Exapesb 2 DampeSbsl  Examplesub 40 D D Lo Example Sub 3
7 e Postion Code (Forecast) GuerdRailtems  GuardRailtems  Sgnltems Con i D e | Sign tems
i o= T (| )| (e
7T Sonvierk 18 Guardrail Type 2 $2500 O $25000.00  $25,000.00 &
19 Guardrail Type 3A $3000 OO $6,000.00  $7,000.00 w @
20 Type 4 Signs s15.00 ¥ $15,000.00  $15,000.00 & Off $300,0
271 Electrical Work 100 Each $5,00000 & 500000 $5,000.00 & $3,500.00 & £3,700.00
B Summary
Minority Type oBE
QuotedTotal $77,00000 52526455 $30,200.00 $71,000.00 $13,00000 $4450.00 $50,000.00 $4,200.00 $300,000.00
ComparableTotal < $77,00000  $98,764.55 $71,964.55 $87,500.00 $98,764.55 $98,76455 $98,764.55 $98,964.55 $385,764.55
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8.4.10.3 Review

You can keep track of what quote groups have been reviewed by checking the Reviewed check box.

Quote Group(s) *
b Description = Reviewed
v Electrical Waork:
v Guardrail Wark o
«f Sign Wark:

This can be helpful when there are many quotes to track and several users managing them. If any
changes are made to quotes within a quote group after the quote group is marked as Reviewed, the
guote group will be highlighted in yellow to indicate something changed since the last review.

Quote Group(s) 4
W Description = Reviewed
v Electrical Wark
v Guardrail Wark v
o Sign Work

Once reviewed again after the changes, you can uncheck and check the Reviewed checkbox again to
indicate it is up to date, and the yellow highlighting disappears.

The following steps walk you through comparing and awarding the Aggregate quotes.

Step by Step — Compare and award quotes

This exercise walks through a specific example using the Training Job.

1. From the main Estimate landing page select Quote>Quote Comparison & Award.

2. Select Resources on the Quote Comparison & Award ribbon.
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System Actions

R T

Resources | Cost Items Reports

Quote Comparison & Award Reports

Under Quote Groups, select Aggregates.
4. Review the quotes to determine the lowest bidder:
e MDIRTB is marked as Free for Example Vendor 4 and their quote is not splitable.
¢ Vendor 2 Stan Mark did not give a quote for MDIRTB, so a substitute value is being used.

5. Vendor 2 has the lowest comparable amount for MBR Aggregate Base Rock and Vendor 1 has
the lowest comparable amount for MDIRTB, so you decide to award each respectively. Award
each of them by right-clicking on the value and selecting Award.

6. On the attention prompt click Yes.

8.4.11 Package Entire Quote

The Package Entire Quote function allows you to mark an entire quote as a package. This is beneficial if
you are attempting to quickly update an existing detailed quote to a lump sum quote from the Quote
Record or Quote Compare and Award form.

G et All to Reviewed M' @ & Duplicate Quml (%2 Package Entre Quote I: Award i Lock & () Quoted Ttems [Ef Zeroltems 57 Configure Totah 1) Session Recap
(3 Set All to Not Reviewed &7 Ignore Quote. %y Edit Package: o Award Andlode | ) Unlock L [EZ] unit Price 17, Scope Ttems. b Set Substitute Rarking | § Auto Award =
EditCost | EditQuote Edit Prices
Tem B substitute values (%) lgnored Quotes [T} Default Data Blecks
Que » status Cost Ttems Quotes view Toals
Quote Comparison & Award - Cost tems &
here to group Find: | [Search For...] ~|  Saved views: | Previous View
Bar
s = Farscast Uit of Total Cort Farmon Contructon  Eagle Conersta Cormp
Positon Code Descry Ser (T/0) Quantity  Measure LM Cant: (Forecast P et Concrete, Sitework | Conaete, Stewark | oo
a1 Sidewaks 4,54.00 SQFT 089 & n9m07 $99939.07 § $44,939.07 @PL 520600000 FPL $22,500.00 &Pl
312 Vb .00 LF $34.51 & §1,725.32 $1.72532 |} $,72532 @R f&n en &
313 Curb and Gutter 1,2.00 LF sa51 8 $43,133.12 13,133.12 | § $43,13312 £P1 &rn P & i
Unlock A
314 Valley gutter S0.00 LF $34.51 3 §1,725.32 3 8. % s1L7s32 &p &rn @rn &
@ Queot:
315 Handcap ramps. 152,00 SQFT 08 8 sy 157,47 | $157247 £P1 &r e @F ;"'tl_'“‘”
» Duplicate Quote
316 Truncated domes 100 Lump Sum $25,000.00 & §25,000.00 § $25,000.00 $25,000.00 @ PL &P @n @ P 5
317 Flow thru planter sisb 15.00 LF 204 & s1200546 w % $12,00546 & P1 &r &
3.18 Flow thru planter wals 15.00 F .04 & $12,005.46 % 51200546 @ FP1 &r @r
319 Median Infil 2500 oy $i.02 8 £,230.60 m2m60 §  $9,230.60 @ FP1 &n
2110 Rolled arb adjacent to 000 F s3451 8 172532 ¢1,725.32 §  $1,72532 @R et
3l Reinforcng 261240 b 3450 & §12,00000 § $12000.00 $1,306.20 & Pl &ri
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8.4.12 Incomplete Quotes

The Incomplete quotes status indicates if a quote includes quote items that do not yet have a price.
This is often the case when vendors respond to an RFQ expressing interest in bidding but do not
provide their prices until right before the bid is due. These quotes display in gray in the Quote Compare
and Award form.

Duplicate Quote Package Entire Quots Award o » (2 Quoted Ttems 1= Zero Items $% Configure Totals ) Session Recap
d Tgnore Quote Exit Package Award And Lock I Urit Price [ scopettems [} SetSubstitute Rarking | § Auto Award -
ARCRa: | o= EARPCES | B o petiute Vakies () lonored Quotes | B Defauit Data Blocks
Cost Items Quotes View Tools

Quote Comparison & Award - Cost items ©

[ Cp—— Find: | [Search For...] ~| Saved views: | Previous View
ncon = Dot oy |are  [mem | PHOR ag i (o [y (" S
411 MU Wals 100 | Lump Sum §485,922.27 (O  $485,922.27 $400,000.00 $%00,000.00 § & P1 $512,648.00 |2 $526,724.53 | 2 P1  $766,352.00
412 Precast Concrete Caps 1.00  Lump Sum $14,577.67 O  $14,577.67 $12,000.00 sizovo.oo % £m l® $12,375.47 | & m1
413 Stee| Embeds 1.00 | Lump Sum $12,148.06 O $12,148.06 $10,000.00 sig,o00.00 § &P1 > $0.00 |2 P1

Scope Items
Demolition u] o o
Caulking, Sealants & o o a
Scafolding u] o a
Shoring/Brading $15,000.00 $12,000.00 o |
Testing/Inspection o o u]
Summary
Minarity Type HMBE
Hotes 15 | || k|

Incomplete Quotes that are Scope Only can be viewed in the Quote Compare and Award form using
the Zero Items toggle. These are quotes that have none of the Items priced. These quotes are
displayed to the right of all the Comparable Quotes.

(3 ByOmtcGow | £ SctAl toReviewed Cuplicate Guots Packege Enfire Quote Award Lock s 2 Quoted Ttems I [T Zero lioms I 5 Confoure Totals ) Session Recen
@@ ellquote croups | (5 set Al o ot Reviewsd Ignore Quots Edit Package. award Ard Lock Uninck L [E] critence 7] stope ttems setsibstmute Raneng | R Aum Award -
- Edit Cost Edit Quote EdtPrices
3 All Quote Ttems Tiem B Substitute Yabies ) Ionered Quotes [ -fault Data Blocks
Layout Quote Group Status | CostTtems Quotes View Tools
Cost Breakdown Structure (CBS) Register ©  Quole Comparison & Award - Cost items  ©
Quote Group(s) X || oragcolumins here 1o groun Find: | [eaichFor., ] ved views: | Previous View
- oo cBs (et Unitcf Total Cost Natomas Mascnry, Inc. | P CosIuebon |y quis Masarry
- DEsCTipton o " Unit Cost - £l Detal s Besonrye & | e, =
Conrete, Pracast Fosition Code z gruar{m Weasure g = Wason'y = Masonry
Concrete, Sitework LSS oMU Wals 100 Lump Sum $1.879,709.33 € $LET.702.33  $4,900,000.00  SLT08,E25.67 R &F P1 $512.64800 & PL $766,552.00 |2 $0.00
e 412 Precast Conerztx Cas 100 Lump Sm $iMe82.67 O SIT066267 $12,000.00 sizoo0.00 RSP &r1 & $0.00
Zoocsamnaare: 413 Steel Embeds 100 Lump Sum $1M0,062.57 2 $170,6€267  $10,000.00 s106000.00 | SP1 Fr1 & 0.00
Eectical Scope Itams:
Frishes i 9) Damalitin o o
Fre Protection Cauking, Sealans & Backer Rod o o
Foundation Scakddin o @
Shoring Bracng £15,000.00 o
Tesiing/Inepection o a
‘. L ST
Plumbing Minority Type (] MBE
Rehar Install Mot 0 o O
Scaffoiding Guoted Tetal $4,422,000... $1,708,826.67 $512,648.00 $574,764.00 $0.00
Sheet Metd > Comparable Total K $4,422,000... $1,730,826.67 $512,648.00 4574,764.00 $1.730RI6.67.
Sitenerk
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8.5 SCOPE ITEMS

During the bidding process, it’'s common for subcontractors and suppliers to provide a quote(s) for
work during the tail end of the bidding process. These last-minute offers make it extremely difficult for
you to evaluate and compare the various quotes and your ability to award them. With scope items,
you can create and evaluate checklists and quote group exclusions, and account for them within the
Quote Comparison and Award form.

You can view scope items as a checklist of items that break down the quote’s scope of work into
individual tasks to aid in the process of evaluating subcontractor and supplier quotes in greater detail.
This can be used to ensure that certain items of work are included or excluded. If excluded, the scope
items need to be properly accounted for by contractor awarding the quote.

Overview - Quote Record - Scope Items

Seller’s By default, all scope items are considered included in the quote, and the Special
Special Conditions amount is $0.00. On the quote record, by selecting the checkbox, you
Terms & can indicate scope items and uncheck items that are not included. The amount

Conditions  associated with these items will then total up in the Special Conditions subtotal.
The person responsible for awarding quotes needs to update the Inclusions field
to correspond with what the subcontractor has agreed to include in the quote.
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Special Terms & Conditions

x
Quote Tax Itemn Tax
Add Taxes to the Quote: (0 Yes (@) No Add Item Taxes to each item's price
TAXES to be added to awarded TOTAL as a % of total :
Tax Rate: 0.00
Total Tax: $0.00
Buyer's Special Terms & Conditions
Seller's Special Terms & Conditions
FIXED COSTto beadded th Seller's awarded total (any combination of items) =
Distribute Special Conditionk: (@ Evenly (O) Using weighted average
Include Special Conditionskosts forunawarded quotes in Comparable Totals
Drag columns here to group Find: Saved views: | Previous View -
oA = Scope Item Quote Group Induded Amount % of Total Motes
Number
= Permits Electrical Wark b o
Surveying and Layout Electrical Work » £500.00 14.29

Temporary Traffic Control Devices Electrical Work

B N

Trench and Badkfill for Electrical W...  Electrical Work

$950.00

4

Special Terms & Conditions  Qualifications  Packages  Seller'sProfile  Setup  Minority

Overview - Quote Comparison and Award - Scope Items

1 Scope ltems Quote Comparison and Award checklist items for your quote that help with
evaluating subcontractor and supplier quotes in greater detail. This is
used to ensure certain items are either included (inclusion) or excluded

(exclusion) in the quote and accounted for by the entity awarding the
quote.

2 Scopeltem Maintained in Quote Record form. These are the Seller's Special Terms &
Inclusions Conditions scope items that the subcontractor is including in their quote
price. When the scope item contains a value, the subcontractor is
agreeing to perform the work.

3 Scopeltem Maintained in Quote record form. These are the Seller’s Special Terms &
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Overview - Quote Comparison and Award - Scope Items (continued)

Exclusions  Conditions scope items price. If the Inclusions checkbox is blank, the
subcontractor is NOT agreeing to perform the scope items.

4  Scopeltem An entered value means that the subcontractor is excluding this scope of
value work. However, you may add an amount because this scope could incur a
cost. Once the bid is awarded, you may find another subcontractor to
perform the work. You are simply accounting for a cost for this scope of
work. In the example below, HD Engineering is not going to paint the
electrical equipment, but you know the cost is $150.00. You are showing
this cost to account the cost for this scope of work that needs to happen.

5 Seller’s By default, all scope items are considered included in the quote, and the
Special Special Conditions amount is $0.00. On the quote record, by selecting this
Terms & checkbox, you can indicate scope items and uncheck items that are not

Conditions included. The amount associated with these items will then total up in the
Special Conditions subtotal. The person responsible for awarding quotes
needs to update the Inclusions field to correspond with what the
subcontractor has agreed to include in the quote.

Cost Breakdown Structure (CBS) Register Quote Register Quote Comparison & Award - Cost items  ©

Quote Group(s) X Drag columns here to group

u Description = Reviewed Forecast Unit Architectural HD Engineering
TG = P, R Gm e
Electrical work 2 7.1 Electrical Work 1.00 Each £4,200... (O $4,200.00 £5,000.00 fe20.00 § & $4,20000 & $4,450,00
Electrical work 3 Scope Items
Guardrail Work Permits o “

Pipe Materials Surveying and Layout $500.00 $500.00

Sign Wark Temporary Traffic Control Devices O
Trench and Backfill for Electrical Work 9 o u]
Painting Electrical Equipment [u} $150,00
Temporary Power and Lighting [u} e $300.00
Summary

Minority Type
Quoted Total $5,000.00 $0.00 $4,200.00 $4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total $0.00 $0.00 $4,200.00 $0.00
Quoted Ttems Total $5,000.00 $0.00 $3,700.00 $3,500.00

> 6 Special Conditions $0.00 $0.00 $500.00 $950.00

Last Update 11/13/2019 1:0...  11/13/2019 3:5...

The example below in the Quote Register form shows quotes from two subcontractors, both with
different quote prices. It is important to understand all scope of work the subs are quoting. By just
viewing these quotes alone, it’s difficult to understand which quote will provide you with the best
value. In other words, just because Example Sub #3 is the lowest priced quote, does not mean it is the
best quote to go with.
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Quote Register ©

Drag columns here to group

- RFQ Quote Quote Awarded . Awarded
Description Description Status Seller Company Total Total Currency Awarded Status
Electrical Work Electrical Work  Accepted Example Sub #5MBE -- Chr... Example Sub #5 MBE $4,450.00 $0.00 U5, Dollar Mone
Electrical Work Electrical Work  Accepted Example Sub #3 --FrankM... ~Example Sub #3 $4,200.00 £0,00 .S, Dollar None

The example below in Quote Comparison and Award shows that HD Engineering Group is excluding 3
scope items in their quote that totals $950. This provides a more granular picture for what is being
included within each subcontractor’s scope of work. It also displays how much each scope of work
costs, so you have the option to find another subcontractor to perform this scope work.

2 Register Quote Comparison & Award - Costitems @
g columns here to group
gg:tion Code Description ?;cengéﬂ tlfnlt ggistt -I[-Footl"al_é:aosstg Flug Detail ;recs':;:sc?;:il EPUE;QIHEEFIHQ
Quantity Me... Electrical Work Electrical Work
27.1 Electrical Work 1.00 Each £4,200.... D §4,200.00 §5,000.00 §4,.200.00 : & $4,200.00 & §4,450.00
Scope Items
Permits m] %)
Surveying and Layout $500.00
Temporary Traffic Control Devices [m] %)
Trench and Badkfill for Electrical Work a %)
Painting Electrical Equipment O £150.00
Temporary Power and Lighting O m
Summary

Minarity Type
Quoted Total $5,000.00 50.00 %4,200.00 %4,450.00
Comparable Total < $5,000.00  $4,200.00 $4,200.00 $4,450.00
Awarded Total £0.00 $0.00 $4,200.00 £0.00
Quoted Ttems Total $5,000.00 $0.00 $3,700.00 \ss,soo.oo
Spedial Conditions $0.00 %0.00 £500.00 %$950.00
Last Update 11/13/2019 1:0... 11/13/2019 3:5...

Utilizing Scope Items enables you to more effectively compare quotes from subcontractors and
suppliers by providing a deeper comparison of quotes. Moreover, it provides clearer visibility of what a
proposal may or may not be including at the time you are attempting to make an award.

You can make a more informed decision on whom to award the quote to, now that the vendor quotes
and associated scope items are all visible on one screen.

8.5.1 Scope Item Setup

Scope items are stored within each quote group tag in the Foundation Setup Data form. On each
Quote Group Tag Record, you can list out scope items that break down the work into smaller scopes of
work, along with the estimated cost amount associated with each scope item.
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Foundation Setup Data Register Quote Group Tag Record ©

Description: * |Electrical Work

Award Status: Complete

Reviewed:

Last Reviewed:

Quote Last Changed:

Drag columns here to group

EET. = Scope Item Amount % of Total
1 Permits > §0.00
2 Surveying and Layout > £500.00
3  Temporary Traffic Control Devices > &0,00
4 Trench and Backfill for Electrical Work > 80,00
5  Painting Electrical Equipment - &0.00
=] - £300.00

Temporary Power and Lighting

Step by Step — Set up scope items

This exercise walks through a specific example using the Training Job.

1. Open your job.
2. Select the Setup tab.
3. Click on Foundation Data Setup in the Initialize section.
4. Select the Quote group tags tab to set up scope items within a quote group.
5. Create a new Quote Group Tag called Electrical Work and click Ok.
6. Open Electrical Work and add the following scope items:
e Permits

Surveying and Layout
e Temporary Traffic Control Devices

¢ Trench and Backfill for Electrical Work
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¢ Painting Electrical Equipment

e Temporary Power and Lighting

7.

8.

Enter 500 in the Amount field for Survey and Layout, and a 300 for Temporary Power and
Lighting.

Click Ok.
Ez::ber 3 Scope [tem Amount % of Total
1 Permits > $0.00
2 Surveying and Layout > $500.00
3 Temporary Traffic Control Devices > £0.00
4 Trench and Backfill for Electrical Work > €0.00
5 Painting Electrical Equipment » £0.00
6 Temporary Power and Lighting > $300.00

Step by Step — Set up quotes for scope items

This exercise walks through a specific example using the Training Job.

From the Estimate tab, click on Cost Breakdown Structure (CBS).

. Change your saved views to Quote Group Setup view.
. Create a cost item Entry Gate with a subordinate Electrical Work.

. Assign the Electrical Work quote group to the Electrical work cost item.

1
2
3
4
5.
6
7
8
9

From the Quote tab, click Request for Quote (RFQ) to open the RFQ register.

. Create an RFQ by selecting the New icon on the Actions tab.
. Select Create RFQ from Quote Group Tag(s) and select Electrical Work.
. Click Ok.

. Click on the Seller Companies tab and select the following company names:
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e Architectural Designs
e HD Engineering Group
10. Highlight both companies and select Publish.

11. Assuming you’ve already received quotes back from both companies, create a quote from this
RFQ for both companies by selecting the companies and selecting Create Quote.

12. Click Ok to close the RFQ record.

RFQ Quote

Description - P Stats Seller
S— D aeensaes
E— e e
Aggregates Aggreaates Received Example Vendar 1 —F;
Aggregates Aggregates Received Example Vendaor 4 DBE
Aggregates Aggregates Received Example Vendaor 2 - 5
Asphalt Materials Received Example Vendaor 1 —-F;
Asphalt Materials Received Example Vendaor 2 - 5
o s [ i ey
Electrical Work Electrical Wark Received Architectural Designs
Electrical Work Electrical Wark Received HD Engineering Grou

8.5.2 Scope Item Creation and Award

The following Step by Step assumes you are putting out an advertisement for bids for some electrical
work on a project. You will add scope items with some fixed costs as a special condition, then will
compare quotes in order to decide which vendor quote is the best deal.

Step by Step — Manage and award scope items

This exercise walks through a specific example using the Training Job.
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10.
11.
12.
13.
14.
15.

16.

. Click the Quote tab and then click the Quotes icon to open the Quote register.

Open the Quote Record for HD Engineering Group and enter a Unit Price of 3,500 which is based
on the quote you received.

Select the Special Terms & Conditions tab and select the Seller's Special Terms & Conditions
radio button.

Assuming the HD Engineering is excluding certain scope items from this quote, click on the
Included checkbox to exclude (uncheck) the following scope items:

Surveying and Layout

Painting Electrical Equipment

Temporary Power and Lighting

Type 150 in the Amount field for Electrical Equipment.

Notice how the 3 scope items you just excluded are now added to the Special Conditions total
for the quote.

Click Next to move to the other Quote record for Architectural Designs.
Enter a Unit Price of 3,700.

Press Tab to move to the Special Terms & Conditions tab and select the Seller's Special Terms &
Conditions (at right) radio button.

Uncheck the inclusions checkbox for Surveying and Layout.

Add the amount 500.

Click Ok.

Select the Quote tab.

Open the Quote Comparison and Award form, and select the Cost Items tab.
Under Quote Groups, select Electrical work.

Right-click on the quoted amount for Architectural Design and select Award to award the work
to them.

Click Yes on the resulting prompt to mark the quote group as reviewed.
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8.6 QUOTE ITEM ADJUSTMENT

Quote items can be adjusted even after a quote has been awarded. This could happen on closing day

when a vendor sends in a last minute discount. For example, vendor 3 has sent in a 10% discount on

piping materials. This percentage discount is applied to the vendor 3 quote by entering the 10% in the

Condition Adjustment column.

Step by Step — Quote item adjustment

From the Ribbon, select the Quote tab.

-

Under the Quote Comparison and Award section, select Resources.
Locate a Vendor column.

Select the quote you want to edit under the vendor column. In the Ribbon, select the Actions
tab.

Under the Quotes section, select Edit Quote. You can also right-click and select Edit Quote. This
launches the Quote Record.

You can make Condition Adjustments by a percentage or an amount. Select the field to adjust
the percentage or amount of the Condition Adjustments.

Iltems adjustments can be applied individually or by using the multi-edit function. Select multiple
resources in the Quote Record, then right-click and select Open. This opens the Quote Resource
Item Record.

If you populate a 10% discount adjustment to all of the items selected using the multi-edit tool,
the amount value changes to “Varies”. This is because of the variance in the unit rates for each
selected item.

Click Ok to save the changes to the line items in the Quote record and to save the Quote.
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Lesson 8 Review

1. When you receive responses to your RFQ, the next step is to enter their pricing in the

CBS Register
PBS

Quote Register

a o T o

RFQ Register

2. On a Quote Record, No Split means
a. The quote must be combined with other quotes from the same vendor
b. All items on the quote must be purchased from that seller

C. You can’t split the quote into multiple quotes

3. When a quote group is highlighted in yellow on the Quote Comparison & Award form, it
signifies that

a. The quote group has changed since it was last marked as Reviewed
b. No quotes have been awarded for that quote group

C. There are some quotes in the quote group that contain substitute values

Lesson 8 Summary

As a result of this lesson, you can:
¢ Create and publish RFQs
* Define quote pricing
e Compare and award quotes

* Create and analyze scope items
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LESSON 9 — FINALIZE THE ESTIMATE

This lesson is primarily suited towards contractors who must add profit or markup to their total
estimated cost, which will be submitted in the form of a bid or proposal. Most owners can divert from
this lesson as it's more geared towards adding profit and markup. There are a few use cases in which
an owner may wish to use the price breakdown structure. For example: to add risk, contingency, or
reserves if it is preferred, these are not shown directly in the budget line items. The price breakdown
structure also provides a summary level review of the total estimate and is a great reference during
estimate reviews.

Lesson Duration: 45 Minutes

Lesson Objectives
After completing this lesson, you will be able to:

¢ Add job markup (profit)
¢ Use tools on the PBS form to review your estimate
e Spread Target Price over pay items

e Make bid adjustments

Lesson Topics
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9.1 JOB MARKUP (PROFIT)

&

On the Data Map =
percentage amounts that make up Direct Costs, Indirect Costs and Target Profit. lllustrations below
show how the Data Map values correspond to the values that make up the cost and profit.

Patal2p otice how the different segments within the pyramid coincide with the

To open the Data Map, select the Price tab, then Data Map from the Overhead and Profit section.

9.1.1 Target Price

For contractors building the price of your project is like building a pyramid. The foundation of your
price consists of the direct costs of the job.

The images below represent a default examples.

Target Price $6,569,736
Markup $984,120 14.98%
Indirect Cost Markup $15,123 023%
Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 527%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

On top of your direct costs, you can decide if costs with a cost segment of business overhead should be
indirect costs or markup. You estimate your direct and indirect costs in the CBS Register.
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Target Price $6,569,736
Markup $984,120 14.98%
Indirect Cost Markup $15,123 0.23%
I:I Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 527%
\ Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rales

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

At the top of the pyramid you add an amount for profit. You add profit in the Price Breakdown
Structure (PBS) form. There is a very small block at the top of the Data Map, which comprises 0.22% of

Indirect Cost Markup.

Target Price $6,569,736
Markup $984,120 14.98%
Indirect Cost Markup $15,123 0.23%
—> Direct Cost Markup $623,074 9.48%
Business Overhead $345,923 527%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 79.96%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252,195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%) Current Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

The total of the direct cost, indirect cost, and profit in the project is referred to in InEight Estimate as
the Target Price. This is the final price that you want to submit as your proposal.
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|Target Price $6,569,736 |
Markup $984,120 14.98%
Indirect Cost Markup $15,123 023%
Direct Cost Markup $623,074 948%
Business Overhead $345923 527%

Total Cost $5,585,617
Indirect Cost $332,422 5.06%
Job Overhead $332,422 5.06%
Direct Cost $5,253,195 7996%
Unassigned Direct Cost $1,000 0.02%
Assigned Direct Cost $5,252 195 79.95%

*Values are based on Charge Rates

$6,569,735 (100.00%)  Cument Price
$1(0.00%) Variance (vs. Target Price)
($851) (-0.01%) Changes Register

9.1.2 Price Breakdown Structure

As you already practiced, your direct and indirect costs are estimated in the CBS. Your project’s profit
needs to be defined in the Price Breakdown Structure (PBS) form.

The main purpose of the Price Breakdown Structure (PBS) is to add markup (profit) to the estimate.
The Price Breakdown Structure is a visual run-down of the costs and profit that make up your Target
Price. It helps you analyze how your costs contribute to the price you are targeting, including the
amount of profit you would like to include.

You can open the PBS from the InEight Estimate landing page by selecting the Price tab, then Price
Breakdown Structure (PBS) from the Overhead and Profit section.

Overview - Price Breakdown Structure

I

1 PBS The left side of the screen displays several cost classifications:

Description « Target Profit
» Business Overhead
e Job Overhead
e Direct Cost

2 Various The Assigned and Unassigned columns show which costs are either
Columns assigned or not assigned to pay items. Unassigned costs are spread back
to pay items based on the distribution logic set in Job Properties > Pricing.
The Total columns represents a summation of both columns.
Each layer displays with an amount, and the percentage of the Target
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Overview - Price Breakdown Structure (continued)

I T

Price that this amount represents.

3 PBSMenu Therightside of the screen holds several tabbed pages of information.
This information is useful in analyzing the job at a summary level.

4 Refresh To ensure that you are always reviewing the most up-to-date factors and
Data ratios, click the Refresh Summary Data button whenever you are
reviewing the data.

%of IMukmAnalvsAs Price Status | Cost Source Vendor Status | a
Description Assgned  Unassigned  Total oot Y
- o [ T O S ——
v A TergetPrice $5,252,19.. $1,317,54.. $6,5609,73 100.00 e 2

\ Markp $0.00 $984,119.62 $984,119.62 14.98

forget Poft EEE 02 9638, 156.%2 o7 as%of  All Costs (Target Price - Markup) 17.62
Indrect Cost Markup $15,12266  $15,122.66 023

Diect Cost Markup $623,073.66  $623,073.66 9.48 12270

A Business Overhead $0.00 $345,923.30 $345,923.30 5.27 w1
B8 Price % Add-On $0.00 $295638.13 $295,638.13 4.50

95 Job Finanding $0.00 $33,105.26  $33,105.26 0.50 S

BB indrect Cost Escala $0.00 213111 $2,13L11 0.03 10126

85 Direct Cost Escalation| $0.00 $15,048.80  $15,048.80 0.23 .

@4 Busiess Overhead $0.00 $0.00 $0.00 0.00 -

~ A Total Cost $5,252,19.. $333,42.97 $5,585,61 85.02 of All OEOperation and RE Operation Costs 177.02

v A Indrect Cost $0.00 $332,421.97 $332,421.97 5.06 I e, ey
v A JobOverhead $0.00 $332,421.97 $332,421.97 5.06

99 prime Bond 000 $47,14068  $47,198.68 on as%of  All Supplies Costs 357102

oo

85 tndrect Cost A $0.00  $5888.67  $5888.67 0.09 & e o]
85 Direct Cost Add. $0.00 $104,088.34 $104,088.34 1.58

i Job Overhead 1 $0.00 $175,296.28 $175,296.28 267 et

~ 4 DrectCost $5,252,19..  $1,000.00 $5,253,19. 7.9 Markup per Equipment hour e
&% Drect CostItems $5,252,19..  $1,000.00 $5,253,19. 793

o

Refresh Summary Data

TIP All costs in the Price Breakdown Structure are based on pay quantities (not forecast take-
off quantities).

9.1.3 Markup vs. Margin

Let’s look at the difference between Markup and Margin.
e Markup is a function of cost, while margin is a function of price
e Markup indicates how much you are marking up the cost
e Margin indicates what percentage of your price the markup represents

The percentages on the main PBS screen are margin, so you can see what percentage each category in
the PBS represents compared to the total price. If you enter 10% in the Target Profit field, your profit
will be 10% margin of your total price.
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Description Assigned Unassigned | Total Ergget
- ‘ Price Breakdown Structure _—_
v J TargetFrice £5,252,19.. §1,317,54.. £5,569,73.. 100.00
« % Markup £0,00 £984,119.62 $§984,119.52 14,98
+ % TargetProfit £538,196.32 S535,196.32 9.7
» = Business Overhead 20,00 §345,923.30 5345,923.30 5.27
~ jk Total Cost §5,252,19... $333,421.97 §5,585,61.. 85.02

When you open the Direct or Indirect Markup Records, the Rate percentage there indicates markup of
the cost. If you enter 10% markup on $100, the markup will be $10.

Within Job Properties, you can choose if costs with a cost segment of business overhead should be
indirect costs or markup. If selecting markup, then Business Overhead will be spread within the
Markup category of the Price Breakdown Structure. The Total Markup will be the sum of Target Profit
and all ltems categorized as Business Overhead.

Data Map Job Properties ©
Cverview Security Cover Sheet Cost Basis Minority Setup Fuel Cost Job Tradking Job Folder Tags Pricing

Balanced Price Options
Calculate Balanced Pay Item Prices using:

(@ Cost Amount
() Billing Amount

Distribute Unassigned Cost/Billing Amount by:

(® Individual Categories
() Top level Categories
() Total Cost/Billing amount

Markup Options
Markup Pay Item by:

(@ Using Weighted Distribution

i) Keeping Markupwith Aszigned Costs

Categorize Business Overhead as:

() Indirect Cost
(® Markup

Page 398 of 417 InEight Inc. | Release 24.7



Estimate Essentials User Guide

9.1 Job Markup (Profit)

This lets you see the true total cost of the job, including the total markup inclusive of the business

overhead. You can also create cost items and categorize them as business overhead, then possibly

include overhead costs such as estimating or home office expenses. This provides you with added

flexibility in marking up your job.

9.1.4 Define Profit

Before you define profit, review the PBS. You estimated your direct cost items, and you also estimated

some indirect cost items in the CBS. You can view your direct and indirect cost totals on the Price

Breakdown Structure. Notice you have not defined profit yet.

Description Assigned Unassigned @ Total '?r.uarzzt
~ 4 | Price Breakdown Structure _—_—
v jh TargetPrice £5,252,19.. $545,755.99  £5,897,950.68 100.00
v % Markup €0.00  $315,692.95 £315,692.95 5,35
v i Target Profit S0.00 £0.00 0.00
Indirect Cost Markup £0.00 £0.00 0.00
Direct Cost Markup 50,00 50,00 0.00
w ™ Business Overhead 20.00 5315,692.95 £315,692.95 5.35
B0 Price % Add-On €0.00 £265,407.78 £265,407.78 4,50
B0 1ob Financing $0.00  §33,105.26 $33,105.26 0.56
OC Indirect Cost Escala... §0.00  $2,131.11 $2,131.11 0.04
OC Direct Cost Escalation £0.00  $15,048.80 £15,048.80 0.26
.'.i Business Overhead ... £0.00 £0.00 £0.00 0.00
~ jh Total Cost $5,252,19... $330,063.05  $5,582,257.73 94,65
+ & Indirect Cost $0.00 $329,063.05 $329,063.05 5,58
+ = Job Overhead $0.00 $329,063.05 $329,063.05 5,58
80 Prime Bond £0.00  $43,789.75 £43,789.75 0.74
00 indirect Cost A... €0.00  §5,888.67 £5,888.67 0.10
OO Direct Cost Add... $0.00 $104,088.34 $104,088.34 1.76
A& Job OverheadI... $0.00 $175,296.28 £175,296, 28 2.97
v g Direct Cost £5,252,19..  §1,000.00  £5,253,194.68 89.07
B Direct Cost Items $5,252,19...  $1,000.00  $5,253,194.58 89.07

You can define profit by entering a profit percentage directly on the PBS, or by modifying the Direct or

Indirect Cost Markup Records.

The following steps walk you through plugging a Target Profit percentage directly on the PBS form.
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9.1.4.1 Profit as a Percentage of Target Price

Step by Step — Add profit as a percentage of target price

Open your job.
Select the Price tab.

Select Price Breakdown Structure (PBS) from the Overhead and Profit section.

> o=

On the Target Profit row, enter a numeric value in the % of Target Price column; press Tab.

e For this example, we’ll add 10% for the Target Profit.

9.1.4.2 Profit Through Direct Cost Markup Record

The following steps walk you through how to add profit as markup on the Direct Cost Markup record.

Step by Step — Modify the direct cost markup record

1. On the PBS form, double-click on the Direct Cost Markup row.
2. Inthe record, overwrite the Default entry with Direct Cost Markup in the description field.

3. In the Rate column on the Dependency Cost Breakdown, add a numeric value in Labor, Owned
Equipment, Materials and Fees categories. Then reset other categories back to 0.

4. Click Ok to save your changes and return to the PBS.
5. Click the Refresh Summary Data button to see the changes reflected.

e For this example, we’ll add a rate of 15 for Labor, 10 for Owned Equipment, 8 for Materials, and
2 for Fees, then zero out all other categories.
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Descipion | Dependency | iflocation Cost Breakdown X
Sved vy . p Cost Cabegory .?:'f“ Raie Cost

Desoroten Currency TotdCost Forecast] ] - Total 102,786 .7 $13,081.82

- EEr N T T et B e

»  Owned Equpment $41.455.82 10.00 $4,145.55

: v Rented Equpment .00 0.00 000

» Supples 2000 0.00 0.0

» Materisy £1,27.00 .00 S8

b Subsoeitact .00 0.00 .00

» Fees sH2L08 .00 524

v Alrance oo .00 p o=}

Cuaiom Cabegaryl .00 0.00 000

Undefined .00 0.00 $0.00

9.2 COST ESTIMATE AUDIT/REVIEW

InEight Estimate offers built-in reports to double check your estimate and review different aspects of
your project, including material costs, quotes, man-hours and production.

9.2.1 Price Breakdown Structure Tabs

The purpose of the tabs on the Price Breakdown Structure is to assist with estimate reviews.

Markup Analysis Price Status Cost Source Resource Utilization Minority Goals Subrontract Status Vendor Status

9.2.1.1 Markup Analysis

On this tab, you can compare your profit to your costs for labor, subcontract and other cost groupings.
By seeing the ratios of your markup compared to your different cost categories, you can gauge if you
have the right balance of costs in your estimate.
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Markup Analysis (based on Bid quantities)

Markup as % of  All Costs (Target Price - Target Profit) 11.11
Markup as % of  All LaborCosts 79.42
Markup as % of  All Direct Labor Costs 44,07
Markup as % of  All Indirect Labor Costs 510.05

For example, if your markup is more than 100% of your Labor cost, it may indicate that you don’t have

enough labor cost in your estimate to cover the work, which could indicate labor cost overruns during
execution that would eat into your profit margin.

9.2.1.2 Cost Source

The Cost Source tab shows the breakdown of Detail, Plug and Quote cost sources, as well as the

amounts and percentages of each that are attributable to Direct and Indirect cost. Your Plug cost
source should be the lowest percentage.

Markup Analysis Price Status I Cost Source I| Resource Utilization

Minority Goals Subcontract Status Vendor Status
Cost Source Analysis (based on Bid quantities)
Detail Plug * Quote Total

Amaunt % Amount Yo Amount % Amount %
Direct Cost §5,156,491.67) 97.95 £64,600.00 1.23 $43,200.00 0.82 55,264,291.67) 100.00
Indirect Cost £638,694.52] 98.62 £5,338.76 0.82 53,570.19 0.55 S647,603.461 100,00
Total £5,795,186.19) 98.03 569,938.76 1.18 £46,770.19 0.79 £5,911,895.14 100.00

* Includes values entered as flat amounts {not percentages) on dependent cost items.

9.2.1.3 Resource Utilization

The Resource Utilization tab shows a breakdown of the man-hours and equipment hours utilized on
the job, based on take-off quantities.
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Markup Analysis Price Status Cost Source Resource Utilization

Resource Utilization Analysis (based on T/D

quantities}

Total Manhours 26,838.86
Total Equipment Hours 15,961.51
Total Shift Hours 5,508.23
Total Days * 682,70
Total Schedule Days 168.00

* shift hours divided by (hours per shift times shift per day)

9.2.1.4 Subcontract Status

The Subcontract Status tab displays a breakdown of subcontractor amounts, costs, and percentages for
guoted cost items. This is a good place to review how much of your estimate is subcontracted.

9.2.1.5 Vendor Status

The Vendor Status tab displays a breakdown of vendor information, including amounts and
percentages of the Target Price represented by vendors. This is a good place to review how much of
your estimate costs come from vendor quotes.

Markup Analysis | Price Status | CostSource | Resource Utilization Minority Goals Subcontract Status Vendor Status

Vendor Analysis (based on Bid quantities)

MNumber of Vendors 2

Total Vendor Amount 51,442,571.50

% of Target Price 21.96

Company Mame Contact Phone Amount  Currency Percent Street Address
Example Vendor 4 DEE Slim, Lester 111-122-1321 £271,471.20 U.S. Dollar 4,13 400 Fourth Street
Example Vendor 1 Roberts, Pat 111-123-2134 £1,171,100.70  U.S. Dollar 17.83 100 Tenth Street

9.3 SPREAD TARGET PRICE OVER PAY ITEMS
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In the Cost Breakdown Structure you generated your direct and indirect costs, and in the Price
Breakdown Structure you added profit to come up with a Target Price for the bid, but you still haven’t
decided how to spread the Target Price over your pay items.

In Lesson 4 you created pay items for the project in the Pay Item & Proposal Register. You can now go
back to the Pay Item & Proposal Register to distribute your Target Price over those pay items.

9.3.1 Current Price vs. Target Price

In InEight Estimate, Current Price means the total price that is currently assigned on your pay items.
Open the Pay Item & Proposal Register to see what the Current Price is for your pay items (Price > Pay
Iltem & Proposal).

At this point there is no pricing on your pay items, so your Current Price is $0.00. This is because you
have not yet spread your Target Price (the total of your cost and profit) over your pay items.

P Forecast Uniit of Unit Total
Description ay (T/0) ft o Price = Price
ey Quantity L (ou... (current)
+ Mobiliation 1.00 1.00  Each S0.00 £0.00
+ Clearing and Grubbg 10.00 15.00 Acre £0.00 £0.00
+ Excavation 50,000.00 40,000.00 CY £0.00 0,00
+ 10 "PVC Pipe 1,000.00 1,000,00 LF 20,00 S0.00

9.3.2 Proposal Recap

On the Pay Item & Proposal Register, there is a Proposal Recap table where you can compare your
Current Price to your Target Price to see if there is any variance.

Proposal Recap - Training Job

Current Target Forecast Variance

Price: £6,455,450.00 56,506,904.35 56,462,850.00 | 55145435 JADD

Profit: £599,221.58 £650,676.22 £655,858.61 £5,182.39 | CUT

Margin%a: 9.28 10.00 10,15 | $10,653.01 |CUT
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Ideally, you want to add pricing to your pay items until your Current Price equals your Target Price, so
that your Variance equals zero. That way you know you are covering all your costs and getting the
profit you want.

Notice the Variance column will indicate if you need to ADD or CUT pricing on your pay items to hit
your Target Price.

9.3.3 Spread the Target Price

For lump sum contracts, spreading the Target Price may be as simple as spreading it to a single pay
item that represents the entire project. However, most jobs will have at least a few pay items defined
by the owner, and Unit Price contracts will have many pay items.

There are two main ways to distribute pricing onto your pay items:

1. Define pay item prices manually, by entering a unit or total price, or a margin percentage.

2. Use InEight Estimate’s AutoPrice feature to distribute pricing automatically.

9.3.4 Define Pricing for Pay Items Manually

First, you will walk through the process of defining pricing manually. This method requires filling in
each item’s price based solely on your own judgment.

Step by Step — Define pricing manually

1.
2.
3.
4.

From the Estimate landing page, select the Price tab.
Select Pay Item & Proposal from the Pay Items section.
Select a Pay Item row.

In either the Unit Price (current), Total Price (current), or % Margin field of a pay item, type a
numeric value.

For this example, we’ll do the following:
* Mobilization pay item — change Total Price (current) to $20,000.

¢ Clearing & Grubbing pay item — change % Margin to 5%.
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Forecast

Pasition . Pay Item . Pay Unit of Unit Price Total Price :
Code = MNumber Desaription Quantity (/o) ) Measure (current) (ourrent) % Margin
Quantity
B 1 200 SITEWORK & ROADWAY $51,369.60
+ 11 6410100 Mobilization 1.00 LS $20,000.00 $20,000.00 -34.67

—mmm-—ml

9.3.5 Use AutoPrice to Balance and Hit the Target Total

Perhaps you want to get a head start and have InEight Estimate spread your Target Price
proportionately over your pay items for you. This can be done using the InEight Estimate AutoPrice
feature.

TIP Once distributed, you will still have the ability to adjust your pricing on pay items
manually as needed.

Look at how you can use the AutoPrice feature.

Step by Step — Use AutoPrice to balance and hit the target total

1.
2.
3.
4,
5.

Open the your job in Estimate.

From the Estimate landing page, select the Price tab.

Click on Pay Item & Proposal to open the Pay Item & Proposal Register.

On the Pay Item & Proposal Register menu, choose Actions > Balanced Bid > Hit Target Total.

Review the Proposal Recap and see that the Variance is now $0.00. Now that the job is balanced,
you can see that the Current Price and the Target Price are the same, indicating that the costs
and profit are spread proportionately over your pay items.

9.3.6 Use AutoPrice to Unbalance and Hit the Target Total

The Autoprice to Unbalance feature in InEight Estimate can automatically distribute profit to account
for your over- and underrun items.

InEight Estimate will take profit from your underrun and put it on your overrun by using the Actions >
Unbalanced > Hit Target Total feature. The purpose is to maximize your profit by spreading it
strategically between these items.
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Step by Step — Unbalance hit target total

1. You may encounter overrun and/or underrun items in the Pay Item & Proposal Register of your

job.
Faorecast )
. — Pay Unit of
Description = 7T T gﬂ?.:ﬁty Meas. .. Curre...
Excavation 10.00 15.00 | Cubic Yard 115, Dallar
Clearing & Grubbing 50,000.00 40,000.00 | Ace LL.5. Dallar

2. If you do, highlight the row for each item to view it’s current balanced item recap.

Item Recap - 2000 Clearing && Grubbing Item Recap - 3000 Excavation
Balanced Unit | Current Unit Balanced Unit | Current Unit
A Price: $4,98570 | $4,994.91 A Price: £2.86 £2.86
i Profit: £515.91 £525.12 i Profit: 50.29 £0.29
Total Cost: 54,469.79 54,469.79 Total Cost: 52.57 52.57
= Business Overhead: £245.35 i Business Overhead: £0.15
Y Job Overhead: %1,681.60 & Job Overhead: £0.91
am |Unassigned Direct Cost: £0.00 am |Unassigned Direct Cost: £0.00
e Assigned Direct Cost: 52,542.84 ey Assigned Direct Cost: £1.52

3. On the Pay Item & Proposal Register menu, choose Actions > Unbalanced Bid.

_

&= Link Field [T1] Assigned Direct Cost Only |+ | Qverwrite Locked Pay Items

H unlink Field | &, Balanced Bid ~ == Custom Auto Price

=1 Unbalanced Bid

Workbook Auto Price

¢ You will see the changes reflected and how the profit was spread to your overrun and
underrun items
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Unit Price _ Total Price %

(current) (current) Margin
§3,000.00  §150,000,000.00 9,26
£4,871.54 £43,718.40 97.68

591, 100,00 591, 100,00 10,05

 Inthe example shown, highlighting each item will show that all your overhead and
profit from Excavation was put onto Clearing & Grubbing.

Ttem Recap - 2000 Clearing && Grubbing Item Recap - 3000 Excavation
Balanced Unit | Current Unit Balanced Unit | Current Unit
A Price: $4885.70 | $11,706.11 A Price: $2.86 $1.52
Total Cost: §4,469.79 §4,469.79 Total Cost: £2.57 $2.57
) Business Overhead: £245.35 ) Business Overhead: $0.15
) Job Overhead: $1,681.60 = Job Overhead: $0.91
am |Unassigned Direct Cost: £0.00 am |Unassigned Direct Cost: £0.00
| AssignedDirect Cost $2,542.84 | Assigned Direct Cost: 51.52

9.4 SELECTIVE PAY ITEM MARKUP

Estimate has a streamlined process to estimate the cost of a project and price the work to ensure all
unassigned costs and markup are included in the final price of the project. For markup to be spread to
pay items, a weighted distribution method is used as determined in the Job Properties, Pricing tab. It
might be desirable for markup percentages to not be distributed, but rather directly applied to the
costs assigned to any particular pay item.

This option can be set to keep markup with assigned costs for establishing a pay item price.
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Job Properties ©

Owerview Security Cover Sheet Cost Basis Minority Setup

Balanced Price Options
Calculate Balanced Pay Item Prices using:

{®) Cost Amount
() Billing Amount

Distribute Unassigned Cast/Billing Amount by:

{® Individual Categories
() Top level Categories
() Total Cost/Billing amount

Markup Options
Markup Pay Item by:
(®) Using Weighted Distribution

() Keeping Markupwith Assigned Costs

Categorize Business Overhead as:

() Indirect Cost
(@) Markup

Calculate Proposal Recap Forecast Markup using:

(®) Unit Markup (current) x Forecast (T/0) Quantity
(") Forecast Price - Total Cost/Billing

Fuel Cost

9.4 Selective Pay Item Markup

Pricing

Additionally, this option can be used to isolate the markup and apply it only to specific pay items. The

following is an example of a dependent cost item being used to mark up the labor of select site work

pay items by 25%.

& Print @ New Copy Toggle Suspended Link Field Insert [0 Assigned Cost Only Ovenwite Locked Pay liems |y Defauit Data Blods M=

R preview Delete Paste Lock Quantites Uniink Field Insert subordinate | €A, Balanced Bid + == custom Auto Price Z 1S Compare Alternate Scenarios )

- Expand [ Configure Price

& Export toExcel Cut FilDown  [/] Lock Prices =0 Unbalanced Bid Collapse ~ Categories

Print Edit Workbook Insert Auto Price View

Pay Item & Proposal Register @

Drag columns here to group
Pay Item Lock lod [ o iton Pay Forecast (T/0) Uit of cureney | LABOR LABOR LABOR LABOR LAOR
Number Quantity Price. Quantity Quantity Measure Cost Distribution Markup Markup % (balancec)

s EARTHUWORK AND UTILITEES 100 100 LmpSum  US.Doler  $52,40L68 000 §15600.42, 2500  sm00200
+ 2 ACPAVING 100 100 LmpSum  US.Doler  $23,71L17 w000 7477 2s00| sa7,1%.96
+3 PAVMENT MARKINGS 100 100 LmpSum  US.Doler  $14,545.57 w000 §36%6.3 2500 818196
+ a4 SITE CONCRETE 100 100 LmpSum  U.S.Doler $0.00 $0.00 0.00 0.00 $0.00
+5 FENCING 100 100 Wwmpsum | U.S. Dolar $7,163.88 000 §1,7%0.7, 25.00 $3,95484
t6 LANDSCAPING 100 100 LmpSum  U.S.Doler $0.00 $0.00 0.00 0.00 $0.00
+ 7 PILES AND PIERS .00 1,00 Lump Sum U.5. Dollar $0.00 $0.00 $0.00 0.00 $0.00
+ 8 CONCRETE .00 1,00 Lump Sum U.5. Dollar $0.00 $0.00 $0.00 0.00 $0.00

InEight Inc. | Release 24.7

5 Bid Wizard

_J Reset Rounding Precision

[3 mport DOT Pay Item File
Tools

LABOR Uit Price Total Price:

Price (current) (current) (current)
$7266437  SI70,700.00  §170,700.00
$34,430.25 $97,253.00 $97,253.00
$16,940.94 $44,200.00 $44,200.00

000 §21530000  $215,300.00
$5,099.23 $42,300.00 $42,300.00
.00 $39,900.00 $39,300.00
£000  $1,625000.00  $1,625,000.00
4000 $5,37,940.00  $5,370,940.00
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Exercise 9.1 — Manually Price Pay Items

To finalize your bid proposal, you will apply final pricing (costs and profit) to your pay items either
manually or using the AutoPrice tool. In this exercise, you will practice entering prices manually for
your pay items. Complete the following steps, using your job.

1. Continue manually pricing items in the Pay Item & Proposal Register.

2. Type 2.75 in the Unit Price (current) column for pay item Excavation.

3. Type 2 in the % Margin field for pay item 4000 — 10” PVC Pipe.

4. Check your variance to see if you need to add or cut your current pricing to hit your
Target Price.

You should end up with similar results

e R ospn Wy OO0 W e me
Quantity {current) {current)

+ 1000 1 Mobilization 1,00 1,00 Lump Sum $20,000,00 $20,000,00 -40,04

+ 2000 2 Clearing & Grubbing 10.00 15.00 Ace $4,705.04  $47,050.40 5.00

+ 3000 3 Excavation 50,000,00 40,000.00 CY €275  §137,500.00 .44

+ 4000 4 107 PVC Pipe 1,000,00 1,000.00  LF £22.00 $22,000,00 1.99

Congratulations, you have completed this exercise!
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9.5 BID ADJUSTMENTS

Often you will want to continue adjusting certain pay items and then rebalance to hit the target total.

9.5.1 Lock Price

You can lock down a pay item price and it will not factor in future rebalancing.

Step by Step — Lock Price

1. Select the Lock Price checkbox on an item's row.

Forecast
Pay Item - — Lock Pay
Description =7 : ) (T/O)
Mumber Price Quantity Quantity
+ 2020183 IUndassified Excavation 50,000.00 50,000.00
+ 6410100 Maobilization v‘ 1.00 1.00
+ 2010102 Clearing & Grubbing 10.00 10.00

2. After making further adjustments in the next step by step, you will return to the Pay Item &
Proposal to rebalance.

* You can continue to adjust at previous levels aside from solely in the Pay Item & Proposal
Register

e For example, you could make a last-minute adjustment in the PBS or CBS. You can make
adjustments anywhere, but for this example an adjustment will be made in the Direct Cost
Add-On record at the CBS level

Step by Step — Make Last Minute Bid Adjustments

1. With your job open, select the Estimate tab.
2. Click on Cost Breakdown Structure to open the CBS.

3. Double click on the row header to open the Direct Cost Add-On dependent cost item record.
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9.5 Bid Adjustments

4. Under the Description tab on the left, click in the blank row under the Description column.

Type in a description.

Make the adjustment by typing a numeric value in the Cost column of the Materials Cost

category under the Cost Breakdown section on the right.

Cost Breakdown

Cost Category
«  Total
»  Labor
»  Owned Equipment
» Rented Equipment
»  Supplies
» Materials
»  Subcontract
» | Fees
»  Allowance
Custom Categoryl
Undefined

Subject Cost
£130,755.83
558,9659.83
568,251.92
£0.00
£0.00
£3,275.00
£0.00
§262.08
50,00
£0.00
£0.00

Rate
-0.76
0.00
0.00
0.00
0.00
-30...
0.00
0.00
0.00
0.00
0.00

Cost
(51,000.00)
£0,00
£0.00
£0,00
£0,00
£0,00
£0.00
£0,00
E £0,00
E £0.00

» To make a cut, enter a negative value, i.e. -1000

7. Press the Tab key, and your adjustment will be reflected on the left-hand side.

Description Dependency

Urag columns nere o group

Description

Small Tools
Safety & Training
= Cut

Cost Categorization

Allocation

Curre...

LL.5. Dollar
L5, Dollar
L.5. Dollar

Finally, return to the Pay Item & Proposal.

Total Cost
(Forecast)

£5,596.93
§2,948,49
{£1,000.00)

On the Actions menu, select Balanced Bid > Hit Target Total.

Ao
Co

10. An Auto Price Warning may display, informing you of rounding variances. After reading the

details, click the Close button.
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B Auto Price Warning = x

Variance due to rounding predsion

Estimate attempted to hit your Target Price by spreading the total variance amount
across the unlocked pay items in accordance with your selected pricing method.
However, due to the items’ rounding precision, a variance still exists,

Initial rounding variance: (%84.43)

Tatal amount still remaining as a variance after
attempting to spread the initial rounding variance
proportionately into each unlocked item: (%0.03)

[] Turn off this warning aboutrounding variances for ALL JOBS.

TIP: You can minimize variances due to rounding by specifying greater rounding
precision for the unlocked items, and by unlocking items with a quantity of 1.

Undo AutoPricing | Close |

¢ Note on the proposal recap that a variance may still exists because there are limited
number of pay items to spread the rounding error over

¢ Note that the locked item did not adjust, but the other pay items were updated

¢ Note that you can overwrite locked items for spreading your price by checking the
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Overwrite Locked Pay Items option on the Actions menu

_
[[1] Assigned Direct Cost Only I Crverwrite Locked Pay Items I

= Custom Auto Price

eld

Field

ok

ﬂ Balanced Bid ~

:E Unbalanced Bid

9.5.2 Suspend Pay Items

Auto Price

9.5 Bid Adjustments

Like suspending cost items in the CBS Register, you can suspend pay items in the Pay Item & Proposal
Register. Suspending a pay item causes it to no longer contribute quantities and pricing to the

estimate.

This can be helpful when considering alternate items on a bid submission. Should the client decide to
not require a pay item, you can suspend it, causing the pay item and any of its assigned cost items to
no longer contribute any cost or price. It will no longer show up on your bid and no longer contribute
to the overall total price.

You can suspend/unsuspend pay items in one of three ways:

¢ Right click on the pay item and select Toggle Suspended

[
BN + 8000400
+ E01(A) 1306
+ 508(A) 1322
+ 503(A) 1313
+ 6000300
+ 700
+ 1000
+ 1010
+ 1200 0100
+ 15000100
+ 15000200
+ 1600 0230
+ o1
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o
9
10

12
13
14
15
16
17
18
19
20
M

U
90
100
110
120
130
140
150
160
170
180
150
200
M

LT LU VL 3 aVILY JTWE LU

ERVEITRIY

4 Foot Diameter Manhole I
Structural Excavation & Badkfil

Steel Reinforcement
Retaining Wall
Paint Existing Steel Bridge Stry
Process Equipment

Removal of Underground Storage T
Disposal of Contaminated Soil
Toll Booth

Guardrail Type 2

Guardrail Type 34 I

ERVETRT VR

[ gpe mm
00.00  Cubic

e New
00.00 | Pounc

€9 Delete
- 50.00  Cubic
o< Cut 100 Lum
a Copy 100 Fach
B2 Paste 2.0¢ Each
% Fill Down Cubi
Link this field to Excel 1.00 Each
UnLink from Excel 00.00  Linear

Teggle Suspended

ﬁD.DD
1

Type 4 Signs

Realinnment of Water | ine

T,000.00

1.00

Linear

Squa
1.00  Farh
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¢ Select the pay item and click Toggle Suspended under the Edit section of the Actions Tab

Estimate Quote Price Execution System
EI! Print B Open g-( Cut Fill Down Lock Prices & Link Field [ Assigned Direct Cost Only Overwrite Locked Pz
'i Preview e Mew % Copy a Toggle Suspended &% Unlink Field & Balanced Bid ~ E Custom Auto Price
&/ Export to Excel e Delete % Paste Lock Quantities =1 Unbalanced Bid
Print Edit Workbook Auto Price

Pay Item & Proposal Register @
Proposal Recap - Training Job
Current Target Forecast Variance
Price: | $6,455,450.00 | $6,514,915.53 | $6,462,850.00 | $59,465.53 |ADD

Profit: £592,026.02 £651,491.55 £658,609.04 £7,11749 | QUT

Margina: 9.17 10.00 10.19 | §13,693.38 |CUT

Drag columns here to group

Pay Item Lock L. Row - Line L Pay Rorecast Unit of
Mumber Qua... F... Mu... = Mu... BT Qua... g:gliﬁty Meas. ..
+ 6410100 1 10 Mobilization 1.00 1.00 | Lump Sur
+ 2010102 2 20 Clearing & Grubbing 10.00 10,00 Acre
+ 2020183 3 30 Unclassified Excavation 50,000.00 50,000.00  Ton
+ 3035912 4 4 Agaregate Base 40,000.,00 45,000.00 Ton
+ 3034263 5 50 Asphalt Concrete Hot Mix Type A 38,000.00 35,000.00 Ton
+ 413(B) 0464 6 60 36 Inch RCP Culvert Class III 1,000.00 1,024.00 LinearF
+ 8000220 7|70 10 Inch PVC Force Main (SDR21) 12,000.00 12,000.00  Linear Fe
+ 5000330 3 80 24 Inch PVC Gravity Sewer EDR35) 3,000.00 3,000.00  Linear Fe
B oo [ W W [ R rooeeetenoe | tooo]  sow]ceo |
F RIS i ik el Euravustinn & BarrAl EQLEn ERNE T ==
e Open the pay item record and checking/unchecking the Suspend box

Pay Item & Proposal Register Pay Item Record © -

Pay Item Number: - ‘ Line Number:
Desription: 4 Foot Diameter Manhole Alternate: | BASE -

Suspend:
Quantity
Lock Quantity:  Pay Quantity: Forecast (T/0) Qty: Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
O [ 16.00] | 16.00| | Each - 0.00 0.00  Even Run
Price

Laock Price: Unit Price Precision:  Unit Price: Total Price: Currency: Payment Method: % Margin:
~ 1T ppee e | —— - | ——
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Lesson 9 Review

1. Markup is a function of cost, while margin is a function of

a. billing
b. price
C. job overhead

o

indirect costs

2. When adding profit, it must be the same amount for direct and indirect costs.
a. True

b. False

3. What options do you have to enter profit on the PBS?
a. % Mark-Up, % Margin, and Fixed Dollar Amount
b. % Mark-Up or % Margin

C. Fixed Dollar Amount Only

4. Once distributed, you still can adjust your pricing on pay items manually as needed.
a. True

b. False

Lesson 9 Summary

As a result of this lesson, you can:
¢ Add job markup (profit)
¢ Use tools on the PBS form to review your estimate
e Spread Target Price over pay items

¢ Make bid adjustments
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